Table of Contents

Chapter 1 Setting up and Preparing for a Training Session .................................................1
   Setting up Training Center ..................................................................................................1
   System requirements for Training Center for Windows ......................................................2
   Setting up Training Center for Windows ..........................................................................2
   Preparing for a training session .........................................................................................3
   Checking your system for UCF Compatibility ..................................................................3
   About WebEx Connect .......................................................................................................4
   About sharing a remote computer .....................................................................................4

Chapter 2 Joining a Training Session ......................................................................................7
   About Joining a Training Session ......................................................................................7
   Registering for a Training Session ....................................................................................8
      Registering for a Training Session from an Invitation Email Message .......................9
      Registering for a Training Session from the Live Sessions Page .............................9
   Adding a scheduled training session to your calendar program ..................................11
   Downloading Course Material Before the Training Session ......................................12
   Joining a Listed Training Session ....................................................................................14
      Joining a Listed Training Session from an Email Message ........................................14
      Joining a Listed Training Session from the Live Sessions Page ............................15
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Joining an Unlisted Training Session</td>
<td>16</td>
</tr>
<tr>
<td>Joining an Unlisted Training Session from an Email Message</td>
<td>16</td>
</tr>
<tr>
<td>Joining an Unlisted Training Session from Your Training Center Web Site</td>
<td>16</td>
</tr>
<tr>
<td>Joining an in-process training session</td>
<td>17</td>
</tr>
<tr>
<td>Joining an in-process training session from an email message</td>
<td>17</td>
</tr>
<tr>
<td>Joining an in-process training session from an instant message</td>
<td>18</td>
</tr>
<tr>
<td>Joining an in-process training session from a text message (SMS)</td>
<td>18</td>
</tr>
<tr>
<td>Obtaining Information About a Scheduled Training Session</td>
<td>19</td>
</tr>
<tr>
<td>Finding a Training Session</td>
<td>20</td>
</tr>
<tr>
<td>About Using the Live Sessions Page</td>
<td>21</td>
</tr>
<tr>
<td>Searching for a Training Session</td>
<td>21</td>
</tr>
<tr>
<td>Sorting the Live Sessions Page</td>
<td>22</td>
</tr>
<tr>
<td>Refreshing the Live Sessions Page</td>
<td>23</td>
</tr>
<tr>
<td>Selecting a Time Zone on the Live Sessions Page</td>
<td>23</td>
</tr>
<tr>
<td><strong>Chapter 3 Using the Calendar</strong></td>
<td>25</td>
</tr>
<tr>
<td>About the training session calendar</td>
<td>25</td>
</tr>
<tr>
<td>Viewing the training session calendar</td>
<td>26</td>
</tr>
<tr>
<td>Selecting a date on the training session calendar</td>
<td>27</td>
</tr>
<tr>
<td>Searching for a training session on the training session calendar</td>
<td>29</td>
</tr>
<tr>
<td>Sorting the training session calendar</td>
<td>29</td>
</tr>
<tr>
<td>Refreshing the training session calendar</td>
<td>30</td>
</tr>
<tr>
<td>Selecting a language and time zone on the training session calendar</td>
<td>30</td>
</tr>
</tbody>
</table>
About the Today view........................................................................................................31
About the Upcoming view ..................................................................................................34
About the Daily view..........................................................................................................36
About the Weekly view.......................................................................................................38
About the Monthly view.....................................................................................................40
About the Search Results page..........................................................................................41

Chapter 4 Setting up and Scheduling a Training Session .............................................45

About scheduling a training session..................................................................................46
Choosing a level of security for a training session ...............................................................46
Setting up a scheduled training session.............................................................................47
Setting up session and access information........................................................................51
  Setting up a topic name and password................................................................................51
About listed and unlisted training sessions.........................................................................52
Specifying whether a training session is listed or unlisted ...................................................53
Supporting over 500 attendees............................................................................................53
Deleting sessions automatically..........................................................................................54
Copying session information from another session...........................................................54
Specifying tracking codes for a scheduled session..............................................................55
Setting up E-commerce (fee or pay-per-use training) .........................................................56
  About E-commerce for Training Center............................................................................56
Setting up fee-based training..............................................................................................56
About using coupons..........................................................................................................57
Setting up pay-per-use training.................................................................57
Specifying audio conferencing options..................................................58
Setting up an audio conference for a scheduled session...........................58
Setting up a VoIP-only audio conference for a scheduled training session .....60
System requirements for Integrated VoIP ..................................................61
Specifying date and time options .............................................................61
  About scheduling a training session time, occurrence, and duration ..........62
  About the Date and Time options ..........................................................62
  Scheduling a training session time, occurrence, and duration ..................66
Setting up Hands-on Lab .......................................................................68
  About Hands-on Lab..............................................................................68
  About the Hands-on Lab page ...............................................................68
  Reserving computers for Hands-on Lab ...............................................69
  Viewing the Hands-on Lab schedule ....................................................70
Specifying registration options ...............................................................70
  About requiring registration for a scheduled training session .................71
  Requiring registration for a scheduled training session ..........................72
  About customizing a registration form ..................................................73
  Customizing a registration form ............................................................75
Inviting attendees and presenters ............................................................77
  About inviting attendees and presenters to a scheduled training session ....77
  Inviting attendees to a scheduled training session .................................78
Inviting a new attendee to a scheduled training session ........................................ 79
Inviting presenters to a scheduled training session .............................................. 80
Inviting a new presenter to a scheduled training session ................................... 80
Inviting contacts in your address book to a scheduled training session .......... 82
Specifying training session options ....................................................................... 83
Specifying options available to participants during a training session ................. 84
Specifying security options for a training session ................................................. 85
Allowing attendees to share UCF media files ...................................................... 86
Specifying a destination Web page after the session ends .................................... 86
Creating a message or greeting for a scheduled training session ...................... 87
About the Session Options page ........................................................................... 88
Setting up breakout sessions .................................................................................. 91
Pre-assigning breakout session participants ......................................................... 91
Assigning registered attendees to breakout sessions .......................................... 92
Selecting email messages to be sent ...................................................................... 93
About sending default email messages .................................................................. 94
Sending an invitation to a training session ............................................................ 94
Sending an update to a scheduled training session .............................................. 95
Sending a registration notification to a scheduled training session ................. 95
Sending a reminder for a scheduled training session .......................................... 96
Receiving a notification when an attendee joins a session .................................. 97
About customizing email messages ..................................................................... 97
Editing a Personal Conference meeting or MeetingPlace Personal Conference meeting ............................................................................................................................................. 114

Starting a MeetingPlace Personal Conference meeting ............................................. 116

Canceling a Personal Conference Meeting or MeetingPlace Personal Conference meeting ............................................................................................................................................. 116

About the Personal Conference Meeting Information page (host)............................ 118

About the Personal Conference Meeting Information page (for attendees) ........ 119

Chapter 6 Using SCORM ................................................................................................................................. 121

SCORM overview ................................................................................................................................. 121

Viewing the SCORM page ....................................................................................................................... 122

Editing the SCORM page ......................................................................................................................... 123

Chapter 7 Setting Up a One-Click Meeting ................................................................................................. 125

About setting up a One-Click Meeting ................................................................................................. 125

Setting up your One-Click Meeting on the Web ....................................................................................... 126

About the One-Click Settings page ......................................................................................................... 127

Installing WebEx Productivity Tools ..................................................................................................... 130

Starting a One-Click Meeting .................................................................................................................... 132

Removing WebEx Productivity Tools ..................................................................................................... 136

Chapter 8 Starting, Modifying, or Canceling a Training Session .............................................................. 137

Starting an instant training session .......................................................................................................... 137

Starting a scheduled training session ....................................................................................................... 139

About starting a scheduled training session ............................................................................................ 139

Starting a scheduled training session from a confirmation email message ..... 140
Starting a scheduled training session from your training sessions page........140
Modifying a scheduled training session..........................................................141
About modifying a scheduled training session.............................................141
Modifying a scheduled training session from a confirmation email message..141
Modifying a scheduled training session from your training sessions page.....142
Canceling a scheduled training session..........................................................143
About canceling a scheduled training session.............................................143
Canceling a scheduled training session from a confirmation email message .144
Canceling a scheduled training session from your training sessions page .....144

Chapter 9 Understanding the Session Window ..............................................147
A quick tour of the Session window..............................................................147
Your first look at the Session window ..........................................................148
Working with the panels ...........................................................................151
Panels overview.........................................................................................152
Minimizing and restoring panels .................................................................153
Expanding and collapsing panels ..............................................................155
Managing panels ......................................................................................156
Restoring the panel layout.........................................................................157
Resizing the content viewer and panels area .............................................157
Accessing panel options............................................................................158
Accessing panels in full-screen view..........................................................160
Overview of Session Controls Panel..........................................................160
Sharing documents or software while in full-screen view ................................. 161
Synchronizing attendee displays ........................................................................... 162
Understanding panel alerts ................................................................................... 163
Overview of panel alerts ....................................................................................... 163
Alerts for minimized panels ................................................................................. 163
Alerts for collapsed panels ................................................................................... 164

Chapter 10 Accessing the Session window using the keyboard .......................... 165
Navigating between Session window areas ........................................................... 166
Navigating between open documents ..................................................................... 166
Navigating the panels area ................................................................................... 167
Using right-click menus ....................................................................................... 168
Working with the participant list ........................................................................... 169
Switching between tabs in dialog boxes ................................................................. 169
Switching between elements in dialog boxes or panels ....................................... 170
Switching between options in dialog boxes .......................................................... 172
Checking and unchecking option boxes ................................................................. 173
Copying text from the Chat panel ........................................................................ 174
Entering text in an input box .................................................................................. 175
Closing dialog boxes ............................................................................................. 176
Activating an option or button ............................................................................. 176
Accessing the Session Controls Panel during sharing ......................................... 177
Screen reader support .......................................................................................... 178
Chapter 11 Managing a Training Session

About managing training sessions

Inviting more people to your in-progress training session

Inviting people by instant message to a training session in progress

Inviting people by email to a training session in progress

Inviting people by phone to a training session in progress

Inviting people by text message (SMS) to a training session in progress

Reminding invitees to join your meeting

Granting attendee privileges during a training session

Changing presenters

   Making a participant the presenter when you are in the meeting window

   Making a participant the presenter when you are sharing

Designating a panelist

Transferring the host role to another participant

Reclaiming the host role

Obtaining information about a training session after it starts

Editing a message or greeting during a training session

Restricting access to the training session

Tracking participant attention

   Checking participant attention in a training session

   Turning on or off attention tracking in a training session

Removing an attendee from the training session
Leaving the training session......................................................................................................199
Ending the training session ..................................................................................................199

Chapter 12 Assigning Privileges during a Training Session .............................................201
About granting privileges to attendees ..................................................................................201
Granting attendee privileges during a training session .........................................................202
About the Assign Privileges dialog box ................................................................................203

Chapter 13 Assigning Sounds to Participant Actions ........................................................205

Chapter 14 Using WebEx Audio ..........................................................................................207
Connecting to an audio conference .....................................................................................208
   Using your telephone to connect to audio ......................................................................209
   Using your computer to connect to audio ....................................................................212
Switching audio devices during a meeting ..........................................................................213
Connecting to audio during sharing ..................................................................................214
Muting and unmuting microphones ......................................................................................214
   Muting and unmuting all participant microphones simultaneously ............................215
Asking to speak in an audio conference ...........................................................................216
Using caller authentication to start or join an audio conference .......................................217
   Specifying call-in authentication for your host account ..............................................218
   Using an authentication PIN .......................................................................................219
Editing or updating your stored phone numbers ...............................................................219

Chapter 15 Sharing Files and Whiteboards .......................................................................221
Granting sharing privileges .................................................................................................222
Content viewer tools

Changing views in a file or whiteboard

Using annotation tools on shared content

Sharing files

Sharing a file

Choosing an import mode for presentation sharing

Sharing a whiteboard

Starting whiteboard sharing

Navigating presentations, documents, or whiteboards

Navigating slides, pages, or whiteboards using the toolbar

Advancing pages or slides automatically

Animating and adding effects to shared slides

Working with pages or slides

Managing views of presentations, documents, or whiteboards

Zooming in or out

Controlling full-screen view

Viewing thumbnails

Synchronizing all participant views

Clearing annotations

Clearing pointers

Saving, opening, and printing presentations, documents, or whiteboards

Saving a presentation, document, or whiteboard
Opening a saved document, presentation, or whiteboard...............................240
Printing presentations, documents, or whiteboards ..................................241
If you are a training session participant...............................................................241
Displaying pages, slides, or whiteboards.........................................................241
Synchronizing your view of pages, slides, or whiteboards.................................242

Chapter 16 Sharing Software.............................................................................243
Sharing applications.............................................................................................244
Starting application sharing ..............................................................................245
Sharing several applications at once .................................................................246
Stopping application sharing for all participants...............................................247
Sharing your desktop ..........................................................................................248
Starting desktop sharing ...................................................................................248
Stopping desktop sharing ..................................................................................249
Sharing a Web browser .......................................................................................250
Starting Web browser sharing ...........................................................................250
Stopping Web browser sharing ........................................................................251
Sharing a remote computer ..............................................................................251
Starting remote computer sharing ....................................................................252
Sharing additional applications on a shared remote computer .......................253
Stopping remote computer sharing ..................................................................254
Managing a shared remote computer ...............................................................255
Reducing the screen resolution for a shared remote computer .......................256
Disabling and enabling the keyboard when sharing a remote computer........257
Adjusting the size of the view of a shared remote computer.........................258
Hiding the contents on a shared remote computer's screen..........................259
Sending a Ctrl+Alt+Del command to a shared remote computer....................260
Selecting an application on a shared remote computer...............................260
Controlling views of shared software..........................................................261
Pausing and resuming software sharing.........................................................262
Controlling full-screen view of shared software ...........................................263
Synchronizing views of shared software.........................................................265
Selecting a monitor to share............................................................................265
Controlling your view as a participant............................................................267
Closing your participant sharing window.........................................................268
Switching your participant view........................................................................269
Annotating shared software............................................................................270
Starting and stopping annotation.....................................................................271
Using annotation tools....................................................................................272
Letting a participant annotate shared software.................................................273
Requesting annotation control of shared software..........................................274
Giving up annotation control...........................................................................275
Stopping an participant from annotating shared software...............................275
Taking a screen capture of annotations on shared software............................276
Granting participants control of shared software.............................................277
| Requesting remote control of shared software | 277 |
| Letting a participant remotely control shared software | 278 |
| Automatically letting participants remotely control shared software | 279 |
| Stopping remote control of shared software | 279 |
| Sharing applications with detailed color (Windows) | 281 |
| Sharing applications with detailed color (Mac) | 282 |
| Tips for sharing software | 283 |

**Chapter 17  Sharing Web Content** ......................................................... 285

| About sharing Web content | 285 |
| Sharing Web content | 286 |
| Differences between sharing Web content and sharing a Web browser | 286 |

**Chapter 18  Transferring and Downloading Files During a Training Session** ...... 289

| Publishing files during a Training Session | 290 |
| Downloading Files During a Training Session | 291 |

**Chapter 19  Polling Attendees** ............................................................. 293

<p>| About polling attendees | 293 |
| Preparing a poll questionnaire | 294 |
| About preparing a poll questionnaire | 294 |
| Composing poll questions and answers | 294 |
| Editing a questionnaire | 297 |
| Renaming and reordering polling tabs | 298 |
| Displaying a timer during polling | 299 |</p>
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Opening a poll</td>
<td>300</td>
</tr>
<tr>
<td>Answering polls</td>
<td>301</td>
</tr>
<tr>
<td>Filling out a poll questionnaire</td>
<td>301</td>
</tr>
<tr>
<td>Viewing poll results</td>
<td>301</td>
</tr>
<tr>
<td>Viewing and sharing poll results</td>
<td>302</td>
</tr>
<tr>
<td>Viewing poll results</td>
<td>302</td>
</tr>
<tr>
<td>Sharing poll results with attendees</td>
<td>303</td>
</tr>
<tr>
<td>Saving and opening poll questionanres and results</td>
<td>304</td>
</tr>
<tr>
<td>Saving a poll questionnaire</td>
<td>304</td>
</tr>
<tr>
<td>Saving poll results</td>
<td>305</td>
</tr>
<tr>
<td>Opening a poll questionnaire file</td>
<td>306</td>
</tr>
<tr>
<td>Opening a poll results file</td>
<td>307</td>
</tr>
<tr>
<td><strong>Chapter 20  Managing Question-and-Answer Sessions</strong></td>
<td>309</td>
</tr>
<tr>
<td>Allowing participants to use Q &amp; A</td>
<td>310</td>
</tr>
<tr>
<td>Setting privacy views in Q &amp; A sessions</td>
<td>310</td>
</tr>
<tr>
<td>Managing questions on your Q &amp; A panel</td>
<td>312</td>
</tr>
<tr>
<td>Working with the tabs on your Q &amp; A panel</td>
<td>314</td>
</tr>
<tr>
<td>Opening a tab</td>
<td>314</td>
</tr>
<tr>
<td>Closing a tab</td>
<td>315</td>
</tr>
<tr>
<td>Assigning a question</td>
<td>316</td>
</tr>
<tr>
<td>Prioritizing questions</td>
<td>316</td>
</tr>
<tr>
<td>Viewing prioritized questions</td>
<td>317</td>
</tr>
</tbody>
</table>
Answering questions in a Q & A session ........................................................................318
Providing a public answer ..............................................................................................319
Answering a question privately ......................................................................................319
Dismissing a question .....................................................................................................320
Deferring a question ........................................................................................................321
Responding to questions answered verbally .................................................................321
Archiving Q & A sessions ...............................................................................................322
Saving a Q & A session .................................................................................................322
Saving changes to a saved Q & A session ....................................................................323
Saving a copy of a previously saved Q & A session .....................................................323
Opening a Q & A file .......................................................................................................324

Chapter 21 Participating in a Question-and-Answer Session .............................325
Working with the tabs on your Q & A panel .................................................................325
Asking a question in a Q & A session ...........................................................................326
Checking the status of your questions ........................................................................326
My Q & A tab ..................................................................................................................327
Answering indicator .....................................................................................................327

Chapter 22 Using Chat .............................................................................................329
Sending chat messages .................................................................................................329
Assigning sounds to incoming chat messages .............................................................330
Printing chat messages .................................................................................................331
Saving chat messages ..................................................................................................331
Saving chat messages to a new file...............................................................332
Saving changes to a chat file........................................................................332
Creating a copy of previously saved chat messages........................................332
Opening a chat file during a training session..................................................333

Chapter 23 Using Feedback...........................................................................335
About using feedback.....................................................................................335
Allowing participants to provide feedback......................................................336
Viewing a running tally of responses...............................................................337
Providing feedback.........................................................................................338
Using emoticons in feedback..........................................................................339
Removing feedback.........................................................................................340

Chapter 24 Managing Hands-on Lab ............................................................341
About Hands-on Lab.......................................................................................342
Setting up Hands-on Lab................................................................................343
  About the Hands-on Lab page.......................................................................343
  Setting up in-session Hands-on Lab...............................................................343
  Reserving computers for in-session Hands-on Lab........................................344
  Viewing the Hands-on Lab schedule...............................................................345
  Assigning Hands-on Lab computers to registered attendees.......................346
  Setting up on-demand Hands-on Lab............................................................347
  About the Reserve Lab Computers for On-demand Use page.......................347
  Scheduling on-demand Hands-on Lab..........................................................348
Inviting attendees for on-demand Hands-on Lab ............................................. 349
Changing reservations .................................................................................. 349
Starting a Hands-on Lab session .................................................................. 350
Recording Hands-on Lab sessions ............................................................... 352
Assigning computers during Hands-on Lab sessions .................................. 354
Unassigning Participants from Computers .................................................. 356
Broadcasting a message to participants ...................................................... 356
Responding to a request for help ................................................................. 357
Taking control of a Hands-on Lab computer .............................................. 358
Asking all to return from labs ..................................................................... 358
Ending the Hands-on Lab session ............................................................... 359

Chapter 25 Using Hands-on Lab .................................................................... 361

About Hands-on Lab ..................................................................................... 361
Connecting to a reserved computer ............................................................. 362
Connecting to unassigned computers ......................................................... 362
Using an audio conference in a Hands-on Lab session .............................. 363
Using the Hands-on Lab Manager ............................................................... 365
Using Hands-on Lab chat .......................................................................... 366
Asking for help in Hands-on Lab ............................................................... 367
Transferring files in a Hands-on Lab session ............................................ 368
Passing control of the Hands-on Lab computer ....................................... 369
Leaving a Hands-on Lab session ............................................................... 370
Chapter 26  Using Breakout Sessions

About Breakout sessions

Using the Breakout Session window

Breakout Session window overview

Breakout Session panel overview

Breakout Session menus

Controlling breakout sessions

About controlling breakout sessions

Granting breakout session privileges

Allowing breakout sessions

Creating a breakout session with automatic assignment

Creating a breakout session with manual assignment

Manually creating a breakout session for another participant

Asking all participants to return from a breakout session

Sending a broadcast message to all breakout sessions

Ending all breakout sessions

Requesting a breakout session presenter to share content

Removing a participant from a breakout session

Presenting breakout sessions

About presenting a breakout session

Creating a breakout session - attendees
Starting a breakout session that was created for you ................................................................. 396
Joining a breakout session ........................................................................................................ 396
Leaving and re-joining a breakout session ................................................................................ 397
Using an audio conference in breakout sessions .................................................................... 397
Managing who can join the breakout session .......................................................................... 399
Passing the presenter role to another participant .................................................................. 401
Presenting information in a breakout session .......................................................................... 402
Granting remote control to a participant in a breakout session .............................................. 402
Ending your breakout session .................................................................................................. 403
Restarting a breakout session .................................................................................................... 404
Sharing content from your breakout session in the main session .............................................. 404

Chapter 27 Testing and Grading ................................................................................................. 407
About testing and grading ........................................................................................................... 408
Adding tests to a scheduled training session ............................................................................ 408
Adding tests to a recorded training session ............................................................................... 410
Understanding the Test Library ................................................................................................ 413
Creating a new test .................................................................................................................... 414
Converting test or poll questionnaires to tests ........................................................................ 416
Specifying test delivery options for a scheduled training session ........................................... 417
  Specifying the delivery method ............................................................................................... 417
Specifying test delivery options for a recorded training session ............................................. 419
  Specifying a time limit ............................................................................................................ 419
Starting and managing scheduled training session tests ........................................420
Managing pre-and post-session tests ..................................................................421
Managing and starting in-session tests .................................................................421
Managing recorded tests ......................................................................................423
Scoring and grading answers for a test ...............................................................425

Chapter 28 Taking a Test .......................................................................................427

About taking a test .................................................................................................427

Obtaining test information .....................................................................................428
About obtaining test information ..........................................................................428
Obtaining test information from a registration confirmation email message ....429
Obtaining test information from the training calendar ........................................429
Obtaining test information from an invitation email message to take a test ....430
About attendee accounts .......................................................................................430

Taking a pre- or post-session test ........................................................................431
About taking a pre- or post-session test ...............................................................431
Taking a test from a registration confirmation email message ............................432
Taking a test from the training calendar ...............................................................432
Taking a test from an invitation email message ................................................433
Leaving and returning to a test ............................................................................433

Taking an in-session test .......................................................................................434
About taking an in-session test ............................................................................434
Taking an in-session test .......................................................................................435
Taking a recorded session test in a Presentation Studio presentation .................. 436

About taking a recorded session test .................................................................. 436
Taking a recorded session test ............................................................................. 437
Leaving and returning to a recorded session test .............................................. 437
Answering questions .......................................................................................... 438
Answering questions .......................................................................................... 438
Saving answers and navigating in a test ............................................................. 439
Viewing test results ............................................................................................. 440
About viewing test results .................................................................................. 440
Viewing results of a test that requires manual scoring ....................................... 441
Taking the test again ........................................................................................... 442

Chapter 29 Sending and Receiving Video .......................................................... 443

Minimum system requirements ........................................................................... 445
Locking focus on one participant ......................................................................... 445
Switching between a list or thumbnail view of participants ............................. 446
Viewing everyone who is sending video ............................................................ 448
Understanding the large video view .................................................................... 448
Expanding the active speaker’s video display ..................................................... 450
Floating Icon Tray in Video Full Screen Mode .................................................. 450
Setting webcam options ..................................................................................... 451
Managing video display during sharing .............................................................. 452
Controlling your self-view .................................................................................. 452
Controlling video display........................................................................................................... 453
Obtaining video and audio data during a training session......................................................... 454

Chapter 30 Using My WebEx ........................................................................................................ 457

About My WebEx ......................................................................................................................... 458
Obtaining a user account ............................................................................................................. 459
Logging in to and out of the WebEx service site ......................................................................... 460
Using your list of meetings ........................................................................................................... 461
About your list of meetings ......................................................................................................... 461
Opening your meetings list .......................................................................................................... 461
Maintaining your scheduled meetings list .................................................................................... 463
About the My WebEx Meetings page .......................................................................................... 463
About the My WebEx Meetings page - Daily tab....................................................................... 465
About the My WebEx Meetings page - Weekly tab .................................................................... 467
About the My WebEx Meetings page - Monthly tab .................................................................. 470
About the My WebEx Meetings page - All Meetings tab ........................................................... 472
Maintaining Your Personal Meeting Room Page ....................................................................... 474
About your Personal Meeting Room page ................................................................................ 475
Viewing your Personal Meeting Room page ............................................................................. 475
Setting options for your Personal Meeting Room page ............................................................ 476
Sharing files on your Personal Meeting Room page ................................................................. 477
Using Access Anywhere (My Computers) .................................................................................. 478
About the My Computers page ................................................................................................ 478
Maintaining files in your personal folders ............................................................. 479
About maintaining files in your folders ............................................................... 480
Opening your personal folders, documents, and files ......................................... 481
Adding new folders to your personal folders ....................................................... 482
Uploading files to your personal folders ............................................................... 482
Moving or copying files or folders in your personal folders .............................. 483
Editing information about files or folders in your personal folders ................. 484
Searching for files or folders in your personal folders ....................................... 485
Downloading files in your personal folders ......................................................... 486
Deleting files or folders in your personal folders ................................................. 486
About the My WebEx Files > My Documents page ........................................... 486
About the Edit Folder Properties page ............................................................... 488
Opening the My Recordings Page ....................................................................... 490
Uploading a recording file .................................................................................. 490
Editing information about a recording ............................................................... 491
About the Add/Edit Recording page .................................................................. 492
Playback control options .................................................................................... 493
About the Recording Information page .............................................................. 494
About the My WebEx Files > My Recordings page ............................................ 496
About the My WebEx Files > My Recordings > Miscellaneous page ............... 497
Maintaining contact information ........................................................................ 498
About maintaining contact information ............................................................. 499
Opening your address book.................................................................499
Adding a contact to your address book.............................................501
About the New/Edit Contact page...................................................502
Importing contact information in a file to your address book.............503
About the Contact Information CSV template ..................................505
Importing contact information from Outlook to your address book.....506
Viewing and editing contact information in your address book.........507
Finding a contact in your personal address book ..............................508
Creating a distribution list in your address book ...............................508
Editing a distribution list in your address book .................................510
About the Add/Edit Distribution List page ......................................511
Deleting contact information in your address book ..........................512
Maintaining your user profile ............................................................513
About maintaining your user profile .................................................513
About the My WebEx Profile page ....................................................514
Editing your user profile ................................................................520
Managing scheduling templates .......................................................520
About managing scheduling templates .............................................521
Managing scheduling templates .......................................................521
Generating Reports ........................................................................522
About generating reports .................................................................522
Generating reports .........................................................................524
Chapter 31 Publishing a Recorded Training Session........................................527
  About publishing recorded training sessions............................................528
    Opening your list of recorded training sessions ....................................528
    Publishing a recorded training session ...............................................529
    Making a recording available to users .................................................533
    Editing information about a recorded training session .........................535
    Editing a recorded training presentation .............................................537
    Removing a recorded training session from your site ..........................543
    Viewing the Recorded Training Access Detail Report ..........................544
  About the My Training Recordings page.................................................546
  About the Add a Recording/Edit Recording Information page ..................548
  About the On-Demand Module .............................................................554
  About Optimizing Recording Playback Quality .....................................555

Chapter 32 Viewing a Recorded Training Session ....................................557
  About viewing a recorded training session ..........................................557
  Viewing a recorded training session....................................................558

Index ........................................................................................................561
Setting up and Preparing for a Training Session

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>set up Training Center for Windows</td>
<td>Setting up Training Center for Windows (on page 2)</td>
</tr>
<tr>
<td>make sure your system can handle Universal</td>
<td>Checking your system for UCF Compatibility</td>
</tr>
<tr>
<td>Communications Format (UCF) media files</td>
<td>(on page 3)</td>
</tr>
<tr>
<td>get prepared for a training session</td>
<td>Preparing for a training session (on page 3)</td>
</tr>
</tbody>
</table>

Setting up Training Center

To participate in a training session, you must set up Training Center on your computer. Once you schedule, start, or join a training session for the first time, your training session service Web site starts the setup process. However, to save time, you can set up the application at any time before scheduling, starting, or joining a training session.

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of system requirements</td>
<td>System requirements for Training Center for Windows (on page 2)</td>
</tr>
<tr>
<td>set up Training Center for Windows</td>
<td>Setting up Training Center for Windows (on page 2)</td>
</tr>
<tr>
<td>check your system for UCF compatibility</td>
<td>Checking your system for UCF Compatibility</td>
</tr>
</tbody>
</table>
If you want to… | See…
---|---
| (on page 3)

**System requirements for Training Center for Windows**

You can find the system requirements and other information about compatible browsers and operating systems on the User Guides page for your service:

1. Log in to your WebEx Training Center site.
2. On the WebEx Training Center navigation bar, click **Support > User Guides**.
3. On the right side of the page, under Release Notes and FAQs, click the link for release notes.

**Setting up Training Center for Windows**

Before installing Training Center, ensure that your computer meets the minimum system requirements. For details, see *System requirements for Training Center for Windows* (on page 2).

If you are not using the Windows operating system, please refer to our FAQ, which includes information about setting up Training Center on other operating systems.

**To go to the list of FAQs:**

4. On your Training Center Web site, on the left navigation bar, click **Support > User Guides**.
5. On the **User Guides** page, under Release Notes and FAQs, click the link for FAQs (Frequently Asked Questions).

A list of questions displays, arranged by topic. Look for your information about your operating system under **Minimum System Requirements**.

**To set up Training Center for Windows:**

1. On the navigation bar, expand **Set Up**, and then click **Training Manager**.

   The Set Up page appears.

2. Click **Set Up**.

3. If a security dialog box appears, click **Yes**.
Setup continues. A progress message box appears, indicating the progress of setup.

4. On the Setup Complete page, click **OK**.

You can now start, schedule, or join a training session.

**Note:**
- Alternatively, you can download the Training Manager for Windows Installer from the Support page on your Training Center Web site, and then install Training Manager on your Web browser. This option is useful if your system does not allow you to install Training Manager directly from the Set Up page.
- If you or another attendee plans to share Universal Communications Format (UCF) media files during a training session, you can verify that the required components are installed on your system to play the media files. For details, see *Checking your system for UCF Compatibility* (on page 3).

---

**Preparing for a training session**

To take advantage of the many features available in a training session, check your system and then install some tools to extend training session capabilities.

- Check your system for UCF compatibility (if you have presentations with animations, save them as .ucf so training session attendees can view these effects) More… (on page 3)
- Set up and install Cisco WebEx Connect More… (on page 4)
- Share a remote computer, if this feature is available More… (on page 4)

**Checking your system for UCF Compatibility**

If you intend to play or view Universal Communications Format (UCF) media files during the training session, either as a presenter or an attendee, you can verify that the following components are installed on your computer:

- Flash Player, for playing a Flash movie or interactive Flash files
- Windows Media Player for playing audio or video files

Checking your system is useful if you or another presenter plans to share a UCF multimedia presentation or standalone UCF media files.
To check your system for UCF compatibility:

1. On the navigation bar, do one of the following:
   - If you are a new training session service user, click New User?
   - If you are already a training session service user, expand Set Up, then click Training Manager.
2. Click Verify your rich media players.
3. Click the links to verify that the required players are installed on your computer.

Note: The option to check your system for required rich media players is available only if your Training Center Web site includes the UCF option.

About WebEx Connect

Use WebEx Connect, the instant messenger for business users to send secure instant messages, invite or remind participants, and manage a training session. Connect integrates with Microsoft Outlook corporate directories and calendars, encrypts messages and scans them for viruses, and offers quick access to business conferencing services from WebEx.

To download WebEx Connect:

1. Log in to your Training Center Web site.
2. On the Training Center navigation bar, click Support > Downloads.
3. Scroll down to the section of the page describing WebEx Connect.
4. Click the link to learn more about this product and download it.

About sharing a remote computer

Use remote computer sharing to show all training session participants a remote computer. Depending on how you set up the remote computer, you can show the entire desktop or just specific applications. Use remote computer sharing to show attendees an application or file that is available only on a remote computer.

Attendees can view your remote computer, including all your mouse movements, in a sharing window on their screens.

You can share a remote computer during a training session for which you are the presenter, if:
You have installed the Access Anywhere Agent on the remote computer

You logged in to your Training Center Web site before joining the training session, if you are not the original training session host

For information about setting up a computer so you can access it remotely, refer to the *Access Anywhere User’s Guide.*
## About Joining a Training Session

You can join the following types of training sessions:

- **Listed training session**—A training session that appears on the list of training sessions page.

---

### Joining a Training Session

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>See…</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of joining a training session</td>
<td><strong>About Joining a Training Session</strong> (on page 7)</td>
</tr>
<tr>
<td>register for a training session</td>
<td><strong>Registering for a Training Session</strong> (on page 8)</td>
</tr>
<tr>
<td>add a training session to your calendar</td>
<td><strong>Adding a scheduled training session to your calendar program</strong> (on page 11)</td>
</tr>
<tr>
<td>download course material before the training session</td>
<td><strong>Downloading Course Material Before the Training Session</strong> (on page 12)</td>
</tr>
<tr>
<td>join a listed training session</td>
<td><strong>Joining a Listed Training Session</strong> (on page 14)</td>
</tr>
<tr>
<td>join an unlisted training session</td>
<td><strong>Joining an Unlisted Training Session</strong> (on page 16)</td>
</tr>
<tr>
<td>join an in-process training session</td>
<td><strong>Joining an in-process training session</strong> (on page 17)</td>
</tr>
<tr>
<td>obtain information about a scheduled training session</td>
<td><strong>Obtaining Information About a Scheduled Training Session</strong> (on page 19)</td>
</tr>
</tbody>
</table>

**Note:** The training session host may choose to record the training session.
Unlisted training session—a training session that does not appear on the list of training sessions page.

In-process training session—a training session that is in process, from which the host invites you by email, instant message, or text message (SMS).

If a training session host either invites you to a training session or approves your registration request for a training session, you receive an email message that includes instructions and a link that you can click to join the training session. The email message contains the training session password, unless the host has specified that passwords do not appear in email messages.

If you did not receive an email invitation or registration confirmation, you can join a training session that is currently in progress. You need not be an authorized user or log in to your Training Center Web site to join a training session, unless the host has specified that all training session attendees must have a user account.

Note: If you have not yet set up Training Manager on your computer, you can do so before joining a training session to avoid a delay. Otherwise, once you join a training session, your Training Center Web site automatically sets up Training Manager on your computer.

Registering for a Training Session

If a training session host invites you to register for a training session, you receive an invitation email message. The email message contains a link that you can click to register for the training session.

If you did not receive an email invitation to register for a training session, you can register for the session on the Live Sessions page on the Training Center Web site:

If registering for a training session requires a password, you must provide the password that the training session host gave to you.

When scheduling a training session, the host may set a limit to the number of session attendees, as well as determine if there will be a waiting list for the session. If so, you may be allowed to register for a waiting list.

Note: If registration is required for a Recurring single-session class or a
Multiple session course, you will be required to register for only one session. If you register again in a subsequent session, the previous registration will be canceled.

Important: The IM feature is not available for training sessions that require registration.

Registering for a Training Session from an Invitation Email Message

To register for a training session from an email invitation that you received, follow these steps:

1. Open your email invitation, then click the link.
2. On the Session Information page that appears, click Register.
3. On the Register for [Topic] page that appears, provide the required information.
4. Click Register.

Once the host approves your registration, you receive a registration confirmation email message. You can then join the training session from the email once it starts.

If the training session is already in progress, and the host has chosen to approve all registration requests automatically, click Join Now to join the training session immediately.

Registering for a Training Session from the Live Sessions Page

To register for a training session from the list of sessions on your Training Center Web site, follow these steps:

1. On the navigation bar, expand Attend a Session to view a list of links.
2. Click Live Sessions.
   The Live Sessions page appears.
3. In the list of sessions, locate the training session for which you want to register.
Chapter 2: Joining a Training Session

**Note:** You can register for only those training sessions with a status of **Register** or **Waitlist**, in which case you would be registering to be put on a waiting list for the session.

To locate a training session quickly, you can

- sort the list of sessions by clicking the column headings. For details, see *Sorting the Live Sessions Page* (on page 22).
- search for a training session. For details, see *Searching for a Training Session* (on page 21).

**Tip:** If the session you are looking for requires registration, select the **Show only sessions that require registration** check box.

4 Click **Register** (or **Waitlist**) next to the name of the training session for which you want to register.

5 On the Register for: [Topic] page that appears, provide the required information.

6 If necessary, select the session date for which you are registering.

**Note:** If you are registering again for this training session, your previous registration will be lost.

7 Click **Register**.

Once the host approves your registration, you receive a registration confirmation email message. You can then join the training session from the email once it starts.

If the training session is already in progress, and the host has chosen to approve all registration requests automatically, click **Join Now** to join the training session immediately.

**Tip:**
- You can obtain detailed information about a selected training session or its agenda before registering for it. For details, see *Obtaining Information*
Adding a scheduled training session to your calendar program

When you receive a training session invitation via email, or are directed to a Web site by the host, there may be an option for you to add the training session to a calendar program, such as Microsoft Outlook or Lotus Notes. This option is applicable only if:

- this feature was enabled on the host's site when the training session was scheduled
- this feature is enabled on the host's Training Center Web site when directed to find the training session information there
- your calendar program supports the iCalendar standard, a common format for exchanging calendaring and scheduling information across the Internet

To add a scheduled training session to your calendar from an email:

1. In the email invitation that you receive, click the link to add the training session to your calendar.
2. If necessary, add the appropriate session and click OK.
3. In the File Download dialog box, click Open.
4. Select the option to accept the training session request. For example, in Outlook, click Accept to add the training session to your calendar.

To add a scheduled training session to your calendar from a Training Center site:

1. Go to the Training Center Web site as directed by the host.
2. Find the training session name on the Live Sessions page and click the topic name.
   The Session Information page appears.
3. Click Add to My Calendar.
Chapter 2: Joining a Training Session

4. If necessary, add the appropriate session and click OK.

5. In the File Download dialog box, click Open.

6. Select the option to accept the training session request. For example, in Outlook, click Accept to add the training session to your calendar.

Note: If you receive an email message that the host has canceled the training session, you can remove it from your calendar program by clicking the link within the email, and then following similar steps that you used for adding the training session.

Downloading Course Material Before the Training Session

If your training instructor uploads course material to the Training Center Web site, you can download it before the training session.

To download course material:

1. On the navigation bar, expand Attend a Session to view a list of links.

2. To view a single list of all training sessions, click Live Sessions. The Live Sessions page appears.

3. On the Live Sessions page, locate the training session for which you want to download course material.

To locate a training session quickly, you can do the following:

- sort the list of training sessions by clicking the column headings.
- display the calendar for another date by clicking the calendar icon.
- view the scheduled sessions for the current day, future sessions, daily, weekly, or monthly recurring sessions by clicking the tabs: Today, Upcoming, Daily, Weekly, and Monthly. The recurring sessions tabs appear only if recurring sessions have been scheduled.
- search for a training session by its host or presenter name, session topic, or any text in the description or agenda.
4. Under **Topic**, click the name of the training session for which you want to download course material.

   The Session Information page appears.

5. Optional. If the training session requires registration and you have not yet registered, do the following:

   a) Click **Register**.

   b) Enter any required information, and then click **Register**.

      The Registration Confirmed page appears.

   c) Click **OK**.

6. If no registration is required, or if you have already registered, click **View Session Details**.

7. Enter the session password and click **OK** to see the complete session information.

8. Next to **Course Material**, click the link for the file.

   The File Download dialog box appears.

9. Click **Save**.

   The Save As dialog box appears.

10. Choose a location at which to save the file. Click **Save**.

    The file downloads to your selected location.

11. If applicable, download additional files.

12. Once you finish downloading files, click **Close**.

13. Click **Go Back**.

---

**Note:** If the host has published a file in the Universal Communications Format (UCF), which has a .ucf extension, a security warning dialog box appears, asking you if you want to install WebEx software that caches, or stores, the file on your computer. Click **Yes** or **OK** to install the software. Once you download the UCF file, the software also downloads the UCF file to the `C:\My WebEx Documents\Cache\[SessionNumber]` folder on your computer, in addition to any other location that you specify. Once the session starts, the UCF file that you downloaded automatically opens in your Session window. During the session, you can view the file’s content much more quickly than if you did not previously download the file.
Chapter 2: Joining a Training Session

Joining a Listed Training Session

If you received either an invitation or registration confirmation email message for a training session, you can join the session from the email message. Or, you can join a listed training session by locating it on training calendar on the Live Sessions page.

If the training session requires a password, you must provide the password that the training session host gave to you.

Joining a Listed Training Session from an Email Message

To join a listed training session from an invitation email message, follow these steps:

1. Open your invitation or registration confirmation email message, then click the link.

   The Session Information page appears.

   Note: If the training session requires registration, a Register button appears on the page. If you have not yet registered for the training session, you must do so before you can join it. For registration information, see Registering for a Training Session from an Invitation Email Message (on page 9).

2. On the Session Information page, enter any required information and click Join Now.

   The Session window appears.

   If the training session includes an integrated audio conference, the Audio Conference dialog box appears. Follow the instructions in the dialog box to start the audio conference.
Joining a Listed Training Session from the Live Sessions Page

To join a listed training session from the Live Sessions page on your Training Center Web site, follow these steps:

1. On the navigation bar, expand **Attend a Session** to view a list of links.
2. Click **Live Sessions**.
   
The Live Sessions page appears.
3. Click **Join** for the training session that you want to attend.

   **Note:** If the training session requires registration, a **Register** link appears next to the training session listing. If you have not yet registered for the training session, you must do so before you can join it. For registration information, see *Registering for a Training Session from the Live Sessions Page* (on page 9).

4. Enter any required information, and then click **Join Now**.

   The Session window appears.

   If the training session includes an integrated audio conference, the Audio Conference dialog box appears. Follow the instructions in the dialog box to start the audio conference.

   **Tip:**

   - You can obtain detailed information about a selected training session or its agenda before registering for it. For details, see *Obtaining Information About a Scheduled Training Session* (on page 19).
   - You can display all training session times in another time zone. For details, see *Selecting a Time Zone on the Live Sessions Page* (on page 23).
   - You can refresh the training calendar to ensure that you are viewing the most recent information. For details, see *Refreshing the Live Sessions Page* (on page 23).
Joining an Unlisted Training Session

To join an unlisted training session—that is, a training session that does not appear on the Live Sessions page—you must provide the training session number that the training session host gave to you.

If you received either an invitation or registration confirmation email message for a training session, you can join the session from the email message. You can also join the training session from your Training Center Web site.

Joining an Unlisted Training Session from an Email Message

To join an unlisted training session from an invitation email message that you received, follow these steps:

1. Open your invitation email message, then click the link.
   
   The Session Information page appears.

   **Note:** If the training session requires registration, a **Register** button appears on the page. If you have not yet registered for the training session, you must do so before you can join it. For registration information, see *Registering for a Training Session from an Invitation Email Message* (on page 9).

2. On the Session Information [Topic] page, click **Join Now**.

   The Session window appears.

   If the training session includes an integrated audio conference, the Audio Conference dialog box appears. Follow the instructions in the dialog box to start the audio conference.

Joining an Unlisted Training Session from Your Training Center Web Site

To join an unlisted training session from your Training Center Web site, follow these steps:

1. On the navigation bar, expand **Attend a Session** to view a list of links.
2 Click **Unlisted Session**.

   The Join an Unlisted Training Session page appears.

3 Type the session number that the host gave to you in the **Session number** box.

4 Click **Join Now**.

   **Note:** If the training session requires registration, a **Register** button appears on the page. If you have not yet registered for the training session, you must do so before you can join it. For registration information, see **Registering for a Training Session from the Live Sessions Page** (on page 9).

5 Enter any required information, and then click **Join Now**.

   The Session window appears.

   If the training session includes an integrated audio conference, the Audio Conference dialog box appears. Follow the instructions in the dialog box to start the audio conference.

### Joining an in-process training session

During a training session, a host may invite you to join. The invitation may arrive via email, via instant message program, or via text message (SMS).

### Joining an in-process training session from an email message

To join an in-process training session from an email message, follow these steps:

1 Open your email message, and then click the link to join the training session.

   The Session Information page appears.

   **Note:** If the training session requires registration, a **Register** button appears on the page. If you have not yet registered for the training session, you must do so before you can join it. For registration information, see **Registering for a Training Session from an Invitation**
Joining a Training Session

Chapter 2: Joining a Training Session

Email Message (on page 9).

2 On the Session Information [Topic] page, enter any required information and click Join Now.

The Session window appears.

If the training session includes an integrated audio conference, the Audio Conference dialog box appears. Follow the instructions in the dialog box to start the audio conference.

Joining an in-process training session from an instant message

To join an in-process training session from an instant message, follow these steps:

1 Open your instant message, and then click the link.

The Session Information page appears.

2 On the Session Information [Topic] page, enter any required information and click Join Now.

Note: If the training session requires a password, contact the training session host if the password is not provided.

3 Click Join Now.

The Session window appears.

If the training session includes an integrated audio conference, the Audio Conference dialog box appears. Follow the instructions in the dialog box to start the audio conference.

Joining an in-process training session from a text message (SMS)

If a training session host invites you to a session via text message, you will receive the following on your mobile device:

- A number you can call to join the training session
To join an in-process training session from a text message (SMS), follow these steps:

1. Open the text message on your mobile device.
2. Enter your information as necessary.
3. To have this information saved for this page, select the **Remember me** check box.
4. Select **Call me back** to receive a call back.

### Obtaining Information About a Scheduled Training Session

Before joining or registering for a training session, you can obtain information about it—such as its description, host, and other details; or its agenda.

**To obtain information about a training session:**

1. On the navigation bar, expand **Attend a Session** to view a list of links.
2. Do *one* of the following:
   - To view all listed training sessions, click **Live Sessions**.
     The Live Sessions page appears, displaying all the scheduled sessions and times.
   - To view the unlisted sessions that require a password, click **Unlisted Sessions**. Type the session number that the host gave to you in the **Session number** box.
     The Unlisted Sessions page appears, displaying information for the unlisted session.
3. If necessary, click the time zone link to select the time zone in which you are currently located.
4 On the Live Sessions page, locate the training session for which you want to obtain information. 

To locate a training session quickly, you can

- sort the list of training sessions by clicking the column headings.
- display the calendar for another date by clicking the calendar icon.
- view the scheduled sessions in another calendar view by clicking the tabs: **Today**, **Upcoming**, **Daily**, **Weekly**, and **Monthly**.
- search for a training session by its host or presenter name, session topic, or any text in the description or agenda.

**Tip:** If the session you are looking for requires registration, select the **Show only sessions that require registration** check box.

5 Under **Topic**, click the name of the training session for which you want to obtain information.

The Session Information page appears.

6 Click **View Session Details**.

7 Type the password that the training session host gave to you and click **OK**.

If you received an invitation email message, the invitation contains the password.

The Session Information page now shows complete information.

## Finding a Training Session

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of using the Live Sessions page</td>
<td><strong>About Using the Live Sessions Page</strong> (on page 21)</td>
</tr>
<tr>
<td>search for a training session</td>
<td><strong>Searching for a Training Session</strong> (on page 21)</td>
</tr>
<tr>
<td>sort the Live Sessions page</td>
<td><strong>Sorting the Live Sessions Page</strong> (on page 22)</td>
</tr>
<tr>
<td>refresh the Live Sessions page</td>
<td><strong>Refreshing the Live Sessions Page</strong> (on page 23)</td>
</tr>
</tbody>
</table>
About Using the Live Sessions Page

The Live Sessions page on your Training Center Web site provides information about all listed training sessions that are either scheduled or in progress. However, the Live Sessions page does not provide information about unlisted training sessions.

You can navigate the list of sessions to quickly find a listed training session. You can also sort the list of training sessions that appear on the page that you are viewing, and refresh the list at any time.

The Live Sessions page provides a list of all scheduled training sessions.

On this page, you can

- search for a training session by its host or presenter name, session topic, or any text in the description or agenda
- view the scheduled sessions for the current day, future sessions, daily, weekly, or monthly recurring sessions by clicking the tabs: Today, Upcoming, Daily, Weekly, and Monthly
- sort the list of training sessions by clicking the column headings
- show a list of training sessions that occurred in the past
- show a list of only training sessions that require registration
- view the calendar and select another date on the calendar, using the Calendar pop-up window
- navigate forward and backward in the calendar, using the Next Day and Previous Day arrow buttons
- join a training session in progress
- obtain general information about a training session or a training session's agenda
- register for a training session that requires registration
- register for a training session's waiting list (if available)

Searching for a Training Session

On the Live Sessions page, you can locate a training session by searching for its host or presenter name, session topic, or any text in the description or agenda. You cannot search for a session number.
Chapter 2: Joining a Training Session

To search for a training session:

1. If you have not already done so, open the list of sessions.
2. Type the text for which you want to search in the **Search for** box.
3. Click **Search**.

The Search Results page appears, listing all training sessions that contain the search text.

On the Search Results page, you can do the following:

- Sort the Live Sessions page. For details, see *Sorting the Live Sessions Page* (on page 22).
- Join a listed training session. For details, see *Joining a Listed Training Session* (on page 14).
- Obtain information about a training session. For details, see *Obtaining Information About a Scheduled Training Session* (on page 19).

### Sorting the Live Sessions Page

By default, the Live Sessions page is sorted by hours, in ascending order. However, you can sort the list of sessions by any column, as follows:

- **Date & Time**—Sorts the list of sessions by hours, in ascending or descending order.
- **Topic**—Sorts the list of sessions alphabetically by topic, in ascending or descending order.
- **Fee**—Sorts the list of sessions by cost. This column appears only if eCommerce is enabled for your Training Center Web site.
- **Presenter**—Sorts the list of sessions alphabetically by presenter—that is, host—name, in ascending or descending order.
- **Duration**—Sorts the list of sessions by duration, in ascending or descending order.

**To sort the list of sessions by ascending or descending order:**

1. If you have not already done so, open the Live Sessions page.
2. Click the column heading by which you want to sort the list of sessions.

The **Ascending Sort** indicator appears, and the list of sessions is sorted by the column, in ascending order.
Optional. To sort the list of sessions in descending order, click the column heading again.

The **Descending Sort** indicator appears, and the list of sessions is sorted by the column, in descending order.

**Refreshing the Live Sessions Page**

Information about training sessions on the Live Sessions page can change at any time. Thus, to ensure that you are viewing the most current training session information, you can refresh the list of sessions.

**To refresh the public list of sessions:**

1. If you have not already done so, open the Live Sessions page.
2. Click the **Refresh** button.

**Selecting a Time Zone on the Live Sessions Page**

On the Live Sessions page, you can access your Preferences page to select the time zone in which you want to view training session times. Your site administrator specifies the default time zone that appears on the list of sessions. You may need to change the time zone, for example, if you are travelling and temporarily in another time zone.

**To select a time zone on the Live Sessions:**

1. If you have not already done so, open the Live Sessions page.
2. Click the time zone link.
   
   The Preferences page appears.
3. In the Time zone drop-down list, select another time zone.
4. Click OK.
Using the Calendar

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of using the calendar</td>
<td>About the training session calendar (on page 25)</td>
</tr>
<tr>
<td>view the training session calendar</td>
<td>Viewing the training session calendar (on page 26)</td>
</tr>
<tr>
<td>select a date on the training session calendar</td>
<td>Selecting a date on the training session calendar (on page 27)</td>
</tr>
<tr>
<td>search for a Training Session on the training session calendar</td>
<td>Searching for a training session on the training session calendar (on page 29)</td>
</tr>
<tr>
<td>sort the training session calendar</td>
<td>Sorting the training session calendar (on page 29)</td>
</tr>
<tr>
<td>refresh the training session calendar</td>
<td>Refreshing the training session calendar (on page 30)</td>
</tr>
<tr>
<td>select a language and time zone on the training session calendar</td>
<td>Selecting a language and time zone on the training session calendar (on page 30)</td>
</tr>
</tbody>
</table>

About the training session calendar

The public training session calendar on your Training Center Web site provides information about each listed training session that is either scheduled or in progress. However, the training session calendar does not provide information about any unlisted training session.
Chapter 3: Using the Calendar

You can navigate the training session calendar to quickly find a listed training session - either on the current date or any date - using one of several calendar views. For example, you can view a training session list for today's date only or for an entire month.

When viewing a training session list, you can sort the list and refresh it at any time.

You can view a list of training sessions that require registration.

Viewing the training session calendar

You can open one of the following calendar views of all listed training sessions:

<table>
<thead>
<tr>
<th>View</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Today</td>
<td>Contains a list of training sessions occurring on the current date, including all training sessions currently in progress and all scheduled training sessions that are not yet in progress.</td>
</tr>
<tr>
<td>Daily</td>
<td>Contains a single list of all training sessions occurring on the current date, or on another date to which you have navigated.</td>
</tr>
<tr>
<td>Weekly</td>
<td>Contains a list of scheduled training sessions for each day of the selected week.</td>
</tr>
<tr>
<td>Monthly</td>
<td>Indicates on which dates training sessions are scheduled for the selected month.</td>
</tr>
<tr>
<td>Upcoming</td>
<td>Contains a list of all upcoming scheduled training sessions. This list includes only those training sessions whose starting time has not yet been reached.</td>
</tr>
</tbody>
</table>

To open a calendar view of all scheduled training sessions:

1. On the navigation bar, expand **Attend a training session** to view a list of links.
2. Click **Live Sessions**.
   
   The training session calendar appears.
3. Click the tabs to navigate to different views of the training session calendar.
   
   You can also view a list that includes past training sessions.

You can view a list of training sessions that require registration.
To include past training sessions in your list of training sessions:
1. Select the Today or Daily tab.
2. Select the Show past training sessions check box.
   The list of training sessions displays accordingly for the tab.

To display a list of only training sessions that requires registration:
1. Select the Today, Upcoming, Daily, or Weekly tab.
2. Select the Show only training sessions that require registration check box.
   The list of training sessions that require registration displays accordingly for the tab.

Selecting a date on the training session calendar

You can view a list of scheduled training sessions for any date on the training session calendar.

To display a list of scheduled training sessions for the previous or next day:
1. If you have not already done so, open the training session calendar. For details, see Viewing the training session calendar (on page 26).
2. On the Daily view of the calendar page, click the forward or backward arrow to navigate to the list of training sessions for the next or previous day.

For details about the options on the Daily view, see About the Daily view (on page 36).

To display a list of training sessions for a specific date:
1. If you have not already done so, open the training session calendar. For details, see Viewing the training session calendar (on page 26).
   On the Today, Upcoming, Daily, or Weekly tab on the calendar page, click the Calendar icon.

   The Calendar window appears, showing the calendar for the current month.
Optional. Do any of the following:

- To view the calendar for the previous month, click the forward arrow.
- To view the calendar for the next month, click the backward arrow.
- To view the calendar for a specific month, in the drop-down list, select a month.
- To view the calendar for a specific year, in the drop-down list, select a year.

Click the date for which you want to view a list of training sessions. The Daily view for the date that you selected appears.

For details about the options on the view tabs, see the following:

- About the Upcoming view (on page 34)

**To display a list of training sessions for a specific date using the Monthly view:**

1. If you have not already done so, open the training session calendar. For details, see Viewing the training session calendar (on page 26).
2. Click the Monthly tab.
3. Click the forward or backward arrow to navigate to the list of training sessions for the next or previous month.
4. Click a date for which you want to view a list of scheduled training sessions. The Daily view appears for the date that you selected.

**Note:** Only dates on which an icon appears have at least one scheduled training session.

For details about the options on the Monthly view, see About the Monthly view (on page 40).
Searching for a training session on the training session calendar

On the training session calendar, you can locate a training session by searching for text in the name of the host or presenter, training session topic, or training session agenda. You cannot search for a training session number.

To search for a training session:

1. If you have not already done so, open the training session calendar. For details, see Viewing the training session calendar (on page 26).
2. Type the text for which you want to search in the Search for box.
3. Click Search.

The Search Results page appears, listing all training sessions that contain the search text.

Sorting the training session calendar

By default, training session lists on the training session calendar are sorted by hours, in ascending order. However, you can sort the training session lists by any column:

<table>
<thead>
<tr>
<th>Column</th>
<th>Sorts the training session list by...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time</td>
<td>hours, in ascending or descending order.</td>
</tr>
<tr>
<td>Topic</td>
<td>alphabetically by topic, in ascending or descending order.</td>
</tr>
<tr>
<td>Fee</td>
<td>by cost, in ascending or descending order.</td>
</tr>
<tr>
<td>Host or Presenter</td>
<td>alphabetically by host or presenter name, in ascending or descending order.</td>
</tr>
<tr>
<td>Duration</td>
<td>by duration, in ascending or descending order.</td>
</tr>
</tbody>
</table>

To sort the public training session calendar:

1. If you have not already done so, open the training session calendar. For details, see Viewing the training session calendar.
2 In a list of training sessions on the **Today**, **Upcoming**, **Daily**, or **Weekly** tab on the calendar page, click the column heading by which you want to sort the training sessions.

An ascending or descending sort indicator appears and the training sessions are sorted accordingly.

**Refreshing the training session calendar**

Information about training sessions on the public Training Center calendar can change at any time. Thus, to ensure that you are viewing the most current Training Center information, you can refresh the Training Center calendar at any time.

**To refresh the public Training Center calendar:**

1. If you have not already done so, open the training session calendar. For details, see **Viewing the training session calendar** (on page 26).
2. Click the **Refresh** button.

**Selecting a language and time zone on the training session calendar**

On the training session calendar, you can access your Preferences page to select the language and time zone in which you want to view training session times. Your site administrator specifies the default language and time zone that appears on the training session calendar. You may need to change the time zone, for example, if you are travelling and temporarily in another time zone.

**To select a language on the public training session calendar:**

1. If you have not already done so, open the training session calendar. For details, see **Viewing the training session calendar** (on page 26).
2. Click the language link on the right side of the page.

The Preferences page appears.
In the **Language** drop-down list, select another language.

4. Click **OK**.

**Note:**
- Your time zone selection affects only your view of your Training Center Web site, not other users' views.
- If you have a user account, all training session invitations that you send automatically specify the training session starting time in the time zone that you selected.
- If you select a time zone for which daylight saving time (DST) is in effect, your Training Center Web site automatically adjusts its clock for daylight saving time.

**To select a time zone on the public training session calendar:**

1. If you have not already done so, open the training session calendar. For details, see **Viewing the training session calendar** (on page 26).

2. Click the time zone link on the right side of the page.
   The Preferences page appears.

3. In the **Time zone** drop-down list, select another time zone.

4. Click **OK**.

**About the Today view**

**How to access this page**

On your Training Center Web site, click **Attend a Session > Live Sessions > Today** tab.
Chapter 3: Using the Calendar

What you can do here

The Today view lists the live training sessions and on-demand hands-on lab sessions that are scheduled for the present day, including those in process, those concluded, and those that have not yet begun.

The training session information displayed in the list can be sorted by clicking the column headings. For details, see Sorting the training session calendar (on page 29).

Options on this page

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Refresh]</td>
<td>Click the Refresh icon at any time to display the most current list of training sessions.</td>
</tr>
<tr>
<td>![Language link]</td>
<td>Click to open the Preferences page, where you can select the language setting for your Training Center Web site.</td>
</tr>
<tr>
<td>![Time zone link]</td>
<td>Click to open the Preferences page, where you can select the time zone setting for your Training Center Web site.</td>
</tr>
<tr>
<td>![Show past sessions]</td>
<td>Select to include concluded training sessions in the list of training sessions.</td>
</tr>
<tr>
<td>![Show only sessions that require registration check box]</td>
<td>Select to display only those training sessions that require registration in the list of training sessions.</td>
</tr>
</tbody>
</table>

The **Ascending Sort** indicator appears next to a column heading, and the training sessions are sorted by the column, in ascending order.

The **Descending Sort** indicator appears next to a column heading, and the training sessions are sorted by the column, in descending order.

| Time | Lists the starting time for each scheduled training session. |
| Topic | Lists the scheduled training sessions by name. Click the topic name to get training session information. |
### Chapter 3: Using the Calendar

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Fee</strong></td>
<td>Sorts the training session list by cost, in ascending or descending order.</td>
</tr>
<tr>
<td><strong>Host or Presenter</strong></td>
<td>Lists the host or presenter for the training session.</td>
</tr>
<tr>
<td><strong>Duration</strong></td>
<td>Lists the scheduled length of the training session.</td>
</tr>
<tr>
<td></td>
<td>Indicates that the live training session is in process.</td>
</tr>
<tr>
<td></td>
<td>Appears next to the Time column to indicate that more training session dates are available. Click to get training session information, including the additional dates.</td>
</tr>
<tr>
<td></td>
<td>Appears next to the Time column to indicate that this is a multi-session course.</td>
</tr>
<tr>
<td><strong>Join link</strong></td>
<td>Click the link to join the Training Center from the Session Information page.</td>
</tr>
<tr>
<td><strong>Register link</strong></td>
<td>Click to open the Register for page, where you can enter the required information to register for the training session.</td>
</tr>
<tr>
<td><strong>Waitlist link</strong></td>
<td>Click to open the Register for page, where you can enter the required information to register for the waitlist for the training session.</td>
</tr>
<tr>
<td><strong>Full link</strong></td>
<td>Indicates that the training session is full.</td>
</tr>
<tr>
<td></td>
<td>Indicates that this is a Personal Conference training session.</td>
</tr>
<tr>
<td><strong>Start link</strong></td>
<td>(Host only) Click to start your training session.</td>
</tr>
<tr>
<td><strong>End link</strong></td>
<td>(Host only) Click to end your training session.</td>
</tr>
</tbody>
</table>
About the Upcoming view

How to access this page
On your Training Center Web site, click Attend a Session > Live Sessions > Upcoming tab.

What you can do here
The Upcoming view lists scheduled live training sessions and on-demand hands-on lab sessions. This list includes only future scheduled sessions - that is, sessions where the starting time has not been reached.

The training session information displayed in the list can be sorted by clicking the column headings. For details, see Sorting the training session calendar (on page 29).

Options on this page

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Refresh" /></td>
<td>Click the Refresh icon at any time to display the most current list of training sessions.</td>
</tr>
<tr>
<td>Language link</td>
<td>Click to open the Preferences page, where you can select the language setting for your Training Center Web site.</td>
</tr>
<tr>
<td>Time zone link</td>
<td>Click to open the Preferences page, where you can select the time zone setting for your Training Center Web site.</td>
</tr>
<tr>
<td>Show only sessions that require registration check box</td>
<td>Select to display only those training sessions that require registration in the list of training sessions.</td>
</tr>
<tr>
<td><img src="image" alt="Ascending Sort" /></td>
<td>The Ascending Sort indicator appears next to a column heading, and the training sessions are sorted by the column, in ascending order.</td>
</tr>
<tr>
<td><img src="image" alt="Descending Sort" /></td>
<td>The Descending Sort indicator appears next to a column heading, and the training sessions are sorted by the column, in descending order.</td>
</tr>
<tr>
<td>Date &amp; Time</td>
<td>Lists the date(s) and starting time of the training session or</td>
</tr>
</tbody>
</table>
Chapter 3: Using the Calendar

<table>
<thead>
<tr>
<th>Topic</th>
<th>Lists the scheduled training sessions by name. Click the topic name to get training session information.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fee</td>
<td>Lists the training session cost.</td>
</tr>
<tr>
<td>Host or Presenter</td>
<td>Lists the host or presenter for the training session.</td>
</tr>
<tr>
<td>Duration</td>
<td>Lists the scheduled length of the training session.</td>
</tr>
<tr>
<td></td>
<td>Appears next to the Time column to indicate that more training session dates are available. Click to get training session information, including the additional dates.</td>
</tr>
<tr>
<td></td>
<td>Appears next to the Time column to indicate that this is a multi-session course.</td>
</tr>
<tr>
<td>Register link</td>
<td>Click to open the Register for page, where you can enter the required information to register for the training session.</td>
</tr>
<tr>
<td>Waitlist link</td>
<td>Click to open the Register for page, where you can enter the required information to register for the waitlist for the training session.</td>
</tr>
<tr>
<td>Full link</td>
<td>Indicates that the training session is full.</td>
</tr>
<tr>
<td></td>
<td>Indicates that this is a Personal Conference training session.</td>
</tr>
<tr>
<td>Start link</td>
<td>(Host only) Click to start your training session.</td>
</tr>
<tr>
<td>End link</td>
<td>(Host only) Click to end your training session.</td>
</tr>
</tbody>
</table>
Chapter 3: Using the Calendar

About the Daily view

How to access this page
On your Training Center Web site, click Attend a Session > Live Sessions > Daily tab.

What you can do here
The Daily view lists the live training sessions and on-demand hands-on lab sessions that are scheduled for the present day. From the Daily view you can navigate to the previous or next day, or use the calendar to view the schedule for another day.

The training session information displayed in the list can be sorted by clicking the column headings. For details, see Sorting the training session calendar (on page 29).

Options on this page

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Refresh icon</td>
<td>Click the Refresh icon at any time to display the most current list of training sessions.</td>
</tr>
<tr>
<td>Language link</td>
<td>Click to open the Preferences page, where you can select the language setting for your Training Center Web site.</td>
</tr>
<tr>
<td>Time zone link</td>
<td>Click to open the Preferences page, where you can select the time zone setting for your Training Center Web site.</td>
</tr>
<tr>
<td>Previous Day icon</td>
<td>Click the Previous Day icon to display a list of training sessions for the previous day.</td>
</tr>
<tr>
<td>Next Day icon</td>
<td>Click the Next Day icon to display a list of training sessions for the next day.</td>
</tr>
<tr>
<td>Calendar icon</td>
<td>Click the Calendar icon to open the Calendar window for the current month. Click on any date to open its schedule.</td>
</tr>
<tr>
<td>Show past sessions</td>
<td>Select to include concluded training sessions in the list of training sessions.</td>
</tr>
</tbody>
</table>
### Show only sessions that require registration check box

Select to display only those training sessions that require registration in the list of training sessions.

<table>
<thead>
<tr>
<th>Ascending Sort</th>
<th>The Ascending Sort indicator appears next to a column heading, and the training sessions are sorted by the column, in ascending order.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Descending Sort</td>
<td>The Descending Sort indicator appears next to a column heading, and the training sessions are sorted by the column, in descending order.</td>
</tr>
</tbody>
</table>

| Time | Lists the starting time for each scheduled training session. |
| Topic | Lists the scheduled training sessions by name. Click the topic name to get training session information. |
| Fee | Lists the training session cost. |
| Host or Presenter | Lists the host or presenter for the training session. |
| Duration | Lists the scheduled length of the training session. |
| Indicated that the live training session is in process. |
| Join link | Click the link to join the Training Center from the Session Information page. |
| Register link | Click to open the Register for page, where you can enter the required information to register for the training session. |
| Waitlist link | Click to open the Register for page, where you can enter the required information to register for the waitlist for the training session. |
| Full link | Indicates that the training session is full. |
| Indicates that this is a Personal Conference training session. |
About the Weekly view

How to access this page

On your Training Center Web site, click **Attend a Session > Live Sessions** > **Weekly** tab.

What you can do here

The Weekly view lists the live training sessions and on-demand hands-on lab sessions that are scheduled, but not ended for the selected week.

The training session information displayed in the list can be sorted by clicking the column headings. For details, see **Sorting the training session calendar** (on page 29).

Options on this page

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="link" alt="Refresh" /></td>
<td>Click the <strong>Refresh</strong> icon at any time to display the most current list of training sessions.</td>
</tr>
<tr>
<td><strong>Language</strong> link</td>
<td>Click to open the Preferences page, where you can select the language setting for your Training Center Web site.</td>
</tr>
<tr>
<td><strong>Time zone</strong> link</td>
<td>Click to open the Preferences page, where you can select the time zone setting for your Training Center Web site.</td>
</tr>
<tr>
<td><img src="link" alt="Previous Week" /></td>
<td>Click the <strong>Previous Week</strong> icon to display a list of training sessions for the previous week.</td>
</tr>
<tr>
<td><img src="link" alt="Next Week" /></td>
<td>Click the <strong>Next Week</strong> icon to display a list of training sessions for the next week.</td>
</tr>
</tbody>
</table>
Chapter 3: Using the Calendar

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calendar icon</td>
<td>Click the Calendar icon to open the Calendar window for the current month. Click on any date to open its schedule.</td>
</tr>
<tr>
<td>Show only sessions that require registration check box</td>
<td>Select to display only those training sessions that require registration in the list of training sessions.</td>
</tr>
<tr>
<td>Day link <strong>Friday</strong></td>
<td>Opens the Daily view, which shows the scheduled training sessions for the selected day.</td>
</tr>
<tr>
<td>Ascending Sort indicator</td>
<td>The Ascending Sort indicator appears next to a column heading, and the training sessions are sorted by the column, in ascending order.</td>
</tr>
<tr>
<td>Descending Sort indicator</td>
<td>The Descending Sort indicator appears next to a column heading, and the training sessions are sorted by the column, in descending order.</td>
</tr>
<tr>
<td>Time</td>
<td>Lists the starting time for each scheduled training session.</td>
</tr>
<tr>
<td>Topic</td>
<td>Lists the scheduled training sessions by name. Click the topic name to get training session information.</td>
</tr>
<tr>
<td>Fee</td>
<td>Lists the training session cost.</td>
</tr>
<tr>
<td>Host or Presenter</td>
<td>Lists the host or presenter for the training session.</td>
</tr>
<tr>
<td>Duration</td>
<td>Lists the scheduled length of the training session.</td>
</tr>
<tr>
<td>Live session indicator</td>
<td>Indicates that the live training session is in process.</td>
</tr>
<tr>
<td>Join link</td>
<td>Click the link to join the Training Center from the Session Information page.</td>
</tr>
<tr>
<td>Register link</td>
<td>Click to open the Register for page, where you can enter the required information to register for the training session.</td>
</tr>
</tbody>
</table>
Chapter 3: Using the Calendar

**Waitlist link** Click to open the Register for page, where you can enter the required information to register for the waitlist for the training session.

**Full link** Indicates that the training session is full.

Indicates that this is a Personal Conference training session.

**Start link** (Host only) Click to start your training session.

**End link** (Host only) Click to end your training session.

### About the Monthly view

**How to access this page**

On your Training Center Web site, click **Attend a Session > Live Sessions > Monthly** tab.

**What you can do here**

The Monthly view shows when the live training sessions and on-demand hands-on lab sessions are scheduled in a monthly calendar view. You can navigate to a specific day or week within the current month, or navigate to the previous or next month.

**Options on this page**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>⬅️</td>
<td>Click the <strong>Previous Month</strong> icon to display a list of training sessions for the previous month.</td>
</tr>
<tr>
<td>➡️</td>
<td>Click the <strong>Next Month</strong> icon to display a list of training sessions for the next month.</td>
</tr>
</tbody>
</table>
Chapter 3: Using the Calendar

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Refresh icon" /></td>
<td>Click the <strong>Refresh</strong> icon at any time to display the most current list of training sessions.</td>
</tr>
<tr>
<td><img src="image" alt="Language link" /></td>
<td>Click to open the Preferences page, where you can select the language setting for your Training Center Web site.</td>
</tr>
<tr>
<td><img src="image" alt="Time zone link" /></td>
<td>Click to open the Preferences page, where you can select the time zone setting for your Training Center Web site.</td>
</tr>
<tr>
<td><img src="image" alt="Week link" /></td>
<td>Opens the Weekly view, which shows the scheduled training sessions for each day of the selected week.</td>
</tr>
<tr>
<td><img src="image" alt="Day link" /></td>
<td>Opens the Daily view, which shows the scheduled training sessions for the selected day.</td>
</tr>
<tr>
<td><img src="image" alt="Meeting icon" /></td>
<td>Appears on the calendar to indicate that one or more training sessions are scheduled on that day.</td>
</tr>
<tr>
<td><img src="image" alt="On-demand icon" /></td>
<td>Appears on the calendar to indicate that one or more on-demand hands-on lab training sessions are scheduled on that day.</td>
</tr>
</tbody>
</table>

**About the Search Results page**

**What you can do here**

- Find a training session on your Training Center Web site.
- Display past training sessions.
- Sort the search results.
- Select a language for your Training Center Web site.
- Select a time zone for your Training Center Web site.
- Display training sessions that require registration.

The training session information displayed in the list can be sorted by clicking the column headings. For details, see *Sorting the training session calendar* (on page 29).
## Options on this page

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Search for...</strong></td>
<td>Enter a host name, training session topic, or any text that may appear in the agenda, and click Search. <strong>Note:</strong> You cannot search for a training session number.</td>
</tr>
<tr>
<td><strong>Language link</strong></td>
<td>Click to open the Preferences page, where you can select the language setting for your Training Center Web site.</td>
</tr>
<tr>
<td><strong>Time zone link</strong></td>
<td>Click to open the Preferences page, where you can select the time zone setting for your Training Center Web site.</td>
</tr>
<tr>
<td><strong>Show past sessions</strong></td>
<td>Select to include concluded training sessions in the list of training sessions.</td>
</tr>
<tr>
<td><strong>Show only sessions that require registration check box</strong></td>
<td>Select to display only those training sessions that require registration in the list of training sessions.</td>
</tr>
<tr>
<td><strong>Navigation links</strong></td>
<td>Click the page numbers or next to navigate through the search results.</td>
</tr>
<tr>
<td><strong>Ascending Sort indicator</strong></td>
<td>The Ascending Sort indicator appears next to a column heading, and the training sessions are sorted by the column, in ascending order.</td>
</tr>
<tr>
<td><strong>Descending Sort indicator</strong></td>
<td>The Descending Sort indicator appears next to a column heading, and the training sessions are sorted by the column, in descending order.</td>
</tr>
<tr>
<td><strong>Date &amp; Time</strong></td>
<td>Lists the date and starting time of the training session.</td>
</tr>
<tr>
<td><strong>Topic</strong></td>
<td>Lists the scheduled training sessions by name. Click the topic name to get training session information.</td>
</tr>
<tr>
<td><strong>Fee</strong></td>
<td>Lists the training session cost.</td>
</tr>
</tbody>
</table>
### Chapter 3: Using the Calendar

<table>
<thead>
<tr>
<th><strong>Host or Presenter</strong></th>
<th>Lists the host or presenter for the training session.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Duration</strong></td>
<td>Lists the scheduled length of the training session.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Indicates that the live training session is in process.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Appears next to the Time column to indicate that more training session dates are available. Click to get training session information, including the additional dates.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Appears next to the Time column to indicate that this is a multi-session course.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Join link</strong></th>
<th>Click the link to join the Training Center from the Session Information page.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Register link</strong></td>
<td>Click to open the Register for page, where you can enter the required information to register for the training session.</td>
</tr>
<tr>
<td><strong>Waitlist link</strong></td>
<td>Click to open the Register for page, where you can enter the required information to register for the waitlist for the training session.</td>
</tr>
<tr>
<td><strong>Full link</strong></td>
<td>Indicates that the training session is full.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Start link</strong></th>
<th>(Host only) Click to start your training session.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>End link</strong></td>
<td>(Host only) Click to end your training session.</td>
</tr>
</tbody>
</table>
### Setting up and Scheduling a Training Session

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>See…</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of scheduling a training session</td>
<td>About scheduling a training session (on page 46)</td>
</tr>
<tr>
<td>set up a scheduled training session</td>
<td>Setting up a scheduled training session (on page 47)</td>
</tr>
<tr>
<td>allow another host to schedule training sessions for you</td>
<td>Allowing another host to schedule your training session (on page 108)</td>
</tr>
<tr>
<td>start an instant training session</td>
<td>Starting an instant training session (on page 137)</td>
</tr>
<tr>
<td>start a scheduled training session</td>
<td>Starting a scheduled training session (on page 139)</td>
</tr>
<tr>
<td>modify a scheduled training session</td>
<td>Modifying a scheduled training session (on page 141)</td>
</tr>
<tr>
<td>cancel a scheduled training session</td>
<td>Canceling a scheduled training session (on page 143)</td>
</tr>
</tbody>
</table>
About scheduling a training session

When scheduling a training session you can accept the default settings that your Training Center Web site provides, or you can specify several options for your training session. These options allow you to customize your training session for your specific needs. Once you schedule a training session, you can modify its options. You can also cancel a scheduled training session at any time.

If another user has granted scheduling permission to you in his or her user profile, you can schedule a training session on behalf of that user. For details about granting scheduling permission to another user, see **Allowing another host to schedule your training session** (on page 108).

Choosing a level of security for a training session

You provide security for your training session by doing any of the following:

- **Require a password**—Most Training Center Web sites require that you specify a password for any session that you host. Attendees must provide this password to join the session.

- **Specify an unlisted training session**—When scheduling a training session, you can specify that the session is unlisted. An unlisted training session does not appear on the training session calendar. To join an unlisted training session, attendees must provide a unique session number. For more information about specifying an unlisted session, see **About listed and unlisted training sessions**.

- **Exclude the session password from email invitations**—When scheduling a training session, you can prevent the password from appearing in the email invitations that your Training Center Web site automatically sends to attendees. For details, see **Excluding the session password from email invitations**.

- **Require attendees to log in**—When scheduling a training session, you can require that attendees have a user account on your Training Center Web site. Thus, attendees must log in to your site before they can attend the session. For more information, see **Requiring attendees to log in to your Training Center Web site**.

- **Require attendees to register for the training session**—When scheduling a training session, you can require each attendee to fill out a registration request that includes his or her name, email address, and other information that require,
and then send the request to you. You can then accept or reject each registration request. For more information, see Requiring registration for a scheduled training session (on page 72).

- **Restrict access to the training session**—Once all attendees have joined a training session, you can prevent additional attendees from joining it by restricting access to the training session.

  **Tip:** Choose a level of security based on the training session’s purpose. For example, if you schedule a session to discuss your company picnic, you probably need to specify only a password for the session. On the other hand, if you schedule a session in which you will discuss sensitive financial data, you may want to specify that the session is unlisted. You may also choose to restrict access to the session once all attendees have joined it.

---

**Setting up a scheduled training session**

When scheduling a training session, you must specify a training session topic, date and time, and password. You can also specify several options to provide security for and customize your training session.

**Open the Schedule Training Session page:**

1. Log in to your Training Center Web site.
2. On the navigation bar, expand **Host a Session** to view a list of links.
3. Click **Schedule Training**.
   
   The Schedule Training Session page appears.

**Set up session and access information:**

1. Specify a topic and a password for the training session. For details, see Setting up session and access information (on page 51).
2. Specify whether the training session is listed or unlisted. For details, see About listed and unlisted training sessions (on page 52).
3. Specify whether the training session can support over 500 attendees. For details, see Supporting over 500 attendees (on page 53).
4. Specify whether to remove a completed training sessions from the training session calendar. For details, see Deleting sessions automatically (on page 54).
5 Specify whether you will receive a copy of the attendee email invitation. For details, see Receiving a copy of the attendee email invitation.

**Specify tracking codes:**

Required for some organizations. Specify tracking information associated with the training session. This option only appears if your site administrator has set it up. For details, see Specifying tracking codes for a scheduled session.

**Specify audio conferencing options:**

Under **Audio Conference Settings**, select whether you want a WebEx audio conference, VoIP-only conference, no conference, or other teleconferencing service. For details, see Setting up an audio conference for a scheduled session (on page 58) or Setting up a VoIP-only audio conference for a scheduled training session (on page 60).

**Schedule the date, time, and occurrence:**

1 Specify the date and time at which the training session starts, its occurrence, and its duration. For details, see Scheduling a training session time, occurrence, and duration (on page 66).

2 Optional. Specify a recurrence pattern for the training session by selecting an option next to **Occurrence**.

**Set up Hands-on Lab:**

This option appears on the Schedule Training page only if your site administrator has set up Hands-on Lab.

1 Reserve computers from a specific Hands-on Lab. For details, see Reserving computers for Hands (on page 69)-on Lab.

2 Check availability of computers and status of your reservation. For details, see Viewing the Hands-on Lab schedule (on page 70).

**Specify registration options:**

1 Optional. Specify whether to require attendees to register for the training session. For details, see Requiring registration for a scheduled training session (on page 72).

2 Optional. Customize your registration form by adding option buttons and specifying required information to register. For details, see Customizing a registration form (on page 75).
Invite attendees:
Optional. Send email invitations to attendees. For details, see *Inviting attendees to a scheduled training session* (on page 78).

Invite presenters:
Optional. Send email invitations to presenters. For details, see *Inviting presenters to a scheduled training session* (on page 80).

Specify training session options:
1 Optional. Specify which session options you want to be available to all participants during the training session. For details, see *Specifying training session options* (on page 83).

2 Optional. Specify which privileges attendees have during the training session. For details, see Specifying options available to participants during a training session.

3 Specify a destination Web page. For details, see *Specifying a destination Web page after the session ends* (on page 86).

4 Optional. Choose an alert to play once a participant either joins or leaves the teleconference. For details, see Playing alerts when participants join or leave a teleconference.

5 Create a message or greeting that appears when attendees join the training session. For details, see *Creating a message or greeting for a scheduled training session* (on page 87).

Specify breakout session assignment settings:
1 Select whether to enable breakout session assignments prior to the start of the session.

2 If selected, specify whether to assign the attendees automatically or manually.
   For details, see *Setting up breakout sessions* (on page 91).

Select email messages to be automatically sent:
1 Select invitation email messages. For details, see *Sending an invitation to a training session* (on page 94).

2 Select email messages to be sent when any schedule updates occur. For details, see *Sending an update to a scheduled training session* (on page 95).

3 Send a registration notification to the host or to attendees. For details, see *Sending a registration notification to a scheduled training session* (on page 95).
4. Send training session reminders to attendees and presenters. For details, see *Sending a reminder for a scheduled training session* (on page 96).

**Specify session information:**

1. Specify an agenda and description for the training session, which attendees can view before the training session starts. For details, see *Setting your agenda* (on page 101).

2. Optional. Add a picture to the Session Information page, which attendees can view before the training session starts. For details, see *Adding a picture to the Session Information page* (on page 101).

**Add course material:**

Upload course material to the Session Information page for attendees to download before the training session. For details, see *Publishing course material for a scheduled training session* (on page 104).

**Add tests:**

You can add tests to the training session during scheduling. For details, see *Using tests in training sessions* (on page 106).

**Add, select, or delete scheduling session templates:**

You can save the Schedule Training Session settings as a template to be used when scheduling future sessions. For details, see *Using the scheduling templates* (on page 107).

**Schedule or start the training session:**

Do *one* of the following:

- If the training session's starting time is the current time, click **Start Session** to start the training session.

- If the training session's starting time is after the current time, click **Schedule**.

The Session Scheduled page appears, confirming that the session is scheduled. You also receive a confirmation email message that includes information about the scheduled session.

**Note:** For details about starting a training session, see *Starting a scheduled training session* on page 119.
Chapter 4: Setting up and Scheduling a Training Session

If you invite an attendee to a training session when scheduling it, the attendee receives an invitation email message that includes information about the training session, including the training session password, unless you specify that passwords do not appear in email invitations.

If you invite an attendee to a training session when scheduling it, and require that attendees register to attend the session, the attendee receives an invitation-to-register email message. This message includes information about the training session, including a link that the attendee can click to register for the session.

Add a scheduled session to your calendar:

You can add a scheduled training session to a calendar program, such as Microsoft Outlook or Lotus Notes. For details, see Adding a scheduled training session to your calendar program (on page 110).

Setting up session and access information

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>See…</th>
</tr>
</thead>
<tbody>
<tr>
<td>set a topic name and password for your training session</td>
<td>Setting up a topic name and password (on page 51)</td>
</tr>
<tr>
<td>get an overview of listed and unlisted training sessions</td>
<td>About listed and unlisted training sessions (on page 52)</td>
</tr>
<tr>
<td>specify whether a training session is listed or unlisted</td>
<td>Specifying whether a training session is listed or unlisted (on page 53)</td>
</tr>
</tbody>
</table>

Setting up a topic name and password

When scheduling a training session, you set up the topic name and password. You can edit the topic name and password on the Edit Scheduled Training Session page. For details, see Modifying a scheduled training session (on page 141).

1 On the Schedule Training Session or Edit Scheduled Training Session page, scroll to Session and Access Information.
Chapter 4: Setting up and Scheduling a Training Session

2 Optional. If scheduling the training session on behalf of someone else, select the person from the **Schedule for** drop-down list. For details, see *Scheduling a training session for another host* (on page 109).

3 Specify a topic for the training session in the **Topic** box.

4 Optional. Type a password in the **Set Session password** box.

5 Type the password again in the **Confirm password** box.

6 If you have completed specifying options, click **Schedule** or **Update**.

**Note:**

- A training session topic cannot contain any of the following characters: \ " / & < > = [ ].
- A training session password should contain a minimum of 4 characters, and can contain a maximum of 16 characters. A password cannot contain any of the following characters: \ " / & < > = [ ], and cannot be your username, the host’s name, the topic name, or the site name.

**About listed and unlisted training sessions**

When scheduling a training session or starting an instant session, you can specify whether the session is one of the following:

**Listed for all**—The training session appears on both the list of sessions and the training session calendar to anyone who visits your Training Center Web site.

**Listed for authorized users only**—The training session appears on both the list of sessions and the training session calendar to only users who have user accounts and have logged in to your Training Center Web site.

**Unlisted**—The training session does not appear on either the list of sessions or the training session calendar. An unlisted training session prevents anyone from viewing information about the session, such as its host, topic, and starting time; and helps to prevent unauthorized access to the session. To join an unlisted training session, an attendee must provide a unique session number.
If you invite an attendee to an unlisted training session, the attendee receives an invitation email message that includes complete instructions for joining the training session—including the training session number—and a URL that links directly to a Web page on which the attendee can join the training session.

### Specifying whether a training session is listed or unlisted

**To specify whether a training session is listed or unlisted:**

1. On the Schedule Training Session or Edit Scheduled Training Session page, scroll to **Session and Access Information**.
2. Below **This training session is**, select one of the following options:
   - **Listed for all**
   - **Listed for authorized users only**
     - If you select this option, the training session appears on either the list of sessions page for only authorized users who have an account on your Training Center Web site.
   - **Unlisted**
3. Click **Schedule** or **Update**.

### Supporting over 500 attendees

You can set up your training session to allow over 500 attendees. However, if you choose this option, some Training Center features may be limited and others will not be supported. These include:

- The multipoint video, private chat, and active talker visual cue features will not be available.
- Attendees will not be able to view the names of other attendees.
- Each Breakout session and Hands-On Lab computer will support a maximum of 100 attendees.

**Note:** You will not be able to change this option within the session.
To specify whether to support over 500 attendees in a training session:

1. On the Schedule Training Session or Edit Scheduled Training Session page, scroll to Session and Access Information.
2. Select the **This session will have over 500 attendees** check box.
   A message box appears, describing the limitations of this option.
3. Click **OK**.
4. If you have completed specifying options, click **Schedule** or **Update**.

Deleting sessions automatically

You can choose to have your training session automatically deleted from the Training Center calendar upon your session's completion.

**Important:** Any tests that you associate with this training session will be lost if you select this option. All associated test will be deleted along with the training session.

To specify whether to automatically delete a training session after it ends:

1. On the Schedule Training Session or Edit Scheduled Training Session page, scroll to Session and Access Information.
2. Select the **Automatically delete session after it ends** check box.
3. If you have completed specifying options, click **Schedule** or **Update**.

Copying session information from another session

You can copy specific session information from other live sessions that you have scheduled, or from those that have been scheduled on your behalf. Some scheduling information will vary from session to session, and therefore cannot be copied into the scheduler, including:

- Date, time, and recurrence (except duration, time zone, and join-before-host options)
- Invited attendees and presenters lists (except estimated number of attendees and presenters)
- Registration data of registered attendees
• Hands-on lab information and reservation
• Course material and tests
• Tests

To copy information from another session:
1 On the Schedule Training Session or Edit Scheduled Training Session page, scroll to Session and Access Information.
2 Click Copy from.
   The Select a Session window appears.
3 Select the session from which to copy session information.
4 Click OK.

Specifying tracking codes for a scheduled session

Your site administrator can specify that tracking code options that appear on the Schedule Training page. Tracking codes may identify your department, project, or other information that your organization wants to associate with your training sessions. Tracking codes can be optional or required, depending on how your site administrator set them up.

To specify tracking codes for a scheduled training session:
1 On the Schedule Training Session or Edit Scheduled Training Session page, scroll to Tracking codes, and then select a code label in the box on the left.
   If your site administrator requires you to select a code from a predefined list, a list of codes appears.
2 Do one of the following:
   • If a list of codes appears in the box on the right, select a code from the list.
   • Type a code in the box on the right.
3 Repeat for each tracking code label.
4 Click Schedule or Update.

Tip: If your site administrator has also specified that the same tracking code options appear in your user profile, you can edit your user profile to specify the tracking codes.
Chapter 4: Setting up and Scheduling a Training Session

The codes then appear automatically on the Schedule Training Session page.

Setting up E-commerce (fee or pay-per-use training)

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of using ecommerce in</td>
<td>About E-commerce for Training Center (on page 56)</td>
</tr>
<tr>
<td>Training Center</td>
<td></td>
</tr>
<tr>
<td>set up fee-based training</td>
<td>Setting up fee-based training (on page 56)</td>
</tr>
<tr>
<td>get an overview about using coupons</td>
<td>About using coupons (on page 57)</td>
</tr>
<tr>
<td>set up pay-per-use training</td>
<td>Setting up pay-per-use training (on page 57)</td>
</tr>
</tbody>
</table>

About E-commerce for Training Center

Note: E-commerce is an optional feature. If provisioned for your site, it must first be enabled and set up by your site administrator.

Training Center allows customers to pay for training conveniently by using credit cards, debit cards, VeriSign Payflow Pro, or PayPal Website Payments Pro (US or UK). Training Center E-commerce includes the following two features:

- **fee-based training (for attendees)**—attendees pay a fee for attending your sessions. For details, see Setting up fee-based training (on page 56).
- **pay-per-use training (for hosts)**—requires hosts to pay before they can start each training session. For details, see Setting up pay-per-use training (on page 57).

Setting up fee-based training

When you use fee-based training, attendees pay a fee for attending your sessions.
A fee-based training session requires attendee registration, and attendees must provide their payment information when registering.

To require a session fee for a training session, type an amount in the Session Fee text box on the Schedule Training Session page.

To turn on this E-commerce feature, contact your WebEx account manager.

**About using coupons**

Your organization can create discount coupons and send them to attendees. For example, you can have attendees pay in advance for a series of training sessions conducted on your organization's Training Center Web site. In return, your organization gives them coupons that they can use for each session in the series. You could also send coupons to prospective attendees as an incentive.

Attendees type the coupon code on the Payment Information page to receive discounts for a training session.

To activate the Coupons feature and distribute coupons, contact your site administrator.

**Setting up pay-per-use training**

Pay-per-use requires hosts to pay before they can start each training session. Pay-per-use is designed for organizations that do not want to handle billing for every training session conducted on their Training Center Web sites.

For example, an organization that allocated a training budget for each division can now ask individual divisions to cover their own expenses for conducting training on the organization's Training Center Web site. Then the organization can reimburse the costs.

To turn on this E-commerce feature, contact your WebEx account manager.

**To set up a pay-per-use training session:**

1. Click **Start Session** or **Schedule** on the Schedule Training Session page after you finish specifying options on the same page.

   The Estimated Session Cost page appears. This page displays the estimated cost of the session based on the number of people minutes, teleconferencing minutes, and the rate per minute.
Chapter 4: Setting up and Scheduling a Training Session

The number of people minutes is the training session duration multiplied by the number of computers connected in the session. The number of teleconferencing minutes is the session duration multiplied by the number of computers connected in the teleconference.

2 Optional. To modify session settings, click Change.

3 To return to the Estimated Session Cost page, click Start Session or Schedule.

4 Enter your payment information.

Specifying audio conferencing options

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>See…</th>
</tr>
</thead>
<tbody>
<tr>
<td>set up a teleconference</td>
<td>Setting up a teleconference for a scheduled session (on page 58)</td>
</tr>
<tr>
<td>set up an Integrated VoIP conference</td>
<td>Setting up an Integrated VoIP conference for a scheduled training session (on page 60)</td>
</tr>
<tr>
<td>review system requirements for Integrated</td>
<td>System requirements for Integrated VoIP (on page 61)</td>
</tr>
<tr>
<td>VoIP</td>
<td></td>
</tr>
</tbody>
</table>

Setting up an audio conference for a scheduled session

Audio conferencing options may differ, depending on which options your organization uses.

To set up an audio conference:

1 On the Schedule Training Session or Edit Scheduled Training Session page, scroll to Audio Conference Settings.

2 Select one of the following options:

- Display toll-free number—If your Training Center site provides toll-free call-in audio conferencing, both a toll-free number and a toll number are available. For toll-free call-in teleconferencing, your organization assumes the charges for the calls; otherwise, participants assume the charges for their calls.

- Show toll-free dialing restrictions link—Click to show a list of calling restrictions by country (www.webex.com/pdf/tollfree_restrictions.pdf).
Display global call-in-numbers—This option provides a list of numbers—such as toll-free or local numbers—that attendees in other countries can call to join the audio conference.

Enable teleconference CLI authentication when participants call in—CLI (caller line identification) is a form of caller ID, a telephony intelligent service that transmits a caller's telephone number before the call is answered. Any dial-in caller with a host site account can be authenticated and placed into the correct teleconference without needing to enter a training session number. For more information on CLI, see Using caller authentication to start or join a dial-in teleconference on page 164.

Mute attendees upon entry—Select if want the attendees' audio to be muted when they enter the training session. This may prevent disruption, especially if the training session is in process.

Entry & exit tone—Select the sound alert or announcement, if any, that you would like all participants to hear when an attendee joins or leaves the session.

Note: WebEx Audio conferencing supports up to 125 callers.

Other teleconference service
- Specifies that the session includes a teleconference that another service provides.
- Enter instructions for joining the teleconference. These will appear on the Session Information page, in email invitations, and in the training session.

Cisco Unified MeetingPlace Audio Conferencing
For Cisco Unified MeetingPlace audio conferencing, select one of the following:
- Attendees call in—Attendees call a phone number to join the teleconference and assume the charges for their calls.
- Attendees receive a call back—Attendees provide their phone numbers once they join the session, and then receive call-backs at the phone numbers they provide. You or your organization assumes the charges for the calls. Recorded instructions guide the attendee through the process of connecting to the teleconference.

Use VoIP only—See Setting up a VoIP-only audio conference for a scheduled training session (on page 60) for more information.
Chapter 4: Setting up and Scheduling a Training Session

- **None**—Specifies that no audio conference is necessary for the session.

3. Click **Schedule** or **Update**.

**Note:** Once you schedule the training session, instructions for joining the teleconference automatically appear
- on the Session Information page on your site, which participants can view before you start the training session
- in invitation email messages, if you invite participants using the Schedule Training page options
- on the Info tab, which appears in the content viewer in the Training Session window
- in the Join Teleconference dialog box, which appears in participants’ Session windows once they join the session

You can also set up an Integrated VoIP (voice over IP (VoIP)) conference, in addition to or instead of a teleconference. For more information about using Integrated VoIP, see Setting up an Integrated VoIP conference for a scheduled training session.

Setting up a VoIP-only audio conference for a scheduled training session

You can use integrated VoIP for the audio in your training session. In a VoIP-only conference, participants use computers with audio capability to communicate over the Internet rather than the telephone system. You can assign a microphone to up to seven participants in an integrated VoIP conference.

**To set up a VoIP-only audio conference:**

1. On the Schedule Training Session or Edit Scheduled Training Session page, scroll to **Audio Conference Settings**.
2. Select the **Use VoIP only** option.
3. Select the **Mute attendees upon entry** check box if you want the attendees’ audio to be muted when they enter the training session. This may prevent disruption, especially if the training session is in process.
4. Click **Schedule** or **Update**.
Note:

- If you set up an integrated VoIP conference, you must start the conference after you start the training session.
- Only participants whose computers meet the system requirements for Integrated VoIP can participate in the conference. For details, see System requirements for Integrated VoIP (on page 61).
- If you use WebEx Recorder to record the training session and want to capture audio in the recording, you must ensure that the correct audio compression scheme is selected. For details, refer to the WebEx Recorder and Player User’s Guide.

System requirements for Integrated VoIP

To participate in an Integrated VoIP conference, you must ensure that your computer meets the following system requirements:

- a supported sound card
  For a list of supported sound cards, refer to the Frequently Asked Questions page on your Training Center Web site. You can access this page from your site’s Support page.
- speakers or headphones
- microphone, if you want to speak during the conference

Tip: For better audio quality and greater convenience, use a computer headset with a high-quality microphone.

Specifying date and time options

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of scheduling a training</td>
<td>About scheduling a training session time,</td>
</tr>
</tbody>
</table>
Chapter 4: Setting up and Scheduling a Training Session

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>See…</th>
</tr>
</thead>
<tbody>
<tr>
<td>session time, occurrence, and duration</td>
<td>occurrence, and duration (on page 62)</td>
</tr>
<tr>
<td>schedule a training session time, occurrence, and duration</td>
<td>Scheduling a training session time, occurrence, and duration (on page 66)</td>
</tr>
</tbody>
</table>

About scheduling a training session time, occurrence, and duration

You can specify the date and time at which a scheduled training session starts, its occurrence, and its estimated duration. You can also determine whether, and how many minutes in advance, to allow attendees to join the training session and audio conference prior to the start time.

About the Date and Time options

How to access this page

On the navigation bar, click Host a Session > Schedule Training > Date and Time.

What you can do here

- Specify the date and time for the training session.
- Specify the number of minutes before the training session's starting time during which attendees can join the training session.
- If attendees are allowed to join the training session before the starting time, specify whether they can also join the audio conference early.
- Specify an occurrence pattern for the training session.
- Specify the time zone for the training session.
- Specify the duration for the training session.
## Options on this page

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Starting time</strong></td>
<td>Select the date and time that you want the training session to occur.</td>
</tr>
<tr>
<td><strong>Attendees can join ___ minutes before the start time</strong></td>
<td>Allow attendees to join the training session within a set number of minutes before the training session's starting time.</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>If you clear this check box, you must start the training session before attendees can join it.</td>
</tr>
<tr>
<td><strong>Attendees can also connect to WebEx audio</strong></td>
<td>Allow attendees to also join the audio conference before the training session's starting time.</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>This option will only be available if you allow attendees to join the training session before its starting time.</td>
</tr>
<tr>
<td><strong>Occurrence</strong></td>
<td></td>
</tr>
</tbody>
</table>
### Chapter 4: Setting up and Scheduling a Training Session

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single-session class</td>
<td>A class that comprises a single training session and occurs only once—that is, it does not have a recurrence pattern.</td>
</tr>
<tr>
<td>Recurring single-session class</td>
<td>A class that comprises a single training session and recurs on a regular basis.</td>
</tr>
</tbody>
</table>

**Note** Attendees register for only one session.

The **Recurrence** options include:

- **Daily**—A class that repeats on a daily basis according to the following conditions:
  - **Every ___ Days**—Select to schedule a training session to occur every specified number of days.
  - **Every weekday**—Select to schedule training sessions for each Monday through Friday.

- **Weekly**—Select the check box for the day(s) of the week on which the training session will occur each week.

- **Monthly**—A class that repeats on a monthly basis according to the following conditions:
  - **Day ___ of every ___ month(s)**—Specify the day of the month and the number of months for the training session to occur.
  - **[which] [day] of every ___ month(s)**—Choose the day of the month and specify the number of months for the training session to occur.

The **Ending** options include:

- **Ending**—Choose the date for the last training session.

- **After**—Specify the number of training sessions, after which no additional training sessions will occur.
# Chapter 4: Setting up and Scheduling a Training Session

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Multiple session course</strong></td>
<td>A course that comprises multiple training sessions—that is, a series of sessions that span over days, weeks, months, and so on.</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>Attendees register once for an entire sequence of sessions.</td>
</tr>
<tr>
<td></td>
<td>The <strong>Recurrence</strong> options include:</td>
</tr>
<tr>
<td></td>
<td><strong>Daily</strong>—A class that repeats on a daily basis according to the following conditions:</td>
</tr>
<tr>
<td></td>
<td><strong>Every ___ Days</strong>—Select to schedule a training session to occur every specified number of days.</td>
</tr>
<tr>
<td></td>
<td><strong>Every weekday</strong>—Select to schedule training sessions for each Monday through Friday.</td>
</tr>
<tr>
<td></td>
<td><strong>Weekly</strong>—Select the check box for the day(s) of the week on which the training session will occur each week.</td>
</tr>
<tr>
<td></td>
<td><strong>Monthly</strong>—A class that repeats on a monthly basis according to the following conditions:</td>
</tr>
<tr>
<td></td>
<td><strong>Day ___ of every ___ month(s)</strong>—Specify the day of the month and the number of months for the training session to occur.</td>
</tr>
<tr>
<td></td>
<td><strong>[which] [day] of every ___ month(s)</strong>—Choose the day of the month and specify the number of months for the training session to occur.</td>
</tr>
<tr>
<td></td>
<td>The <strong>Ending</strong> options include:</td>
</tr>
<tr>
<td></td>
<td><strong>Ending</strong>—Choose the date for the last training session.</td>
</tr>
<tr>
<td></td>
<td><strong>After</strong>—Specify the number of training sessions, after which no additional training sessions will occur.</td>
</tr>
<tr>
<td><strong>Schedule irregular sessions</strong></td>
<td>A single-session course that is offered on multiple dates on an irregular basis.</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>Attendees register for only one session. Each session may be edited independently.</td>
</tr>
<tr>
<td></td>
<td><strong>Irregularly</strong>—A class that repeats on an irregular basis according to the following conditions:</td>
</tr>
<tr>
<td></td>
<td><strong>Session 1</strong>—Choose the date and time for the first training session to occur.</td>
</tr>
<tr>
<td></td>
<td><strong>Add another session</strong>—Click the link and then choose the date and time for additional training sessions to occur.</td>
</tr>
<tr>
<td><strong>Plan session time zones</strong></td>
<td>Select the time zone in which the training session time will appear in the list of sessions and on the training calendar.</td>
</tr>
</tbody>
</table>
### Chapter 4: Setting up and Scheduling a Training Session

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Estimated duration</td>
<td>Select the length of time that you estimate that the training session will last.</td>
</tr>
</tbody>
</table>

**Note:** The estimated duration is provided for planning purposes. The training session does not end automatically once the specified duration elapses.

---

### Scheduling a training session time, occurrence, and duration

1. On the Schedule Training Session or Edit Scheduled Training Session page, scroll to **Date and Time**.

2. In the **Starting time** drop-down lists, select the month, day, year, hour, and minute at which you want the training session to start.

3. Select whether to allow attendees to join the training session before the scheduled start time. If so, select the number of minutes from the drop-down list.

4. If attendees are allowed to join the training session before the scheduled start time, select whether attendees can also join the audio conference early.

5. Under **Occurrence**, select *one* of the following options:
   - **Single-session class**
   - **Recurring single-session class**
   - **Multiple session course**
   - **Schedule irregular sessions**

6. If you are scheduling a **Recurring single-session class**, do the following:
Chapter 4: Setting up and Scheduling a Training Session

a Select one of the following Recurrence patterns:

- **Daily**—Select the session to occur either every specified number of days, or every weekday.
- **Weekly**—Select the check box for the day(s) of the week on which the session will occur.
- **Monthly**—Select the session to occur either on a certain date (for example, the 5th of each month), or a certain day (for example, the second Tuesday of each month), as well as the monthly recurrence pattern (for example, 1 = every month, 2 = every other month, etc.).

b Select the Ending date to occur either on a selected date, or after a specified number of sessions.

7 If you are scheduling a Multiple session course, do the following:

a Select one of the following Recurrence patterns:

- **Daily**—Select the session to occur either every specified number of days, or every weekday.
- **Weekly**—Select the check box for the day(s) of the week on which the session will occur.
- **Monthly**—Select the session to occur either on a certain date (for example, the 5th of each month), or a certain day (for example, the second Tuesday of each month), as well as the monthly recurrence pattern (for example, 1 = every month, 2 = every other month, etc.).

b Select the Ending date to occur either on a selected date, or after a specified number of sessions.

8 If you are scheduling a Schedule irregular sessions course, do the following:

a Select the date for the first session.

b Click Add another session, select the date for the second session, and repeat for any additional sessions.

9 Optional. In the Time zone drop-down list, select a different time zone.

In the Time zone drop-down list, the time zone that you specified in your user profile is selected by default.

10 In the Estimated duration drop-down lists, select the hours and minutes for which you estimate the training session will continue.

11 If you have completed specifying options on the Schedule a Training Session page or Edit a Scheduled Training Session page, click Schedule or Update, respectively.
Chapter 4: Setting up and Scheduling a Training Session

Setting up Hands-on Lab

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of Hands-on Lab</td>
<td>About Hands-on Lab (on page 68)</td>
</tr>
<tr>
<td>reserve computers for Hands-on Lab</td>
<td>Reserving computers for Hands-on Lab (on page 69)</td>
</tr>
<tr>
<td>view the Hands-on Lab schedule</td>
<td>Viewing the Hands-on Lab schedule (on page 70)</td>
</tr>
</tbody>
</table>

About Hands-on Lab

Hands-on Lab sessions allow instructors to prepare lessons or exercises that students can complete on remote computers on which training software is installed. Students can use these remote computers during a training session for hands-on learning and practice. Because instructors can control Hands-on Lab sessions, they can maintain an optimized lab environment that is effective, familiar, and consistent.

You can schedule the following two types of Hands-on Lab sessions:

- **In-session Hands-on Lab.** For details, see *Setting up in-session Hands-on Lab* (on page 343).
- **On-Demand Hands-on Lab.** For details, see *Setting up on-demand Hands-on Lab* (on page 347).

About the Hands-on Lab page

To access the Hands-on Lab page, log in to your Training Center Web site. On the navigation bar, expand **Host a Session**, and then click **Hands-on Lab**.

You can do the following from this page:

**Hands-on Labs tab**

- View a list of the Hands-on Lab computers set up by your Hands-on Lab administrator.
- View the schedule for each of the labs.
Reserve computers for on-demand sessions.

My Reservations tab
- View the sessions you have scheduled for in-session or on-demand Hands-on Lab.
- Change your reservations, such as inviting attendees and canceling reservations.

Reserving computers for Hands-on Lab

When scheduling a training session, you can set up a Hands-on Lab session and reserve computers for that session. For information on Hands-on Lab sessions, see About Hands-on Lab (on page 68).

To reserve computers for a Hands-on Lab session:
1. On the Schedule Training Session or Edit Scheduled Training Session page, scroll to Hands-on Lab.
2. Select Reserve computers from lab.
   For instructions of viewing the Hands-on Lab schedule, see Viewing the Hands-on Lab schedule (on page 70).
3. Choose a lab from the drop-down list. Hands-on Labs are set up by your site administrator.
4. To view the lab description or number of computers set up in a selected lab, click Lab Info.
5. In the Number of computers box, type the number of computers that you want to reserve.
6. To check availability of the computers and lab, click Check Availability.
   The Computers Available dialog box appears indicating how many computers are available for the time and lab that you specified.
   Your reservation status appears in the Reservation status box. The reservation status refreshes each time you click Check Availability.
7. To pre-assign computers to registered attendees, select Require attendee registration in the Registration section of the Schedule Training Session page.
   Requiring attendee registration allows you to assign computers to attendees as they register. To assign computers to attendees as they register, see Assigning Hands-on Lab computers to registered attendees on page 305.
8 When you are finished scheduling your training session and Hands-On Lab, click **Schedule** at the bottom of the Schedule Training Session page.

If the computers are available for your scheduled Hands-on Lab, the Session Scheduled page appears with your reservation confirmation.

If the computers are not available, the Computers Not Available page appears. Click **Close**, and select a new reservation time or number of computers on the Schedule Training Session page.

9 Click **OK**.

**Viewing the Hands-on Lab schedule**

You can view the Hands-on Lab schedule from your Training Center Web site.

**To view the Hands-on Lab schedule:**

1 Log in to your Training Center Web site.

2 On the navigation bar, expand **Host a Session** to view a list of links.

3 Click **Hands-On Lab**.

   The Hands-on Lab page appears.

4 For the lab in which you are interested, under **Lab Schedule**, click **View Schedule**.

   The Lab Schedule page appears.

5 Point to a time slot to view details of the lab schedule.

6 When finished, click **Close**.

**Specifying registration options**

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>See…</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of requiring registration for a scheduled training session</td>
<td>About requiring registration for a scheduled training session (on page 71)</td>
</tr>
<tr>
<td>require registration for a scheduled training session</td>
<td>Requiring registration for a scheduled training session (on page 72)</td>
</tr>
</tbody>
</table>
### About requiring registration for a scheduled training session

You can require training session attendees to register for a training session before they can join it. Requiring registration allows you to view a list of attendees to determine whether they have registered for the training session, obtain attendees’ names, email addresses, and optionally additional personal information before they can join the training session, and accept or reject individual registration requests. If you invite an attendee to a training session that requires registration, the attendee receives an invitation email message that includes information about the training session, including the registration password if you specify one, and a link that the attendee can click to register for the training session.

#### Important:
- If you accept registration requests automatically for a training session that requires a password and an attendee registers after the training session has already started, the attendee can join the training session immediately, without providing the password. Therefore, to secure a training session from unauthorized access, you must clear the **Automatically approve all registration requests** box, and manually accept or reject all registration requests.
- If you do not accept registration requests automatically for a training session that requires a password and an attendee registers after the training session has already started, the attendee cannot join the training session until he or she receives a registration confirmation email message and can provide the training session password.
- If you do not check for registration requests in your email program during the training session, and accept the attendee’s request, the attendee cannot join the training session.
- If you require registration for a training session **that has reached its maximum attendee registrants**, you can allow attendees to register for a waiting list.
Requiring registration for a scheduled training session

**To require registration for a scheduled training session:**

1. On the Schedule Training Session or Edit Scheduled Training Session page, scroll to **Registration**.

2. Next to **Attendee Registration**, select the **Require attendee registration** check box.

3. Optional. To customize the registration form to obtain additional information about each attendee, click **Customize form**. For details about customizing a registration form, see *Customizing a registration form* (on page 75).

4. Do one of the following:
   - To accept or reject each registration request, clear the **Automatically approve all registration requests** check box.
   - To accept registration requests automatically without accepting or rejecting them individually select the **Automatically approve all registration requests** check box.

5. Optional. Specify a password that registrants must provide to register for the session, by typing it in the **Set registration password** and **Confirm registration password** boxes.

   Specify a registration password only if you want to limit registrants to those whom you invite to register. If you invite attendees to register, each invitee receives an invitation email message, which contains the registration password.

6. Specify a date or time on which you will no longer accept registration requests, as follows:
   - Select **None** if there is no registration close date.
   - From the drop-down lists, select the days, hours, and minutes before the session starts.

7. Specify a maximum number of registration requests, by typing a number in the **Maximum registrations allowed** box. Leave the box blank for unlimited registrations.

8. If you specified a maximum number of registrations, select whether to allow attendees to register for a waiting list. If so, select whether to:
   - Automatically register the first attendee in the waitlist.
   - Manually register from the waitlist.
Specify whether an attendee can cancel registration, as follows:

- Select **Not allowed** if you will not allow attendees to cancel registration.
- From the drop-down lists, select the days, hours, and minutes before the session starts that an attendee can cancel registration.

Click **Schedule** or **Update**.

**About customizing a registration form**

If you require attendees to register for a live or recorded training session, you can customize the registration form on which attendees must provide information.

When customizing the form, you can choose which standard options you want to appear on the form and create any of the following options:

- **Text Box**—Opens the Add Text Box window, on which you can specify text boxes that appear on the registration form. For detailed information about specifying a text box, see *About the Add Text Box window* (on page 73).

- **Check Boxes**—Opens the Add Check Boxes window, on which you can specify check boxes that appear on the registration form. For detailed information about specifying a check box, see *About the Add Check Boxes window* (on page 74).

- **Radio Buttons**—Opens the Add Radio Buttons window, on which you can specify radio buttons that appear on the registration form. For detailed information about specifying radio buttons, see *About the Add Radio Button window* (on page 74).

- **Drop-Down List**—Opens the Add Drop-Down List window, on which you can specify a drop-down list that appears on the registration form. For detailed information about specifying a drop-down list box, see *About the Add Drop-Down List window* (on page 75).

For each option that you add to the form, you can specify whether the information is required that is, whether attendees must provide the information to register for the live or recorded training session.

**About the Add Text Box window**

The Add Text Box window allows you to specify a text box that appears on the registration form. A text box allows an enrollee to type information on the registration form. The detailed reports that you can obtain for live or recorded training sessions indicate which text boxes each registrant selected when registering for a live or recorded training session.
Textbox name—Specifies the text that appears to the left of the text box. A text box label can contain a maximum of 256 characters.

Type—Specifies whether the text box contains a single line or multiple lines on which an enrollee can type. If you select Multi-line, specify a number of lines in the Height box.

Width—Specifies the width of the text box, in characters. The number that you specify determines how the text box appears on the registration form, but does not affect the number of characters that an enrollee can type in the text box. Any text box that you add can contain a maximum of 256 characters.

Height—Specifies the number of lines that the text box contains. To specify a number of lines, you must first select Multi-line under Type. If you do not specify a number of lines, Training Center uses the default height, which is one line.

About the Add Check Boxes window

The Add Check Boxes window allows you to specify one or more check boxes that appear on the registration form. The detailed reports that you can obtain for live or recorded training sessions indicate which check boxes each registrant selected when registering for a live or recorded training session.

Check box group name—Specifies the text that appears to the left of a group of check boxes that you add to a registration form. To specify a group label, type it in the box. If you are adding only one check box and do not want a group label, leave this box blank.

Check box 1 to 9—Specifies the text label that appears to the right of the check box, and whether the check box is selected or cleared by default on the registration form. To add a check box to the registration form, type its label in the box, then choose Checked or Unchecked in the drop-down list.

About the Add Radio Button window

The Add Radio Button window allows you to specify radio buttons that appear on the registration form. Radio buttons allow an enrollee to select only one choice from a group of choices. The detailed reports that you can obtain for live or recorded training sessions indicate which radio buttons each registrant selected when registering for a live or recorded training session.

Radio button group name—Specifies the text that appears to the left of a group of radio buttons that you add to a registration form. To specify a group label, type it in the box.
Chapter 4: Setting up and Scheduling a Training Session

Default choice—Specifies which radio button is selected by default on the registration form. To specify a default choice, first ensure that you have specified the labels for the radio buttons, then select the number for the button in the drop-down list.

choice 1 to 9—Specifies the text label that appears to the right of the radio button. To add a radio button to the registration form, type its label in the box.

About the Add Drop-Down List window

The Add Drop-Down List window allows you to specify a drop-down list box that appears on the registration form. A drop-down list box allows a registrant to select a single option from a list. The detailed reports that you can obtain for live or recorded training sessions indicate which choices each registrant selected when registering for a live or recorded training session.

Drop-down name—Specifies the text that appears to the left of the drop-down list that you add to a registration form. To specify a label, type it in the box.

Default choice—Specifies which choice is selected by default in the drop-down list on the registration form. To specify a default choice, first ensure that you have specified the choices in the list, then select the number for the choice in the drop-down list. If you do not want a choice to be selected by default, select None in the drop-down list.

choice 1 to 9—Specifies the text that appears for the choice in the drop-down list. To add a choice to the list, type its text in the box.

Customizing a registration form

To customize a registration form:

1 On the Schedule Training Session or Edit Scheduled Training Session page, scroll to Registration.

2 Select Customize form.

The Customize Registration Form page appears. Under Standard Options, the following options appear:

- first and last name (always appears on the Registration page)
- email address (always appears on the Registration page)
- phone number
Chapter 4: Setting up and Scheduling a Training Session

- fax number
- company
- title
- address information

3 Optional. Under **Standard Options**, do the following:
   - For each option that you want to appear on the registration form, select the check box under.

   ![Check box](image)

   - For each option for which you want to require attendees to provide information, select the check box under.

   ![Check box](image)

4 Optional. Add custom options to the form by clicking *one* of the following:
   - **Text Box**
   - **Check Boxes**
   - **Radio Buttons**
   - **Drop-Down List**

For more information about specifying custom options, see *About customizing a registration form* (on page 73).

5 To save the customized registration form so you can use it for future scheduled sessions, click **Save As**.

The Save Registration Form page appears. You can save up to five customized forms on this page. Type a name for your form in the **Form Description** box. Click **Save**.

6 Click **OK** to save your changes and close the Customize Registration Form page.
Inviting attendees and presenters

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>See…</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview about inviting attendees and presenters to a scheduled training session</td>
<td>About inviting attendees and presenters to a scheduled training session (on page 77)</td>
</tr>
<tr>
<td>invite attendees to a scheduled training session</td>
<td>Inviting attendees to a scheduled training session (on page 78)</td>
</tr>
<tr>
<td>invite a new attendee to a scheduled training session</td>
<td>Inviting a new attendee to a scheduled training session (on page 79)</td>
</tr>
<tr>
<td>invite presenters to a scheduled training session</td>
<td>Inviting presenters to a scheduled training session (on page 80)</td>
</tr>
<tr>
<td>invite a new presenter to a scheduled training session</td>
<td>Inviting a new presenter to a scheduled training session (on page 80)</td>
</tr>
<tr>
<td>invite contacts in your address book to a scheduled training session</td>
<td>Inviting contacts in your address book to a scheduled training session (on page 82)</td>
</tr>
</tbody>
</table>

About inviting attendees and presenters to a scheduled training session

To invite attendees and presenters to a scheduled training session, you can

- specify their email addresses
- select contacts in your personal address book
- specify information about new contacts in your personal address book, and then select them for inclusion in your list of attendees

When inviting attendees and presenters to a scheduled training session, you can select contacts in the following lists:

- **Personal contacts**—Includes any individual contacts that you have added to your personal address book. If you use Microsoft Outlook, you can import the personal contacts that you keep in an Outlook address book or folder to this list of contacts.

- **My groups**—Includes any contact groups that you have created for your personal address book.
Chapter 4: Setting up and Scheduling a Training Session

- **Company address book**—Your organization's address book, which includes any contacts that your site administrator has added to it. If your organization uses a Microsoft Exchange Global Address List, your site administrator can import its contacts to this address book.

Each invitee receives an invitation email message that includes the following:

- a link that the attendee or presenter can click to join the training session or obtain more information about it
- the training session password, if you specified one
- teleconferencing information, if your training session includes an integrated teleconference
- the session number, which the attendee must provide if your training session is unlisted

**Note:** Once you start a scheduled training session, you can invite additional attendees.

### Inviting attendees to a scheduled training session

**To invite attendees to a scheduled training session:**

1. On the Schedule Training Session or Edit Scheduled Training Session page, scroll to **Attendees**, and then click **Invite Attendees**.

   The Invite Attendees page appears.

2. Add any of the following to the list of invited attendees:
   - individual contacts and contact groups already in your personal address list, and individual contacts in your company address book. For details, see Inviting contacts in your address book to a scheduled training session.
   - new individual attendees who are not already contacts in one of your address lists. For details, see **Inviting a new attendee to a scheduled training session** (on page 79).

3. Click **Schedule** or **Update**.
Inviting a new attendee to a scheduled training session

When inviting attendees to a scheduled training session, you can add a new attendee to your list of attendees—that is, an attendee that is not already a contact in one of your address books. Once you specify information about a new attendee, you can add the attendee's information to your personal address book.

**To invite a new attendee to a scheduled training session:**

1. If you have not already done so, open the *Invite Attendees* page. For details, see *Inviting attendees to a scheduled training session* (on page 78).

2. On the *Invite Attendees* page, under *New Attendee*, provide information about the attendee, as follows:
   a. Type the attendee's full name in the *Full name* box.
   b. Type the attendee's email address in the *Email address* box.
   c. Optional. Type the contact's phone number in the *Phone number* boxes and select the time zone, language, and locale.

   **Note:** If you do not know the attendee's country code, click *Country/region*. In the window that appears, select the attendee's country from the drop-down list, and then click *Close*. The country code appears in the *Country/Region* box.

3. Optional. To add the new attendee's information to your personal address book, select the *Add new attendee in my address book* check box.

4. Optional. To make this attendee an alternate host—one who can start this training session and act as the host—select the *Invite as alternate host* check box.

   **Note:** An alternate host must have a user account on your Training Center Web site.

5. Click *Add Attendee*.

   The contact appears under *Attendees to Invite* on the Invite Attendees page.

6. Optional. To remove the new attendee from your list of attendees, select the check box for the attendee, then click *Delete*. 
Chapter 4: Setting up and Scheduling a Training Session

7 To add the attendee to your list of invited attendees, click OK.

The contact appears in the Invited attendees box on the Schedule Training Session page.

**Note:** If you later modify the training session to remove an attendee from your participant list, you can optionally send the attendee an automatic email message that informs the attendee that the training session was canceled.

Inviting presenters to a scheduled training session

**To invite presenters to a scheduled training session:**

1 On the Schedule Training Session or Edit Scheduled Training Session page, scroll to Presenters, and then click Invite Presenters.

The Invite Presenters page appears.

2 Add any of the following to the list of invited presenters:
   - individual contacts and contact groups already in your personal address list, and individual contacts in your company address book. For details, see Inviting contacts in your address book to a scheduled training session (on page 82).
   - new individual presenters who are not already contacts in one of your address lists. For details, see Inviting a new presenter to a scheduled training session (on page 80).

3 Click Schedule or Update.

Inviting a new presenter to a scheduled training session

When inviting presenters to a scheduled training session, you can add a new presenter to your list of presenters—that is, a presenter who is not already a contact in one of your address books. Once you specify information about a new presenter, you can add the presenter's information to your personal address book.
To invite a new presenter to a scheduled training session:

1. On the *Invite Presenters* page, under *New Presenter*, provide information about the presenter, as follows:
   - **a** Type the presenter's full name in the *Full name* box.
   - **b** Type the presenter's email address in the *Email address* box.
   - **c** Optional. Type the presenter's phone number in the *Phone Number* boxes and select the time zone, language, and locale.
   - **d** Optional. To add the new presenter's information to your personal address book, select the *Add presenter as attendee in my address book* check box.
   - **e** Optional. To make this presenter an alternate host—one who can start this training session and act as the host—select the *Invite as alternate host* check box.

**Note:** An alternate host must have a user account on your Training Center Web site.

2. Click *Add Presenter*.
   The contact appears under *Presenters to Invite*.

3. Optional. To remove the new presenter from your list of presenters, select the check box for the presenter, then click *Delete*.

4. To add the presenter to your list of invited presenters, click *OK*.

**Note:** If you later modify the training session to remove a presenter from your participant list, you can optionally send the presenter an automatic email message that informs the presenter that the training session was canceled.
Inviting contacts in your address book to a scheduled training session

To invite a contact in your address book to a scheduled training session:

1. If you have not already done so, open the Invite Attendees page. For details, see Inviting attendees to a scheduled training session (on page 78).

2. On the Invite Attendees page, click Select Contacts.

   The Select Contacts page appears.

3. Next to View, in the drop-down list, select one of the following contact lists:
   - Personal Contacts
   - Company Address Book
   - My Groups

   A list of all contacts in the list that you selected appears.

4. Select the check box for each individual contact or contact group that you want to add to your list of attendees.

   When selecting contacts, you can do the following:
   - In the Index, click a letter of the alphabet to display a list of contacts whose names begin with that letter. For example, the name Susan Jones appears under S.
   - To search for a contact in the list that you are currently viewing, type text that appears in either the contact's name or email address in the Search for box, then click Search.
   - If the entire list of contacts does not fit on a single page, view another page by clicking the Next Page button or the Previous Page button.
   - To select all contacts that currently appear in the list, click Select All.
   - To clear all selections in the current list, click Clear All.

   Tip: To change information about a contact, click the contact's name. On the page that appears, specify new information, then click OK.

5. To add all selections to your list of attendees, click Add Attendees.
Chapter 4: Setting up and Scheduling a Training Session

The Select Contacts page closes and the Invite Attendees page reappears. The contacts that you selected appear under **Attendees to Invite**.

6 Optional. To add this contact as an alternate host—one who can start this training session and act as the host, select the check box for the contact, then click **Add as Alternate Host**.

**Note:** An alternate host must have a user account on your Training Center Web site.

7 Optional. To remove the contact from your list of attendees, select the check box for the contact, then click **Delete**.

8 To add the contacts to your list of invited attendees, click **Invite**.

**Note:** If you later modify the training session to remove an attendee from your participant list, you can optionally send the attendee an automatic email message that informs the attendee that the training session was canceled.

---

### Specifying training session options

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>specify options available to participants during a training session</td>
<td><em>Specifying options available to participants during a training session</em> (on page 84)</td>
</tr>
<tr>
<td>specify security options for a training session</td>
<td><em>Specifying security options for a training session</em> (on page 85)</td>
</tr>
<tr>
<td>allow attendees to share UCF media files</td>
<td><em>Allowing attendees to share UCF media files</em> (on page 86)</td>
</tr>
<tr>
<td>specify a destination Web page after the session ends</td>
<td><em>Specifying a destination Web page after the session ends</em> (on page 86)</td>
</tr>
<tr>
<td>create a message or greeting for participants to view when they join a training session</td>
<td><em>Creating a message or greeting for a scheduled training session</em> (on page 87)</td>
</tr>
</tbody>
</table>
Specifying options available to participants during a training session

When scheduling a training session, you can specify options or privileges available to participants during a session. The privileges that you select determine the default privileges that attendees have once you start the training session.

To specify attendee privileges when scheduling a training session:

1. On the Schedule Training Session or Edit Scheduled Training Session page, scroll to Session Options.
2. Click Edit Options.
   The Session Options page appears.
3. Under Attendee Privileges, specify attendee privileges as follows:
   ▪ To grant a privilege to all attendees, select its check box.
   ▪ To remove a privilege from all attendees, clear its check box.

   For descriptions of the privileges on the Session Options page, see the topic About the Session Options page (on page 88).
4. Click Save to close the Session Options page.
5. Click Schedule or Update.

Note: A presenter can grant the following privileges to or remove them from attendees during a training session, whether or not you select them on the Session Options page:

- Save
- Print
- Annotate
- Attendee list
- Thumbnails
- Video
- Next or previous pages
- Chat
Specifying security options for a training session

When scheduling a training session, you can specify security options to prevent unauthorized attendees from joining.

Excluding the session password from email invitations

If you invite attendees to a training session, you can prevent the password from appearing in the email invitations that your Training Center Web site automatically sends to attendees.

To exclude the session password from email invitations:

1. On the Schedule Training Session or Edit Scheduled Training Session page, scroll to Session Options.
2. Click Edit Options.
   The Session Options page appears.
3. Under Security, select the Exclude password from emails sent to attendees check box.
4. Click Save.

Requiring attendees to log in to your Training Center Web site

You can require attendees to have a user account on your Training Center Web site to join the training session. Thus, attendees must log in to your site before they can attend the training session.

To require attendees to log in to your Training Center Web site:

1. On the Schedule Training Session or Edit Scheduled Training Session page, scroll to Session Options.
2. Click Edit Options.
   The Session Options page appears.
3 Under Security, select the Attendees must have an account on this service to attend session check box.

4 Click Save.

Allowing attendees to share UCF media files

When scheduling a training session, you can allow attendees to share Universal Communications Format (UCF) media files during the session, either in a UCF multimedia presentation or as standalone UCF media files. You can also prevent attendees from sharing UCF media files during a session. If you do so, only you, the session host, can share UCF media files when also acting as the presenter.

You may want to prevent attendees from sharing UCF media files, for example, if you intend to allow attendees to share presentations or documents but want to prevent an attendee from inadvertently sharing a very large media file.

To allow attendees to or prevent them from sharing UCF media files:

1 On the Schedule Training Session or Edit Scheduled Training Session page, scroll to Session Options, and then click Edit Options.

2 Under Universal Communications Format (UCF), do one of the following:
   - To allow attendees to share UCF media files, select the Allow attendees to share UCF objects check box.
   - To prevent attendees from sharing UCF media files, clear the Allow attendees to share UCF objects check box.

3 Click Save to close the Session Options page.

4 Click Schedule or Update.

Note: If you allow attendees to share UCF media files, the presenter must also grant them the Share documents privilege during the session.

Specifying a destination Web page after the session ends

While scheduling a training session, you can specify a destination Web page or Web site that attendees view automatically after the training session ends.
To specify a destination URL:
1. On the Schedule Training page or Edit Scheduled Training Session page, scroll to Session Options.
2. Type a destination Web site address (URL) in the Destination address (URL) after session box.
3. Click Schedule or Update.

Creating a message or greeting for a scheduled training session

You can create a message or greeting that optionally appears in an attendee’s Session window when the attendee joins a scheduled training session. For example, you can welcome the attendee to the training session, provide important information about the training session, or provide special instructions. Attendees can view the greeting or message at any time during the training session.

To create a message or greeting for a scheduled training session:
1. On the Schedule Training page or Edit Scheduled Training Session page, scroll to Session Options.
2. Next to Greeting message, click Customize greeting message when attendee joins.
   The Create an Attendee Greeting page appears.
3. Optional. Select the Display this message when attendees join the session check box.
4. Type a message or greeting in the Message box.
   A message or greeting can contain a maximum of 4000 characters.
5. Click OK.
6. Click Schedule or Update.

Note: Attendees can view the message or greeting at any time during a training session, by choosing Welcome Message on the Session menu.
**About the Session Options page**

From the Session Options page, you can specify which options are available to attendees during the session. If an option is not selected, it is unavailable during the session.

**How to access this page**

On the navigation bar, click **Host a Session > Schedule Training**. Scroll to **Session Options** and then click **Edit Options**.

**What you can do here**

- Specify which options are available during the training session.
- Specify attendee privileges.
- Specify security options.
- Specify whether attendees can share UCF rich media files.

**Note:** A presenter can turn any option on or off during the training session.

**Options on this page**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Training session options</td>
<td></td>
</tr>
</tbody>
</table>
### Option Description

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chat</td>
<td>If selected, specifies that chat is available during a training session—that is, chat options appear on the <strong>Participants</strong> panel in the Session window. If you clear this option, chat options do not appear on the <strong>Participants</strong> panel.</td>
</tr>
<tr>
<td>File transfer</td>
<td>If selected, specifies that the presenter can transfer files to attendees during a training session. If you clear this option, the Transfer option does not appear on the <strong>File</strong> menu in the Session window, and the presenter cannot transfer files to attendees during a training session.</td>
</tr>
<tr>
<td>Video</td>
<td>If selected, specifies that video is available during a training session—that is, the <strong>Video</strong> tab appears in the Session window. If you clear this option, the <strong>Video</strong> tab does not appear in the Session window.</td>
</tr>
</tbody>
</table>

**Enable high-quality video:** Video can be as high as 360p resolution (640x360). However, the quality of the video that participants can send and receive depends on each participant's webcam and computer capability, and network speed.

### Attendee Privileges

<table>
<thead>
<tr>
<th>Sessions</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recording</td>
<td>If selected, specifies that the attendee can start recording the training session.</td>
</tr>
<tr>
<td>Send Video</td>
<td>If selected, specifies that attendees can send video during a training session—that is, the <strong>Video</strong> icon appears next to the participant's name in the Participant's panel. If you clear this option, sending video is not available for participants.</td>
</tr>
<tr>
<td>Number of attendees</td>
<td>If selected, specifies that the attendees can view the number of attendees in the training session.</td>
</tr>
<tr>
<td>Attendee list</td>
<td>If selected, specifies that all attendees can view the participant list on the <strong>Participants</strong> panel. A presenter can grant this privilege to or remove it from attendees during a training session, whether or not you select it here.</td>
</tr>
</tbody>
</table>
Chapter 4: Setting up and Scheduling a Training Session

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Documents**        | **Save**—If selected, specifies that all attendees can save any shared documents, presentations, or whiteboards that appear in their content viewers. A presenter can grant this privilege to or remove it from attendees during a training session, whether or not you select it here.  
  **Print**—If selected, specifies that all attendees can print any shared documents, presentations, or whiteboards that appear in their content viewers. A presenter can grant this privilege to or remove it from attendees during a training session, whether or not you select it here.  
  **Annotate**—If selected, specifies that all attendees can annotate any shared documents or presentations, or write and draw on shared whiteboards, that appear in their content viewers, using the toolbar that appears below the viewer. A presenter can grant this privilege to or remove it from attendees during a training session, whether or not you select it here.  
  **Thumbnails**—If selected, specifies that all attendees can display miniatures of any pages, slides, or whiteboards that appear in their content viewers. This privilege allows attendees to view miniatures at any time, regardless of the content that appears in the presenter's content viewer. However, attendees with this privilege cannot display a miniature at full size unless they also have the View any page privilege. A presenter can grant this privilege to or remove it from attendees during a training session, whether or not you select it here.  
  **Next or previous page**—If selected, specifies that all attendees can view any pages, slides, or whiteboards that appear in their content viewers. This privilege allows attendees to navigate independently through pages, slides, or whiteboards. A presenter can grant this privilege to or remove it from attendees during a training session, whether or not you select it here. |
| **Security**         | **Exclude password from emails sent to attendees**—If selected, prevents the training session password from appearing in the email invitations, to help increase the security for your training session. If you exclude the password in email invitations, however, you must provide the password to attendees using another method for example, by phone. |
| **Attendees must have an account on this service to attend session**—Specifies that all attendees must have an account and log in to your Training Center Web site to attend the training session. |
| **Universal Communications Format (UCF)** | **Allow attendees to share UCF objects**—Allows attendees to share Universal Communications Format (UCF) media files during the training session, either in a UCF multimedia presentation or as standalone UCF media files. A host who is also the presenter can always share UCF media files, whether or not you select this check box. |
Chapter 4: Setting up and Scheduling a Training Session

Setting up breakout sessions

If your user account privileges allow you to host breakout sessions, you can set breakout session assignments within the Training Center scheduler. You can pre-assign attendees to breakout sessions here, or make these settings later from within a training session.

For more information on breakout sessions, see Using Breakout Sessions (on page 373).

Pre-assigning breakout session participants

When scheduling a training session, you can enable pre-assignment of attendees to breakout sessions prior to your training session.

From the Breakout Session Assignments Settings section of the scheduler, you can do the following:

- Enable the option to assign attendees to breakout sessions prior to your training session
- Choose to have Training Center make the breakout session assignments for you
- Set the number of breakout sessions for your training session
- Set the number of attendees per breakout session
- Choose to manually assign attendees to breakout sessions as you manage your registrations

Note:

You must enable registration to manually assign attendees to breakout sessions prior to your training session.

The number of breakout sessions must be between 1 and 100.

The number of attendees allowed in a breakout session must be between 1 and 100.
To assign attendees to breakout sessions automatically:
1. On the Schedule Training Session or Edit Scheduled Training Session page, scroll to **Breakout Session Assignments Settings**.
2. Select **Enable Pre-Session Assignment**.
3. Select **Automatically assign attendees during the session**.
4. Select the option to set either the number of breakout sessions or the number of attendees per breakout session.
5. Enter the number accordingly for your selection.

To assign attendees to breakout sessions manually:
1. On the Schedule Training Session or Edit Scheduled Training Session page, set registration requirements in the Registration section of the scheduler.
2. Scroll to **Breakout Session Assignments Settings**.
3. Select **Enable Pre-Session Assignment**.
4. Select **Manually assign registered attendees to breakout sessions**.

Assigning registered attendees to breakout sessions
If you enabled pre-session assignments to breakout sessions when scheduling your training session, you must manually assign attendees when you manage registrations.

To manage breakout session assignments prior to your training session:
1. Log in to your Training Center Web site.
2. On the navigation bar, expand **Attend a Session** to view a list of links.
3. Click **Live Sessions**.
4. Click on your session topic.
   The Session Information page appears.
5. Click **Manage Registrations**.
Chapter 4: Setting up and Scheduling a Training Session

The Registered Attendees page appears.

6 Click **Pre-assign attendees to breakout sessions**.

7 On the Pre-assign attendees to breakout sessions page, change the session name, if necessary.

8 Highlight one or more names from the Not Assigned column and add them to the session by clicking the add icon.

9 The first added attendee will be assigned as the presenter. To change this designation, highlight an assigned attendee and click the assign presenter icon.

10 If you want to remove an attendee, highlight the assigned attendee and click the remove icon.

11 Click **Add Breakout Session** if you want to add more breakout sessions.

12 Click **OK**.

Selecting email messages to be sent

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>See…</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of sending default email messages</td>
<td><em>About sending default email messages</em> (on page 94)</td>
</tr>
<tr>
<td>send an invitation to a training session automatically</td>
<td><em>Sending an invitation to a training session</em> (on page 94)</td>
</tr>
</tbody>
</table>
### About sending default email messages

While you are scheduling your training session, you can select the default email messages that you send to attendees. You can also customize the Training Center email message templates by editing, rearranging, or deleting the text and variables—code text that Training Center recognizes and substitutes with your specific training session information.

- Under **Reminder**, you can choose to receive an email when an attendee joins a training session.
- Notification to Host Upon Attendee Joining a Session

### Sending an invitation to a training session

When you are scheduling a training session, you can choose to have your Training Center automatically send invitation email messages to attendees. When you select an email message to send, you can send the default email message or choose to customize the message. For details, see *About customizing email messages* (on page 97).

**To send an automatic invitation to a training session:**

1. On the Schedule Training Session page or the Edit Scheduled Training Session page, scroll to **Email options**.
2. Click **Edit Email Options**.
3. Under **Invitations**, select the check box next to any of the following:

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>See…</th>
</tr>
</thead>
<tbody>
<tr>
<td>send an update to a scheduled training session</td>
<td>Sending an update to a scheduled training session (on page 95)</td>
</tr>
<tr>
<td>send registration notifications to the host or attendees</td>
<td>Sending a registration notification to a scheduled training session (on page 95)</td>
</tr>
<tr>
<td>send a reminder for a scheduled training session</td>
<td>Sending a reminder for a scheduled training session (on page 96)</td>
</tr>
<tr>
<td>get an overview of customizing email messages</td>
<td>About customizing email messages (on page 97)</td>
</tr>
<tr>
<td>customize an email message</td>
<td>Customizing an email message (on page 98)</td>
</tr>
</tbody>
</table>
Chapter 4: Setting up and Scheduling a Training Session

- Invitation to Join a Training Session
- Invitation to a Training Session in Progress
- Invitation to Register for a Training Session

4 Click Schedule or Update.

Sending an update to a scheduled training session

When you are scheduling a training session, you can choose to have your Training Center automatically send email messages to attendees whenever you update your scheduled training session. When you select an email message to send, you can send the default email message or choose to customize the message. For details, see About customizing email messages (on page 97).

To send automatic updates to attendees:

5 On the Schedule Training Session page or the Edit Scheduled Training Session page, scroll to Email options.

6 Click Edit Email Options.

7 Under Updates, select the check box next to any of the following:
   - Training Session Rescheduled
   - Updated Information to Join a Training Session
   - Updated Information to Register for a Training Session
   - Training Session Cancelled

8 Click Schedule or Update.

Sending a registration notification to a scheduled training session

When you are scheduling a training session, you can choose to have your Training Center automatically send email messages to you whenever an attendee registers and automatically send email messages to attendees when their registration status changes. When you select an email message to send, you can send the default email message or choose to customize the message. For details, see About customizing email messages (on page 97).

To send automatic updates to attendees:
9 On the Schedule Training Session page or the Edit Scheduled Training Session page, scroll to Email options.

10 Click Edit Email Options.

11 Under Registrations, select the check box next to any of the following:
   - Registration Notification to Host
     You cannot change this default email message.
   - Attendee Registration Pending
   - Attendee Registration Confirmed
   - Attendee Registration Rejected

12 Click Schedule or Update.

Sending a reminder for a scheduled training session

You can send training session reminders to attendees and presenters and to yourself from 15 minutes to 2 weeks before a scheduled training session. When you select an email message to send, you can send the default email message or choose to customize the message. For details, see About customizing email messages (on page 97).

To send reminders for a scheduled training session:

1 On the Schedule Training Session page or the Edit Scheduled Training Session page, scroll to Email options.

2 Click Edit Email Options.

3 Under Reminder, select the check box next to Training Session Reminder to Attendees.

4 Select the time before a training session that you want reminders to be sent.

5 To include additional email reminders, click Add another reminder email, and then select the time before a training session that you want this reminder sent.

   Note: You can add up to three reminder emails.

6 Next to Presenters, in the drop-down list, select the time before a training session that you want reminders sent to presenters.
Chapter 4: Setting up and Scheduling a Training Session

7 Next to Host, in the drop-down list, select the time before a training session that you want a reminder sent to you.

8 After via email address, type the email address to which you want your Training Center to send you a reminder, in the following format:
   name@domain.com

   **Important:** Do not type multiple email addresses in the box. If you do, your Training Center will not send the reminder.

9 Click Schedule or Update.

Receiving a notification when an attendee joins a session

When you are scheduling a training session, you can choose to have your Training Center automatically send an email message to you whenever an attendee joins your training session. For details, see About customizing email messages (on page 97).

To send an automatic invitation to a training session:

1 On the Schedule Training Session page or the Edit Scheduled Training Session page, scroll to Email options.

2 Click Edit Email Options.

3 Under Reminder, select the Notification to Host Upon Attendee Joining a Session check box.

4 Click Schedule or Update.

About customizing email messages

You can customize the default email messages for your preferences. You can delete variables, but do not change the text within the percentage signs (example, %ParticipantName%).

If you change these, Training Manager will not substitute the correct text from your profile or registration information. For descriptions of variables, see Email message variables.

You can edit the following options in the Edit Email message window.
Chapter 4: Setting up and Scheduling a Training Session

- **Email Subject**—Specifies the text that appears in the subject line of the email message.
  
  To specify a new subject, type it into the box.

- **Content**—Specifies the content of the email message. The default content contains variables, which Training Center replaces with your training session information. You can rearrange, delete, or replace variables and text with specific information. Do not change the text within a variable.

### Customizing an email message

**To customize an email message:**

1. On the Schedule Training Session page or Edit Scheduled Training Session page, under **Email options**, click **Edit Email Options**.
2. Click the email message that you want to customize.
   
   The Edit Email window appears.
3. Edit the email message. Be sure not to change the text within a variable. For descriptions of variables, see **Email message variables** (on page 98).
4. To save your edited email message, click **Update**.
5. Optional. To return the email message to the default message, click **Reset to Default**. If you click **OK**, the default email message replaces any edits that you have made.

### Email message variables

Each variable used in Training Center Email Messages is replaced by corresponding information you provide when scheduling a training session. The following table includes many of these variables and their meanings.

<table>
<thead>
<tr>
<th>This variable…</th>
<th>is replaced by…</th>
<th>For use in these Email Messages…</th>
</tr>
</thead>
<tbody>
<tr>
<td>%EmailFooter%</td>
<td>A Web site’s email signature.</td>
<td>All</td>
</tr>
<tr>
<td>%HostEmail%</td>
<td>The email address that you specified your user profile.</td>
<td>All</td>
</tr>
<tr>
<td>This variable...</td>
<td>is replaced by...</td>
<td>For use in these Email Messages...</td>
</tr>
<tr>
<td>-----------------</td>
<td>------------------</td>
<td>-----------------------------------</td>
</tr>
<tr>
<td>%HostName%</td>
<td>The first and last name that you specified in your user profile.</td>
<td>All</td>
</tr>
<tr>
<td>%ParticipantName%</td>
<td>First and last names that the participants specified when either enrolling for or joining a training session.</td>
<td>All</td>
</tr>
<tr>
<td>%PhoneContactInfo%</td>
<td>If you specified a phone number in your user profile, the following text: <strong>call %HostPhone%</strong>, where %HostPhone% is replaced by the phone number that you specified in your user profile.</td>
<td>Attendee Registration Confirmed, Training Session Reminder to Attendees</td>
</tr>
<tr>
<td>%RegistrationID%</td>
<td>The enrollment ID for the attendee. OnStage automatically creates this ID for an attendee after you approve his or her enrollment request. If you do not require enrollment for the training session, this variable is replaced by following text: <em>(This training session does not require an enrollment ID.)</em></td>
<td>Attendee Registration Confirmed, Training Session Reminder to Attendees</td>
</tr>
</tbody>
</table>
| %SessionDateOrRecurrence% | If the session is a single session, then display: **[SessionDate]**  
If the session is a recurring session or multiple-session course, display: **[SessionRecurrence]** | Attendee Registration Confirmed, Training Session Reminder to Attendees |
| %SessionInfoURL% | The Web address, or URL, for the Training Information page for the training session. Training Manager automatically creates the URL once you schedule a training session. | All |
| %SessionNumber% | The number of your session specified by Training Manager. | All |
Chapter 4: Setting up and Scheduling a Training Session

<table>
<thead>
<tr>
<th>This variable...</th>
<th>is replaced by...</th>
<th>For use in these Email Messages...</th>
</tr>
</thead>
<tbody>
<tr>
<td>%SessionPassword%</td>
<td>The password for the training session that you specified when scheduling the training. If you do not require a password, this variable is replaced by the following text: (This training session does not require a password.)</td>
<td>Attendee Registration Confirmed Training Session Reminder to Attendees</td>
</tr>
<tr>
<td>%SessionTime%</td>
<td>The time that you specified when scheduling the training session in the following format: HH:MM [am/pm]. For example: 12:30 pm</td>
<td>All</td>
</tr>
<tr>
<td>%TeleconferenceInfo%</td>
<td>The following text: To join the teleconference, call %CallInNumber% and enter the training session number. Where %CallInNumber% is replaced by the number(s) that you specified in the Phone numbers box when scheduling the training.</td>
<td>All</td>
</tr>
<tr>
<td>%TimeZone%</td>
<td>The time zone that you specified when scheduling the training.</td>
<td>All</td>
</tr>
<tr>
<td>%Topic%</td>
<td>The training session topic that you specified when scheduling the training.</td>
<td>All</td>
</tr>
</tbody>
</table>

Specifying session information

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>add an agenda and training session description to the Session Information page</td>
<td>Setting your agenda (on page 101)</td>
</tr>
</tbody>
</table>
Chapter 4: Setting up and Scheduling a Training Session

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>See…</th>
</tr>
</thead>
<tbody>
<tr>
<td>add a picture to the Session Information page</td>
<td>Adding a picture to the Session Information page (on page 101)</td>
</tr>
</tbody>
</table>

Setting your agenda

You can specify an agenda for a scheduled training session. The agenda appears on the Agenda page on your Training Center Web site, which attendees can view before the training session starts.

If you invite an attendee to the training session, the attendee receives an invitation email message that includes a link that the user can click to view the training session's agenda.

To set your training session agenda:

1. On the Schedule Training Session page or Edit Scheduled Training Session page, scroll to **Session Information**.
2. Next to **Agenda**, select **Plain text** or **HTML**.
3. For plain text, type the training session's agenda in the **Agenda** box. For HTML input, type or paste HTML text in the **Agenda** box.
   a. **Important** Click the Help icon to check for supported HTML tags and attributes.
4. Next to **Description**, select **Plain text** or **HTML**.
5. For plain text, type a description of the training session in the **Description** box. For HTML input, type or paste HTML text in the **Description** box.
   a. **Important** Click the Help icon to check for supported HTML tags and attributes.
   b. The agenda and description appear on the Session Information page available for training session participants to view.
6. Click **Schedule** or **Update**.

Adding a picture to the Session Information page

You can add a picture to a training session description. The picture appears on the Session Information page, which attendees can view before the training session starts.
The picture that you add must be

- a graphics file that is in the GIF or JPEG format
- less than 100K in size

**Note:** Large images will be adjusted down to approximately 460 x 300 pixels.

**To add a picture to a training session description:**

1. On the Schedule Training Session page or Edit Scheduled Training Session page, scroll to **Session Information**.
2. Click **Import Picture**.
   
The Upload Your Picture page appears.
3. Click **Browse**.
4. Select the file that you want to add to your training session description.
5. Click **Import**.
   
   Training Manager imports your picture and adds it to the Session Information page for the training session.
6. Optional. To remove your picture from the Session Information page, click **Remove Picture**.
7. Click **Schedule** or **Update**.

**About Quick Start**

The Quick Start page allows the host, presenters, panelists, and attendees to quickly display a document, application or other item they want to share during a training session. The host can also remind or invite participants to a training session via email, phone, text message, or instant message.

If the Display Quick Start option is selected by the host in the Session Information section of the Schedule Training Session page, the Quick Start will appear for the host, presenters, panelists, and attendees when a training session or breakout session begins.
Chapter 4: Setting up and Scheduling a Training Session

Note: To allow the Quick Start to show to your attendees, you must select the Show QuickStart to Attendees check box in the Session Options section of the My Profile page in My WebEx.

Adding course material

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of publishing course material for your training session</td>
<td>About publishing course material for a scheduled training session (on page 103)</td>
</tr>
<tr>
<td>publish course material to the Session Information page</td>
<td>Publishing course material for a scheduled training session (on page 104)</td>
</tr>
</tbody>
</table>

About publishing course material for a scheduled training session

When scheduling a training session, you can publish files and course material on your Training Center Web site. This option lets participants download course material for review, preparation, testing, and so on before the session starts. To publish course material, you can either select files already in your personal folders in My Folders, or upload new files to My Folders first and then select them for publication on your site.

Once you publish course material, participants can download it from the Session Information page on your Training Center Web site. Once you approve participants' registrations, they receive a confirmation email message that contains a link to the Session Information page.

Any file that you publish that is in the Universal Communications Format (UCF), which has a .ucf extension, automatically opens in your content viewer once you start the session. If participants have downloaded a published UCF file before the session starts, it automatically opens in their content viewers as well once you start the session. Up to 10 published UCF files will automatically open in the content viewer.
Chapter 4: Setting up and Scheduling a Training Session

To download UCF files that you publish, participants must install software that automatically caches, or stores, the file on their computers. Once a participant accesses the Session Information page on which you have published a UCF file, a security warning message box appears, in which the participant must click Yes to install the caching software.

Without the software, a participant cannot download the UCF file, and it will not open automatically in the participant's content viewer once you start the session.

Tip: For more information about UCF files and how to create UCF multimedia presentations, refer to the guide Getting Started with WebEx Universal Communications Toolkit, which is available on your Training Center Web site.

Publishing course material for a scheduled training session

You can publish course material for participants to download before you start a session.

To publish course material on your Training Center site:

1. On the Schedule Training Session page or Edit Scheduled Training Session page, scroll to Course Material.
2. Click Add Course Material. The Add Course Material page appears.
3. Do the following:
   - To upload the course material files to My Folders, enter the file name or click Browse to locate the file. Click Upload.
   - To publish files already in My Folders, select the check box next to the name of the file or files that you want to publish, then click Add. The file or files appear on the Schedule Training Session page, under Course Material.
4. Optional. To remove a file, click Remove next to the file name.
5. Click Schedule or Update.
Tip:

You can customize the registration confirmation email message to instruct participants to download course material before the session starts. If you publish a UCF file, you can also instruct participants to click Yes when the Java security message appears on the Session Information page, which allows them to download the UCF file. For details about customizing a registration confirmation email message, see Customizing an email message (on page 98).

If you provide a description of a file in your personal folders, the description appears under the file name on the Session Information page. This description can help participants to identify the course material. You can provide a description when either initially storing the file in your personal folders, or at any time by editing the file’s description.

If you specify a password for your training session, participants must provide the password on the Session Information page to download the course material.

You can update or remove course material that you published at any time, by editing the scheduled training session. To remove a file, click Remove next to the file name. To update a file, remove it first, and then publish the updated file.

About the Add Course Material page

What you can do here

- Select files already in your personal folders in My Folders to publish to your Training Center Web site.
- Upload new files to My Folders and then publish them to your Training Center Web site.

Participants can download course material for review, preparation, or testing before the session starts.

Options on this page

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File name box</td>
<td>Enter the name of the file to upload to your folder.</td>
</tr>
</tbody>
</table>
## Chapter 4: Setting up and Scheduling a Training Session

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Browse button</td>
<td>Click to select a UCF presentation or document that resides in your personal folders.</td>
</tr>
<tr>
<td>Upload button</td>
<td>Click to upload the specified file to your folder.</td>
</tr>
<tr>
<td>Select</td>
<td>Select the check box of the file to be added to the training session.</td>
</tr>
<tr>
<td>Name</td>
<td>Indicates the names of the files residing in your folder.</td>
</tr>
<tr>
<td>Description</td>
<td>Describes the folder or file.</td>
</tr>
<tr>
<td>Size</td>
<td>Indicates the size of the folder or file in kilobytes.</td>
</tr>
<tr>
<td>Add button</td>
<td>Click to publish the specified file on your Training Session Web site, making it available to participants prior to the session start time.</td>
</tr>
</tbody>
</table>

### Using tests in training sessions

You can add tests to your training session during the scheduling process, or after it has been scheduled. For information on adding tests to an already scheduled training session, see *Testing and Grading* (on page 407).

### Adding a test while scheduling a training session

To test attendees, you must add tests to the training session that they will be attending.

**Note:** During the training session scheduling process, you can only add a test that you have already created and saved to the Test Library.

**Important:** During scheduling, if you selected the option to automatically delete the training session from your Training Center Web site after it ends, a message box will appear. If you do not turn off this option, you will lose all tests associated with this session.
Chapter 4: Setting up and Scheduling a Training Session

To add a test while scheduling a training session:

1. On the Schedule Training Session or Edit Scheduled Training Session page, scroll to **Tests**.
2. Click **Add Test**.
   The Select from Test Library page appears.
3. Select a test on which to base your new test, and then click **Next**.
4. Type a name for your new test, select test delivery options, and then click **Save**.
   For details, see *Specifying test delivery options for a scheduled training session* (on page 417).
5. Repeat these instructions to add multiple tests to your training session.
6. Click **Schedule** or **Update**.

Using the scheduling templates

When scheduling a training session, you can save scheduling option settings as a template for future use. Some scheduling information will vary from session to session, and therefore cannot be imported into a template. The following scheduling options are not passed on to the template:

- Date, time, and recurrence (except duration, time zone, and join-before-host options)
- Invited attendees and presenters lists (except estimated number of attendees and presenters)
- Registration data of registered attendees
- Hands-on lab information and reservation
- Course material and tests

When you choose a template, the scheduler's option fields are populated with the values for the chosen template. Each template can be updated or saved as a new template on your Training Center Web site.

To save scheduling options as a template:

1. On the Schedule Training Session page or Edit Scheduled Training Session page, enter data into the scheduling option fields or change settings.
2. Click **Save As Template**, located at the bottom of the page.
Chapter 4: Setting up and Scheduling a Training Session

The Save As Template window appears.

3 Fill in the Template name field, or change the name if modifying an existing template.

4 Click Save.

To select and use a template:

1 At the top of the Schedule Training Session page or Edit Scheduled Training Session page, select a template from the Set options using template drop-down list.

2 Enter data into the remaining scheduling option fields.

3 Click Schedule or Update.

To delete a template:

1 On the navigation bar, click My WebEx.

2 Click My Profile.

   The My WebEx Profile page appears.

3 Under Scheduling Templates, select the template.

4 Click Delete.

5 Click Update.

Allowing another host to schedule your training session

For users with an account only

You can set up the option for other hosts in your organization to schedule a training session for you. If another host schedules a training session in your name, you are the only host who can start the session.

To allow another user to schedule training sessions for you:

1 If you have not already done so, log in to your Training Center Web site.

2 On the navigation bar, click My WebEx.

3 Click My Profile.

   The My Profile page appears.
4 Under **Session Options**, do *either* or *both* of the following:
   - In the **Scheduling permission** box, type the email addresses of the users to whom you want to grant scheduling permission. Ensure that you separate multiple addresses with either a comma or semicolon.
   - Click **Select From Host List** to select users from a list of all users who have accounts on your Training Center Web site.

5 Click **Update**.

**Note:** A user to whom you grant permission to schedule training sessions must have an account on your Training Center Web site.

### Scheduling a training session for another host

If another host set up your name to schedule training sessions on behalf of him or her, you can schedule a training session for the host using the Schedule Training Session page.

If you schedule a training session for another host, only the other host will be able to start the training session. Both you and the other host can modify the training session on the Edit Session page.

**To schedule a training session for another host:**

1 Log in to your Training Center Web site.

2 On the navigation bar, expand **Host a Session** to view a list of links.

3 Click **Schedule Training**.
   The Schedule Training Session page appears.

4 Under **Session and Access Information**, in the drop-down list next to **Schedule for**, select the host’s name for whom you are scheduling the session.

5 Finish completing the Schedule Training Session page. For details, see *Setting up a scheduled training session* (on page 47).

6 If you have completed specifying options on the Schedule Training Session page or Edit Scheduled Training Session page, click **Schedule** or **Update**, respectively.
Adding a scheduled training session to your calendar program

Once you schedule a training session, you can add it to a calendar program, such as Microsoft Outlook or Lotus Notes, if the feature is enabled on your site. This option is applicable only if your calendar program supports the iCalendar standard, a common format for exchanging calendaring and scheduling information across the Internet.

For information on adding a Personal Conference session to your calendar, see Adding a scheduled Personal Conference training session to your calendar program (on page 113).

To add a scheduled training session to your calendar:

1. Choose either method:
   - On the Session Scheduled or Session Information page for the training session, click Add to My Calendar.
   - In the confirmation email message that you receive once you schedule or edit a training session, click the link to add the training session to your calendar.

2. In the File Download dialog box, click Open.

3. Select the option to accept the training session request. For example, in Outlook, click Accept to add the training session to your calendar.

Note:

If you cancel a training session, the Session Deleted page and the confirmation email message that you receive contains an option that lets you remove the training session from your calendar program, following similar steps that you used for adding the training session.

If you invite attendees to a training session, the invitation email message that they receive contains an option to add the training session to their calendar programs.
## Scheduling a MeetingPlace Personal Conference meeting

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Get an overview of MeetingPlace Personal Conference meetings</td>
<td>About MeetingPlace Personal Conference meetings (on page 112)</td>
</tr>
<tr>
<td>Set up a MeetingPlace Personal Conference meeting</td>
<td>Setting up a Personal Conference meeting or MeetingPlace Personal Conference meeting (on page 112)</td>
</tr>
<tr>
<td>Add a MeetingPlace Personal Conference meeting to your calendar</td>
<td>Adding a scheduled Personal Conference meeting or MeetingPlace Personal Conference meeting to your calendar program (on page 113)</td>
</tr>
<tr>
<td>Make changes to the MeetingPlace Personal Conference meeting you have scheduled</td>
<td>Editing a Personal Conference meeting or MeetingPlace Personal Conference meeting (on page 114)</td>
</tr>
<tr>
<td>Start your MeetingPlace Personal Conference meeting</td>
<td>Starting a MeetingPlace Personal Conference meeting (on page 116)</td>
</tr>
<tr>
<td>Cancel your MeetingPlace Personal Conference meeting</td>
<td>Canceling a Personal Conference Meeting or MeetingPlace Personal Conference meeting (on page 116)</td>
</tr>
</tbody>
</table>
About MeetingPlace Personal Conference meetings

A MeetingPlace Personal Conference meeting uses your Cisco Unified MeetingPlace audio conferencing account for the audio conference, and does not have an online portion for the meeting. MeetingPlace Personal Conference meetings are only available if your site supports Cisco Unified MeetingPlace audio conferencing and MeetingPlace Personal Conferencing.

Setting up a Personal Conference meeting or MeetingPlace Personal Conference meeting

To set up a Personal Conference meeting or MeetingPlace Personal Conference meeting:

1. Log in to your Training Center website.
2. On the left navigation bar, select Schedule a Training Session.
3. Select Advanced Scheduler.
   The Advanced Scheduler displays.
4. On the Required Information page, for Meeting type, select Personal Conference or MeetingPlace Personal Conference.
5. Enter the requested information.

Note: If you are scheduling a Personal Conference meeting, you do not need to specify a password. By default, the password is the attendee access code in your Personal Conference number account that is specified for this meeting. If you are scheduling a MeetingPlace Personal Conference, you do need to specify a password.

For an overview of this page and the information requested, select the Help button in the upper-right corner of the page.
6 Schedule your training session now, or add more details.
   - To schedule your training session with these details, select **Schedule Training Session**
   - To add more options, select **Next** or select another page in the scheduler. After you have added the details you need, select **Schedule Training Session**.

Adding a scheduled Personal Conference meeting or MeetingPlace Personal Conference meeting to your calendar program

Once you schedule a Personal Conference meeting or MeetingPlace Personal Conference meeting, you can add the Personal Conference meeting or MeetingPlace Personal Conference meeting to your calendar program, such as Microsoft Outlook. This option is applicable only if your calendar program supports the **iCalendar** standard, a common format for exchanging calendaring and scheduling information across the Internet.

**To add a scheduled Personal Conference meeting or MeetingPlace Personal Conference meeting to your calendar**

1 Choose either method:
   - On the Personal Conference Meeting Scheduled page or the Personal Conference Meeting Information page, select **Add to My Calendar**.
   - In the confirmation email message that you receive once you schedule or edit a Personal Conference meeting or MeetingPlace Personal Conference meeting, click the link to add the meeting to your calendar.
A meeting opens in your calendar program.

2 Select the option to accept the meeting request. For example, in Outlook, select **Accept** to add the Personal Conference training session item to your calendar.

**Note:**
- If you cancel a Personal Conference meeting or MeetingPlace Personal Conference meeting, the Personal Conference Meeting Deleted confirmation page and the confirmation email message that you receive contains an option that lets you remove the meeting from your calendar program.
- If you invite participants to a Personal Conference meeting or MeetingPlace Personal Conference meeting, the invitation email message that they receive also contains an option to add the meeting to their calendar programs.

### Editing a Personal Conference meeting or MeetingPlace Personal Conference meeting

Once you schedule a Personal Conference meeting or MeetingPlace Personal Conference meeting, you can make changes to it at any time before you start it—including its starting time, topic, agenda, attendee list, and so on.

If you update any information about the Personal Conference meeting or MeetingPlace Personal Conference meeting, including adding or removing attendees, you can choose to send attendees a new invitation email message containing the new details about the meeting. Attendees removed from the attendee list receive an email message letting them know that they are no longer asked to attend.

If you are logged in, you can edit the meeting details by clicking the link in the confirmation email message that you received after you scheduled the Personal Conference meeting or MeetingPlace Personal Conference meeting, or from your list of training sessions in My WebEx.

**To edit Personal Conference meeting or MeetingPlace Personal Conference meeting from the confirmation email message:**

1 Open your confirmation email message, and then click the link to view your Personal Conference meeting information.

The Personal Conference Meeting Information page appears.
2 Select Edit.

3 Make changes to the Personal Conference meeting details.
   For details about the information requested on any page, click the Help button in the upper-right corner of the page.

4 To save your changes to the meeting, select Save.
   If you invited attendees, a message appears, asking you whether you want to send an updated email invitation to attendees.

5 If a message box appears, click the appropriate update option, and then select OK.
   The Personal Conference Meeting Information page appears.
   You receive a confirmation email message that includes information about the changes that you made to the meeting.

6 Optional. If you added the meeting to your calendar program, such as Microsoft Outlook, on the Training Session Updated page, select Add to My Calendar.

To edit a Personal Conference meeting or MeetingPlace Personal Conference meeting from your list of training sessions on your Training Center Web site:

1 Log in to your Training Center website.

2 On the navigation bar, select My WebEx.
   The My Meetings page appears, showing a list of any training sessions that you have scheduled. Personal Conference training sessions have “Personal Conference” in the Type column.

3 In the list of training sessions, under Topic, click the topic for the training session or click the Display Info link.

4 Select Edit.

5 Make changes to the Personal Conference meeting details.
   For details about the options on each page, click the Help button in the upper-right corner of the page.

6 Select Save.
   If you invited attendees, a message appears, asking you whether you want to send an updated email invitation to attendees.

7 If a message box appears, click the appropriate update option, and then click OK.
   If you select Cancel in the message box, the Personal Conference meeting is not updated.
Optional. If you added the meeting to your calendar program, such as Microsoft Outlook, in the confirmation email message, click the Update My Calendar link.

Starting a MeetingPlace Personal Conference meeting

Personal Conference training sessions do not start automatically at scheduled times. You must start the audio portion of the Personal Conference first, and then you can start the online portion of the Personal Conference.

To start a MeetingPlace Personal Conference meeting:

Call the number listed in the confirmation email or on the Personal Conference Training Session Information page.

To access the MeetingPlace Personal Conference Meeting Information page:

1 Log in to your Training Center service site.

2 On the navigation bar, select My WebEx.
   The My Meetings page appears, showing a list of any training sessions that you have scheduled. Personal Conference meetings are listed as “Personal Conference” in the Type column.

3 In the list of training sessions, select the Topic or Display Info link for your Personal Conference training session.
   The Personal Conference Training Session Information page displays.

4 If necessary, select the More Info link to display all the information about the training session.

Under Audio conference, look for the valid phone number or numbers to call for your MeetingPlace Personal Conference training session, as well as other information you need to start the meeting. You may need to click the Show detailed dial-in information link.

Canceling a Personal Conference Meeting or MeetingPlace Personal Conference meeting

You can cancel any Personal Conference meeting or MeetingPlace Personal Conference meeting you have scheduled. Once you cancel a meeting, you can choose to send a cancellation email message to all attendees whom you invited to the meeting. The Personal Conference meeting is removed automatically from your list of training sessions in My WebEx.
Chapter 5: Scheduling a MeetingPlace Personal Conference meeting

If you are logged in, you can cancel a Personal Conference meeting or MeetingPlace Personal Conference meeting from the confirmation email message that you received after you scheduled the meeting or from your list of training sessions in My WebEx.

To cancel a Personal Conference meeting or MeetingPlace Personal Conference meeting from a confirmation email message:

1. Open your confirmation email message, and then click the link to view your Personal Conference meeting information.

   The Personal Conference Meeting Information page appears.

2. Select **Delete**.

   If you invited attendees, a message appears, asking you whether you want to send a cancellation email message to all attendees whom you invited to the training session.

3. In the message box, click **Yes** or **No**, as appropriate.

   If you click **Cancel** in the message box, the meeting is not canceled.

   The Personal Conference Meeting Deleted page appears.

4. Optional. If you added the Personal Conference meeting to your calendar program, such as Microsoft Outlook, on the Personal Conference Meeting Deleted page, click **Remove From My Calendar** to remove the meeting from your calendar.

To cancel a Personal Conference meeting or MeetingPlace Personal Conference meeting on your Training Center website:

1. Log in to your Training Center website.

2. On the navigation bar, select **My WebEx**.

   The My Meetings page appears, showing a list of any training sessions that you have scheduled. Personal Conference meetings are indicated by the words "Personal Conference" in the **Type** column.

3. In the list of training sessions, under **Topic**, click the topic for your Personal Conference meeting.

4. Select **Delete**.

   If you invited attendees, a message appears, asking you whether you want to send a cancellation email message to all attendees whom you invited to the Personal Conference meeting or MeetingPlace Personal Conference meeting.

5. In the message box, click **Yes** or **No**, as appropriate.
If you click Cancel in the message box, the meeting is not canceled.

You receive a cancellation confirmation email message.

Optional. If you added the Personal Conference meeting or MeetingPlace Personal Conference meeting to your calendar program, such as Microsoft Outlook, on the Personal Conference Meeting Deleted page, select Remove From My Calendar to remove the meeting from your calendar.

### About the Personal Conference Meeting Information page (host)

This page provides the details about the Personal Conference meeting or MeetingPlace Personal Conference meeting you have scheduled.

**What you can do on this page**

- Review the date, time, duration, and other helpful information about the Personal Conference training session.
- Click the More Info link to view the meeting number, audio conference information, and meeting password. This information can help you start the audio portion of the Personal Conference training session.
- Edit the details about the Personal Conference meeting or MeetingPlace Personal Conference meeting.
- Cancel the Personal Conference meeting or MeetingPlace Personal Conference meeting.
- Add the Personal Conference meeting or MeetingPlace Personal Conference meeting to your calendar, if you haven’t already done so.
- Start the online portion of the Personal Conference after the audio portion has started. (Does not apply to MeetingPlace Personal Conference meetings.)

<table>
<thead>
<tr>
<th>Select this button…</th>
<th>To…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit</td>
<td>Edit the details about the Personal Conference meeting or MeetingPlace Personal Conference meeting. For example, you can add attendees, change the Personal Conference number account for this training session, or change the date, time, and duration.</td>
</tr>
<tr>
<td>Delete</td>
<td>Cancel the meeting.</td>
</tr>
</tbody>
</table>
**Chapter 5: Scheduling a MeetingPlace Personal Conference meeting**

<table>
<thead>
<tr>
<th>Select this button…</th>
<th>To…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add to My Calendar</td>
<td>Add this Personal Conference meeting or MeetingPlace Personal Conference meeting to a calendar program, such as Microsoft Outlook. To use this feature, your calendar program must conform with the iCalendar standard, a format used widely across the Internet for exchanging calendar information.</td>
</tr>
<tr>
<td>Go Back</td>
<td>Return to the training session calendar.</td>
</tr>
<tr>
<td>Start</td>
<td>Start the online portion of the Personal Conference meeting. This button is only available after you have started the audio portion of the Personal Conference meeting. (Does not apply to MeetingPlace Personal Conference meetings.)</td>
</tr>
</tbody>
</table>

**About the Personal Conference Meeting Information page (for attendees)**

This page provides the details about Personal Conference meeting or MeetingPlace Personal Conference meeting.

**What you can do on this page**

- Review the date, time, duration, and other helpful information about the Personal Conference meeting or MeetingPlace Personal Conference meeting.

- Click the More Info link to see the meeting number, audio conference information, and meeting password. This information can help you join the audio portion of the Personal Conference training session or the MeetingPlace audio conference.

- Add the meeting to your calendar, if you haven’t already done so

- Join the online portion of the Personal Conference after the audio portion has started. (Does not apply to MeetingPlace Personal Conference meetings.)

**Options on this page**

<table>
<thead>
<tr>
<th>Click this button…</th>
<th>To…</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Agenda</td>
<td>View Personal Conference meeting or MeetingPlace Personal Conference meeting agenda, if the host has provided it.</td>
</tr>
</tbody>
</table>
### Chapter 5: Scheduling a MeetingPlace Personal Conference meeting

<table>
<thead>
<tr>
<th>Click this button...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add to My Calendar</td>
<td>Add Personal Conference meeting or MeetingPlace Personal Conference meeting to a calendar program, such as <em>Microsoft Outlook</em>. To use this feature, your calendar program must conform with the iCalendar standard, a format used widely across the Internet for exchanging calendar information.</td>
</tr>
<tr>
<td>Go Back</td>
<td>Return to the training session calendar.</td>
</tr>
<tr>
<td>Join</td>
<td>Once the audio portion of the Personal Conference meeting has started, you can select <strong>Join</strong> to join the online portion of the Personal Conference meeting. (Does not apply to MeetingPlace Personal Conference meetings.)</td>
</tr>
</tbody>
</table>
### Using SCORM

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of SCORM</td>
<td><strong>SCORM overview</strong> (on page 121)</td>
</tr>
<tr>
<td>view the SCORM page</td>
<td><strong>Viewing the SCORM page</strong> (on page 122)</td>
</tr>
<tr>
<td>edit the SCORM page</td>
<td><strong>Editing the SCORM page</strong> (on page 123)</td>
</tr>
</tbody>
</table>

### SCORM overview

SCORM (Sharable Courseware Object Reference Model) is a set of technical standards allowing Web-based learning systems to find, import, share, reuse, and export learning content in a standardized way. In SCORM pages, the learning management system (LMS) can track what needs to be delivered to the learner, when the learner achieves the skill or competency, and sends the learner to the appropriate level of content.

An Application Programming Interface (API) provides a standard way of communicating with the LMS using Web-friendly JavaScript. WebEx provides a SCORM page in which the host can specify which information is provided in the API.

You can read more about SCORM at the following Web sites:

- [www.adlnet.org](http://www.adlnet.org)
- [www.imsglobal.org](http://www.imsglobal.org)
- [www.rhassociates.com/scorm.htm](http://www.rhassociates.com/scorm.htm)
- [www.teleologic.net/SCORM/index.htm](http://www.teleologic.net/SCORM/index.htm)
- [www.altrc.org/specifications.asp](http://www.altrc.org/specifications.asp)
Viewing the SCORM page

To view SCORM data for a scheduled training session from your personal training calendar on your Training Center Web site, follow these steps:

1. Log in to your Training Center Web site.
2. On the navigation bar, click **My WebEx**.
   The My Meetings page appears, showing a list of any training sessions that you have scheduled.
3. In the list of training sessions, click the link for the training session that you want to view.
   The Session Information page appears.
4. Click a link next to **SCORM data**.
   The Edit SCORM Information page appears.

   ![Edit SCORM Information](image)

5. To download the file, click **Save and Download**. Follow the instructions in the File Download dialog box.
Editing the SCORM page

To edit SCORM data for a scheduled training session from your personal training calendar on your Training Center Web site, follow these steps:

1. Log in to your Training Center Web site.
2. On the navigation bar, click My WebEx.
   The My Meetings page appears, showing a list of any training sessions that you have scheduled.
3. In the list of training sessions, click the link for the training session that you want to view.
   The Session Information page appears.
4. Click a link next to SCORM data.
   The Edit SCORM Information page appears.
5. Make your changes in the text boxes, and select your options in the drop-down lists.
6. When you have finished editing, click Save to save your changes.
7. To download the file, click Save and Download. Follow the instructions in the File Download dialog box.
Setting Up a One-Click Meeting

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of starting a One-Click Meeting</td>
<td>About setting up a One-Click Meeting (on page 125)</td>
</tr>
<tr>
<td>specify settings for your One-Click Meeting</td>
<td>Setting up your One-Click Meeting on the Web (on page 126)</td>
</tr>
<tr>
<td>install WebEx One-Click, which includes the One-Click panel and One-Click shortcuts</td>
<td>Installing WebEx Productivity Tools (on page 130)</td>
</tr>
<tr>
<td>start a One-Click Meeting from your WebEx service Web site</td>
<td>Starting a One-Click Meeting (on page 132)</td>
</tr>
<tr>
<td>remove WebEx One-Click, including all One-Click shortcuts, from your computer</td>
<td>Removing WebEx Productivity Tools (on page 136)</td>
</tr>
</tbody>
</table>

About setting up a One-Click Meeting

WebEx One-Click allows you to start a meeting instantly from your desktop (desktop version) and from your WebEx service Web site (Web version). You can set up one or both versions, depending on your needs:

- **Web version**: allows you to start a One-Click Meeting from your WebEx service Web site. Doing so does not require you to download any application. For more information about the web version, refer to the *WebEx One-Click User’s Guide*, which is available on the Support page of your WebEx Service web site.
Chapter 7: Setting Up a One-Click Meeting

- **Desktop version:** if this feature and the Productivity Tools feature are enabled by your site administrator, allows you to start and join meetings and send meeting invitations without logging in to your WebEx service site or navigating Web pages. For more information about the desktop version, refer to the *WebEx One-Click User's Guide*.

### Setting up your One-Click Meeting on the Web

The One-Click Meeting Setup page allows you to specify options a One-Click Meeting. You can return to the One-Click Meeting Setup page at any time to modify your meeting.

The settings you specify apply to both the One-Click Web version and the desktop version.

**To set up your One-Click Meeting:**

1. Log in to your WebEx Service Web site.
2. Click **My WebEx > Productivity Tools Setup** (on the left navigation bar).
   - The Productivity Tools Setup page appears.
   - On this screen, you can also download WebEx Productivity Tools, which include the desktop version of One-Click and its shortcuts. For details, see *Installing WebEx Productivity Tools* (on page 130).
3. Click **Set Up Now**.
   - The One-Click Setup page appears.
4. Specify the meeting information and settings on the page.
   - For details about the options on the One-Click Settings page, see *About the One-Click Settings page* (on page 127).
5. Click **Save**.

**Tip:** Whenever you want to edit options for your One-Click Meeting, return to the One-Click Settings page by clicking **My WebEx > Productivity Tools Setup > Edit Settings**.
About the One-Click Settings page

How to access this page:
On your WebEx service Web site, do one of the following:

- If you are setting up your One-Click Meeting for the first time, on your WebEx service Web site, click **My WebEx > Productivity Tools Setup** (on the left navigation bar) > **Set Up Now**.
- If you already set up your One-Click Meeting, on your WebEx service Web site, click **My WebEx > Productivity Tools Setup** (on the left navigation bar) > **Edit Settings**.

What you can do here:
Set options for your One-Click Meeting

### Meeting Options

<table>
<thead>
<tr>
<th>Use this option…</th>
<th>To…</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Service type</strong></td>
<td>Select the type of WebEx session for which you want to start a One-Click Meeting. This option lists only the session types available for your site and user account.</td>
</tr>
</tbody>
</table>
| **Meeting template** | Select the meeting template you want to use to set options for your One-Click Meeting. The drop-down list of templates includes:  
  **Standard templates**: Templates that your site administrator set up for your account.  
  **My Templates**: Any personal templates that you created by saving the settings for a meeting you previously scheduled, using the scheduling options on your site. |
| **Topic** | Specify the topic for the meeting |
| **Meeting password** | Specify the password for the meeting. |
| **Confirm password** | Type the password again to prevent typing errors. |
| **Listed for all** | Specify that the training session appears for any users who visit the the Live Sessions page on your site. Available for training sessions only. |
Chapter 7: Setting Up a One-Click Meeting

<table>
<thead>
<tr>
<th>Listed for authorized users only</th>
<th>Specify that the training session appears on the Live Sessions page for only users who have user accounts and have logged in to your site. Available for training sessions only.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unlisted</td>
<td>Specify that the training session does not appear on the Live Sessions page on your site. An unlisted training session prevents anyone from viewing information about the session, such as its host, topic, and starting time; and helps to prevent unauthorized access to the session. To join an unlisted training session, an attendee must provide a unique session number. Available for training sessions only.</td>
</tr>
</tbody>
</table>

**Tracking Codes**

<table>
<thead>
<tr>
<th>Use this option...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tracking code</td>
<td>Identify your department, project, or other information that your organization wants to associate with your meetings. Tracking codes can be optional or required, depending on how your site administrator set them up. If your site administrator requires you to select a code from a predefined list, click the link <strong>Select Code</strong>, and then select a code from the list or enter one in the box above.</td>
</tr>
</tbody>
</table>

**Audio Conference**

*meetings, training sessions, and sales meetings only*

<table>
<thead>
<tr>
<th>Use this option...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use</td>
<td>Select the type of teleconference you would like to use:</td>
</tr>
</tbody>
</table>
### Use this option...  
<table>
<thead>
<tr>
<th>WebEx Audio:</th>
<th>Specifies that the meeting includes an integrated audio conference. If you select this option, select one of the following options:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Display toll-free number:</strong></td>
<td>Select if your site provides toll-free call-in audio conferencing, in which both a toll-free number and a toll number are available. If your participants dial a toll-free call-in number, your organization assumes the charges for the calls. Otherwise, participants assume the charges for their calls.</td>
</tr>
<tr>
<td><strong>Display global call-in numbers to attendees:</strong></td>
<td>Select if you want to provide a list of numbers—such as toll-free or local numbers—that attendees in other countries can call to join the audio conference.</td>
</tr>
</tbody>
</table>

**Note:** After you start the meeting, participants have a choice of joining by can choose to use their computer as their audio device, using VoIP, or to use their phone as their audio device.

**Tip:** A participant must have a direct phone line to receive a call from the teleconferencing service. However, a participant without a direct phone line can join an audio conference by calling a call-in telephone number, which is always available in the Meeting window.

### Personal Conference Number Account

Available only if your site has the Personal Conferencing feature turned on, and only for Meeting Center.

Select the Personal Conference number account that you want to use for your meeting. You can manage your Personal Conference number accounts on the My WebEx >Personal Conferencing page.

### Cisco Unified MeetingPlace Audio Conferencing

Available only if your site has Cisco Unified MeetingPlace Audio turned on.

If you select this option, choose the type of conference:

**Call-in teleconference:** Select if you want customers to dial a number to join

**Call-back teleconference:** Select if you want customers to type in a phone number and receive a call back from the conferencing service.

A participant must have a direct phone line to receive a call from the conferencing service. However, a participant...
Chapter 7: Setting Up a One-Click Meeting

### Use this option... To...

- **Without a direct phone line can join an audio conference by dialing a call-in number, which is always available in the meeting window.**

<table>
<thead>
<tr>
<th>Other teleconference service:</th>
<th>Specifies that the meeting includes a teleconference that another service provides, such as a third-party teleconferencing service or internal teleconferencing system, such as a PBX (private branch exchange). In the text box, type instructions for joining the teleconference.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Use VoIP Only</strong></td>
<td>Specify that the meeting includes only Integrated VoIP, which allows meeting participants to use computers with audio capability to communicate over the Internet rather than the telephone system.</td>
</tr>
<tr>
<td><strong>None</strong></td>
<td>Specify that the meeting does not include either an audio conference or Integrated VoIP.</td>
</tr>
</tbody>
</table>

### Installing WebEx Productivity Tools

If your site administrator has enabled you to download WebEx Productivity Tools, you can start or join meetings instantly using One-Click; start meetings instantly from other applications on your desktop, such as Microsoft Office, Web browsers, Microsoft Outlook, IBM Lotus Notes, and instant messengers; and schedule meetings using Microsoft Outlook or IBM Lotus Notes without going to your WebEx service site.

Before installing WebEx Productivity Tools, ensure that your computer meets the following minimum system requirements:

- Microsoft Windows 2000, XP, 2003, Vista
- Microsoft Internet Explorer 6.0 SP1 or 7.0, or Firefox 3.0 or later
- Intel x86 (Pentium 400MHZ +) or compatible processor
- JavaScript and cookies enabled in the browser

**To install WebEx Productivity Tools:**

1. Log in to your WebEx service Web site.
2 Click **My WebEx > Productivity Tools Setup** (on the left navigation bar).

   The Productivity Tools Setup page appears.

3 Click **Install Productivity Tools**.

   The File Download dialog box appears.

4 Save the installation program to your computer.

   The name of the installation file has an **.msi** extension.

5 Run the installation file and follow the instructions.

6 Once you complete installation, log in using your WebEx account information and then verify your WebEx settings for Productivity Tools, including One-Click, in the WebEx Settings dialog box.

   **Note:** System administrators can also perform a mass installation for computers at their site. For more information, see the IT Administrator Guide for Mass Deployment of WebEx Productivity Tools at [http://support.webex.com/US/PT/wx_pt_ag.pdf](http://support.webex.com/US/PT/wx_pt_ag.pdf).

After you have logged in, the WebEx One-Click panel and shortcuts appear. For instructions about using the One-Click panel and shortcuts, see the **WebEx One-Click User's Guide**.

The Help in the WebEx One-Click panel also provides detailed information about how to use the One-Click panel and shortcuts.
Tip: For instructions on using the WebEx One-Click panel and the One-Click taskbar menu, refer to the WebEx One-Click User's Guide, which is available on the Support page of your WebEx Service web site.

Starting a One-Click Meeting

Before you start a One-Click Meeting from your WebEx Service Web site, ensure that you set up One-Click settings. For details about setting up One-Click settings, see Setting up your One-Click Meeting on the Web (on page 126). For details

To start a One-Click Meeting from your WebEx service Web site:

1. Log in to your WebEx Service Web site.
2. Click My WebEx > Start One-Click Meeting.

Your meeting starts.

To start a One-Click Meeting using the WebEx One-Click panel:

1. Open your WebEx One-Click panel by doing any of the following:
   - Double-click the WebEx One-Click shortcut on your desktop.
   - Go to Start > Programs > WebEx > Productivity Tools > WebEx One-Click.
   - Right-click the WebEx One-Click icon on the taskbar of your desktop.
Chapter 7: Setting Up a One-Click Meeting

If you did not specify automatic login, enter the required WebEx account information in the dialog box, and then click Log In.

2 On the WebEx One-Click panel, click Start Meeting.

![WebEx One-Click Panel]

**Note:** For instructions on using the WebEx One-Click panel, refer to the WebEx One-Click User's Guide.

**To start a One-Click Meeting using a One-Click shortcut:**

Click one of the following shortcuts:
Chapter 7: Setting Up a One-Click Meeting

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Open One-Click</strong></td>
<td><strong>Right-click menu of taskbar icon shortcut:</strong> Right-click the WebEx One-Click taskbar icon and then click <strong>Start meeting now</strong> to start an instant meeting. Right-click the WebEx One-Click taskbar icon and then click <strong>Start a Scheduled Meeting</strong> to start a previously scheduled meeting, or click <strong>Start Personal Conference meeting</strong> to start a previously scheduled Personal Conference meeting. <strong>Note:</strong> You can also right-click the WebEx One-Click taskbar icon and then click <strong>Schedule a meeting</strong> to schedule a WebEx meeting using Microsoft Outlook or Lotus Notes. For more details, see the <strong>Integration to Outlook User's Guide</strong> and the <strong>Integration to Lotus Notes User's Guide</strong>, which are available on the Support page of your WebEx Service web site.</td>
</tr>
<tr>
<td>Start Meeting Now</td>
<td></td>
</tr>
<tr>
<td>Start Personal Conference Meeting</td>
<td></td>
</tr>
<tr>
<td>Start a Scheduled Meeting…</td>
<td></td>
</tr>
<tr>
<td>Schedule a Meeting…</td>
<td></td>
</tr>
<tr>
<td>Join a Meeting…</td>
<td></td>
</tr>
<tr>
<td>Connect to My Computers…</td>
<td></td>
</tr>
<tr>
<td>WebEx Settings…</td>
<td></td>
</tr>
<tr>
<td>Help</td>
<td><strong>F1</strong></td>
</tr>
<tr>
<td>About WebEx One-Click…</td>
<td></td>
</tr>
<tr>
<td>Exit</td>
<td></td>
</tr>
</tbody>
</table>

**Email and Scheduling shortcut:** Click **One-Click Meeting** in Microsoft Outlook or Lotus Notes to start a One-Click meeting. **Note:** You can also click **Schedule Meeting** in Microsoft Outlook or Lotus Notes to schedule a WebEx meeting using Outlook or Lotus Notes. For more details, see the **Integration to Outlook User's Guide** and the **Integration to Lotus Notes User's Guide**, which are available on the Support page of your WebEx Service web site.
Chapter 7: Setting Up a One-Click Meeting

### Shortcut

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Instant messenger shortcut:</strong> Click WebEx &gt; Start WebEx Meeting to start a One-Click meeting in your instant messenger, such as Skype, AOL Instant Messenger, Lotus SameTime, Windows Messenger, Google Talk, or Yahoo Messenger. For more details, see the Integration to Instant Messengers Guide, which is available on the Support page of your WebEx Service web site. Available for meetings, sales meetings, training sessions, and support sessions only.</td>
<td></td>
</tr>
<tr>
<td><strong>Web browser shortcut:</strong> Click this icon to start your meeting. <strong>Note</strong> If you previously customized your Internet Explorer toolbar, the shortcut button may not automatically appear on the toolbar. Instead, it is added to the list of available toolbar buttons in Internet Explorer. In this case, you must add the button to the toolbar, using the Internet Explorer Customize option. To access this option, on the View menu, point to Toolbars, and then choose Customize. Available for meetings, sales meetings, training sessions, and support sessions only.</td>
<td></td>
</tr>
<tr>
<td><strong>Microsoft Office shortcut:</strong> In Microsoft Word, Microsoft Excel, and Microsoft PowerPoint, select Share As Document or Share As Application. This command starts the meeting and automatically shares the application you are using, including all files that are already open in that application. You can still work in the application during the meeting. Available for meetings, sales meetings, training sessions, and support sessions only.</td>
<td></td>
</tr>
<tr>
<td><strong>Right-Click menu shortcut:</strong> Right-click the icon for an application or document file on your computer, and then point to Share in WebEx Meeting &gt; As Application. This command starts the meeting and automatically shares the application, including all files that are already open in that application. You can still work in the application during the meeting. Available for meetings, sales meetings, training sessions, and support sessions only.</td>
<td></td>
</tr>
</tbody>
</table>
Tip:

Once you start a One-Click Meeting, it appears on your Personal Meeting Room page, unless you specified it to be an unlisted meeting. If you provide others with the URL for this page, they can quickly join your meeting by clicking the link for the meeting on this page.

You can control which shortcuts are available in the WebEx Settings dialog box.

For instructions on using the WebEx One-Click shortcuts, refer to the WebEx One-Click User’s Guide.

Removing WebEx Productivity Tools

You can uninstall WebEx Productivity Tools at any time. Uninstalling Productivity Tools removes all Productivity Tools, including the WebEx One-Click panel and One-Click shortcuts, from your computer.

To uninstall WebEx Productivity Tools:

1. Click Start > Programs > WebEx > Productivity Tools > Uninstall
2. Click Yes to confirm that you want to uninstall WebEx Productivity Tools.

To uninstall WebEx Productivity Tools from the Control Panel:

1. Click Start > Settings > Control Panel.
2. Double-click Add/Remove Programs.
3. Click WebEx Productivity Tools.
4. Click Remove.
5. Click Yes to confirm that you want to uninstall WebEx Productivity Tools.

Note: Uninstalling Productivity Tools removes all Productivity Tools and shortcuts from your computer. If you want to keep using some Productivity Tools but disable others, edit the options in the WebEx Settings dialog box.
Starting an instant training session

If your Training Center Web site includes the instant training session option, you can start a training session at any time, without the need to schedule it first. An instant, or impromptu, training session can include an audio conference.

Once you start an instant training session, you can optionally invite attendees. Each invited attendee receives an invitation email message that includes information about the training session and a link that the attendee can click to join the training session.
To start an instant training session:

1. Log in to your Training Center Web site.
2. On the left navigation bar, expand Host a Session to view a list of links.
3. Click Instant Session.

   The Start an Instant Training Session page appears.
4. Type the training session's topic in the Topic box.
5. Type a password for the training session in the Set Session Password and Confirm password boxes. A valid password should contain at least 6 characters.
   Attendees must provide this password to join the training session.
6. Optional. If you do not want the training session to be included in the list of sessions on the training session calendar, select Unlisted training session. For details, see Specifying whether a training session is listed or unlisted (on page 53).
7. Optional. To include an integrated audio conference, select the Audio Conference check box.
8. Click Start Session.

   If you did not select an audio conference, the Session window appears.
9. If you selected an audio conference, select the type of conference that you would like on the Audio Conference Settings page that appears. See Specifying audio conferencing options (on page 58) for details.
10. Click OK.
11. If you haven't already set up Training Center on your computer, the Set Up Training Center page appears. Click Set Up.
12. If your Training Center requires that you provide tracking information for the training sessions that you host, do one of the following for each option on the Tracking Codes page that appears:
   - Type a code or other text in the box.
   - If your site administrator requires you to select a code from a predefined list, you cannot type text in the box.
   - If a predefined list of codes is available, click the code's label, then, in the list that appears, select a code. Click OK.

   The Session window appears, and the Audio Conference dialog box appears.
13. Follow the instructions in the dialog box to start the audio conference.
Optional. After starting the session, invite attendees to the training session by sending them invitation email messages that include instructions for joining the training session.

**Note:** To receive a call back, an attendee must have a direct phone line. If a receptionist answers the call, or the attendee’s phone system uses a recorded greeting for incoming calls, the attendee cannot receive a call back. However, an attendee without a direct phone line can join an audio conference by calling a call-in telephone number, which is always available in the Session window, on both the Info tab and in the Session Information dialog box.

If you set up an Integrated VoIP conference, the presenter must start the conference after you start the training session.

### Starting a scheduled training session

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>See…</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of starting a scheduled training session</td>
<td><a href="#"><em>About starting a scheduled training session</em></a> (on page 139)</td>
</tr>
<tr>
<td>start a scheduled training session from a confirmation email message</td>
<td><a href="#"><em>Starting a scheduled training session from a confirmation email message</em></a> (on page 140)</td>
</tr>
<tr>
<td>start a scheduled training session from your training sessions page</td>
<td><a href="#"><em>Starting a scheduled training session from your training sessions page</em></a> (on page 140)</td>
</tr>
</tbody>
</table>

### About starting a scheduled training session

Training Sessions do not start automatically at scheduled times. As the training session host, you must first start a training session, then attendees can join the session. You can start a training session that you scheduled at its starting time, or any time before or after that time.

Once you schedule a training session, you receive a confirmation email message that includes a link that you can click to start the session. Or, you can start the training session from your personal sessions page on your Training Center Web site.
Starting a scheduled training session from a confirmation email message

You can start your training session from the confirmation email message that you receive after you schedule your session.

To start a training session from the confirmation email message:

1. Open your confirmation email message, and then click the link.
   If you are not already logged in to your Training Center Web site, the Log In page appears.

2. If the Log In page appears, provide your account username and password, then click Log In.
   The Session Information page appears.

3. Click Start Now.
   The Session window appears.
   If the training session includes an audio conference, the Audio Conference dialog box appears. Follow the instructions in the dialog box to start the audio conference.

Starting a scheduled training session from your training sessions page

You can start your training session from your training sessions page on your Training Center Web site.

To start a training session from your training sessions page:

1. Log in to your Training Center Web site.

2. On the navigation bar, click My WebEx.

3. Click My Meetings.
   The My WebEx Meetings page appears.

4. Use the Daily, Weekly, Monthly, or All Meetings tab to find the training session that you would like to start.

5. Click Start.
The Session window appears.

If the training session includes an audio conference, the Audio Conference dialog box appears. Follow the instructions in the dialog box to start the audio conference.

### Modifying a scheduled training session

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>See…</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview about modifying a scheduled training session</td>
<td>About modifying a scheduled training session (on page 141)</td>
</tr>
<tr>
<td>modify a scheduled training session from a confirmation email message.</td>
<td>Modifying a scheduled training session from a confirmation email message (on page 141)</td>
</tr>
<tr>
<td>modify a scheduled training session from your training sessions page in My WebEx.</td>
<td>Modifying a scheduled training session from your training sessions page (on page 142)</td>
</tr>
</tbody>
</table>

### About modifying a scheduled training session

Once you schedule a training session, you can modify it at any time before you start it—including its starting time, topic, password, agenda, and so on.

If you update any information about a training session, including adding or removing attendees, you can choose to send attendees a new invitation email message that informs them that you have modified information about the training session. Attendees whom you removed from the attendee list receive an email message informing them that the training session was canceled.

You can modify a training session from the confirmation email message that you received after you scheduled the session, or from your personal sessions page on your Training Center Web site.

### Modifying a scheduled training session from a confirmation email message

You can modify a training session from the confirmation email message that you received after scheduling a training session.
To modify a training session from the confirmation email message:
1. Open your confirmation email message, and then click the link.
   If you are not already logged in to your Training Center Web site, the Log In page appears.
2. If the Log In page appears, provide your account username and password, and then click Log In.
   The Session Information page appears.
3. Click Edit.
4. Modify the training session. For more information about the options that you can modify, see Starting a scheduled training session (on page 139).
5. To save your changes to the training session, click Update.
   If you invited attendees, a message appears, asking you whether you want to send an updated email invitation to attendees.
6. In the message box, click the appropriate update option, and then click OK.
   You receive a confirmation email message that includes information about the changes that you made to the training session.

Modifying a scheduled training session from your training sessions page
You can modify a scheduled training session from your list of sessions on your Training Center Web site.
1. Log in to your Training Center Web site.
2. On the navigation bar, click My WebEx.
3. Click My Meetings.
   The My WebEx Meetings page appears.
4. Use the Daily, Weekly, Monthly, or All Meetings tab to find the training session that you would like to modify.
5. In the list of training sessions, under Topic, click the topic name for your training session.
   The Session Information page appears.
6. Click Edit.
Modify the training session. For more information about the options that you can modify, see *Starting a scheduled training session* (on page 139).

Click Update.

If you invited attendees, a message appears, asking you whether you want to send an updated email invitation to attendees.

In the message box, click the appropriate update option, and then click OK.

If you click Cancel in the message box, the training session is not updated.

You will receive a confirmation email message.

### Canceling a scheduled training session

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>See…</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview about canceling a scheduled training session</td>
<td><em>About canceling a scheduled training session</em> (on page 143)</td>
</tr>
<tr>
<td>cancel a scheduled training session from a confirmation email message.</td>
<td><em>Canceling a scheduled training session from a confirmation email message</em> (on page 144)</td>
</tr>
<tr>
<td>cancel a scheduled training session from your training sessions page in My WebEx.</td>
<td><em>Canceling a scheduled training session from your training sessions page</em> (on page 144)</td>
</tr>
</tbody>
</table>

### About canceling a scheduled training session

You can cancel any training session that you have scheduled. Once you cancel a training session, you can choose to send a cancellation email message to all attendees whom you invited to the training session. Canceling a training session deletes it from your list of training sessions.

You can cancel a training session from the confirmation email message that you received after you scheduled the training session or from your list of training sessions in My WebEx.
Canceling a scheduled training session from a confirmation email message

To cancel a training session from a confirmation email message:

1. Open your email confirmation message, and then click the link.
   If you are not already logged in to your Training Center Web site, the Log In page appears.

2. If the Log In page appears, provide your account username and password, and then click Log In.
   The Session Information page appears.

3. Click Delete, and then click OK to confirm that you want to cancel the training session.
   If you invited attendees, a message appears, asking you whether you want to send a cancellation email message to all attendees whom you invited to the training session.

4. In the message box, make the appropriate selection and then click OK.
   If you click Cancel in the message box, the training session is not canceled.
   You will receive a cancellation confirmation email message.

5. On the Session Deleted page, click OK.

Note: If the iCalendar feature is available on your site, and you have added this training session to your calendar, click Remove From My Calendar to remove it. There is also a link available in the email confirmation message.

Canceling a scheduled training session from your training sessions page

To cancel a scheduled training session from your training sessions page on your Training Center Web site:

1. Log in to your Training Center Web site.
2 On the navigation bar, click **My WebEx**.
3 Click **My Meetings**.
   The My WebEx Meetings page appears.
4 Use the Daily, Weekly, Monthly, or All Meetings tab to find the training session that you would like to cancel.
5 In the list of training sessions, select the check box for the training session you wish to delete.
6 Click **Delete**, and then click **OK** to confirm that you want to cancel the training session.
   If you invited attendees, a message appears, asking you whether you want to send a cancellation email message to all attendees whom you invited to the training session.
7 In the message box, click **Yes** or **No**, as appropriate.
   If you click **Cancel** in the message box, the training session is not canceled.
   You receive a cancellation confirmation email message.

**Note:** If the iCalendar feature is available on your site, and you have added this training session to your calendar, click **Remove From My Calendar** to remove it. There is also a link available in the email confirmation message.
Understanding the Session Window

The Session window displays the content viewer on the left side, where you share documents, applications, desktops, and other items with attendees. The right side of the Session window contains panels, which you can display or hide as you need them.

This chapter gives you a quick overview of the Session window and the elements that compose it.

<table>
<thead>
<tr>
<th>If you want to ...</th>
<th>See ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>learn about the Session window and the tools for sharing information</td>
<td>A quick tour of the Session window (on page 147)</td>
</tr>
<tr>
<td>learn how to manipulate the panels</td>
<td>Working with the panels (on page 151)</td>
</tr>
<tr>
<td>access panels while you are in full-screen view</td>
<td>Accessing panels in full-screen view (on page 160)</td>
</tr>
<tr>
<td>learn about alerts for panels you have minimized or collapsed</td>
<td>Understanding panel alerts (on page 163)</td>
</tr>
</tbody>
</table>

A quick tour of the Session window

The Session window provides the online environment where training session participants interact.
In the Session window, you can share documents, presentations, desktops, and Web content, send chat messages, coordinate polls, and perform other training session management tasks.

<table>
<thead>
<tr>
<th>If you want to ...</th>
<th>See ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of the Session window</td>
<td>Your first look at the Session window (on page 148)</td>
</tr>
<tr>
<td>learn about the tools available in the content viewer</td>
<td>Tools for sharing</td>
</tr>
<tr>
<td>learn about the view tools</td>
<td>Changing views of shared content</td>
</tr>
<tr>
<td>learn about the annotation tools</td>
<td>Using annotation tools on shared content (on page 224)</td>
</tr>
</tbody>
</table>

Your first look at the Session window

The following figure shows the basic components of the Session window:

- Sharing icons in the upper left corner provide easy access to the presentations, documents, applications, desktops, or whiteboards that you want to share.

- Documents and whiteboards you have opened appear as viewer tabs at the top of the Session window. To rename or change the order of these tabs, see Renaming the tab for a presentation, document, or whiteboard or Reordering the tabs for documents, presentations, and whiteboards.

- You manipulate panels using a mouse click to open, close, and minimize them.
Chapter 9: Understanding the Session Window

1. Click for audio conference options
2. Click to invite more participants or remind invitees
3. Click to share your desktop
4. Click to see more sharing options
5. Click to record your session
6. View or interact with participants
7. Click to end your session

Note: For Mac users, the Session window appears as shown below. Although
there are slight differences from the images and descriptions included in this section, the functionality remains the same.

The following table describes what you can do with each menu.

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td>Provides commands for saving, opening, printing, or transferring files during a training session; and ending or leaving a training session.</td>
</tr>
<tr>
<td>Edit</td>
<td>Provides commands for editing shared content in the content viewer.</td>
</tr>
</tbody>
</table>
Chapter 9: Understanding the Session Window

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Share</td>
<td>Provides commands for sharing documents, presentations, applications, Web browsers, desktops, multimedia Web content, and whiteboards.</td>
</tr>
<tr>
<td>View</td>
<td>Provides commands for displaying information in the content viewer on a host's, presenter's, or attendee's screen.</td>
</tr>
<tr>
<td>Audio</td>
<td>Provides commands for setting up an audio conference.</td>
</tr>
<tr>
<td>Participant</td>
<td>Provides commands pertaining to participants, such as inviting a participant to a training session, assigning roles and privileges, controlling participants' audio, and so on.</td>
</tr>
<tr>
<td>Session</td>
<td>Provides commands pertaining to the training session, such as viewing training session information, restricting access to the training session, and recording the training session.</td>
</tr>
<tr>
<td>Breakout</td>
<td>Provides commands pertaining to breakout sessions, such as starting a breakout session and controlling breakout sessions.</td>
</tr>
<tr>
<td>Help</td>
<td>Provides information about the Training Center service.</td>
</tr>
</tbody>
</table>

The content viewer displays one or more documents, presentations, applications, and whiteboards that you share during a training session. Tabs at the top of the viewer allow you to switch among multiple shared documents, presentations, and whiteboards.

Working with the panels

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of the panels</td>
<td>Panels overview (on page 152)</td>
</tr>
<tr>
<td>minimize and restore panels</td>
<td>Minimizing and restoring panels (on page 153)</td>
</tr>
</tbody>
</table>
If you want to… | See…
---|---
expand or collapse panels | Expanding and collapsing panels (on page 155)
open, close, or rearrange panels | Managing panels (on page 156)
restore the panels | Restoring the panel layout (on page 157)
resize the content viewer and panels areas | Resizing the content viewer and panels areas (on page 157)
access the panel options | Accessing panel options (on page 158)

Panels overview

The panels on the right side of the Session window are very flexible. You can open, expand, or close them quickly and easily. You can also minimize all the open panels to icons, providing greater space for sharing documents, applications, and other items with training session participants.

Your service selects which panels display initially.

In this example, note the following:
- the Recorder, Q&A, and Polling panels are minimized
- the Participants and Chat panels are open
- the Breakout Sessions panel is collapsed
Use the arrow icon on the left side of the panel title bar to collapse or expand a panel.

**Minimizing and restoring panels**

Minimizing and restoring panels has no effect on other participants’ displays.

**Note:** If you use the *Restore Panels* command after you have minimized panels using the *Minimize all* command, those panels also display for the other participants.
To minimize a panel:
Click the Close icon on the title bar of the panel you want to minimize.

The panel no longer displays. It appears as an icon on the icon tray at the top of the panels.

To restore a minimized panel:
Click its icon on the icon tray.

To minimize all panels:
1. On the icon tray, click the drop-down arrow.
2. On the drop-down menu, choose Hide Panels.

The open panels shrink to icons on the icon tray.
To restore all minimized panels:

The **Restore Layout** command quickly restores all panels you have minimized using the **Hide Panels** command.

1. On the icon tray, click the drop-down arrow.
2. On the drop-down menu, choose **Restore Layout**.

Minimized panels now display.

**Note:** For Mac users, minimizing and restoring panels are controlled from the icon tray located below the panels. Click an icon to make a panel appear or disappear. You can also restore or manage panels from this area.

Expanding and collapsing panels

Expanding and collapsing panels has no effect on other participants’ displays.

**To collapse a panel:**

Click the icon in the upper left corner of a panel to collapse it.

The panel collapses, leaving only the title bar visible.
To expand a panel:
If a panel is collapsed (you only can see its title bar), click the icon in the left corner of the title bar to expand it.

Managing panels
You can determine which panels are displayed in the training session window, and in which order they will be displayed:

To manage the display of panels:
1. Click this button.

   for Windows

   for the Mac

2. Choose Manage Panels from the menu.

   Use the Add or Remove buttons to specify which panels should display in your training session window.

   Use the Move Up or Move Down buttons to specify the order of the panel display.

   Click the Reset button to restore the panel view to the default layout.

   Clear the check box beside Allow participants to change the sequence of panels if you want to permit attendees to manage their own display of panels.
Chapter 9: Understanding the Session Window

Restoring the panel layout

If you have closed, minimized, or expanded or collapsed panels, you can restore the display to the layout

- you specified in the Manage Panels dialog box.
- that existed when you first joined the training session (if you did not specify a layout via the Manage Panels dialog box)

To restore the panel layout:
1. Click this button.
   ![for Windows](image)
   ![for the Mac](image)
2. Choose Restore Layout.

Resizing the content viewer and panels area

When you are sharing a document or presentation, you can control the size of the content viewer by making the panel area narrower or wider.

**Note:** This feature is unavailable when you are sharing your desktop, an application, or a Web browser.

To change the size of the content viewer and panels:
Click the dividing line between the content viewer and the panels.

- Drag the line to the left to make the area devoted to the panels wider.
- Drag the line to the right to make the content viewer larger.
For details about hiding, minimizing, and closing the panels, see Accessing panels in full-screen view.

**Accessing panel options**

You can access the options related to any panel by right-clicking its title bar to see a menu of commands. Each panel title bar includes common commands to control the panel, but the following panels have additional options.

**Note:** For Mac users, select the ctrl key and then click a panel's title bar to view its options.

<table>
<thead>
<tr>
<th>Panel</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Participants</td>
<td><strong>Sound Alerts:</strong> Lets you choose a sound to play when a participant:</td>
</tr>
<tr>
<td></td>
<td>Joins a training session</td>
</tr>
<tr>
<td></td>
<td>Leaves a training session</td>
</tr>
<tr>
<td></td>
<td>Selects the Raise Hand button</td>
</tr>
<tr>
<td>Chat</td>
<td><strong>Sound Alerts:</strong> Lets you choose the kinds of chat messages for which you want a sound to play. Select a sound from the drop-down list or click <strong>Browse</strong> to find a sound in a different location on your computer.</td>
</tr>
</tbody>
</table>
Chapter 9: Understanding the Session Window

### Panel | Options
---|---
Q&A | **Attendee Options**: Available for only the training session host. Displays the Attendee Options dialog box, from which you can determine what the attendees see during a Q&A session.
All | **Manage Panels**: Opens the Manage Panels dialog box, where you can determine which panels are displayed in the training session window. More (on page 156)

### Right-clicking the participant's name
You can control some of the actions of an attendee directly from the Participants list. Right-click a participant's name to see a menu of commands related to the participant.

**Note**: For Mac users, select ctrl and then click the participant's name.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Role To</td>
<td>Select to change the participant's role to Presenter, Panelist, Attendee, or Host. Options that are not available for a participant will not be selectable.</td>
</tr>
</tbody>
</table>
### Accessing panels in full-screen view

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>See…</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of how to access panels while you are in full-screen view</td>
<td>Overview of Session Controls Panel (on page 160)</td>
</tr>
<tr>
<td>share documents or software while you are in full-screen view</td>
<td>Sharing documents or software while in full-screen view (on page 161)</td>
</tr>
<tr>
<td>resize the displays for attendees to match yours</td>
<td>Synchronizing attendee displays (on page 162)</td>
</tr>
</tbody>
</table>

### Overview of Session Controls Panel

While you are viewing or remotely controlling a shared application, desktop, or Web browser, or viewing a shared remote computer, the presenter can switch between a standard window and full-screen view.

In full-screen view, you can access the panels from the Session Controls Panel located at the top of your screen.
Sharing documents or software while in full-screen view

In full-screen view, you have access to sharing and viewing options from the Session Controls Panel.

Sharing a document in full-screen view

To display a document:

1. On the Session Controls Panel, click the Select Content to Share icon.

2. Select Share File (Including Video).

If the document that you wish to share is already open, it will be available in the list for you to select. If not, select Share File (Including Video).
3 Select the file that you want to share and click **Open**.

**Sharing an application in full-screen view**

**To share an application:**

1 On the Session Controls Panel, click the **Select Content to Share** icon.

2 Select **Share Application**.

3 Select the application you want to share or select **Share a New Application** to open an application not already running on your desktop.

**Sharing your desktop in full-screen view**

In full-screen view, you can share your desktop if you have not already done so.

**To share your desktop while you are in full-screen view:**

1 On the Session Controls Panel, click the **Select Content to Share** icon.

2 Select **Share Desktop**.

**Synchronizing attendee displays**

**To resize the display of participants to match your display:**

1 Click this button on the Event Controls Panel.
2 On the menu, choose View > Synchronize for All. All attendee displays now match your display.

Understanding panel alerts

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>See…</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of panel alerts</td>
<td>Overview of panel alerts (on page 163)</td>
</tr>
<tr>
<td>learn about alerts for collapsed panels</td>
<td>Alerts for collapsed panels (on page 164)</td>
</tr>
<tr>
<td>learn about alerts for minimized panels</td>
<td>Alerts for minimized panels (on page 163)</td>
</tr>
</tbody>
</table>

Overview of panel alerts

If you have minimized or collapsed the Chat, Q & A, or Polling, or Participants panels, and any of those panels requires your attention, you see an orange alert on that panel.

Here are the reasons for seeing alerts:

- A participant arrives or leaves a training session
- A Raise Hand indicator appears in your Participants list.
- An attendee sends a chat message.
- An attendee sends a question.
- A poll opens or closes
- Poll answers are received

Alerts for minimized panels

If you have minimized a panel, the icon representing that panel blinks for a few seconds and changes color to alert you to a change.
Alerts for collapsed panels

If you have collapsed a panel, the **Expand/Collapse** icon blinks for a few seconds and changes color to get your attention to a change.
Windows operating system participants who have special needs, or who are power users, can navigate around the Session window using keyboard shortcuts. Some of these shortcuts are standard in the Windows environment.

<table>
<thead>
<tr>
<th>Press</th>
<th>to</th>
</tr>
</thead>
<tbody>
<tr>
<td>F6</td>
<td><strong>Switch between Session window areas</strong> (on page 166)</td>
</tr>
<tr>
<td>Ctrl+Tab</td>
<td><strong>Switch between open documents</strong> (on page 166) in the content area</td>
</tr>
<tr>
<td></td>
<td><strong>Navigate within the panels area</strong> (on page 167)</td>
</tr>
<tr>
<td></td>
<td><strong>Switch between tabs in the Invite and Remind dialog box and the Preferences dialog box</strong> (on page 169)</td>
</tr>
<tr>
<td>Shift+F10</td>
<td><strong>Use right-click menus</strong> (on page 168)</td>
</tr>
<tr>
<td></td>
<td><strong>Work with the participant list</strong> (on page 169)</td>
</tr>
<tr>
<td></td>
<td><strong>Copy text from the Chat panel</strong> (on page 174)</td>
</tr>
<tr>
<td>Tab</td>
<td><strong>Switch between elements</strong> (on page 170), such as buttons, fields, and check boxes within a dialog or panel</td>
</tr>
<tr>
<td>Arrow keys</td>
<td><strong>Switch between options in dialog boxes</strong> (on page 172)</td>
</tr>
<tr>
<td>Alt+F4</td>
<td><strong>Close any dialog box</strong> (on page 175)</td>
</tr>
<tr>
<td>Spacebar</td>
<td><strong>Check or uncheck an option box</strong> (on page 173)</td>
</tr>
<tr>
<td></td>
<td><strong>Enter text in an input box</strong> (on page 175)</td>
</tr>
<tr>
<td>Enter</td>
<td><strong>Carry out the command for the active button</strong> (on page 176) (usually replaces a mouse click)</td>
</tr>
</tbody>
</table>
Chapter 10: Accessing the Session window using the keyboard

<table>
<thead>
<tr>
<th>Press</th>
<th>to</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+A</td>
<td>Copy text from the Chat panel (on page 174)</td>
</tr>
<tr>
<td>Ctrl+Alt+Shift</td>
<td>Show the Session Controls Panel (on page 177) in full-screen mode</td>
</tr>
<tr>
<td>Ctrl+Alt+Shift+H</td>
<td>Hiding the Training Session controls, panels, and notifications</td>
</tr>
</tbody>
</table>

Navigating between Session window areas

Select **F6** to switch between the content area and the panels area.

Navigating between open documents

Select **Ctrl+Tab** to switch between open documents in the content area of the Session window.
Navigating the panels area

The panels area contains:

- the panel icon tray from which you can select panels to open or close
- any panels that are currently open
Chapter 10: Accessing the Session window using the keyboard

Select **Ctrl+Tab** to switch between the panels icon tray and any open panels.

To navigate within the panels icon tray:

- Select **Tab** to navigate from one icon to the next.
- Using the **spacebar** and **Enter** keys open and close a panel.
- When focused on the drop-down menu arrow, use the **spacebar** or **down arrow** keys to open the drop-down menu.
- Select **Esc** to dismiss the drop-down list.

**Using right-click menus**

Currently you can use the shortcut keys **Shift+F10** to open the right-click menu in the following panels and elements:

- Participant panel
- Chat panel
- Notes panel
Chapter 10: Accessing the Session window using the keyboard

- Closed Captions panel
- File Transfer window
- Shared whiteboard and file tabs

Working with the participant list

The participant panel provides a right-click menu that allows you to act upon a participant depending on your role in the meeting.

- If you are the host or presenter, you can perform actions such as making someone else the presenter; or muting another participant's microphone if it is too noisy.
- If you are not the host or presenter, you can perform actions such as asking to become the presenter or muting your own microphone.

Use the up and down arrow keys to navigate between participants.

Select Shift+F10 to open the right-click menu on a specific participant.

Switching between tabs in dialog boxes

Currently you can use the shortcut keys Ctrl+Tab to switch between tabs in the following dialog boxes:

- Invite and Remind
- Preferences
- Meeting Options
Participant Privileges

Note: You can also use Ctrl+Tab to navigate between open documents (on page 166) in file sharing and navigate between panels (on page 167) in the meeting window.

Switching between elements in dialog boxes or panels

When you open a dialog box or a panel, you can switch between the elements using the Tab key. Each dialog box or panel will have an initial focus area from which you can begin navigating.

For example, if you open the Audio Conference dialog box, here is how the Tab key guides you through the elements:

- The first time the Audio Conference dialog box opens, the initial focus is on Use Phone.
- Continually selecting Tab moves the focus through the elements, and eventually back to Use Phone.

When the focus is on an element that can be expanded, or a drop-down box, select Enter to expand and view the information.
If you have expanded a drop-down box, use the down arrow key to move the focus through the drop-down list of options.

Select Esc to dismiss the drop-down list.

**Tab order**

For dialog boxes with multiple sections, use Tab key to navigate through the options. The order of navigation is through one section at a time, going from top-to-bottom and then left-to-right.

**Note:** If you focus on a button, and then want to click it, simply select Enter.
Switching between options in dialog boxes

When you open a dialog box or a panel, you can switch between options using the Arrow keys. Each dialog box or panel will have an initial focus area from which you can begin navigating.

Here are some examples.

Use the **Up** and **Down Arrows** to move between the options.

Within an option, use the **Tab** key.

Use the **Up** and **Down Arrows** to navigate file types when sharing web content.
Chapter 10: Accessing the Session window using the keyboard

Use the Left and Right Arrows to adjust volume when using your computer for audio.

Note: If you focus on a button, and then want to click it, simply select Enter.

Checking and unchecking option boxes

Use the spacebar to check and uncheck option boxes.

In the following example, the option Remember phone numbers on this computer is checked.
if you don't want this option checked:

Navigate to the check box using the Tab and down arrow keys as required.

Select the **spacebar** to uncheck the box.

---

**Copying text from the Chat panel**

The Chat panel provides a right-click menu that allows you to copy text from the Chat history area.

With the focus on the Chat history area, select **Shift+F10** to open the right-click menu. Use this function to copy text or to select all text. Alternatively, you can use **Ctrl+A** to select all the chat text.

To select only a portion of the text, move your cursor with the arrow keys and then use **Shift-[Arrow]** to highlight text.
Entering text in an input box

Want to enter text in an input box? Here is how you would answer questions in a poll.

Navigate between questions using the Tab key.

Move between answers using the Up and Down Arrow keys.

Move the cursor to focus on the text input area and use the Spacebar or Enter key so you can type your answer. Click Enter or Esc to finish editing.
Closing dialog boxes

Select Alt+F4 to close a dialog box.

Activating an option or button

When the focus is on an active option or button, select Enter to activate it.
Accessing the Session Controls Panel during sharing

During sharing the Session Controls Panel is partially hidden at the top of your screen:

Enter Ctrl+Alt+Shift to show the panel.

After the panel is displayed, the initial focus is on the Participants icon.

- Use Tab to change focus
- Use Enter to activate a feature

To return to the sharing area from the Session Controls Panel, select the Alt+Tab keys as you would in any Windows application to switch between items:

- If you are sharing a file, select the WebEx ball to return to the sharing area.
Chapter 10: Accessing the Session window using the keyboard

- If you are sharing an application, select the application to return focus to it.
- If you are sharing your desktop, select the application you want to share.

**Note:** To switch from the Session Controls Panel to another open panel, such as the participant list, enter **F6**.

**Screen reader support**

Cisco WebEx supports JAWS screen reading software for the following elements:

1. Application menus and drop-down menus
2. Shared file titles and tab titles
3. Quick Start page buttons, button titles, and tooltips
4. Panel and Panels tray buttons, button titles, and tooltips
Chapter 10: Accessing the Session window using the keyboard

Annotation panel and toolbars

Shared Session window content area toolbars
Chapter 10: Accessing the Session window using the keyboard

Meeting Controls Panel buttons, button titles, and tooltips
## Managing a Training Session

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview about managing training sessions for hosts</td>
<td>About managing training sessions (on page 182)</td>
</tr>
<tr>
<td>invite others to a training session that is already in progress</td>
<td>Copy of Inviting more people to your in-progress training session (on page 182)</td>
</tr>
<tr>
<td>remind attendees that a training session is already in progress</td>
<td>Reminding invitees to join your training session (on page 188)</td>
</tr>
<tr>
<td>grant attendee privileges during a training session</td>
<td>Granting attendee privileges during a training session (on page 188)</td>
</tr>
<tr>
<td>choose a participant to present documents or other information to session attendees</td>
<td>Changing presenters (on page 189)</td>
</tr>
<tr>
<td>choose a participant to join in discussions and respond to questions and chat messages</td>
<td>Designating a panelist (on page 191)</td>
</tr>
<tr>
<td>appoint another participant as host of the training session</td>
<td>Transferring the host role to another participant (on page 192)</td>
</tr>
<tr>
<td>reclaim the host role</td>
<td>Reclaiming the host role (on page 193)</td>
</tr>
<tr>
<td>stop attendees from joining a training session in progress</td>
<td>Restricting access to the training session (on page 195)</td>
</tr>
<tr>
<td>leave a session without ending it</td>
<td>Leaving the training session (on page 199)</td>
</tr>
<tr>
<td>stop the training session</td>
<td>Ending the training session (on page 199)</td>
</tr>
</tbody>
</table>
About managing training sessions

You can run a seamless and smooth training session using the features available in Training Center. For instance, you can do the following:

- Invite others, including coworkers, prospective clients, subject matter experts, or managers to join a training session that has already started
- Ask another participant to host the session; if you need to leave unexpectedly, you can rejoin later and reclaim the host role
- Ask another participant to present materials, such as a presentation, file, spreadsheet or other document
- Designate an attendee as a panelist, to join in discussions and to answer questions

Inviting more people to your in-progress training session

After you start your training session, you may find that you forgot to invite a stakeholder or someone else who should be in the training session.

To invite someone after you start your training session:

Select Invite & Remind on the Quick Start page.

Invite & Remind

The Invite and Remind dialog box appears.
You can invite someone to the training session by

Email: invite by WebEx or your own email. More (on page 185)

Phone: Enter the invitee name and phone number and select Call. More (on page 186)

Text message (SMS): Enter the invitee mobile number and select Send. More (on page 187)

IM: Invite by WebEx or your own IM. More (on page 183)

Inviting people by instant message to a training session in progress

You can invite more people to your in-progress training session by WebEx IM or another instant messenger.

To invite more people using WebEx IM:

Note: Start your WebEx IM if it is not currently running.
1. From the Quick Start page, open the Invite and Remind dialog box.
   On the IM tab, select Invite.

   The Invite More dialog box appears.

   Type a screen or domain name for the attendee.
   Click the Plus button to add the name to the list of participants.

   To quickly find screen names:

1. Click the Address Book button to open your address book.

2. In the Method drop-down list, select IM.
   If the attendee is not currently available, you can send an email invitation instead.
   Simple select Email in the drop-down list.

3. Click Invite.
   Each attendee receives an IM message, which includes:
A link that the attendee can click to join the training session
- Training Session topic
- Training Session start time

**Tip:** If you invite attendees by instant messenger, and your training session requires a password, remember to provide the password to attendees.

**To invite more people using another IM:**

Open the Invite and Remind dialog box from the QuickStart page.
Select **Copy** at the bottom of the dialog box, then paste the URL into your own IM and send it.

---

**Inviting people by email to a training session in progress**

Each person that you invite receives an invitation email message, which provides information about the training session-including the password, if any-and a link that the participant can click to join the training session.
To send an email invitation:

From the Quick Start page, Open the Invite and Remind dialog box.

On the Email tab do one of the following:

Enter one or more email addresses and select Send to have WebEx send the invitation emails.

Click the link to send invitations using your own email program (MS Outlook or Lotus Notes only).

Inviting people by phone to a training session in progress

You can invite people by phone to a training session in progress.

To invite people by phone:

From the Quick Start page, open the Invite and Remind dialog box.

On the Phone tab, enter the invitee name and phone number. Select Call.
You can speak to the invitee privately, then add the invitee to the general training session.

If you are not yet connected to the audio conference, the invitee receives a phone call to join the audio conference.

Inviting people by text message (SMS) to a training session in progress

You can invite people by text message (SMS) to a training session in progress. This feature must be enabled by your site administrator.

To invite a person by text message from the training session:

1. From the Quick Start page, open the Invite and Remind dialog box.
2. On the SMS tab, enter the invitee mobile phone number.
3. Select Send.

Each invitee receives a text message, which includes:

- A number the invitee can call to join the training session
- The account code
- Training Session topic
- Training Session start time
- The host name
- A reply code to receive a call from the training session.
Reminding invitees to join your meeting

After the training session starts, and you see that some invitees have not yet joined, you can send an email reminder.

To remind someone to join your training session:

1. Select Invite & Remind on the Quick Start page.
2. Select the Remind tab. All invitees who are not in the training session are automatically chosen to receive the reminder.
3. Uncheck the box beside any person you don't want to remind.
4. Select Send Reminder.

An email reminder is sent to each person selected.

Granting attendee privileges during a training session

During a training session, the session host can grant privileges to or remove them from attendees at any time.
To specify attendee privileges during a training session:

1. In the Session window, do one of the following:
   - On the Participant menu, point to Assign Privileges.
   - On the Participants panel, right-click a participant's name, and select Assign Privileges.

   The Assign Privileges dialog box appears.

2. Specify attendee privileges, as follows:
   - To grant a privilege to all attendees, select its check box.
   - To grant all privileges to attendees, select the All attendee privileges check box.
   - To remove a privilege from all attendees, clear its check box.

3. Click OK.

Changing presenters

Depending on your site settings, a participant can become the presenter in a number of ways:

- The first person to join automatically becomes the presenter.
- As host, you can make a participant the presenter before sharing (on page 189) or during sharing (on page 191)

Making a participant the presenter when you are in the meeting window

During a training session, you can make any training session participant the presenter - also referred to as passing the ball. Any presenter can also pass the ball to make another training session participant the presenter.

There are numerous ways to make someone the presenter depending on how you are viewing participants.
Here are a couple of quick ways to make another participant the presenter:

If you are viewing a list of participants, do either of the following:
Drag the ball from the last presenter to the next presenter.
Choose a name and select **Make Presenter**.

If you are viewing participant thumbnails, do either of the following:
Mouse over a thumbnail and select **Make Presenter**.
Choose a thumbnail, then select **Make Presenter**.
The participant becomes the presenter with all associated rights and privileges for sharing information.

**Note:** Use the docked tray at the top of your screen to change presenters when you are sharing.

### Making a participant the presenter when you are sharing

When you are sharing your desktop, an application, or files in full screen mode, the docked tray at the top of your screen provides an easy way to change presenters.

**To make someone else the presenter using the docked tray:**

1. Mouse over the bottom of the docked tray to expose it.
2. Select **Assign**, then **Make Presenter**.
3. Select a participant.

The participant becomes the presenter with all associated rights and privileges for sharing information.

**Note:** You can make someone else the presenter from the participant list when you are in the meeting window.

### Designating a panelist

During a training session, you can designate any training session attendee as a panelist. You can also change the panelist's role back to attendee at any time.

**To designate a panelist:**

1. In the Session window, in the participant list on the **Participants** panel, select the name of the attendee whom you want to designate as a panelist.
2. Do one of the following:
Chapter 11: Managing a Training Session

- Right-click the attendee's name, point to Change Role To, and then choose Panelist.
- On the Participant menu, point to Change Role To, and then choose Panelist.

The attendee’s name appears in the list of panelists.

To change the panelist’s role back to attendee:
1. On the Participants panel, in the panelist list, select the attendee’s name.
2. Do one of the following:
   - Right-click the attendee’s name, point to Change Role To, and then choose Attendee.
   - On the Participant menu, point to Change Role To, and then choose Attendee.

Transferring the host role to another participant

As the host, you can transfer the host role—and thus control of the training session—to another participant at any time. This option can be useful if you need to leave the training session for any reason. You can reclaim the host role at any time.

Important: If you leave a training session—whether intentionally or inadvertently—and then log back in to your Training Center Web site, you automatically become the training session host once you rejoin the training session. You can rejoin a training session using either the Live Sessions page or your private Meeting Room page.

To transfer the host role to an attendee:
1. Optional. If you plan to reclaim the host role later, write down the host key that appears on the Info tab in the Session window’s content viewer.
2. Click the Participants panel.
3. In the participant list, select the name of the attendee to whom you want to transfer the host role.
4. Do one of the following:
   - Right-click on the participant’s name, point to Change Role To, and then choose Host.
On the Participant menu, point to Change Role To, and then choose Host.

5. A confirmation message appears, in which you can verify that you want to transfer control of the training session to the attendee whom you selected.

6. Click OK.

The word (Host) appears to the right of the attendee’s name in the participant list.

Reclaiming the host role

If an attendee has control of the training session, you can assume control by reclaiming the host role.

Important: If you leave a training session—whether intentionally or inadvertently—and then log back in to your Training Center Web site, you automatically become the training session host once you rejoin the training session. You can rejoin the training session using your list of scheduled training sessions.

To reclaim the host role:

1. Click the Participants panel.

2. In the participant list, select your own name.

3. On the Participant menu, choose Reclaim Host Role.

   The Reclaim Host Role dialog box appears.

4. Type the host key in the Host key box.

5. Click OK.

   In the participant list, the word (Host) appears to the right of your name.

Tip: If you did not write down the host key before transferring the host role to another attendee, you can ask the current host to send you the host key in a private chat message. The host key appears on the current host’s Info tab in the content viewer.
Obtaining information about a training session after it starts

During a training session, you can obtain general information about the session, including the following:

- training session topic
- location, or URL, of the Web site on which the training session is occurring
- training session number
- audio conference information
- current host
- current presenter
- current user—that is, your name
- current number of participants

To obtain information about a session in progress:

In the Session window, on the Session menu, choose Information.

The Training Session Information dialog box appears listing general information about the training session.

Editing a message or greeting during a training session

When scheduling a training session, you can create a message or greeting for attendees, and optionally specify that the message or greeting automatically appears in attendees' Session windows once they join the training session. During a training session, you can edit the message or greeting that you created, or edit the default greeting.

In your message or greeting, you can welcome the attendee to the training session, provide important information about the training session, or provide special instructions.

To edit a message or greeting during a training session:

1. In the Session window, on the Session menu, choose Greeting Message.
The Create an Attendee Greeting page appears.

2 Optional. Select the **Display this message when attendees join the session** check box.

The message or greeting automatically appears once the attendee joins the training session.

3 Type a message or greeting in the **Message** box.

4 A message or greeting can contain a maximum of 4000 characters.

5 Click **OK**.

**Note:** Attendees can view the message or greeting at any time by choosing **Greeting Message** on the **Session** menu.

### Restricting access to the training session

Once you start the training session, you can restrict access to it at any time. This option prevents anyone from joining the training session, including attendees whom you invited to the training session but have not yet joined it.

**To restrict access to the training session:**

1 In the Session window, on the **Session** menu, choose **Restrict Access**.
Attendees can no longer join the training session.

2 Optional. To restore access to the training session, on the Session menu, choose Restore Access.

Tracking participant attention

During your training session, you can easily tell if attendees are no longer focused on your presentation. The attention indicator shows if an attendee has:

- Minimized the training session window
- Brought another window, such as any kind of instant messaging (IM) window, in focus on top of the training session window

<table>
<thead>
<tr>
<th>During a session, you can check:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Attentiveness</strong></td>
</tr>
<tr>
<td>Attentive</td>
</tr>
<tr>
<td><img src="image" alt="67%" /></td>
</tr>
<tr>
<td>2 Attendee(s)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Overall attentiveness</th>
</tr>
</thead>
<tbody>
<tr>
<td>The left side of the bar graph indicates the percentage of attendees who are paying attention; the right side indicates the percentage of attendees who are not paying attention.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Individual attentiveness</th>
</tr>
</thead>
<tbody>
<tr>
<td>If an attendee is not paying attention, an exclamation mark appears next to the name of the attendee.</td>
</tr>
</tbody>
</table>

After a training session ends, you can generate reports to obtain data about individual attentiveness. A report contains this information for each attendee:
Chapter 11: Managing a Training Session

- Attention-to-attendance ratio: Attentiveness based on how long the attendee was in the training session
- Attention-to-duration ratio: Attentiveness based on the duration of the training session

For details, see *About generating reports* (on page 522).

Checking participant attention in a training session

During a training session, you can easily check which attendees are not paying attention.

**To check who is not paying attention in the training session:**

Look for the icon 🚫 that appears next to the name of the attendee who is not paying attention.

**To check overall attentiveness:**

Click the icon ⚠️ on the toolbar of your Participants panel.

Turning on or off attention tracking in a training session

*Host only*

You can turn on or off attention tracking in a session.

**To turn on or off attention tracking in a session:**

1. On the **Session** menu, choose **Options**.
2 On the Communications tab, select Attention tracking.

Note: If the Attention tracking option is unavailable, contact your site administrator.

Removing an attendee from the training session

You can remove an attendee from the training session at any time.

To remove an attendee from the training session:

1 In the Session window, in the participant list on the Participants & Communications panel, select the name of the attendee whom you want to remove from the training session.

2 On the Participant menu, choose Expel.
   A confirmation message appears, in which you can verify that you want to remove the attendee from the training session.

3 Click Yes.
   The attendee is removed from the training session.
Leaving the training session

You can leave the training session at any time. If you are participating in a call-back teleconference or an Integrated VoIP conference, Training Manager automatically disconnects you from the conference once you leave the training session.

**Note:** If you are the training session host, first transfer the host role to another attendee before leaving the training session. For more information, see *Transferring the host role to another participant* (on page 192).

**To leave the training session:**

1. In the Session window, session participants can click the **Leave Training Session** button on the Quick Start page. They can also choose **Leave Training Session** from the **File** menu.

   A confirmation message box appears, in which you can verify that you want to leave the training session.

2. Click **Yes**.

   The Session window closes.

Ending the training session

You can end the training session at any time. Once you end a training session, the Session window closes for all attendees. If the training session includes an integrated audio conference, the conference also ends.

**To end the training session:**

1. On the Quick Start page, click the **End Training Session** button. You can also choose **End Training Session** from the **File** menu.
Chapter 11: Managing a Training Session

A confirmation message appears, in which you can verify that you want to end the training session. If you have not yet saved an annotated document or presentation, recording, poll questionnaire, poll results, or chat, Training Manager asks you whether you want to save it before ending the training session.

2 Click Yes.

The Session window closes.

**Note:** Alternatively, as the training session host, you can leave a training session without ending it. Before you leave a training session, you should first transfer the host role to another attendee. For more information, see *Transferring the host role to another participant* (on page 192).
Assigning Privileges during a Training Session

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>See…</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of privileges</td>
<td>About granting privileges to attendees (on page 201)</td>
</tr>
<tr>
<td>specify particular privileges for training session attendees</td>
<td>Granting attendee privileges during a training session (on page 202)</td>
</tr>
<tr>
<td>review specific details about each attendee privilege</td>
<td>About the Assign Privileges dialog box (on page 203)</td>
</tr>
</tbody>
</table>

About granting privileges to attendees

Once a training session starts, all attendees automatically receive privileges:

- If the host scheduled the training session and specified attendee privileges, attendees receive those privileges.
- If the host scheduled the training session but did not specify attendee privileges, attendees receive the default privileges.
- If the host started an instant training session, attendees receive the default privileges.

You can grant or remove privileges for the following training session activities:

- Document sharing, including privileges for saving, printing, and annotating shared content in the content viewer
Granting attendee privileges during a training session

During a training session, the session host can grant privileges to or remove them from attendees at any time.

To specify attendee privileges during a training session:

1. In the Session window, do one of the following:
   - On the Participant menu, point to Assign Privileges.
   - On the Participants panel, right-click a participant's name, and select Assign Privileges.

   The Assign Privileges dialog box appears.

2. Specify attendee privileges:
   - To grant a privilege to all attendees, select its check box.
   - To grant all privileges to attendees, select the All attendee privileges check box.
   - To remove a privilege from all attendees, clear its check box.

   For a detailed description of the options in the Assign Privileges dialog box, see About the Assign Privileges dialog box (on page 203).

3. Click OK.
About the Assign Privileges dialog box

For details about each privilege, review the table below. To access the attendee privileges page:

- On the **Participant** menu, point to **Assign Privileges**.
- On the **Participants** panel, right-click a participant's name, and select **Assign Privileges**.

<table>
<thead>
<tr>
<th>Document</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Save</strong></td>
<td>Specifies that attendees can save any shared documents, presentations, or whiteboards that appear in the content viewer.</td>
</tr>
<tr>
<td><strong>Print</strong></td>
<td>Specifies that attendees can print any shared documents, presentations, or whiteboards that appear in the content viewer.</td>
</tr>
<tr>
<td><strong>Annotate</strong></td>
<td>Specifies that attendees can annotate any shared documents, presentations, or whiteboards that appear in the content viewer, using the toolbar that appears above the viewer. Also allows attendees to use pointers on shared documents, presentations, and whiteboards.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>View</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Number of attendees</strong>—If selected, specifies that the attendees can view the number of attendees in the training session.</td>
<td></td>
</tr>
<tr>
<td><strong>Attendee list</strong>—If selected, specifies that attendees can view the names of all other attendees on the <strong>Participants</strong> panel. If this option is not selected, attendees can view the names of only the training session host and the presenter on the <strong>Participants</strong> panel.</td>
<td></td>
</tr>
<tr>
<td><strong>Thumbnails</strong>—Specifies that attendees can display miniatures of any pages, slides, or whiteboards that appear in the content viewer. This privilege allows attendees to view miniatures at any time, regardless of the content that appears in the presenter’s content viewer. Note—If attendees have this privilege, they can display any page at full size in the content viewer, regardless of whether they also have the <strong>Any page</strong> privilege.</td>
<td></td>
</tr>
<tr>
<td><strong>Any document</strong>—Specifies that attendees can view any document, presentation, or whiteboard that appears in the content viewer, and navigate to any pages or slides in documents or presentations.</td>
<td></td>
</tr>
<tr>
<td><strong>Any page</strong>—Specifies that attendees can view any pages, slides, or whiteboards that appear in the content viewer. This privilege allows attendees to navigate independently through pages, slides, or whiteboards.</td>
<td></td>
</tr>
</tbody>
</table>
Chapter 12: Assigning Privileges during a Training Session

### Training session

<table>
<thead>
<tr>
<th>Privilege</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Send Video</strong></td>
<td>If selected, specifies that attendees can send video during a training session—that is, the Video icon appears next to the participant's name in the Participants panel. If you clear this option, sending video is not available for participants.</td>
</tr>
<tr>
<td><strong>Record the session</strong></td>
<td>Specifies that attendees can record all interactions during a training session and play them back at any time.</td>
</tr>
<tr>
<td><strong>Share documents</strong></td>
<td>Specifies that all attendees can share documents, presentations, and whiteboards, and copy and paste any pages, slides, and whiteboards in the content viewer.</td>
</tr>
<tr>
<td><strong>Control shared applications, Web browser, or desktop remotely</strong></td>
<td>Specifies that all attendees can request that the presenter grant them remote control of a shared application, Web browser, or desktop. If this privilege is cleared, the command to request remote control is unavailable to attendees.</td>
</tr>
</tbody>
</table>

### Communications

<table>
<thead>
<tr>
<th>Chat with</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Host</strong></td>
<td>Specifies that attendees can chat with only the training session host. If an attendee sends a chat message to the host, it appears in only the host's Chat viewer.</td>
</tr>
<tr>
<td><strong>Presenter</strong></td>
<td>Specifies that attendees can chat with only the presenter. If an attendee sends a chat message to the presenter, it appears in only the presenter's Chat viewer.</td>
</tr>
<tr>
<td><strong>Panelist</strong></td>
<td>Specifies that attendees can chat privately with any panelist or all panelists.</td>
</tr>
<tr>
<td><strong>All attendees</strong></td>
<td>Specifies that attendees can chat with either other attendees at once, not including the training session host and the presenter or all participants at once, including all attendees, the training session host, and the presenter.</td>
</tr>
</tbody>
</table>

### Breakout sessions with:

| Host | Specifies that all attendees can join breakout sessions with only the training session host. This privilege is set as a default. |
| Presenter | Specifies that all attendees can join breakout sessions with only the presenter. This privilege is set as a default. |
| Panelists | Specifies that attendees can join breakout sessions with any panelist or all panelists. This privilege is set as a default. |
| All attendees | Specifies that all attendees can join breakout sessions with either other attendees, not including the training center host, the presenter, and panelists or all participants, including all attendees, the session host, the presenters, and the panelists. |

### All attendee privileges

<table>
<thead>
<tr>
<th>Privilege</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>All attendee privileges</strong></td>
<td>Specifies that attendees have all privileges.</td>
</tr>
</tbody>
</table>
Assigning Sounds to Participant Actions

*Host only*

During a training session, you can assign sounds to play when a participant:

- Joins the training session
- Leaves the training session
- Clicks Raise Hand on the Participants panel
- Clicks Ask for Mic on the Participants panel

**To assign sounds to participant actions:**

1. In the Session window, on the Edit menu, choose *Personal Preferences*. The Personal Preferences dialog box appears.
2. Select the type of action for which you want to assign a sound by clicking:
   - **Join/Leave**
   - **Communications**
3. Select a sound using one of these methods:
   - In the drop-down list for each selected action, choose a sound to play.
     By default, the drop-down list contains the names of all sound files that reside at the default location on your computer.
   - Click **Browse**, and then select a sound file that resides in another folder.
4. Optional. To play the currently selected sound, click the button 🎧.
5 Click OK.

**Note:**

- Training Center saves your sound preferences on your computer. However, if you start or join a training session on another computer, you need to set your preferences again on that computer.
- Sound files must have a .wav extension
- In most cases, the default location for sound files is C:\WINDOWS\Media. You can copy other sound files to the default folder or any other directory to make them available in the Personal Preferences dialog box.
WebEx Audio lets you use either your telephone or your computer to hear others and to speak in your training session:

- **Telephone**—you can use your telephone to receive a call to the audio portion of the training session or to dial in.
- **Computer**—you can use a headset connected to your computer to join the audio portion of the training session if the computer has a supported sound card and a connection to the Internet.

**Note:** If you are a host, you can invite up to 500 people to participate in the audio conference.

After joining the conference, participants can switch between audio modes with little or no listening interruption. In a mixed-mode conference, where some participants are using the telephone and others are using the computer, up to 125 people can speak.

Your role in an audio conference determines your level of participation. Whichever role you take, the following table describes the basic tasks you can accomplish in that role. For detailed instructions on a particular task, click "More" by the task description.
## Connecting to an audio conference

Once you start or join a training session that uses WebEx Audio, the Audio Conference dialog box appears automatically on your screen.

What device do you want to use for speaking and listening in the training session?

- **your phone**: typically provides good voice transmission, but may have a cost attached.

### Task description

<table>
<thead>
<tr>
<th>Call using phone</th>
<th>Host an audio conference:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>join or leave the audio conference More (on page 208)</td>
</tr>
<tr>
<td></td>
<td>switch audio connection modes More (on page 213)</td>
</tr>
<tr>
<td></td>
<td>mute or unmute one or more microphones More (on page 214)</td>
</tr>
<tr>
<td></td>
<td>use caller authentication to join the conference More? More (on page 217)</td>
</tr>
<tr>
<td></td>
<td>edit or update phone numbers in your user profile More</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Call using computer</th>
<th>Participate in an audio conference:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>join or leave the audio conference More (on page 208)</td>
</tr>
<tr>
<td></td>
<td>switch audio connection modes More (on page 213)</td>
</tr>
<tr>
<td></td>
<td>ask to speak More (on page 216)</td>
</tr>
<tr>
<td></td>
<td>mute or unmute your microphone More (on page 214)</td>
</tr>
<tr>
<td></td>
<td>use caller authentication to join the conference More (on page 217)</td>
</tr>
<tr>
<td></td>
<td>edit or update phone numbers in your user profile More</td>
</tr>
</tbody>
</table>

**Note:** If you set up another type of audio conference—such as that of a third-party service—you must manage the conference using the options that service provides.
your computer (with a headset, and an Internet connection): Sometimes causes noisy transmission, or an irregular voice stream, but has no cost attached.

You can select your preferred device from the Audio Conference dialog box that appears automatically after you start or join a training session:

- **Use Phone**: You can call in or have the training session call you. More
- **Use Computer for Audio**: Select the arrow, then choose *Call using Computer*. More (on page 212)

At any time during the training session, you can switch your audio device (on page 213).

### Using your telephone to connect to audio

After you join a training session, the Audio Conference dialog box appears automatically. When you use your telephone to connect to the audio portion of the training session, you can call in or receive a call back.

- **Call back**—receive a call at a valid number you provide, or at number that is already stored in your user profile. A valid number must contain the area code and the seven-digit local telephone number.
- **Call in**—call in from your phone to a number your host provides.

The Audio Conference dialog box appears automatically.

**To receive a call back**:

In the Use Phone pane of the Audio Conference dialog box, do one of the following:
Chapter 14: Using WebEx Audio

To call in:

1. In the Use Phone pane of the Audio Conference dialog box, select **I will call in** from the dropdown menu.
2 Follow the instructions to join the audio conference.

3 **Optional.** To view all international numbers, click the link **All global call-in numbers.**

   An information dialog box appears, which lists international numbers.

   A telephone icon appears next to your name in the participant list to indicate that you are using your phone in the audio conference, and a mute icon appears next to the video icon so that you can mute or unmute your microphone as desired. *More* (on page 214)

To leave an audio conference:

1 Click **Audio** below the Participant list.

   The Audio Conference dialog box appears.

2 **Click Leave Audio Conference.**

   Your participation in the audio conference ends; however, your participation in the training session continues until you leave it or the host concludes it.
Using your computer to connect to audio

After you join a training session, the Audio Conference dialog box appears automatically. When you use your computer to speak and listen in a training session, your computer sends and receives sound across the Internet. To do this, your computer must have a supported sound card and be connected to the Internet.

**Note:** For purposes of audio quality and convenience, use a computer headset with a high-quality microphone rather than speakers and a microphone.

To use your computer for audio:

1. Select the arrow.
2. Select **Call Using Computer**.

**Note:** If this is your first time connecting to a training session with your computer, a wizard appears to fine tune your sound settings (on page 213).

After you are connected to your training session, you can 
mute or unmute your speaker or microphone 
change the volume on your speaker or microphone

A headset icon appears next to your name in the participant list to indicate that you are using your phone in the audio conference, and a mute icon appears next to the video icon so that you can mute or unmute your microphone as desired. *More* (on page 214)

You can switch from using your computer as your audio device to using your telephone at any time during the audio conference. *More* (on page 213)
Fine tuning your microphone and speaker settings

If you are using your computer to connect to the meeting audio, you can fine-tune your microphone and speaker settings to optimize your audio experience.

The Speaker/Microphone Audio Test walks you through testing your devices, and setting your speaker volume and microphone level.

When you first start or join a meeting, you can manually test and adjust your sound device before you actually start using your computer for audio.

To open the Speaker/Microphone Audio Test and adjust your sound settings:

1. From the meeting window menu, select Audio > Speaker/Microphone Audio Test.
2. Follow the instructions.

Tip: After you join the audio portion of the meeting you can retest your settings at any time simply by reopening the Audio Conference dialog box and clicking Test speaker/microphone at the bottom of the box.

Switching audio devices during a meeting

You can easily switch from one audio device to another during a training session with little disruption.

To switch from your computer connection to a phone connection:

Open the Audio Conference dialog box from
- the Quick Start page
- your participant list
- the Audio menu.
- the Session Controls Panel (If you are sharing)

Select the down arrow beside Use Phone.

Call the number in the Use Phone area and enter the access code and attendee ID, as directed by the automated operator.

After you are connected by phone, your computer connection is dropped automatically.
To switch from your phone connection to a computer connection:

Open the Audio Conference dialog box from

- the Quick Start page
- your participants list
- the Audio menu.
- the Session Controls Panel (If you are sharing)

Select the down arrow beside **Use Computer for Audio**.

Select **Switch to Using Computer**.

Your phone connection is dropped after your computer connection is established.

(Remember to switch to your computer headset.)

**Connecting to audio during sharing**

If you join a training session that is already in progress and shared content is all you see, you can connect to the audio portion of the training session from the Session Controls Panel.

To connect to the audio portion of the training session:

On the Session Controls Panel at the top of your screen, select Audio.

The Audio Conference dialog box opens **Connect to the audio** (on page 208) portion of the training session as usual.

**Muting and unmuting microphones**

The following table illustrates how to quickly mute and unmute microphones in your training session depending on your user role.
### Role

<table>
<thead>
<tr>
<th>Role</th>
<th>Task description:</th>
</tr>
</thead>
</table>
| **Host** | **Windows:** Right click in the participants list  
**Mute on Entry** to mute all microphones automatically when participants join a training session  
**Mute or Unmute** to mute or unmute your own or a specific participant's microphone  
**Mute All** to mute or unmute all participant microphones simultaneously at any time during a training session | More (on page 215) |
| **Participant** | **Mac:** Ctrl + click in the participants list  
Select the **Mute** or **Unmute** icon to mute or unmute your own microphone. | |

The microphone icon to the right changes state.

**Tip:** During sharing, participants can mute and unmute their microphones from the Session Controls Panel at the top of their screens.

---

**Muting and unmuting all participant microphones simultaneously**

*Host and presenter only*

You can mute or unmute all participant microphones simultaneously.

This option does not affect the host's and presenter's microphones.
To mute or unmute all participants:

- **Windows**: Right click on the participant list
- **Mac**: Ctrl + click on the participant list

Select **Mute All** or **Unmute All**.

The microphone icon to the right of each participant's name changes state.

### Asking to speak in an audio conference

*Participant*

If you want to speak and the host has muted your microphone, you can ask the host to unmute your microphone so that you can speak. You can cancel a request to speak at any time.

<table>
<thead>
<tr>
<th>To ask to speak</th>
<th>Windows</th>
<th>result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select <strong>Raise Hand</strong> on the Participants panel</td>
<td><img src="image" alt="Raise Hand" /></td>
<td>The <strong>Raised Hand</strong> indicator appears on the participant list for the host and presenter.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>To cancel a request to speak</th>
<th>Windows</th>
<th>result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select <strong>Lower Hand</strong> On the Participants panel</td>
<td><img src="image" alt="Lower Hand" /></td>
<td>The <strong>Raised Hand</strong> indicator is removed from the participant list for the host and presenter.</td>
</tr>
</tbody>
</table>
### To ask to speak

<table>
<thead>
<tr>
<th>Mac</th>
<th>result</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Raise Hand icon" /></td>
<td>The Raised Hand indicator appears on the participant list for the host and presenter.</td>
</tr>
</tbody>
</table>

### To cancel a request to speak

<table>
<thead>
<tr>
<th>Mac</th>
<th>result</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Lower Hand icon" /></td>
<td>The Raised Hand indicator is removed from the participant list for the host and presenter.</td>
</tr>
</tbody>
</table>

---

## Using caller authentication to start or join an audio conference

*Host accounts only*

CLI (caller line identification), or ANI (automatic number identification), is a form of caller ID, a telephony intelligent service that transmits a caller’s telephone number before the call is answered. Any dial-in caller with a host site account can be authenticated and placed into the correct audio conference without needing to enter a meeting number.

If you have a host account, and your site is enabled for ANI/CLI, you can

- schedule a meeting with dial-in ANI/CLI teleconferencing authentication.
- be authenticated whenever you dial into any ANI/CLI enabled audio conference to which you have been invited by email. Call-in authentication is established by mapping your email address to a phone number in your user profile.
- specify a call-in authentication PIN to prevent "spoofers" from using your number to dial into an audio conference

### To schedule an audio conference with ANI/CLI authentication:

1. Log in to your Training Center Web site.
2. On the navigation bar, under **Host a Meeting**, click **Schedule a Meeting**.
   
   The Schedule a Meeting page appears.
Chapter 14: Using WebEx Audio

3 Click **Change audio options**.

The Audio Options dialog box appears.

4 Select the **Enable audio conference CLI authentication when participants call in** checkbox if it is not already selected.

   **Note:** Caller authentication will **only** be available to participants if they are invited to a CLI/ANI enabled audio conference by email during the meeting scheduling process. Any participant invited to the audio conference once it has begun cannot use caller authentication.

---

### Specifying call-in authentication for your host account

If you have a host account, and your site is enabled for call-in authentication, you can set authentication for any phone number listed in your user profile. Your call will be authenticated by mapping your email address against specified phone numbers in your profile whenever you dial into a CLI (caller line identification), or ANI (automatic number identification) enabled audio conference to which you have been invited by email.

   **Note:** Caller authentication will **only** be available if you have been invited to a CLI/ANI (automatic number identification) enabled audio conference by email during the meeting scheduling process. Caller authentication will not be available if you are dialing in to a CLI/ANI enabled audio conference:
   - from an invitation other than email.
   - from an email invitation originated during the meeting.

**To specify call-in authentication for your host account:**

1 Log in to your Training Center Web site.

2 On the navigation bar, click **My WebEx**.

3 Click **My Profile**.

   The My WebEx Profile page appears.

4 Under **Personal Information**, select the **Call-in authentication** checkbox beside any phone number for which you want dial-in authentication.

5 Click **Update**.
Using an authentication PIN

If you have a host account, and your site is enabled for CLI (caller line identification), or ANI (automatic number identification) audio conferences, you can use an authentication PIN to prevent "spoofers" from using your number to dial into an audio conference.

If your site administrator sets the authentication PIN as mandatory for all accounts using call-in authentication on your site, then you must specify a PIN number or caller authentication will be disabled for your account.

To specify an authentication PIN:

1. Log in to your Training Center Web site.
2. On the navigation bar, click My WebEx.
3. Click My Profile.
   The My WebEx Profile page appears.
4. Under Personal Information, in the PIN: text box, enter a 4-digit PIN number of your choosing.
5. Click Update.

Editing or updating your stored phone numbers

You can edit or update the phone numbers listed in your profile if you have not yet joined the audio conference or if you joined the audio conference from your computer. In addition, you can view any phone number cookies stored on your computer.

Any updates you make do not take effect until the next time you join a training session.

To edit or update your profile:

1. Do either of the following:
   - On the Audio menu, choose Join Audio Conference.
   - At the bottom of the Participants panel, click Audio.
Chapter 14: Using WebEx Audio

2 The Audio Conference dialog box appears.

Select Manage phone numbers from the dropdown box in the lower pane. The Manage phone numbers dialog box appears.

3 Click Edit to update the phone numbers in your My WebEx profile, or Clear to delete phone numbers that are stored in cookies on your computer.

**Note:** You cannot be participating in an audio conference by phone if you want to edit or update your phone numbers.
Sharing Files and Whiteboards

Your user role in a training session determines your level of file sharing. Whichever role you take, the following table describes the basic tasks associated with that role. The type of files you can share include documents, presentations, and videos.

For detailed instructions on a particular task, click “More” by the task description.

<table>
<thead>
<tr>
<th>Task description:</th>
<th>Open and share a file or whiteboard</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>learn about tools for sharing More (on page 222)</td>
</tr>
<tr>
<td></td>
<td>start sharing More (on page 225)</td>
</tr>
<tr>
<td></td>
<td>assigning sharing privileges to participants More (on page 222)</td>
</tr>
<tr>
<td></td>
<td>save a file More (on page 239)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Task description:</th>
<th>View and interact with shared files and whiteboards</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>display slides or pages More (on page 241)</td>
</tr>
<tr>
<td></td>
<td>use tools to annotate a file More</td>
</tr>
<tr>
<td></td>
<td>synchronize your view with the host More (on page 242)</td>
</tr>
</tbody>
</table>
Granting sharing privileges

To grant or remove participant privileges during a training session:

1. In the Training Session window, on the Participant menu, choose Assign Privileges.
   The Participant Privileges dialog box appears.
2. Grant or remove a privilege, as follows:
   - To grant a specific privilege, select its check box.
   - To grant all privileges, select the Assign all privileges check box.
   - To remove a privilege, clear its check box.
   - To revert to the preset privileges, click Reset to Training Session Defaults.
3. Click Assign.

Content viewer tools

<table>
<thead>
<tr>
<th>Content Viewer</th>
<th>Tools</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Content Viewer" /></td>
<td>The tools on the content viewer toolbar allow you to share and perform actions on whiteboards, or on files, such as presentations or documents.</td>
</tr>
<tr>
<td><img src="image" alt="New Whiteboard" /></td>
<td>Select this button at the top right of the content viewer to start a new whiteboard.</td>
</tr>
<tr>
<td><img src="image" alt="Annotation Toolbar" /></td>
<td><strong>annotation toolbar</strong>—Select a drawing tool for directing attention onscreen, using pointers, a highlighter, or drawing a shape. More (on page 224)</td>
</tr>
</tbody>
</table>
Changing views in a file or whiteboard

You can switch views in the content viewer by clicking the view icons and selecting from the View menu in the bottom left corner of the content viewer:

<table>
<thead>
<tr>
<th>Tool</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Thumbnail</td>
<td></td>
<td>To display thumbnails, or miniatures, of shared pages, slides, or whiteboards to the side of the content, click <strong>Show Thumbnail</strong>. This tool helps you locate a page or slide quickly.</td>
</tr>
<tr>
<td>Full-Screen View</td>
<td></td>
<td>Displays shared content in a full-screen view. Helps to ensure that participants can view all activity on your screen. Also helps to prevent participants from viewing or using other applications on their screens during a presentation. Click <strong>ESC</strong> to return to the content viewer.</td>
</tr>
<tr>
<td>Rotate page</td>
<td></td>
<td>For documents in landscape orientation, you can rotate the pages to the left or right so they appear correctly in the content viewer.</td>
</tr>
<tr>
<td>Zoom In/Zoom Out</td>
<td></td>
<td>Lets you display shared content at various magnifications. Click this button, and then click the page, slide, or whiteboard to change its magnification. For more magnification options, click the downward-pointing arrow.</td>
</tr>
</tbody>
</table>
Using annotation tools on shared content

In an online training session, you can use annotation tools on shared content to annotate, highlight, explain, or point to information:

<table>
<thead>
<tr>
<th>Annotation Tool</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pointer</td>
<td>![Pointer Icon]</td>
<td>Lets you point out text and graphics on shared content. The pointer displays an arrow with your name and annotation color. To display the laser pointer, which lets you point out text and graphics on shared content using a red “laser beam,” click the downward-pointing arrow. Clicking this button again turns off the pointer tool.</td>
</tr>
<tr>
<td>Text</td>
<td>![Text Icon]</td>
<td>Lets you type text on shared content. Participants can view the text once you finish typing it and click your mouse in the content viewer, outside the text box. To change the font, on the Edit menu, choose Font. Clicking this button again turns off the text tool.</td>
</tr>
<tr>
<td>Line</td>
<td>![Line Icon]</td>
<td>Lets you draw lines and arrows on shared content. For more options, click the downward-pointing arrow. Clicking this button closes the Rectangle tool.</td>
</tr>
<tr>
<td>Rectangle</td>
<td>![Rectangle Icon]</td>
<td>Lets you draw shapes, such as rectangles and ellipses on shared content. For more options, click the downward-pointing arrow. Clicking this button again closes the Rectangle tool.</td>
</tr>
<tr>
<td>Highlighter</td>
<td>![Highlighter Icon]</td>
<td>Lets you highlight text and other elements in shared content. For more options, click the downward-pointing arrow. Clicking this button again closes the Highlighter tool.</td>
</tr>
<tr>
<td>Annotation Color</td>
<td>![Annotation Color Icon]</td>
<td>Displays the Annotation Color palette, on which you can select a color to annotate shared content. Clicking this button again closes the Annotation Color palette.</td>
</tr>
</tbody>
</table>
Chapter 15: Sharing Files and Whiteboards

### Annotation Tool

<table>
<thead>
<tr>
<th>Tool</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Eraser</td>
<td><img src="image" alt="Eraser Icon" /></td>
<td>Erases text and annotations or clears pointers on shared content. To erase a single annotation, click it in the viewer. For more options, click the downward-pointing arrow. Clicking this button again turns off the eraser tool.</td>
</tr>
</tbody>
</table>

---

**Sharing files**

File sharing is ideal for presenting information that you do not need to edit during the training session, such as a video or slide presentation. Participants can

- view shared files in their content viewers without the need for the application with which it was created.
- view a media file, such as a video, without the need for special software or hardware.
- view any animation and transition effects on shared Microsoft PowerPoint slides.

After a training session starts, you can open a presentation or document to share. You do not need to select it or "load" it before the training session.

While sharing a file, you can:

- Draw on the screen
- Use a pointer to emphasize text or graphics
- Print it
- Display it at various magnifications, in miniature (thumbnails), and in a full-screen view
- Synchronize all participants' displays with the display in your content viewer
- Save it to a file (More on page 239)

At any time during a meeting, you can grant participants privileges that allow them to annotate, save, print, and display different views of shared content.
Chapter 15: Sharing Files and Whiteboards

Sharing a file

You can share a file, such as a document, presentation, or video, that resides on your computer. Participants view the shared file in their content viewers.

To share a file:
   The Share File dialog box appears.
2. Select the document or presentation that you want to share.
3. Click Open.
   The shared document or presentation appears in the content viewer.

Choosing an import mode for presentation sharing

For Windows users only

Before you share a presentation, you can choose one of the following import modes:

- **Universal Communications Format (UCF)** - The default mode. Lets you display animations and slide transitions in Microsoft PowerPoint presentations. In the UCF mode, Training Manager imports presentations more quickly than it does in the printer driver mode. However, pages or slides may not appear consistently in Training Manager across platforms.

- **Printer driver** - Displays shared presentations as they appear when you print them, providing a consistent appearance of pages and slides in Training Manager across platforms. However, this mode does not support animations or slide transitions. In this mode, the first page or slide may appear quickly, but the total import time for all pages or slides is usually longer than it is in the UCF mode.

  **Note:** Changing the import mode does not affect any presentations that you are currently sharing. To apply a new import mode to a shared presentation, you must close it first, and then share it again.

To choose an import mode for shared presentations:
1. In the Training Session window, on the Training Session menu, choose Options.
Chapter 15: Sharing Files and Whiteboards

The Training Session Options dialog box appears, with the Options tab selected by default.

2 Click the Import Mode tab.

The Import Mode tab options appear.

3 Select either Universal Communications Format or Printer driver.

Sharing a whiteboard

Sharing a whiteboard allows you to draw objects and type text that all Participants can see in their content viewers. You can also use a pointer to emphasize text or graphics on a whiteboard.

Other things you can do while sharing a whiteboard:

- Display it at various magnifications, in miniature (thumbnails), and in a full-screen view.
- Copy and paste images into it
- Reorder its position in reference to any other whiteboards
- Print it
- Synchronize Participants' displays with the display in your content viewer More (on page 236)
- Save it

If you allow participants to annotate slides and pages, you and participants can draw and type on a whiteboard simultaneously. You can also allow participants to save, print, and display different views of shared whiteboards. For details, see Granting sharing privileges (on page 222).
Starting whiteboard sharing

You can share a whiteboard on which you can draw and write. Participants can view a shared whiteboard in their content viewers.

To share a whiteboard:

On the Share menu, choose Whiteboard.

Note:
- You can add multiple pages to a shared whiteboard. For details, see Adding new pages or slides (on page 232).
- You can share multiple whiteboards. For each whiteboard that you share, you see a new Whiteboard tab in the content viewer.

Navigating presentations, documents, or whiteboards

When sharing a file, such as a document, presentation, or whiteboard, you can

- Navigate slides, pages, or whiteboards using the toolbar More (on page 228)
- Advance pages or slides automatically, at an interval of time that you specify More (on page 230)
- Perform animations and slide transitions in a presentation More (on page 231)
- Use keys on your computer’s keyboard to navigate a presentation and display animations on the slides.

Navigating slides, pages, or whiteboards using the toolbar

You can navigate to different pages, slides, or whiteboard “pages” in the content viewer. Each document, presentation, or whiteboard being shared appears on a tab at the top of the content viewer.
To display pages or slides in the content viewer:

1. In the Training Session window, in the content viewer, select the tab for the document, presentation, or whiteboard that you want to display.
   If there are more tabs than can appear at one time, select the down arrow button to see a list of remaining tabs, or use your keyboard arrows forward and back through all the tabs.

2. On the toolbar, click a button to change the page or slide you are viewing.
Note:

- Alternatively, you can navigate to different pages or slides in a shared document, presentation, or whiteboard by opening the thumbnail viewer. For details, see Viewing thumbnails (on page 235).
- You can advance pages or slides automatically at a time interval that you specify. For details, see Advancing pages or slides automatically (on page 230).
- If your presentation includes animations or slide transitions, you can use the toolbar or keyboard shortcuts to perform them. For details, see Animating and adding effects to shared slides (on page 231).

Advancing pages or slides automatically

When sharing a document or presentation in the content viewer, you can automatically advance pages or slides at a specified interval. Once you start automatic page or slide advancement, you can stop it at any time.

To automatically advance pages or slides:

1. In the Training Session window, in the content viewer, select the tab for the document or presentation for which you want to advance pages or slides automatically.

2. On the View menu, choose Automatically Advance Pages.

   The Automatically Advance Pages dialog box appears.

3. To change the time interval for advancing pages, do one of these:
   - click the up or down buttons to increase or decrease the interval
   - type a specific time interval

   Optional: To restart page or slide advancement once all pages or slides are displayed, select the Return to beginning and continue advancing pages check box.

4. Click Start.

5. Optional. Close the Automatically Advance Pages dialog box by clicking the Close button in the upper-right corner of the dialog box.
The pages or slides continue to advance at the specified interval.

**To stop automatic page or slide advancement:**

1. If you closed the Automatically Advance Pages dialog box, on the View menu, choose Automatically Advance Pages.
   The Automatically Advance Pages dialog box appears.
2. Click Stop.

### Animating and adding effects to shared slides

When sharing a Microsoft PowerPoint slide presentation in the content viewer, you can animate text and slide transitions, just as you can when using the Slide Show option in PowerPoint.

**Note:** To show slide animations and transitions, you must share the presentation as a Universal Communications Format (UCF) file (.ucf). The UCF import mode automatically converts a PowerPoint file (.ppt) to a UCF file when you share it. More (on page 226)

For best results when sharing a presentation created using Microsoft PowerPoint 2002 for Windows XP, use a computer with an Intel Celeron or Pentium 500 MHz or faster processor.

If at least one training session participant is using the Java Training Manager, animations and slide transitions will not display during the training session. The training session host can prevent participants from joining a training session using the Java Training Manager when scheduling the training session.

**To show slide animations and transitions in a shared presentation:**

1. Ensure that the content viewer has input focus by clicking in the viewer.
   The content viewer has input focus if a blue border appears around the outside of the slide in the viewer.
2. On the toolbar, select the appropriate arrows to move through your presentation.
Working with pages or slides

When sharing a file, such as a document, presentation, or whiteboard, you can

- Add new, blank pages or slides for annotation More (on page 232)
- Paste images that you copy to your computer’s clipboard into a new page or slide in a shared document, presentation, or whiteboard More (on page 232)

Adding new pages to shared files or whiteboards

When sharing a file or whiteboard in the content viewer, you can add a new, blank page for annotation.

To add a new page or slide:

1. In the content viewer, select the tab for the document, presentation, or whiteboard to which you want to add a page or slide.
2. Select Add Page from the Edit menu.

A new page appears in the content viewer at the end of the currently selected document, presentation, or whiteboard.

Tip: If you have added multiple pages to a shared file or whiteboard tab, you can view thumbnails (on page 235) to make it easy to view and navigate around your added pages.

Pasting images in slides, pages, or whiteboards

If you copy any bitmap image to your computer’s clipboard, you can paste the image into a new page, slide, or whiteboard in the content viewer.

For example, you can copy an image on a Web page or in an application, then quickly share that image by pasting it in the content viewer.

To paste an image in a page, slide, or whiteboard in the content viewer:

1. In the content viewer, select the tab for the document, presentation, or whiteboard in which you want to paste an image.
Managing views of presentations, documents, or whiteboards

All shared files, such as presentations, documents, or whiteboards, appear in the content viewer in the Training Session window. A tab at the top of the content viewer appears for each document, presentation, or whiteboard that is being shared.

Depending on your role and the privileges that you have, you can do the following when viewing shared content in the content viewer:

- **Magnify** (on page 233) slides, pages, or whiteboards
- **View thumbnails** (on page 235) of slides, pages, or whiteboards.
- **Display a full-screen view** (on page 234) of a page, slide, or whiteboard.
- **Synchronize all participant views** (on page 236) of a page or slide with the view that appears in your content viewer

**Zooming in or out**

Using the tools on the content viewer toolbar, you can:

- Zoom in to or out from a page, slide, or whiteboard
- Adjust the size of a page, slide, or whiteboard to fit the content viewer
- Turn off the Zoom tool at any time

**To zoom in to or out from a page, slide, or whiteboard:**

On the content viewer toolbar:

- Select the **Zoom In** or **Zoom Out** button, and then drag your mouse to the area. Release your mouse button.
Chapter 15: Sharing Files and Whiteboards

- To zoom in or out to a preset percentage, select the downward-pointing arrow to the left of the **Zoom In/Zoom Out** button, and then choose the percentage.

![Zoom options](image)

**To adjust the size of a page, slide, or whiteboard within the content viewer:**

On the toolbar, select the downward-pointing arrow to the left of the **Zoom In/Zoom Out** buttons.

![Zoom options](image)

**To turn off a zoom tool:**

On the toolbar, click the **Zoom In/Zoom Out** button.

**Controlling full-screen view**

You can maximize the size of a page, slide, or whiteboard in the content viewer to fit your monitor's entire screen. A full-screen view replaces the normal training session window view. You can return to a normal view at any time.

**Note:** If a training session presenter displays a full-screen view of a page, slide, or whiteboard, participant screens automatically display a full-screen view as well. However, participants can control full-screen view independently in their training session windows.
Chapter 15: Sharing Files and Whiteboards

To display a full-screen view:

![Full Screen Icon]

On the content viewer toolbar, select the Full Screen icon.

To return to a normal view:

![Session Controls Panel]

On the Session Controls Panel, select the stop icon to return to the main window.

Viewing thumbnails

You can view thumbnails of the shared pages, slides, and whiteboards that appear in the content viewer. Thumbnails provide a fast way to locate a shared page or slide that you want to display in the content viewer.

To view thumbnails of slides, pages, or whiteboards:

1. In the content viewer, select the tab for the document, presentation, or whiteboard for which you want to view thumbnails.
2. On the content viewer toolbar, select Show Thumbnails from the View menu.

![Show Thumbnails Menu]

Thumbnails of all pages or slides in the selected document, presentation, or whiteboard appear in the thumbnail viewer, in the left column.
Optional. To display any page or slide in the content viewer, double-click its miniature in the thumbnail viewer.

**Note:** Participants must have both the View thumbnails and View any page privileges to display a miniature of a page or slide at full size in the content viewer.

To close the thumbnail viewer:

On the content viewer toolbar, select *Hide Thumbnail* from the *View* menu.

**Synchronizing all participant views**

You can synchronize the display of a shared page, slide, or whiteboard in all participant content viewers with the display in your viewer. Once you synchronize displays, the page, slide, or whiteboard in participant content viewers appears at the same magnification as in your content viewer.

**To synchronize participant views of slides, pages, or whiteboards:**

On the *View* menu at the bottom of the window, select *Sync Display for All*. 
Clearing annotations

You can clear any annotations made by you or another participant on a shared page, slide, or whiteboard in the content viewer. You can clear:

- All annotations at once
- Only specific annotations
- If you are the presenter or host, clear all annotations you have made

To clear all annotations on a shared page, slide, or whiteboard:

1. On the annotation toolbar, click the downward-pointing arrow to the right of the Eraser Tool icon.

2. Choose Clear All Annotations.

Note: Only annotations on the page or slide that currently appears in your content viewer are cleared. Annotations on other pages or slides are not cleared.

If you are the host or presenter, you can clear all the annotations you've made.

To clear all annotations you have added to a shared page, slide, or whiteboard:

1. On the annotation toolbar, click the downward-pointing arrow to the right of the Eraser Tool icon.
Chapter 15: Sharing Files and Whiteboards

Choose **Clear My Annotations**.

**To clear specific annotations on a shared page, slide, or whiteboard:**

1. On the toolbar, click the **Eraser Tool** icon.

   ![](Eraser_tool.png)

   Your mouse pointer changes to an eraser.

2. Click the annotation you want to clear.

**To turn off the eraser tool:**

On the toolbar, click the **Eraser Tool** icon.

![](Eraser_tool.png)

---

**Clearing pointers**

You can clear your own pointers on all shared slides, pages, or whiteboards in the content viewer. If you are a presenter, you can also clear all participant pointers.

![](annotation_tools.png)

**To clear your own pointer on all shared slides, pages, or whiteboards:**

1. On the toolbar, click the downward-pointing arrow to the right of the **Eraser Tool** icon.

   ![](Eraser_tool.png)

2. Choose **Clear My Pointer**.
Saving, opening, and printing presentations, documents, or whiteboards

Training Session participants (hosts, presenters, and participants with privileges) can access and print documents, presentations, and whiteboards shared in a training session. For example, you can:

- save a shared presentation *More* (on page 239)
- open a saved document *More* (on page 240)
- print a whiteboard *More*

Saving a presentation, document, or whiteboard

You can save any shared document, presentation, or whiteboard that appears in the content viewer. A saved file contains all the pages or slides in the document, presentation, or whiteboard that is currently displayed in the content viewer, including any annotations and pointers that you or other attendees added to them.

Files that you save are in the Universal Communications Format (UCF), which have a `.ucf` extension. You can open a `.ucf` file either in another training session or at any time outside of a training session.

Once you save a new document, presentation, or whiteboard to a file, you can save it again to overwrite the file or save a copy to another file.

*To save a new document, presentation, or whiteboard that appears in the content viewer:*

1. On the **File** menu, choose **Save > Document**.
   
The Save Document As dialog box appears.
2. Choose a location at which to save the file.
3. Type a name for the file in the **File name** box.

*To save changes to a saved document, presentation, or whiteboard that appears in the content viewer:*

On the **File** menu, choose **Save > Document**.

Training Manager saves the changes to the existing file.
To save a copy of a document, presentation, or whiteboard:

1. On the **File** menu, choose **Save As > Document**.
   
The Save Document As dialog box appears.

2. Do *either or both* of the following:
   - Type a new name for the file.
   - Choose a new location at which to save the file.

**Opening a saved document, presentation, or whiteboard**

If you saved a document, presentation, or whiteboard that appeared in the content viewer during a training session, you can do *either* of the following:

- Open file in the content viewer during another training session for sharing. Only a presenter or participants who have the **Share documents** privilege can open a saved file during a training session.

- Open the file at any time on your computer's desktop. If you open a saved file on your desktop, it appears in the WebEx Document Manager, a standalone, or "offline," version of the content viewer.

A saved document, presentation, or whiteboard is in the saved Universal Communications Format (UCF) and has a **.ucf** extension.

**To open a saved document, presentation, or whiteboard file in the content viewer:**

1. On the **File** menu, choose **Open and Share**.
   
The Share Document dialog box appears.

2. Select the document, presentation, or whiteboard file that you want to open.

3. Click **Open**.

**To open a saved document, presentation, or whiteboard on your computer's desktop:**

Double-click the saved file.

The document, presentation, or whiteboard opens in the WebEx Document Viewer.
Printing presentations, documents, or whiteboards

You can print any shared presentations, documents, or whiteboards that appear in your content viewer. A printed copy of shared content includes all added annotations and pointers.

To print shared content:

1. In the content viewer, select the tab for the document, presentation, or whiteboard that you want to print.
2. On the **File** menu, choose **Print > Document**.
3. Select the printing options that you want to use, and then print the document.

**Note:** When printing shared content in the content viewer, Training Manager resizes it to fit on the printed page. However, for whiteboards, the Training Manager prints only the content that lies within the dashed lines on the whiteboard.

If you are a training session participant...

If you are participating in a training session (and have not taken on another role, such as host or presenter), you can move around independently in shared documents and presentations if the host has assigned these privileges to you. For shared documents, presentations, and whiteboards, you can:

- display any page **More** (on page 241)
- synchronize your view with the host's view **More** (on page 242)
- save shared documents **More** (on page 239)
- open shared documents **More** (on page 240)
- print shared documents **More**

Displaying pages, slides, or whiteboards

*For participants*
If you have been granted the necessary privileges, you can navigate to different pages, slides, or whiteboard “pages” in the content viewer. Each document, presentation, or whiteboard being shared appears on a tab at the top of the content viewer.

1 In the Training Session window, in the content viewer, select the tab for the document, presentation, or whiteboard that you want to display.

If there are more tabs than can appear at one time, select the down arrow button to see a list of remaining tabs, or use your keyboard arrows forward and back through all the tabs.

2 On the toolbar, click a button to change the page or slide you are viewing.

Synchronizing your view of pages, slides, or whiteboards

During a training session, you can synchronize the display of shared content in your content viewer with the display in the presenter’s viewer. This option is useful, for example, if you are viewing a previous slide in a presentation and want to quickly return to the actual slide that the presenter is discussing. Synchronizing your display also resizes it to that in the presenter’s content viewer.

To synchronize your view of shared content in the presentation viewer:

On the View menu at the bottom of the window, select Sync Display With Presenter.
Sharing Software

Sharing a tool, like a software application, works differently from sharing a document or presentation. When you share software during a training session, a sharing window opens automatically on all participant screens. You can show, in this special sharing window:

- **an application** (for example, you want to edit a document as a group or show your team how a tool works)
- **computer desktop** (for easily sharing several applications at once and for sharing file directories open on your computer)
- **web browser** (useful for sharing particular Web pages with participants or showing a private intranet)
- **any application or the desktop on a remote computer with Access Anywhere installed on it** (for example, you are on the road, and the computer in your office has the information you need)

Your site settings and your user role in a training session determines your level of participation in sharing software. Whichever role you take, this table describes the basic tasks associated with that role. For detailed instructions on a particular task, select "More" by the task description.
## Chapter 16: Sharing Software

### Sharing applications

You can use application sharing to show all training session participants one or more applications on your computer. Application sharing is useful for demonstrating software or editing documents during a training session.

<table>
<thead>
<tr>
<th>Role</th>
<th>Task description:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>host and presenter</strong></td>
<td><strong>Share software:</strong></td>
</tr>
<tr>
<td></td>
<td>Share applications <em>More</em>… (on page 244)</td>
</tr>
<tr>
<td></td>
<td>Share your desktop <em>More</em> (on page 248)</td>
</tr>
<tr>
<td></td>
<td>Share a Web browser <em>More</em> (on page 250)</td>
</tr>
<tr>
<td></td>
<td>Share a remote computer <em>More</em> (on page 251)</td>
</tr>
<tr>
<td></td>
<td>Control the appearance of shared software <em>More</em> (on page 261)</td>
</tr>
<tr>
<td></td>
<td>Annotate shared software <em>More</em> (on page 270)</td>
</tr>
<tr>
<td></td>
<td>Let a participant control your shared software <em>More</em></td>
</tr>
<tr>
<td><strong>participant</strong></td>
<td><strong>View and work with shared software:</strong></td>
</tr>
<tr>
<td></td>
<td>Control the appearance of shared software <em>More</em> (on page 267)</td>
</tr>
<tr>
<td></td>
<td>Ask to control shared software <em>More</em> (on page 277)</td>
</tr>
<tr>
<td></td>
<td>Annotate shared software <em>More</em> (on page 270)</td>
</tr>
<tr>
<td></td>
<td>Stop participating in software sharing <em>More</em> (on page 279)</td>
</tr>
</tbody>
</table>
Participants can view the shared application, including all mouse movements without having to run the application that you are sharing on their computers.

**Here are just a few tasks you can perform:**

- Start sharing an application *More* (on page 245) and open more applications to share *More* (on page 246)
- Control the appearance and viewing of shared software (pausing, changing to full-screen view, and so on) *More* (on page 261)
- Annotate and draw on a shared application *More* (on page 270) and allow participants to draw *More*
- Learn about sharing application effectively *More* (on page 283)
- Stop sharing an application *More* (on page 247)

**Starting application sharing**

*Host or Presenter only*

You can share any application on your computer with training session participants.

**To share an application:**

1. On the *Share* menu, choose *Application*.

   The list of all applications currently running on your computer is displayed.
2 Do one of the following:

- If the application you want to share is currently running, select it in the list to begin sharing it.

- If the application you want to share is not currently running, select Other Application. The Other Application dialog box appears, showing a list of all applications on your computer. Select the application, and then select Share.

Your application appears in a sharing window on participant screens.

For tips that can help you to share applications more effectively, see Tips for Sharing Software (on page 283).

Sharing several applications at once

Host or Presenter only

If you are already sharing an application, you can share additional applications simultaneously. Each application that you share appears in the same sharing window on participant screens.

To share an additional application:

Select the application you want to share:

- If that application is currently running: Select the Share button.

Tip: When you open any application that you have minimized, it opens with the sharing buttons in the upper-right corner.

- If the application is not currently running: Select the Share Application button in the Session Controls Panel. You can also find it using File Explorer or any other tool you use to locate applications on your computer. When you open it, it appears with the Share button.

Your application appears in a sharing window on participant screens.

Training Center tracks the number of applications you are currently sharing:
Chapter 16: Sharing Software

The Share button to the right of Pause lets you select the different types of content you want to share.

Tip: Alternatively, you can share multiple applications by sharing your computer’s desktop. For details, see Sharing your desktop. (on page 248)

Stopping application sharing for all participants

*Host or Presenter only*

You can stop sharing an application at any time. Once you stop sharing an application, participants can no longer view it.

If you are sharing multiple applications simultaneously, you can stop sharing either a specific application or all applications at once.

To stop sharing a specific application when sharing multiple applications:

On the title bar of the application that you no longer want to share, select the Stop button, or in the Session Controls Panel, select the STOP button.

To stop sharing all applications:

In the Session Controls Panel, select the STOP button.

You can also pause sharing: Select the Pause button (located next to the Stop button).
Sharing your desktop

You can share the entire content of your computer, including any applications, windows, and file directories that reside on it. Participants can view your shared desktop, including all mouse movements.

Tasks related to sharing your desktop:

- Start sharing your desktop More (on page 248)
- Manage how participants view your shared software (pausing, changing to full-screen view, and so on) More (on page 261)
- Annotate and draw on your desktop More (on page 270) and allow participants to annotate More
- Read a few tips for sharing your desktop effectively More (on page 283)
- Stop sharing your desktop More (on page 249)
- Allow a participant to control the shared desktop More…

Starting desktop sharing

Host or Presenter only

You can share your computer's desktop with training session participants.

To share your desktop:


   If you have more than one monitor, a submenu shows the available monitors.
2 Select the monitor to share.

Your desktop appears in a sharing window on participants' screens.

For ideas that can help you to share your desktop more effectively, see *Tips for Sharing Software*. (on page 283)

**Note**: If your desktop has any background images or patterns, or wallpaper, your Training Manager software may remove them from participant views to improve the performance of desktop sharing.

## Stopping desktop sharing

You can stop desktop sharing at any time.

**To stop sharing your desktop:**

In the Session Controls Panel, select the **Stop** button.

You can also pause sharing: Select the **Pause** button (located next to the **Stop** button).

If you are a participant, rather than the presenter, select the **Return** button to leave the sharing session.
Sharing a Web browser

A presenter uses Web browser sharing to show all training session participants all Web pages that he or she accesses in a browser. Web browser sharing is useful for showing participants Web pages on the Internet, or the presenter's private intranet or computer.

Participants can view the presenters Web browser, including mouse movements, in a sharing window on their screens.

Tasks related to sharing a Web browser:
- Start sharing a web browser *More* (on page 250)
- Manage how participants view the shared Web browser *More*
- Annotate and draw on a shared Web browser *More* and let a participant draw on a shared Web browser *More*
- Learn how to share Web browsers effectively *More* (on page 283)
- Stop sharing a Web browser *More* (on page 251)

Starting Web browser sharing

*Host or Presenter only*

You can share a Web browser with training session participants.

To share a Web browser:
   
   Your default Web browser opens.
2. Go to a Web page in your browser.
Note: Participants view all new Web browser windows that you open. You can show participants several Web pages simultaneously.

Stopping Web browser sharing

You can stop sharing a Web browser at any time.

To stop Web browser sharing:

On the title bar of the application that you no longer want to share, select the Stop button.

Tip: You can temporarily pause Web browser sharing, rather than stopping Web browser sharing. For details, see Pausing and resuming software sharing (on page 262).

Sharing a remote computer

A presenter uses remote computer sharing to show all training session participants a remote computer. Depending on how the remote computer is set up, the presenter can show the entire desktop or just specific applications. Remote computer sharing is useful to show participants an application or file that is available only on a remote computer.

Participants can view the remote computer, including all the presenter's mouse movements, in a sharing window on their screens.

As presenter, you can share a remote computer during a training session if:

- You have installed the Access Anywhere Agent on the remote computer
- You logged in to your Training Center Web site before joining the training session, if you are not the original training session host

For information about setting up a computer for remote access, refer to the Access Anywhere User's Guide.
Chapter 16: Sharing Software

Tasks related to sharing a remote computer:

- Start sharing a remote computer \textit{More} (on page 252)
- Manage how and what participants view on the shared remote computer (pausing, changing to full-screen view, and so on) \textit{More} (on page 261)
- Change settings on a remote computer while sharing it \textit{More} (on page 255)
- Stop sharing a remote computer \textit{More} (on page 254)

Starting remote computer sharing

\textit{Host or Presenter only}

If you have already set up a computer for Access Anywhere, you can share the computer during a training session.

\textbf{To share a remote computer:}

1. On the \textbf{Share} menu, choose \textbf{Remote Computer}.
2. The Access Anywhere dialog box appears.

3. Under \textbf{Remote Computers}, select the computer you want to share.
4. Under \textbf{Applications}, select an application that want to share.

   If you set up the remote computer so you can access its entire desktop, the option \textbf{Desktop} appears under Applications.
Select Connect.

Depending on the authentication method you chose when you set up the computer for Access Anywhere, you perform one of these tasks:

- **If you chose access code authentication**: You enter the access code you typed when you set up the remote computer.
- **If you chose phone authentication**: You receive a phone call at the number that you entered when you set up the remote computer.

Complete your authentication.

- **If you chose access code authentication**: Type your access code in the box, and then select OK.
- **If you chose phone authentication**: Follow the voice instructions.

**Note:**

- If you are not the original training session host, you must log in to your Training Center Web site before joining a training session in which you want to share a remote computer. If you are already in a training session, but did not log in to your site, you must leave the training session, log in to your site, and then rejoin the training session.
- If a password-protected screen saver is running on the remote computer, your training session service automatically closes it once you provide your access code or pass code.
- If the remote computer is running Windows 2000, and you must log in to the computer, send a Ctrl+Alt+Del command to the computer.
- If you set up the remote computer so you can access multiple applications, you can share additional applications simultaneously.

### Sharing additional applications on a shared remote computer

*Host or Presenter only*

While sharing a remote computer on which you have specified that you can access only specific applications rather than its entire desktop, you can share additional applications on the remote computer. Training Session participants can view all shared applications simultaneously.
To share an additional application on a shared remote computer:

1. On the Session Controls Panel, select the down arrow button (it is the last button on the Session Controls Panel). Then choose **Share Remote Application**.

2. In the Select Application box, select the application you want to share.

   Example: You opened the **Paint** application first. Then you chose **Notepad** from the Select Application box. Both applications remain open on the shared desktop.

3. Select **OK**.

**Stopping remote computer sharing**

*Host or Presenter only*
You can stop sharing a remote computer during a training session at any time. Once you stop sharing a remote computer, the Access Anywhere Server disconnects your local computer from the remote computer. The remote computer remains logged into the Access Anywhere Server, so you can access it again at any time.

**Before you stop remote computer sharing:**

To ensure your privacy and the security of your remote computer, do one of the following:

- Close any applications that you started during the sharing session.
- If the remote computer is running Windows 2000, and you have administrator rights on the computer, log off from or lock the computer. To access these options on the computer, send a Ctrl+Alt+Del key combination to the remote computer. *More…* (on page 260)
- Specify a screen saver password, and set the screen saver to appear after short period of inactivity—for example, 1 minute.
- Shut down the computer, if you do not plan to access it again remotely.

**To stop remote computer sharing:**

On the Session Controls Panel, select **Stop Sharing**.

![Sharing Controls Panel](image)

Sharing stops and you return to Training Session Manager.

**Managing a shared remote computer**

*Host or Presenter only*

While sharing a remote computer during a training session, you can manage the remote computer by setting options and sending commands.

**Options you can set:**

- Disable or enable the keyboard and mouse on the remote computer. *More* (on page 257)
Chapter 16: Sharing Software

- Reduce the screen resolution on the remote computer to match that of your computer, or restore the resolution on the remote computer More (on page 256)
- Adjust the size of the view of the remote computer that appears in the sharing window, including zooming in to and out from the view and scaling the view to fit the sharing window More (on page 258)
- Hide or display the contents on the remote computer's screen at the remote location More (on page 259)

Note: Any changes that you make to options affect the remote computer only during the current sharing session. The changes do not affect the default options that you set for the remote computer in the Access Anywhere Agent preferences.

Commands you can send:
- Ctrl+Alt+Del key combination, which allows you to access options to log in to, log out from, lock, or unlock a Windows PC More (on page 260)
- A command to bring remote applications to the front of your screen, if they are either behind other applications or minimized More (on page 260)

Reducing the screen resolution for a shared remote computer

While sharing a remote computer, you can reduce the screen resolution on the remote computer. This option helps to prevent the need to scroll while viewing the desktop or applications on the remote computer. The reduced screen resolution also appears in all participant sharing windows. You can return a remote computer's screen resolution to its original setting at any time during a remote access session.

To reduce the screen resolution on a remote computer:

On the Session Controls Panel, select the down arrow button (it is the last button on the Session Controls Panel). Then choose Reduc Screen Resolution to Match This Computer.
Chapter 16: Sharing Software

Note:

- If you reduce the screen resolution a remote computer during a sharing session, the Access Anywhere Agent restores the resolution to its original setting once you end the session.
- You can specify whether or not the remote computer's screen resolution is reduced automatically once you connect to the computer remotely. For details, refer to the Access Anywhere User's Guide.

**Disabling and enabling the keyboard when sharing a remote computer**

*Host or Presenter only*

While sharing a remote computer, you can disable the keyboard and mouse on the remote computer, thereby preventing anyone from using the computer while you are accessing it remotely. You can re-enable a remote computer's keyboard and mouse at any time.

**To disable or enable a remote computer's keyboard and mouse:**

On the Session Controls Panel, select the down arrow. Then choose **Disable Keyboard and Mouse**.
Chapter 16: Sharing Software

The down arrow is located at the end of the Session Controls Panel.

A check mark next to the command indicates that the keyboard and mouse are disabled. If no check mark appears, the keyboard and mouse are enabled.

**Note:**
If you disable a remote computer's keyboard and mouse during a sharing session, the Access Anywhere Agent re-enables them once you end the session.
You can specify whether or not the remote computer's keyboard and mouse are disabled automatically once you connect to the computer remotely. For details, refer to the *Access Anywhere User's Guide*.

Adjusting the size of the view of a shared remote computer

*Host or Presenter only*
While sharing a remote computer, you can adjust the size of the shared view using one of these methods:

- Select a preset percentage at which to view the remote computer.
- Zoom in to and out from the remote computer in increments.
- Scale the remote computer view to fit the sharing window in which it appears.
To adjust the size of the view of a shared remote computer:

On the Session Controls Panel, select the down arrow (the last button on the panel) and then choose View. Choose a display option from the menu.

Hiding the contents on a shared remote computer's screen

Host or Presenter only

While sharing a remote computer, you can make a remote computer's screen blank, thereby preventing anyone at the remote computer's location from viewing the contents of the screen. If the contents on a remote computer's screen are hidden, you can display them at any time.

To hide or display the contents on a remote computer's screen:

On the Session Controls Panel, select the down arrow (the last button on the panel) and then choose Make Screen Blank.

A check mark next to the command indicates that the contents on the remote computer's screen are not visible. If no check mark appears, the contents on the remote computer's screen are visible.

Note:
If you make a remote computer's screen blank during a sharing session, the Access Anywhere Agent displays the contents on the screen once you end the session.

You can preset the remote computer screen to be blank after you connect to it. For details, refer to the Access Anywhere User's Guide.

Sending a Ctrl+Alt+Del command to a shared remote computer

*Host or Presenter only*

While sharing a remote computer that is running Windows, you can send a Ctrl+Alt+Del command to the computer to access options that let you:

- **Log in** to the computer
- **Log out** from the computer
- **Lock** the computer
- **Unlock** the computer

**To send a Ctrl+Alt+Del command to a shared remote computer:**

On the Session Controls Panel, select the down arrow (the last button on the panel) and then choose **Make Screen Blank. Send Ctrl+Alt+Del.**

Selecting an application on a shared remote computer

*Host or Presenter only*

If you have set up a remote computer to share only selected applications, rather than the entire desktop, you can only work with one application at a time. You can easily switch and share a different application.

**To choose a different application to share:**

On the Training Session Controls panel, select the down arrow. Then choose **Share Remote Application.**

Select the application you want to share from the list of available application.
### Controlling views of shared software

<table>
<thead>
<tr>
<th>Role</th>
<th>Task description:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host or Presenter</td>
<td>Pause or resume sharing More</td>
</tr>
<tr>
<td></td>
<td>Control full-screen view of shared software More (on page 261)</td>
</tr>
<tr>
<td></td>
<td>Synchronize views More (on page 264)</td>
</tr>
</tbody>
</table>

#### Table

<table>
<thead>
<tr>
<th>Role</th>
<th>Share</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host or Presenter</td>
<td>View</td>
</tr>
<tr>
<td></td>
<td>My Desktop</td>
</tr>
<tr>
<td></td>
<td>File (Including Video)... Ctrl+Alt+O</td>
</tr>
<tr>
<td></td>
<td>Application</td>
</tr>
<tr>
<td></td>
<td>Whiteboard</td>
</tr>
<tr>
<td></td>
<td>Web Content...</td>
</tr>
<tr>
<td></td>
<td>Web Browser</td>
</tr>
<tr>
<td></td>
<td>Remote Computer...</td>
</tr>
<tr>
<td></td>
<td>My Meeting Window</td>
</tr>
</tbody>
</table>
The presenter can control participant views of a **shared desktop**, **remote computer** (if available), **application** or **Web browser**.

Participants can manipulate their individual displays of the shared software.

### Pausing and resuming software sharing

*Host or Presenter only*

While sharing software, you can temporarily pause sharing to freeze attendees' views.

If you want to return attendees to the Training Session window while sharing software, pausing shared software conserves resources on your computer and bandwidth for your Internet connection. This option is also useful if you do not want attendees to see certain actions that you take with shared software.

You can resume sharing to restore attendees' views of shared software at any time.

**To pause software sharing:**

Select the **Pause** button, located to the right of the **Stop** button.
The word "Paused" now appears in the panel. A short message is displayed indicating that the participant view would be frozen until you resume sharing. Additionally, the Pause button text changes to Resume.

To resume software sharing:
Select the Resume button.

Controlling full-screen view of shared software

*Host or Presenter only*

You can switch participant views of a shared application, remote computer (if available), or Web browser between a standard window and a full-screen view.

A full-screen view of shared software fits participant entire screens and does not include a title bar or scroll bars.

Participants can override your setting to control full-screen view or to zoom in or out on the shared software on their computers.

**To display shared software in a full-screen view:**

On the Session Controls Panel, select the down arrow (the last button on the panel) and then choose View. Then choose Full screen for Participants.
To see panel controls, select the gray down-arrow button (it is the last button).
Synchronizing views of shared software

*Host or Presenter only*

While sharing an application, desktop (if desktop sharing is available), or Web browser, you can synchronize all participant views of the software with your view.

Synchronizing views of shared software ensures that the sharing window appears as the active window on participant screens. For example, if a participant has minimized the sharing window, or moved another window on top of it, the sharing window becomes the active window when you synchronize views.

**Note:** Synchronizing views has no effect on the size in which the shared software appears on participant screens. Participants can control the size of their views independently.

**To synchronize your view with participants:**

On the Session Controls Panel, select the down arrow (the last button on the panel) and then choose **View**. Then choose **Synchronize for All**.

---

Selecting a monitor to share

**To select a monitor to share:**

1. Start sharing your desktop:
   - On the Quick Start page, select **Share Desktop**.
     
     If two or more monitors are detected on your system, a window appears and allows you to select one of the monitors.
On the Share menu, select Desktop. A submenu shows the available monitors.

2 Select the monitor you want to share.

The Session Controls Panel indicates which monitor you are sharing. If you are sharing the same monitor where the Session Controls Panel is, it says, “You are sharing this monitor.”

If you are sharing a monitor that is not the same monitor where the Session Controls Panel is, it says, “You are sharing monitor <number>.”

In addition, a green border appears around the monitor you are sharing.
To select a different monitor to share:

1. On the Meeting Control Panel, select the Select Content to Share button.

2. In the submenu that appears, select Share Desktop. A submenu shows you the available monitors.

3. Select the monitor number you want to share.

The Session Controls Panel indicates which monitor you are sharing. In addition, a green border appears around the monitor you are sharing.

Controlling your view as a participant

**Participant only**

When viewing or remotely controlling shared software, you can set these options, which determine how shared software appears on your screen:

- Display the shared software in a full-screen view or a standard window. A full-screen view of a shared application or desktop fits your entire screen and does not include a title bar or scroll bars.
- Scale, or resize, a shared desktop or application to fit the full-screen view or standard window in which it appears.

To control your view of shared software:

On the Session Controls Panel, select the down arrow (the last button on the panel) and then choose View. Then choose an option from the menu.
Chapter 16: Sharing Software

Tip: To switch quickly from the standard window to a full-screen view of shared software, double-click the shared software.

Closing your participant sharing window

Participant only

While viewing or remotely controlling shared software, you can close the sharing window in which the software appears at any time. Closing a sharing window returns you to the Training Session window. If you close a sharing window, you can reopen it at any time.

To close a sharing window:

1. On the Session Controls Panel, select the down arrow (the last button on the panel) and then choose Stop <option> from the menu. The following graphic shows the Stop Application Sharing option because an application has been shared. If you have shared your desktop or Web Browser, the menu would show Stop Desktop Sharing.
2 Choose the appropriate option.

The sharing window closes. The Training Session window then automatically opens.

**To return to the sharing window at any time:**

In the Training Session window, on the **Sharing** menu, select a sharing option (desktop, remote computer, application or Web browser).

**Switching your participant view**

*Participant only*

While a presenter is sharing software, you can return to the Training Session window at any time. The sharing window remains open on your computer, so you can return to viewing the shared software at any time.

**To return to the Training Session window while the presenter is sharing software:**

On the Session Controls Panel, select the **Return to Training Session Window** icon.

The Training Session window then appears.
To return to a sharing window:

In the Application Share dialog box, which appears in the Training Session window, select **Return to Sharing**.

### Annotating shared software

<table>
<thead>
<tr>
<th>Task description:</th>
<th>Host or Presenter</th>
<th>Participant</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start or stop annotation mode</td>
<td>More (on page 271)</td>
<td>Ask for permission to use annotation</td>
</tr>
<tr>
<td>Use annotation tools</td>
<td>More (on page 272)</td>
<td>Use annotation tools</td>
</tr>
<tr>
<td>Let a participant use annotation</td>
<td>More</td>
<td>Save annotations</td>
</tr>
<tr>
<td>Save annotations</td>
<td>More (on page 276)</td>
<td>Give up annotations</td>
</tr>
</tbody>
</table>

You can annotate a shared **desktop**, **application** or **Web browser** during a training session, using the highlighter or other annotation tool.

Training Session participants can see annotations in their sharing windows.
Starting and stopping annotation

*Host or Presenter only*

When you are sharing a **desktop, application** or **Web browser**, you can make annotations on the software.

Participants can see all your annotations.

**To start annotating shared software:**

1. On the Training Session Controls panel, select the **Annotate** button.

   ![Annotation button](image)

   The **Annotation** button has the image of a pencil on it.

   The Tools panel appears.

2. Select a tool for making annotations.

   For details about annotation tools, see *Using annotation tools* (on page 272).

   ![Annotation Tools panel](image)

   **Note:**

   You can let one or more participants annotate the shared software. For details, see *Letting a participant annotate shared software*.

   Once you or a participant makes annotations, you can save an image of the software, including the annotations. For details, see *Taking a screen capture of annotations on shared software* (on page 276).

To stop making annotations on shared software and return your mouse to a normal pointer, you must stop annotation mode.

**To stop annotation mode:**

Select the **Stop Annotating** button in the **Tools** panel.
Using annotation tools

If, while sharing software, you are the presenter or the presenter allows you to annotate, you can use the Annotation Tools panel that appears to make annotations. The Annotation Tools panel provides a variety of tools for annotating a shared desktop or application.

<table>
<thead>
<tr>
<th>Annotation Tool</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pointer</td>
<td>🔄️</td>
<td>Lets you point out text and graphics on shared content. The pointer displays an arrow with your name and annotation color. To display the laser pointer, which lets you point out text and graphics on shared content using a red &quot;laser beam,&quot; click the downward-pointing arrow. Clicking this button again turns off the pointer tool.</td>
</tr>
<tr>
<td>Text</td>
<td>📝</td>
<td>Lets you type text on shared content. Participants can view the text once you finish typing it and click your mouse in the content viewer, outside the text box. To change the font, on the Edit menu, choose Font. Clicking this button again turns off the text tool.</td>
</tr>
<tr>
<td>Line</td>
<td>📌</td>
<td>Lets you draw lines and arrows on shared content. For more options, click the downward-pointing arrow. Clicking this button closes the Rectangle tool.</td>
</tr>
<tr>
<td>Rectangle</td>
<td>☐</td>
<td>Lets you draw shapes, such as rectangles and ellipses on shared content. For more options, click the downward-pointing arrow. Clicking this button again closes the Rectangle tool.</td>
</tr>
<tr>
<td>Annotation Tool</td>
<td>Icon</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td>Highlighter</td>
<td>🆙</td>
<td>Lets you highlight text and other elements in shared content. For more options, click the downward-pointing arrow. Clicking this button again closes the Highlighter tool.</td>
</tr>
<tr>
<td>Annotation Color</td>
<td>📈</td>
<td>Displays the Annotation Color palette, on which you can select a color to annotate shared content. Clicking this button again closes the Annotation Color palette.</td>
</tr>
<tr>
<td>Eraser</td>
<td>🗑</td>
<td>Erases text and annotations or clears pointers on shared content. To erase a single annotation, click it in the viewer. For more options, click the downward-pointing arrow. Clicking this button again turns off the eraser tool.</td>
</tr>
</tbody>
</table>

**Letting a participant annotate shared software**

*Host or Presenter only*

You can let one or more training session participants annotate a shared **desktop** (if available), **application** or **Web browser**.

You can let several participants annotate shared software at the same time.

**To let a participant annotate shared software:**

1. On the Session Controls Panel, select the **Annotate** icon.

   The tools panel appears.

2. Select the down arrow on the **Allow to Annotate** button.
3 On the menu that appears, choose which participants can annotate the shared software:

You can choose "All" or select someone from the list.

**Note:**
You can stop a participant from annotating shared software at any time. For details, see *Stopping a participant from annotating shared software.* (on page 275)

---

### Requesting annotation control of shared software

**Participant only**

If a presenter is sharing a desktop, Web browser or application, you can ask the presenter to allow you to annotate the shared software.

After you have permission, you can:

- Make annotations by highlighting areas on the software, drawing lines and shapes, typing text, and using pointers.
- Clear annotations at any time.
- Change the color that you are using to make annotations.
- Save an image of your annotations on the shared software.

**To request annotation control of shared software:**

1 In the Session Controls Panel, select the **Annotate** button.

The **Annotate** button has the image of a pencil on it.

A request message appears on the presenter's screen.

After the presenter allows you to annotate, the Annotation Tools panel appears:
2 Select the tool you want to use.

3 Optional. Choose another annotation tool. For details, see *Using annotation tools* (on page 272).

**Note:** If you are controlling shared software remotely, the presenter must take back control to turn on annotation mode. You and the presenter can then annotate the shared software simultaneously.

### Giving up annotation control

*Participant only*

If the presenter has granted permission to you to annotate, you can stop annotating at any time.

**To stop annotating:**

In the Annotation Tools panel, select the **Stop Annotating** button.

### Stopping an participant from annotating shared software

*Host or Presenter only*

If a participant is annotating shared software, you can turn off the annotation feature.

**To turn off the drawing feature:**

1 On the Session Controls Panel, select the **Assign Control** button.
2 On the menu that appears, choose **Allow to Annotate**.  
A check mark appears next to the names of those who can annotate the shared software.  
3 Choose the name of the participant to cancel the selection.

**Taking a screen capture of annotations on shared software**

If you make annotations on shared software, you can save an image of the shared software, including all annotations and pointers, to a WebEx Universal Communications Format (.ucf) file. You can open a .ucf file on your computer desktop or in the content viewer in a training session.

*Note:* Participants cannot use this option unless the Host or Presenter grants the **Screen Capture** privilege to them. As Host, if you are sharing proprietary software, you may want to ensure that this privilege is turned off.

**To take a screen capture of annotations on shared software:**

1 On the Tools panel, select the **Screen Capture** button.

The Save As dialog box appears.

2 Choose a location at which to save the file, and then select **Save**.

*Note:* The file you save is an image of your entire desktop.
Granting participants control of shared software

While sharing the following types of software, the presenter can let a participant control it remotely:

- Application
- Desktop (if available)
- Web browser

A participant who has remote control of shared software can interact with it fully. While a participant is controlling shared software, the presenter's mouse pointer is inactive.

Rules of thumb for controlling shared software:

- Any participant can send a request to control the software remotely. More (on page 277)
- The presenter can then grant control to the participant. More (on page 278)
- Alternatively, the presenter can automatically grant control of shared software to any participant who requests remote control. More (on page 279)
- The presenter can stop a participant from remotely controlling shared software at any time. More (on page 279)

Caution: A participant who has remote control of the presenter's desktop can run any programs and access any files on the computer that the presenter has not protected with a password.

Requesting remote control of shared software

Participant only

If the presenter is sharing an application, desktop, or Web browser, you can ask the presenter to grant remote control to you.

Once you assume remote control of shared software, you can interact with it fully.
Chapter 16: Sharing Software

To request remote control of shared software:

On the Session Controls Panel select Ask to Control.

A request message appears on the presenter’s screen.

Tip: While remotely controlling shared software, you can request the presenter to allow you to annotate it. For details, see Requesting annotation control of shared software. (on page 274)

Letting a participant remotely control shared software

Host or Presenter only

If you are sharing software, you can let a participant control it remotely.

To let a participant remotely control shared software:

1. On the Session Controls Panel select the down-arrow button on the Assign button.

This button is the third button from the left on the Controls panel.

2. On the menu that appears, choose Pass Keyboard and Mouse Control > [name of participant].
Automatically letting participants remotely control shared software

*Host or Presenter only*

While sharing software, you can automatically grant control of the software to a participant who requests control. In this case, a participant who requests remote control automatically takes control of the software that you are sharing. While automatic remote control is turned on, any participant can take control away from any other participant by requesting remote control.

**To automatically let participants control shared software:**

1. On the Session Controls Panel select the down-arrow button on the Assign button.

2. On the menu that appears, choose **Pass Keyboard and Mouse Control > Auto Accept All Requests**.

**To stop letting participants control shared software automatically:**

1. On the Session Controls Panel select the down-arrow button on the Assign button.

2. On the menu that appears, choose **Pass Keyboard and Mouse Control**. Then select **Auto Accept All Requests** to remove the check mark and cancel the selection.

Stopping remote control of shared software

*Host or Presenter only*
While a participant is remotely controlling a shared application, desktop, or Web browser, you can take back control of the shared software at any time. You can do either of the following:

- Take back remote control of shared software temporarily, allowing a participant to take control at any time.
- Prevent a participant from further controlling shared software.

**To take back control a shared software temporarily:**

On your computer's desktop, select your mouse.

You can now control the shared software.

The participant who was controlling the shared software can take back control at any time by clicking his or her mouse.

**To prevent a participant from further controlling a shared software:**

1. On your computer's desktop, click your mouse.

   You can now control the shared software.

   On the Session Controls Panel select the down-arrow button on the **Assign** button.

2. On the menu that appears, choose **Pass Keyboard and Mouse Control**.

   A menu appears, containing a list of all participants in the training session. A check mark appears to the left of the participant who has remote control.

3. Choose the participant's name to remove the check mark and cancel the selection.
Sharing applications with detailed color (Windows)

*For Windows users only*

By default, Training Manager sends images of shared software using 16-bit color mode, which is the equivalent of your computer’s “High Color” (16-bit) setting. This mode provides an accurate representation of color for most shared applications. However, if your shared application contains detailed color images—such as color gradients—the color may not appear accurately on participants' screens. For example, color gradients may appear and color “bands.”

If the accuracy and resolution of color in a shared application is important, you can turn on True Color mode in Training Manager. Using this mode, however, may affect the performance of application sharing.

When using True Color mode, you can select one of the following options:

- Better imaging (no image compression)
- Better performance (some image compression)

“Performance” refers to the “speed” at which images appear on participant screens, and “imaging” refers to the quality of the color in shared images.

**Note:** Before turning on True Color mode, ensure that your monitor display is set to True Color (either 24- or 32-bit color). For more information about setting options for your monitor, refer to Windows Help.

**To turn on True Color mode:**

1. If you are currently sharing an application, stop your sharing session.
2. On the **Training Session** menu, choose **Training Session Options**.
   The Training Session Options dialog box appears.
3. Select the **True Color Mode** tab.
4. Select **Enable True Color mode**.
5. Select one of the following options:
   - **Better imaging**
   - **Better performance**
6. Select **OK** or **Apply**.
Sharing applications with detailed color (Mac)

For Mac users only

Before sharing an application or your desktop, you can choose one of the following display modes:

- **Better performance**: The default mode. Lets you display your content faster than you do using the better image quality mode.

- **Better image quality**: Lets you display your content with better image quality. In this mode, your shared content may take longer time to display than in the better performance mode.

*Note:* Changing the display mode does not affect presentation or document sharing.

To choose a display mode for your shared desktop or applications:

1. In the Training Session window, on the *Training Center* menu, choose *Preferences*.
   
The Preferences dialog box appears.

2. Select *Display*.

3. Select **Better performance** or **Better image quality**, as appropriate.
Tips for sharing software

The following tips can help you to share software more effectively:

- **Application sharing only:** To save time during a training session, ensure that any applications you intend to share are open on your computer. At the appropriate time during the training session, you can then quickly begin sharing an application, without waiting for the application to start.

- If participants cannot see all of the shared software without scrolling their sharing windows, they can adjust their views of the shared software. They can reduce the size of the shared software in decrements, or scale it to fit inside their sharing windows.

- To improve the performance of software sharing, close all applications that you do not need to use or share on your computer. Doing so conserves processor usage and memory on your computer, thus helping to ensure that Training Manager can send images of shared software quickly during a training session. Also, to ensure that a maximum amount of bandwidth is available for software sharing, close any applications that use bandwidth, such as instant messaging or chat programs, and programs that receive streaming audio or video from the Web.

- If you are sharing an application for which the rendering of color on participants' screen is important, you can improve color quality by turning on True Color mode. For details, see *Sharing applications with detailed color* (on page 281).

- **Application and Web browser sharing only:** Avoid covering a shared application or Web browser with another window on your computer's desktop. A crosshatched pattern appears in participant sharing windows where the other window is covering the shared application or browser.

- **Application and Web browser sharing only:** If you want to switch your display between shared software and the Training Session window, you can pause software sharing before you return to the Training Session window, and then resume sharing once you return to the shared application. Pausing software sharing conserves processor usage and memory on your computer while you view the Training Session window. For details, see *Pausing and resuming software sharing*. (on page 262)

- **Application and Web browser sharing only:** If you have more than one monitor, when you share an application or web browser, the participants can see it on whichever monitor you are displaying it. If you move the application or Web browser to another monitor, it is still visible to the participants. If you are sharing
more than one application, the participants will see the best view if you make sure the applications are displaying on the same monitor.

- Because software sharing requires additional bandwidth during a training session, it is recommended that you use a dedicated, high-speed Internet connection when sharing software. However, if participants are using dial-up Internet connections, they may notice a delay in viewing or controlling shared software. If you want to share a document, such as a Microsoft Word or Excel document, you can improve the training session experience for these participants by using document sharing instead of application sharing.
Sharing Web Content

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of sharing Web content</td>
<td>About sharing Web content (on page 285)</td>
</tr>
<tr>
<td>share Web content with meeting participants</td>
<td>Sharing Web content (on page 286)</td>
</tr>
<tr>
<td>understand the differences between sharing a browser and sharing Web content</td>
<td>Differences between sharing Web content and sharing a Web browser (on page 286)</td>
</tr>
</tbody>
</table>

**About sharing Web content**

You can share Web content that resides on:

- The public Internet or Web
- Your company's intranet
- Your computer or another computer on your private network

Web content includes:

- Web pages, including pages that contain embedded media files, such as Flash, audio, or video files
- Standalone media files, such as Flash, audio, or video files

The Web content that you share opens in the content viewer on each participant's screen. If you share a Web page, participants view and interact independently with the content on the page. If the page contains links to other pages, they can also navigate independently to those pages.
If you use Web content sharing, then, participants can experience audio and video effects on a Web page. However, unlike Web browser sharing, this option does not allow you to guide participants to other Web pages. For more information, see Differences between sharing Web content and sharing a Web browser (on page 286).

**Important:** If you share content that requires a media player, participants can view and interact with the content only if the appropriate player is installed on their computers.

## Sharing Web content

You can share a Web page that contains multimedia effects. The page opens in the content viewer on each participant's screen.

**To share Web content:**

1. On the **Share** menu, choose **Web Content**. The Share Web Content dialog box appears.
2. In the **Address** box, enter the address, or URL, at which the content resides. Or, if you have previously shared the content, select it in the drop-down list.
3. In the **Type** box, select the type of Web content that you want to share.
4. Click **OK**.

**Tip:** You can copy a URL from any source, such as another browser window, and then paste it in the **Address** box.

## Differences between sharing Web content and sharing a Web browser

Training Center provides two options for sharing Web-based information. You can share Web content or share a Web browser with training session participants. Choose the feature that better suits your needs.
### Chapter 17: Sharing Web Content

<table>
<thead>
<tr>
<th>Sharing option</th>
<th>Advantages</th>
<th>Disadvantages</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web browser sharing</td>
<td>Lets you guide participants to various Web pages and sites on the Web.</td>
<td>Does not display media effects or transmit sounds on Web pages.</td>
</tr>
<tr>
<td></td>
<td>Lets you grant attendees control of your Web browser.</td>
<td>Does not let participants interact with Web pages independently.</td>
</tr>
<tr>
<td></td>
<td>Lets you and other participants annotate Web pages.</td>
<td></td>
</tr>
<tr>
<td>Web content sharing</td>
<td>Displays Web pages, and lets participants experience media effects on Web pages, including video and sound.</td>
<td>Does not let you guide participants to other Web pages.</td>
</tr>
<tr>
<td></td>
<td>Lets participants interact with Web pages independently in their content viewers.</td>
<td></td>
</tr>
</tbody>
</table>
During a training session, you can publish files that reside on your computer. Training Session participants can then download the published files to their computers or local servers. Publishing files is useful if you want to provide participants with a document, a copy of your presentation, an application, and so on.

Files that you publish reside only on your computer - not on a server. Thus, your published files are always protected from unauthorized access during a training session.
Publishing files during a Training Session

During a training session, you can publish files that reside on your computer, and training session attendees can download the files to their computers or local servers.

**To publish files during a training session:**

1. In the Session window, on the **File** menu, choose **Transfer**.
   
The File Transfer window appears.

2. Click **Share File**.
   
The Open dialog box appears.

3. Select the file that you want to publish.

4. Click **Open**.
   
The file appears in the File Transfer window.
   
The file is also now available in each attendee's File Transfer window.

5. Optional. Publish additional files that you want attendees to download.

   **Note:** The number of attendees that have the File Transfer window open, including you, appears in the lower-right corner of the File Transfer window.

**To stop publishing files during a training session:**

In the title bar of the File Transfer window, click the **Close** button.

Training Manager closes the File Transfer window in each attendee's Session window.
Chapter 18: Transferring and Downloading Files During a Training Session

Downloading Files During a Training Session

If a presenter publishes files during a training session, the File Transfer dialog box automatically appears in your Session window. You can then download the published files to your computer or a local server.

To download files during a training session:

1. In the File Transfer window, select the file that you want to download.

2. Click Download.

   The Save As dialog box appears.

3. Choose a location at which to save the file.

4. Click Save.

   The file downloads to your selected location.

5. If applicable, download additional files.

6. Once you finish downloading files, in the title bar of the File Transfer window, click the Close button.

   **Note:** To reopen the File Transfer window at any time, from the File menu, choose Transfer. This option is available only if the presenter is currently publishing files.
Polling Attendees

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of polling attendees</td>
<td><em>About polling attendees</em> (on page 293)</td>
</tr>
<tr>
<td>prepare a poll questionnaire</td>
<td><em>Preparing a poll questionnaire</em> (on page 294)</td>
</tr>
<tr>
<td>take a poll during a training session</td>
<td><em>Answering polls</em> (on page 301)</td>
</tr>
<tr>
<td>view or share poll results during a training session</td>
<td><em>Viewing and sharing poll results</em> (on page 302)</td>
</tr>
<tr>
<td>save or open poll questionnaires or results</td>
<td><em>Saving and opening poll questionnaires and results</em> (on page 304)</td>
</tr>
</tbody>
</table>

**About polling attendees**

During a training session, you can poll attendees by presenting them with a questionnaire on which they can select multiple-choice answers. Taking a poll can be useful for gathering feedback from attendees, allowing attendees to vote on a proposal, testing attendees’ knowledge of a topic, and so on.

To take a poll, you must first prepare a poll questionnaire. You can prepare a questionnaire at any time during a training session. Or, to save time during a training session, you can prepare a questionnaire before a training session’s starting time, save it, and then open it for use during the training session.

Once you close a poll, you can view the results and share them with attendees. You can also save the results of a poll for viewing outside of a training session.
Prefering a poll questionnaire

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of preparing a poll questionnaire</td>
<td>About preparing a poll questionnaire (on page 294)</td>
</tr>
<tr>
<td>compose a questionnaire</td>
<td>Composing poll questions and answers (on page 294)</td>
</tr>
<tr>
<td>edit your poll questions or answers</td>
<td>Editing a questionnaire (on page 297)</td>
</tr>
<tr>
<td>rename or reorder polling tabs</td>
<td>Renaming and reordering polling tabs (on page 298)</td>
</tr>
<tr>
<td>display a timer when a poll is in progress</td>
<td>Displaying a timer during polling (on page 299)</td>
</tr>
</tbody>
</table>

About preparing a poll questionnaire

On the Polling panel, you can prepare a poll questionnaire that includes multiple-answer, single-answer, and text questions. Once you complete a questionnaire, you can open the poll at any time during a training session.

Composing poll questions and answers

You can create a questionnaire at any time after you start a training session. The following figure shows a portion of the Polling panel, which offers the tools you use to compose a questionnaire.

Tip To save time during a training session, you can prepare a poll questionnaire before attendees join a training session, save it, and then open it for use during the training session.

To compose a questionnaire:

1. Click the Polling tab.

The Polling panel appears.
Under **Question Type**, select the type of question you want to compose by doing one of the following:

- To compose a multiple-answer question, select **Multiple choice**, and then choose **Multiple Answers** in the drop-down list.
- To compose a single-answer question, select **Multiple choice**, and then choose **Single Answer** in the drop-down list.

- To compose a text question, select **Short answer**.

**Note:** Mac users will set the question type when adding an answer.

3. Click **New**. Mac users will click the Add New Question icon.
4. Type a question.

Poll Questions:

| How did you like the presentation? |

5. In the Answer section, click Add. Mac users will click the Add an Answer icon.

An answer box appears below the question.

Poll Questions:

| How did you like the presentation? |

6. Type an answer to the question in the box that appears. You can enter additional answers in the same manner.
The question and answers appear in the **Poll Questions** area.

7 To add questions, repeat steps 2 to 7.

The following figure shows an example of a poll questionnaire.

<table>
<thead>
<tr>
<th>Poll Questions:</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. What is your favorite color?</td>
</tr>
<tr>
<td>a. blue</td>
</tr>
<tr>
<td>b. red</td>
</tr>
<tr>
<td>c. green</td>
</tr>
<tr>
<td>d. black</td>
</tr>
<tr>
<td>2. What do you enjoy doing at leisure?</td>
</tr>
<tr>
<td>a. reading</td>
</tr>
<tr>
<td>b. watching movies</td>
</tr>
<tr>
<td>c. traveling</td>
</tr>
<tr>
<td>d. sports</td>
</tr>
<tr>
<td>3. Please give us feedback about this event.</td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

**Tip:** While you are creating a poll questionnaire, Training Center automatically saves it every two minutes to the WebEx folder in the My Documents folder on your computer. If you ever lose your poll questionnaire, you can easily recover it in the designated folder.

### Editing a questionnaire

You can change the type of a question and edit, rearrange, or delete the questions and answers.

**To change the type of a question:**

1 Select the question by clicking it, and then select the new type of question in the Question section.

For more information about the different types of questions, see *Composing poll questions and answers* (on page 294).

2 Click **Change Type**.
To edit any question or answer that you typed:

1. Select the question or answer by clicking it, and then click the Edit icon.

2. Make your changes.

To delete a question or an answer:

Select the question or answer by clicking it, and then click the Delete icon.

To rearrange questions or answers:

Select the question or answer by clicking it, and then click the Move Up or Move Down icon, as appropriate.

To delete an entire questionnaire:

Click Clear All.

If you have not saved the questionnaire, a message box appears, asking whether you want to save it or not.

Renaming and reordering polling tabs

You can easily change a tab name or change the tab order within the Polling panel.

**Note:** For Mac users, select ctrl and then click the tab to see additional options.
To rename a tab in the content viewer:

1. Do one of the following:
   - Right-click the tab name and select **Rename**.
   - Double-click the tab name.
2. Enter the new name on the tab.
3. Press **Enter** or click outside the tab.
   This tab displays the new name.

To reorder the tabs in the content viewer:

1. Right-click any tab and select **Reorder Polling Tabs**.
2. In the Reorder Viewer Tabs dialog box, use the arrows to change the order of the tabs.
   Moving a tab up in the order moves that tab to the left in the content viewer.
3. Click **OK**.

**Tip:** To quickly move a tab to the left or right, select the tab and use a drag and drop operation to move it.

Displaying a timer during polling

You can specify that a timer displays for attendees and yourself when a poll is in progress.

To display a timer:

1. Click **Options**.

   ![Options](image)

   On the Mac, select the Set Options icon.

2. In the dialog box that appears, select **Display**, and then type the length of time in the **Alarm** box.
3 Click OK.

Opening a poll

Once you finish preparing a poll questionnaire, you can open the poll.

If you prepared your questionnaire in advance and saved it, you must first open it on the Polling panel. For details, see Opening a poll questionnaire file (on page 306).

To open a poll:

1 Open the Polling panel.
2 Click Open Poll.

The questionnaire appears on attendees' Polling panels. Attendees can now fill out the questionnaire.

As attendees answer the questions, you can watch the polling status on your Polling panel. The following figure shows an example.

3 Click Close Poll when the time is up.

If you specify a timer and the poll times out, the poll automatically closes.

Attendees can no longer answer questions.

Once you close a poll, you can view the poll results and optionally share them with attendees. For details, see Viewing and sharing poll results (on page 302).
Answering polls

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>fill out a poll questionnaire during a training session</td>
<td>Filling out a poll questionnaire (on page 301)</td>
</tr>
<tr>
<td>learn about viewing shared poll results</td>
<td>Viewing poll results (on page 301)</td>
</tr>
</tbody>
</table>

Filling out a poll questionnaire

Once the presenter opens a poll during a training session, the poll questionnaire appears on your Polling panel.

**To fill out a poll questionnaire:**

1. Select the option buttons or check boxes for each question.
2. If the questionnaire includes text questions, type your answers in the boxes.
3. When you finish answering the questionnaire, click Submit.

If the presenter shares the results of the poll, you can view them on your Polling panel. For details, see Viewing poll results (on page 301).

Viewing poll results

After the presenter closes a poll, the presenter can share the results with training session attendees. Shared results appear on your Polling panel.

The following figure shows an example of shared poll results:
Chapter 19: Polling Attendees

### Viewing and sharing poll results

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>view and understand poll results</td>
<td>Viewing poll results (on page 302)</td>
</tr>
<tr>
<td>share poll results with attendees after you close a poll</td>
<td>Sharing poll results with attendees (on page 303)</td>
</tr>
</tbody>
</table>

### Viewing poll results

Once you close a poll, you can view the complete results of the poll and share them with attendees.

The following figure shows an example of your Polling panel after you close a poll. The Results column indicates the percentage of attendees who chose each answer. The Bar Graph column provides a graphic representation of each percentage in the Results column.
Note: Training Manager bases the percentage of attendees who chose each answer on the total number of attendees in the training session, not the total number of attendees who filled out the questionnaire.

Sharing poll results with attendees

After you close a poll, you can share the following with attendees:

- Poll results—shows the poll results in the attendee's Polling panel
- Individual Results—shares an attendee results document in a Web browser with the attendee
- Correct answers—shows the correct answers in the Polling panel
- Individual's grades—shows the attendee's grade in the Polling panel
To share the results of a poll:

1. In the **Share with attendees** section on your Polling panel, select **what you would like to share**.
2. Click **Apply**.

## Saving and opening poll questionnaires and results

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>save a poll questionnaire to a file</td>
<td><em>Saving a poll questionnaire</em> (on page 304)</td>
</tr>
<tr>
<td>save poll results to a file</td>
<td><em>Saving poll results</em> (on page 305)</td>
</tr>
<tr>
<td>open a poll questionnaire during a training session</td>
<td><em>Opening a poll questionnaire file</em> (on page 306)</td>
</tr>
<tr>
<td>open poll results on your computer</td>
<td><em>Opening a poll results file</em> (on page 307)</td>
</tr>
</tbody>
</table>

### Saving a poll questionnaire

Once you create a poll questionnaire, you can save it as an .atp file. You can open the file for use in any training session. For more information about preparing a poll questionnaire, see *Composing poll questions and answers* (on page 294).

If you make changes to a poll questionnaire after you save it, you can either save the changes to the same file or save a copy of the questionnaire to another file.

#### To save a new poll questionnaire:

1. On the **File** menu, choose **Save > Poll Questions**.
   
   The Save Poll Questions As dialog box appears.
2. Choose a location at which to save the file.
3. Type a name for the file.
4. Click **Save**.
Training Manager saves the poll questionnaire to a file at the location you specified. Poll questionnaire file names have an .atp extension.

To save changes to a poll questionnaire that you previously saved:

On the File menu, choose Save > Poll Questions.

Training Manager saves the changes to the existing poll questionnaire file.

To save a copy of a poll questionnaire:

1. On the File menu, choose Save As > Poll Questions.
   
The Save Poll Questions As dialog box appears.

2. Do either or both of the following:
   
   - Type a new name for the file.
   - Choose a new location at which to save the file.

3. Click Save.

Training Manager saves the poll questionnaire to a file at the location you specified. The names of poll questionnaire files have an .atp extension.

Saving poll results

If you conduct a poll and then share its results, you can save the results to a text, or .txt, file.

Once you save poll results to a file, you can save changes to the poll results or save a copy of the results to another file.

**Tip:** Training Center automatically saves poll results every two minutes to the WebEx folder in the My Documents folder on your computer. If you ever lose your poll results, you can easily recover them in the designated folder. Training Center saves both group and individual results.

To save new poll results:

1. Close the poll if you have not done so.

2. On the File menu, choose Save > Poll Results.
   
The Save Poll Results As dialog box appears.
Chapter 19: Polling Attendees

3 Choose a location at which to save the file.
4 Type a name for the file.
5 Click Save.

Training Manager saves the poll results to a file at the location you specified. The names of poll results files have a .txt extension.

To save changes to poll results that you previously saved:
On the File menu, choose Save > Poll Results.
Training Manager saves the changes to the existing poll results file.

To save a copy of a poll results:
1 On the File menu, choose Save As > Poll Results.
The Save Poll Results As dialog box appears.
2 Do either or both of the following:
   ▪ Type a new name for the file.
   ▪ Choose a new location at which to save the file.
3 Click Save.

Training Manager saves the poll results to a file at the location you specified. The names of poll results files have a .txt extension.

Opening a poll questionnaire file
If you saved a poll questionnaire to a file, you can display the questionnaire during a training session by opening the file.

Note: You can open a poll questionnaire file, which has an .atp extension, only when a training session is in progress.

To open a poll questionnaire file:
1 On the File menu, choose Open > Poll Questions.
The Open Poll Questions dialog box appears.
2 Select the poll questionnaire file that you want to open.
3 Click **Open**.

The poll questionnaire appears on your **Polling** panel. You can now open the poll to training session attendees.

### Opening a poll results file

If you saved poll results to a file, you can open the file on your computer.

**To open a poll results file on your computer:**

Double-click the saved file, which has a `.txt` extension.

The poll results file opens in your default text editor.

For each question, the poll results show the number and percentage of attendees who chose each answer and the total number of attendees in the training session.

The following figure shows an example of poll results in the text format.
### Chapter 19: Polling Attendees

1. **How helpful was the presentation?**
   - a. Very helpful 1/4 (25%)
   - b. Somewhat helpful 2/4 (50%)
   - c. Not helpful 1/4 (25%)

2. **How was the speed of the presentation?**
   - a. Too fast 2/4 (50%)
   - b. Just right 2/4 (50%)
   - c. Too slow 0/4 (0%)

3. **How clear were the slides?**
   - a. Very clear 3/4 (75%)
   - b. Somewhat clear 1/4 (25%)
   - c. Not clear 0/4 (0%)
Managing Question-and-Answer Sessions

Host only

During a question-and-answer (Q & A) session, you can respond to questions that attendees ask during the training session. A Q & A session not only provides instant text messaging similar to that in Chat, but also does the following:

- Provides a more formal procedure for asking and answering questions in text format
- Automatically groups questions to help you manage the queue, such as quickly identifying questions that you have or have not answered
- Displays visual cues for the status of questions
- Lets you assign questions to the appropriate domain expert on your team
- Allows you to quickly send a standard response to questions for which you cannot or do not want to answer immediately

You can save the questions and answers in a Q & A session to either a text (.txt) file or a comma-separated/comma-delimited values (.csv) file for future reference.

Tip: If you use Q & A during a training session, WebEx recommends that a panelist (the host or presenter) monitors the Q & A panel at all times during the training session.
Allowing participants to use Q & A

*Host only*

To use Q & A during a training session, ensure that the Q & A option is turned on. You can also turn it off at any time, if necessary.

**To turn on or off Q & A during a training session (Windows):**

1. In the Session window, on the *Session* menu, choose *Session Options*.
   
   An options dialog box appears.

2. On the *Communications* tab, check or uncheck Q & A, as appropriate, and then select OK.

**To turn on or off Q & A during a training session (Mac):**

1. In the Session window, on the *Training Center* menu, select *Preferences*.

2. Select *Tools*.

3. Check or uncheck Q & A, and then select OK.

Setting privacy views in Q & A sessions

*Host only*
To protect the privacy of panelists and attendees during a training session, you can hide or show the following information when questions and answers are published on attendees' Q & A panels:

- Names of attendees who send questions
- Names of panelists who send answers
- Time stamps for questions and answers respectively

**Note:** The names of attendees and panelists and time stamps are always visible on panelists' Q & A panels.

**To set privacy views:**

1. Open the Attendee Options dialog by following one of these steps:
   - Windows: Right-click the title bar of your Q & A panel, and then choose **Attendee Options**.
   - Mac: Select **ctrl**, click, and then choose **Attendee Options**.

2. In the dialog box that appears, select any of the options that you want attendees to see, and then click **OK**.
Chapter 20: Managing Question-and-Answer Sessions

Managing questions on your Q & A panel

The tabs and visual cues on your Q & A panel allow you to manage the questions you receive in the queue in the following ways:

- Set a priority for any question you have received
- Identify the status of questions and answers—answered, unanswered, assigned, private, dismissed, or deferred—and address questions that need your attention.
- Assign questions to the appropriate expert on your team in the training session.
- Get an idea of the interactions between the panelists and attendees who ask questions.
The auto-grouping of questions by tab make it easy for you to filter and answer questions.

**Examples:**

Follow up on the questions that are sent or assigned to you on the My Q & A panel.

View questions that have been given a priority status on the Prioritized tab; view only questions with a certain priority status on the Prioritized tab.

**Visual cues,** such as "deferred" and "private," tell you the status of a question.

A question appears bold if no panelist has answered it.

Right-click (Windows) or select **ctrl** and click (Mac) a question to:

- Assign it to a subject-matter expert, defer it, or dismiss it
- Assign a priority status
- Send a standard response if this question has been answered verbally
Working with the tabs on your Q & A panel

Your Q & A panel consists of five tabs. The All tab displays by default. The following table describes what each tab displays.

<table>
<thead>
<tr>
<th>Tab</th>
<th>Displays ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>All questions and answers—unanswered, answered, private, deferred, and dismissed—in the queue</td>
</tr>
<tr>
<td>Unanswered</td>
<td>Questions that have not been answered by a panelist</td>
</tr>
<tr>
<td>Answered</td>
<td>Questions that have been answered by a panelist and answers</td>
</tr>
<tr>
<td>My Q &amp; A</td>
<td>Questions that attendees specifically send to you by your name other panelists assign to you attendees send to All Panelists and that you have answered attendees send to Host&amp;Presenter, Host, or Presenter, if you are the host or presenter</td>
</tr>
<tr>
<td>Prioritized</td>
<td>Questions that have been assigned a priority status</td>
</tr>
</tbody>
</table>

Opening a tab

When you open the Q & A panel, the All tab appears by default.

To open other tabs on the Q & A panel:

1. Depending on the operating system you are using, follow one of these steps:
   - Windows: Right-click the All tab.
   - Mac: Select ctrl and then click the All tab.
2. Choose Open Tab > the tab you want to open.
If you want to open one more tab, right-click (Windows) or select `ctrl` and click (Mac) any of the open tab, and then choose **Open Tab** > the tab you want to open.

### Displaying hidden tabs

The Q & A panel cannot display all open tabs at one time unless you expand the panels to the left.

**To display a hidden tab on the Q & A panel:**

Click the downward arrow, and then choose the tab you want to display.

### Closing a tab

You can close all the tabs, except the **All** tab, on your Q & A panel.

**To close a tab on the Q & A panel:**

Click the X button on the tab you want to close.

**Note:** Closing a tab does not remove the information on the tab. You can view the information on that tab by opening it again. *More…* (on page 314)
Assigning a question

You can assign questions to yourself or another panelist. The questions appear on the designated panelists’ My Q & A tab, with the text assigned next to them.

To assign a question:

From any of the tabs on which you received the question, right-click (Windows) or select ctrl and then click (Mac) the question, and then choose Assign to > the person you want to assign it to.

Note:
- To assign multiple questions at the same time, hold down the Ctrl key while selecting the questions.
- If an assigned question is answered, the text assigned still displays.
- The text assigned does not display on attendees’ Q & A panels.

Prioritizing questions

You can set priorities—high, medium, or low—for any questions you have received on the Q & A panel. Your prioritized questions display on the Prioritized tab.

To set a priority for a question:
Right-click (Windows) or select ctrl and then click (Mac) the question, and then choose **Priority** > **High**, **Medium**, or **Low**.

**Fast track**

After you set a priority for a question for the first time during a training session, a column appears to the left of the Q & A panel showing rectangular icons.

Click the rectangular icon for the question you want to set priorities for, and then choose **High**, **Medium**, or **Low**.

To remove the priority status from a question:

Click the rectangular icon for the question, and then choose **Clear**.

---

**Viewing prioritized questions**

You view your prioritized questions on the **Prioritized** tab.

**To view your prioritized questions:**

1. Click the **Prioritized** tab.
Optional. To view only questions with a certain priority status, select the status at the "View priority" option.

If you do not want to view questions with a certain status, uncheck the appropriate check box.

Answering questions in a Q & A session

During a Q & A session, you can:

- Provide an answer to a question publicly. More… (on page 319)
- Provide an answer to a question privately. More… (on page 319)
- Defer a question. More… (on page 321)
- Dismiss a question. More… (on page 320)

Tip: You can respond to a question from any of the four tabs on which you receive the specific question. If a question shows as assigned on the All tab, you can check whether this question has been assigned to you on your My Q & A tab.

When a panelist is typing an answer to a question that no one else has responded to yet, an in-progress indicator displays under that question for all participants. This figure shows an example.

Alex Simpson - 03:40 pm
Q: (assigned) hello, i have a question.
This question is being answered..
Providing a public answer

Your answer to a question appears on all participants' Q & A panels, unless you choose to send your answer privately.

To provide a public answer during a Q & A session:
1. On your Q&A panel, select the question from any of the tabs on which you received the question.

   To select a question, click it once.
   To copy the question into the text box, right-click (Windows) or press ctrl and then click (Mac) your mouse, choose Copy, and then paste it in the text box.
   To clear the selection, right-click (Windows) or press ctrl and then click (Mac) the question, and then choose Deselect.

2. Type your answer in the text box.
   To edit your answer before sending it, highlight the text you want to edit and then right-click (Windows) or press ctrl and then click (Mac) the highlighted text. The menu that appears provides editing commands.

3. When you finish typing your answer, click Send.
   The answer appears on all panelists' and attendees' Q & A panels.

Answering a question privately

If you send your answer privately, these participants can see the private answer:
- the attendee who sent you the question
- all panelists

To answer a question privately:
1. On your Q&A panel, select the question from any of the tabs on which you received the question, and then click Send Privately.
To select a question, click it once.

To clear the selection, right-click (Windows) or press ctrl and then click (Mac) the question, and then choose Deselect.

To copy the question into the text box, right-click (Windows) or press ctrl and then click (Mac) your mouse, choose Copy, and then paste it in the text box.

2 In the dialog box that appears, type your answer in the text box.

3 If you want to save the answer you typed as the standard private answer for all panelists to use, click Save or Save as Default.

4 Click Send.

**Dismissing a question**

In a Q & A session, you can dismiss a question using a standard or customized answer. The standard answer reads: *Thank you for your question. The information that you requested cannot be provided by any of the panelists.*

If you dismiss a question, these participants can see the Dismiss answer:

- the attendee who sent the question
- all panelists

**To dismiss a question during a Q & A session:**

1 From any of the tabs where you received the question, right-click the question, and then choose Dismiss.

**Tip for Windows users:** To dismiss multiple questions at one time, hold down the Ctrl key while selecting the questions, right-click your mouse, and then choose Dismiss.

The Respond Privately dialog box appears, containing the standard Dismiss answer.

2 Optional. To customize the standard answer, click Custom, and then edit the text in the text box.
Deferring a question

In a Q & A session, you can defer a question using a standard or customized answer. The standard answer reads: Thank you for your question. Your question was deferred but will remain in the queue. A panelist will answer your question at a later time.

If you defer a question, the following participants can see the Defer answer:
- the attendee who sent the question
- all panelists

To defer a question during a Q & A session:

1. From any of the tabs where you received the question, right-click the question, and then choose Defer.

   **Tip for Windows users:** To defer multiple questions at one time, hold down the Ctrl key while selecting the questions, right-click your mouse, and then choose Defer.

   The Respond Privately dialog box appears, containing the standard Defer answer.

2. Optional. To customize the standard answer, click Custom, and then edit the text in the text box.

3. Optional. To save your customized answer as the standard Defer answer for all panelists to use, click Save (Windows) or Save as Default (Mac).

4. Click Send.

Responding to questions answered verbally

If a question has been answered verbally, you can send a standard response: This question has been answered verbally.
Follow these steps:

Right-click (Windows) or select `ctrl` and then click (Mac) the question and then choose *Answered Verbally*.

**Archiving Q & A sessions**

At any time during a training session, you can save the questions and answers on the **All** tab on your Q & A panel to a .txt or .csv (comma-separated/comma-delimited values) file. If there are updates in the Q & A session, you can save them to the existing file.

Once you save a new Q & A session to a file, you can also save a copy to another file.

**Saving a Q & A session**

At any time during a training session, you can save the questions and answers on the **All** tab on your Q & A panel to a .txt or .csv file.

**Note:** Training Manager automatically saves Q & A sessions every two minutes to the WebEx folder in the My Documents folder on the host and presenter computers.
To save a Q & A session:

1. In the Session window, on the File menu, choose Save > Questions and Answers.
2. Choose a location at which to save the file.
3. Type a name for the file.
4. In the Save as type box, select Text Files (*.txt) or CSV (comma-separated/comma-delimited values).
5. Click Save.
   Training Manager saves the file at the location and format that you chose.

To review the content of an archived Q & A session, open the .txt file in a text editor or the .csv file in a spreadsheet program, such as Microsoft Excel.

Saving changes to a saved Q & A session

If you have previously saved a Q & A session, and there are additional changes in the Q & A session, you can save the updates to the existing file.

To save changes in an existing Q & A file:

In the training session window, on the File menu, choose Save > Questions and Answers.

Training Center saves the changes to the existing Q & A file.

**Note:** If there are no changes on the All tab on your Q & A panel, the Save option is unavailable.

Saving a copy of a previously saved Q & A session

If you have previously saved a Q & A session, and you want to save another copy of the session, you can do so by following these steps:

1. In the Session window, on the File menu, choose Save As > Question and Answers.
   The Save Questions and Answers As dialog box appears.
2. Do *any* or *all* of the following:
Type a new name for the file.
Choose a new location at which to save the file.
Choose a different format for the file.

3. Click Save.

Training Manager saves the file with any additional changes in the Q & A session.

Opening a Q & A file

The Q & A files that you saved during a training session have either a .txt or .csv extension.

To view a .txt file, open it in a text editor, such as Notepad.

To view a .csv file, open it in a spreadsheet program, such as Microsoft Excel.
Participating in a Question-and-Answer Session

Question-and-Answer (Q & A) sessions during a training session allow you to ask questions and receive answers using your Q & A panel, in a more formal way than Chat.

Your Q & A panel automatically groups questions and answers into these two tabs, which make it easy for you to check whether your questions have been answered:

All—all questions and answers in a Q & A session during the training session  
More… (on page 325)

My Q & A—the questions you sent and the answers to your questions  
More… (on page 325)

Note: The host has to turn on the Q & A function in the event before you can use the Q & A panel.

Working with the tabs on your Q & A panel

Your Q & A panel provides two views of the question-and-answer queue: the All and My Q & A tabs. The All tab stays open all the time on your Q & A panel.

The My Q & A tab displays as soon as you send your first question using Q & A. You can close the My Q & A tab at any time.
To open the My Q & A tab:
Right-click (Windows) or select ctrl and then click (Mac) the All tab, and then choose Open Tab > My Q & A.

To close the My Q & A tab:
Right-click (Windows) or select ctrl and then click (Mac) the My Q & A tab, and then choose Close Tab.

Note: Closing the My Q & A tab does not cause you to lose the questions and answers on the tab. You can re-open it at any time.

Asking a question in a Q & A session
During a training session, you can send your questions to all or specific panelists in a Q & A session.

To ask a question in a Q & A session:
1. Open the Q & A panel.
2. On the Q & A panel, type your question in the text box.
3. Optional. To edit your question, highlight the text you want to edit, and then right-click (Windows) or select ctrl and then click (Mac) to use the editing commands in the menu.
4. In the Ask drop-down list, select the recipient, and then click Send.

Checking the status of your questions
The auto-grouping of questions and answers and visual cues on attendees' Q & A panels make it easy for you to check whether a panelist has responded to your question.

Always check the My Q & A tab to quickly find out whether your question has been answered. More… (on page 327)

When a panelist is answering your question, an indicator appears under the question. More… (on page 327)
My Q & A tab

Your Q & A panel provides two views of the question-and-answer queue: the All and My Q & A tabs. Always check the My Q & A tab to quickly find out whether your question has been answered. This tab displays a list of the questions you sent and the answers, whether public or private, to those questions.

<table>
<thead>
<tr>
<th>Q&amp;A</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>All (2)</td>
<td>My Q&amp;A (2)</td>
<td></td>
</tr>
<tr>
<td>Jay Chow 10:46 am</td>
<td>Q: I have a question.</td>
<td></td>
</tr>
<tr>
<td>Janet Goodman 10:46 am</td>
<td>A: yes, please send it to me.</td>
<td></td>
</tr>
<tr>
<td>Jay Chow 10:58 am</td>
<td>Q: How do I record the session?</td>
<td></td>
</tr>
<tr>
<td>Felicity Wu 10:59 am</td>
<td>A: [private] We will post the recording after the session ends.</td>
<td></td>
</tr>
</tbody>
</table>

1. The My Q & A tab displays the questions that you sent and the answers to those questions.

2. If a panelist answers your question privately, the text *private* appears next to the answer. No attendee can see this private answer, except yourself.

Answering indicator

When a panelist is typing an answer to a question, an in-progress indicator displays under that question. This figure shows an example.
Jay Chow - 01:54 pm

Q: I have a question.

This question is being answered...
Using Chat

Chat is useful during a training session if you want to:

- send brief information to all participants
- send a private message to another participant
- ask a question but do not want to use the Q & A option, which provides a formal procedure for asking and answering questions

All chat messages that you send or receive appear on the Chat panel in the training session window.

The Chat function allows you to perform these tasks:

- Send chat messages More… (on page 329)
- Assign sounds to incoming messages More… (on page 330)
- Print chat messages More… (on page 331)
- Save chat messages More… (on page 332)
- Open a chat file during a training session More… (on page 333)

Sending chat messages

During a training session, the presenter can specify chat privileges for participants. These privileges determine to whom participants can send chat messages.

To send a chat message:

1. Open the Chat panel.
2. In the Send to drop-down list, select the recipient of the message.
3 Enter your message in the chat text box.

4 Depending on the operating system you use, follow this step:
   - Windows: Click Send.
   - Mac: Select enter on your keyboard.

Note: If you join a training session in progress, you can see only the chat messages that participants send after you join the training session.

Assigning sounds to incoming chat messages

You can choose to play a sound for one of these occasions:
- If you are not viewing the Chat panel
- For only the first chat message that you receive in a thread
- Whenever you receive a chat message

To assign sounds to incoming chat messages:
1 Open the Personal Preferences dialog box using one of these two methods:
   - On the Chat panel, right-click the Chat title bar, and then choose Sound Alerts.
   - In the Session window, on the Edit menu, choose Personal Preferences.
2 Click Communications under Category.
3 Select Receiving a chat message.
4 In the When drop-down list, choose the occasion for which you want to assign a sound.
5 Select a sound using one of these methods:
   - Select a sound in the Play sound drop-down list.
     This list contains the names of all sound files that reside at the default location on your computer.
   - Click Browse, and then select a sound file that resides in another folder.
6 Optional. To play the currently selected sound, click the button 🎵.
Chapter 22: Using Chat

7 Click OK.

Note:
Training Center saves your sound preferences on your computer. However, if you start or join a training session on another computer, you need to set your preferences again on that computer.
Sound files must have a .wav extension
In most cases, the default location for sound files is C:\WINDOWS\Media. You can copy other sound files to the default folder or any other directory to make them available in the Personal Preferences dialog box.

Printing chat messages
You can print all the chat messages that appear on the Chat panel.

To print chat messages:
1 In the Session window, on the File menu, choose Print > Chat.
   A print dialog box appears.
2 Optional. Specify printer options.
3 Print.

Saving chat messages
You can save chat messages that appear on the Chat panel to a .txt file. You can then reopen the file for use in any training session or view the file’s content outside a training session by opening the file in a text editor.

Once you save chat messages to a file, you can save changes to the messages or save a copy of them to another file.

For help in performing these tasks, click the "More" link:
- Save chat messages for the first time in a training session More… (on page 332)
- Save change to a chat file More… (on page 332)
- Create a copy of a chat file More… (on page 332)
Saving chat messages to a new file

You can save chat messages you have sent or received to a new chat file.

**To save chat messages to a new file:**

1. In the Session window, on the **File** menu, choose **Save > Chat**.
   
   The **Save Chat As** dialog box appears.
2. Choose a location at which you want to save the file.
3. Type a name for the file.
4. Click **Save**.

Training Manager saves the chat messages in a .txt file at the location you selected.

Saving changes to a chat file

If you make changes to the messages on your Chat panel, you can save them to an existing chat file.

**To save changes to a chat file:**

1. In the Session window, on the **File** menu, choose **Save > Chat**.
2. Training Manager saves the changes to the existing chat file.

Creating a copy of previously saved chat messages

If you have saved chat messages and want to create another copy of the messages, you can do so by saving the chat messages to a chat file with a different name.

**Note:** Training Center also automatically saves chat messages every two minutes to the WebEx folder in the My Documents folder on the host and presenter computers.
To create a copy of chat messages that have been previously saved:

1. In the Session window, on the File menu, choose Save As > Chat.
   The Save Chat As dialog box appears.
2. Do either or both of the following:
   - Type a new name for the file.
   - Choose a new location at which you want to save the file.
3. Click Save.
   Training Manager saves the file at the location you chose. The file name has a .txt extension.

Opening a chat file during a training session

If you saved chat messages to a .txt file, you can display those chat messages on your Chat panel by opening the file.

To open a chat file in a training session:

1. In the Session window, on the File menu, choose Open > Chat.
   The Open Chat dialog box appears.
2. Select the chat file that you want to open.
3. Click Open.
   The chat messages appear on the Chat panel.

If there are already chat messages in your chat viewer, Training Manager appends the messages from the chat file to the existing messages.
Using Feedback

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of using Feedback</td>
<td>About using feedback (on page 335)</td>
</tr>
<tr>
<td>allow participants to use Feedback options</td>
<td>Allowing participants to provide feedback (on page 336)</td>
</tr>
<tr>
<td>view a running tally of responses</td>
<td>Viewing a running tally of responses (on page 337)</td>
</tr>
<tr>
<td>provide feedback</td>
<td>Providing feedback (on page 338)</td>
</tr>
<tr>
<td>use emoticons in feedback</td>
<td>Using emoticons in feedback (on page 339)</td>
</tr>
<tr>
<td>remove responses from the Participants panel</td>
<td>Removing feedback (on page 340)</td>
</tr>
</tbody>
</table>

About using feedback

Feedback is a feature that allows the presenter to pose a question at any time—either verbally during a WebEx Audio conference, or in a chat message—and receive instant feedback from other participants.

As the host, you can:

- allow attendees to provide feedback
- respond to the presenter’s verbal request for feedback
- provide unsolicited feedback
- view the results on the Feedback palette

As the presenter, you can:
Chapter 23: Using Feedback

- pose a question and request feedback
- share the feedback results with all participants
- clear the feedback results
- view the results on the Feedback palette

As a participant, you can:
- click the Raise Hand button if the presenter asks for a show of hands in response to a question or if you have a question
- select Yes or No in response to a question
- select Go Faster or Go Slower to request that the presenter speed up or slow down his or her pacing
- express yourself using emoticons

**Note:** When participants use the Raise Hand icon, the panelists will see the order in which the participants raised their hands, indicated by a number next to the participant's icon. The panel will show this ordered raised hand for up to 10 participants at a time.

Allowing participants to provide feedback

You can allow participants to use the Feedback options during a training session.

**To allow participants to use the Feedback options:**

1. On the Session menu, select Session Options. The Training Session Options dialog box appears.
2 Select the **Feedback** check box.
3 Click **Apply**, and then click **OK**.

A Feedback column appears on the Participants panel.

---

**Viewing a running tally of responses**

You can view a running tally of responses from attendees during a training session.

**To view a running tally of responses:**

On the **Participants** panel, click the **Feedback** icon.

The Feedback palette appears.

Your Feedback palette displays a running tally of responses. See the following figure for an example.

On the Participants panel, a response indicator appears to the right of the name of each participant who has responded to a presenter’s question.
Providing feedback

You can provide feedback by clicking one of the icons on the Participants panel.

The response icon appears to the right of your name. You can remove the icon by clicking it again.

The following table shows the types of feedback you can provide during a training session:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🙊</td>
<td>click if the presenter asks for a show of hands in response to a question or if you have a question</td>
</tr>
<tr>
<td>✓</td>
<td>click to indicate yes in response to a question</td>
</tr>
<tr>
<td>✗</td>
<td>click to indicate no in response to a question</td>
</tr>
<tr>
<td>🏃♂️</td>
<td>click to indicate to the presenter to slow down his or her pacing</td>
</tr>
</tbody>
</table>
Your Feedback palette displays a running tally of responses. On the **Participants** panel, a response indicator appears to the right of the name of each participant who has responded to a presenter’s question.

### Using emoticons in feedback

You can use emoticons to express your feelings or status from the **Participants** panel by using the emoticons drop-down menu.

**To use emoticons:**

1. Click the Emoticons button on the Participants panel.

   ![Emoticons button](image)

   The Emoticons palette appears.

2. Select **one** of the following emoticons from the palette.

   - **applaud the presenter**
   - **approve the presenter**
<table>
<thead>
<tr>
<th>Emoticon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🛌️</td>
<td>indicate you are taking a rest or break or would like to take a break</td>
</tr>
<tr>
<td>🚫</td>
<td>indicate you are not available</td>
</tr>
<tr>
<td>✨</td>
<td>indicate you have an idea</td>
</tr>
<tr>
<td>😳</td>
<td>indicate that you are confused</td>
</tr>
<tr>
<td>😨</td>
<td>indicate that you are sleepy or bored</td>
</tr>
<tr>
<td>😲</td>
<td>show astonishment or surprise</td>
</tr>
<tr>
<td>😊</td>
<td>indicate happiness</td>
</tr>
<tr>
<td>😂</td>
<td>laugh out loud</td>
</tr>
<tr>
<td>😵</td>
<td>show that you are curious or skeptical</td>
</tr>
<tr>
<td>🔴</td>
<td>indicate presenter to watch out or be careful</td>
</tr>
</tbody>
</table>

The corresponding emoticon appears to the right of your name on the Participants panel.

Removing feedback

You can remove all the feedback at any time during a training session.

To remove feedback (erase all responses):

1. On the Session menu, select Session Options.
   The Training Session Options dialog box appears.
2. Remove the check next to the Feedback check box.
3. Click Apply, and then click OK.
   The Feedback column is no longer showing and all feedback is cleared.
### Managing Hands-on Lab

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>See…</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of Hands-on Lab</td>
<td>About Hands-on Lab (on page 342)</td>
</tr>
<tr>
<td>set up an in-session or on-demand Hands-on Lab session</td>
<td>Setting up Hands-on Lab (on page 343)</td>
</tr>
<tr>
<td>reserve computers for an in-session Hands-on Lab</td>
<td>Reserving computers for in-session Hands-on Lab (on page 344)</td>
</tr>
<tr>
<td>view the Hands-on Lab schedule</td>
<td>Viewing the Hands-on Lab schedule (on page 345)</td>
</tr>
<tr>
<td>assign Hands-on Lab computers to registered attendees</td>
<td>Assigning Hands-on Lab computers to registered attendees (on page 346)</td>
</tr>
<tr>
<td>start Hands-on Lab sessions</td>
<td>Starting a Hands-on Lab session (on page 350)</td>
</tr>
<tr>
<td>record Hands-on Lab sessions</td>
<td>Recording Hands-on Lab sessions (on page 352)</td>
</tr>
<tr>
<td>assign computers during Hands-on Lab sessions</td>
<td>Assigning computers during Hands-on Lab sessions (on page 354)</td>
</tr>
<tr>
<td>unassign participants from computers</td>
<td>Unassigning Participants from Computers (on page 356)</td>
</tr>
<tr>
<td>respond to a request for help</td>
<td>Responding to a request for help (on page 357)</td>
</tr>
<tr>
<td>take control of a Hands-on Lab computer</td>
<td>Taking control of a Hands-on Lab computer (on page 358)</td>
</tr>
<tr>
<td>ask all to return from Hands-on Lab</td>
<td>Asking all to return from labs (on page 358)</td>
</tr>
<tr>
<td>end Hands-on Lab sessions</td>
<td>Ending the Hands-on Lab session (on page 359)</td>
</tr>
</tbody>
</table>
About Hands-on Lab

Hands-on Lab sessions allow instructors to prepare lessons or exercises that students can complete on remote computers on which training software is installed. Students can use these remote computers during a training session for hands-on learning and practice. Because instructors can control Hands-on Lab sessions, they can maintain an optimized lab environment that is effective, familiar, and consistent.

You can schedule the following two types of Hands-on Lab sessions:

- In-session Hands-on Lab. For details, see Setting up in-session Hands-on Lab (on page 343).
- On-Demand Hands-on Lab. For details, see Setting up on-demand Hands-on Lab (on page 347).

To set up a Hands-on Lab session, the host schedules the lab and reserves the computers for the presenter. Then the host starts the Hands-on Lab within the training session. The presenter assigns computers to participants, connects the computers with a mouse click, and then each participant can use the virtual computer at remote locations. The presenter or host can also

- set recording options for the Hands-on Lab session
- broadcast a message to all participants
- respond to a participant's request for help
- ask all to return from the lab
- end the Hands-on Lab session

**Note:** If you chose the scheduling option to support over 500 attendees for this session, the number of participants that can access a Hands-on Lab computer is limited to 50.
Chapter 24: Managing Hands-on Lab

Setting up Hands-on Lab

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>reserve computers for Hands-on Lab</td>
<td>Reserving computers for in-session Hands-on Lab (on page 344)</td>
</tr>
<tr>
<td>view the Hands-on Lab schedule</td>
<td>Viewing the Hands-on Lab schedule (on page 345)</td>
</tr>
<tr>
<td>assign Hands-on Lab computers to registered attendees</td>
<td>Assigning Hands-on Lab computers to registered attendees (on page 346)</td>
</tr>
</tbody>
</table>

About the Hands-on Lab page

To access the Hands-on Lab page, log in to your Training Center Web site. On the navigation bar, expand Host a Session, and then click Hands-On Lab.

You can do the following from this page:

**Hands-on Labs tab**

- View a list of the Hands-on Lab computers set up by your Hands-on Lab administrator.
- View the schedule for each of the labs.
- Reserve computers for on-demand sessions.

**My Reservations tab**

- View the sessions you have scheduled for in-session or on-demand Hands-on Lab.
- Change your reservations, such as inviting attendees and canceling reservations.

Setting up in-session Hands-on Lab

In-session Hands-on Lab allows attendees to practice what they learn while they are attending a training session. Attendees gain hands-on experience by connecting to remote computers on which training software has been installed.
To set up in-session Hands-on Lab, first reserve computers in one of the labs when scheduling a training session, and then start Hands-on Lab during the training session.

See Also: Setting up on-demand Hands-on Lab (on page 347).

Note: Hosts reserve in-session Hands-on Lab computers from the same pool of remote computers that hosts reserve for on-demand Hands-on Lab. Labs and remote computers are set up by the Hands-on Lab administrator in your organization.

Reserving computers for in-session Hands-on Lab

When scheduling a training session, you can set up a Hands-on Lab session and reserve computers for that session. For more information on Hands-on Lab sessions, see About Hands-on Lab (on page 342).

Your site administrator sets up Hands-on-Labs.

To reserve computers for an in-session Hands-on Lab:

1. On the Schedule Training Session or Edit Scheduled Training Session page, scroll to In-session Hands-on Lab.

2. Select Reserve computers from lab.
   For instructions on viewing the Hands-on Lab schedule, see Viewing the Hands-on Lab schedule (on page 345).

3. Choose a lab from the drop-down list. Hands-on Labs are set up by your site administrator.

4. To view the lab description or number of computers set up in a selected lab, click Lab Info.

5. In the Number of computers box, type the number of computers that you want to reserve.

6. To check availability of the computers and lab, click Check Availability.
   The Computers Available dialog box appears indicating how many computers are available for the time and lab that you specified.
   Your reservation status appears in the Reservation status box. The reservation status refreshes each time you click Check Availability.
To pre-assign computers to registered attendees, select Require attendee registration in the Registration section of the Schedule Training Session page.

Requiring attendee registration allows you to assign computers to attendees as they register. To assign computers to attendees as they register, see Assigning Hands-on Lab computers to registered attendees (on page 346).

When you are finished scheduling your training session and Hands-On Lab, click Schedule at the bottom of the Schedule Training Session page.

Requiring attendee registration allows you to assign computers to attendees as they register. To assign computers to attendees as they register, see Assigning Hands-on Lab computers to registered attendees (on page 346).

If the computers are available for your scheduled Hands-on Lab, the Session Scheduled page appears with your reservation confirmation.

If the computers are not available, the Computers Not Available page appears. Click Close, and select a new reservation time or number of computers on the Schedule Training Session page.

Click OK.

**Viewing the Hands-on Lab schedule**

You can view the Hands-on Lab schedule from your Training Service Web site.

**To view the Hands-on Lab schedule:**

1. Log in to your Training Center Web site.
2. On the navigation bar, expand Host a Session to view a list of links.
3. Click Hands-On Lab.
   
The Hands-on Lab page appears.
4. For the lab in which you are interested, under Lab Schedule, click View Schedule.
   
The Lab Schedule page appears.
5. Point to a time slot to view details of the lab schedule.
6. When finished, click Close.
Assigning Hands-on Lab computers to registered attendees

You can assign Hands-on Lab computers to attendees as they register for your training session. You can also either assign computers to participants during the Hands-on Lab session, or allow participants to choose their Hands-on Lab computer when they join the session.

Note: If you chose the scheduling option to support over 500 attendees for this session, the number of participants that can access a Hands-on Lab computer is limited to 50.

To pre-assign computers to registered attendees:

1. Log in to your Training Center Web site.
2. On the navigation bar, expand Attend a Session to view a list of links.
3. Click Live Sessions.
4. Click on your session topic.
   The Session Information page appears.
5. Click Attendees.
   The Registered Attendees page appears.
6. Click Pre-assign Computers.
   The Pre-assign Computers page appears.
7. To assign an attendee to a computer, click on the name of the attendee under Unassigned Attendees.
8. To assign multiple attendees to one computer, hold down the Ctrl key while selecting the names of the attendees.
9. Click Assign.
   You can continue to assign computers to attendees or groups of attendees as long as computers are available.
10. When finished assigning computers, click OK.
Setting up on-demand Hands-on Lab

To provide attendees with more hands-on training, Training Center supports on-demand Hands-on Lab sessions in which attendees connect to remote computers outside a training session to practice what they learn at their own pace.

You can schedule an on-demand Hands-on Lab session by reserving Hands-on Lab computers. Each of the invited attendees can then join the lab session any time within the time limit during the scheduled time frame.

To set up an on-demand Hands-on Lab session, first reserve computers in one of the labs, and then invite attendees to use the reserved computers during the scheduled time. For details, see Scheduling on-demand Hands-on Lab (on page 348).

See also: Setting up in-session Hands-on Lab (on page 343).

Note: Hosts reserve on-demand Hands-on Lab computers from the same pool of remote computers that hosts reserve for in-session Hands-on Lab. Labs and remote computers are set up by the Hands-on Lab administrator in your organization.

About the Reserve Lab Computers for On-demand Use page

How to access this page

On your Training Center Web site, click Host a Session > Hands-On Lab. On the Hands-on Lab page, click any Reserve Computers link.

Options on this page

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Topic</td>
<td>Type a topic for this on-demand session.</td>
</tr>
<tr>
<td>Reserve computers from lab</td>
<td>Choose a lab in the drop-down list, which displays all the labs set up by your Hands-on Lab administrator.</td>
</tr>
<tr>
<td>Lab Info</td>
<td>Click this button to view the description of the selected lab and the number of computers in the lab.</td>
</tr>
</tbody>
</table>
### Scheduling on-demand Hands-on Lab

To schedule an on-demand Hands-on Lab session, first reserve Hands-on Lab computers for the session. Then invite attendees to use the reserved computers during the scheduled time.

**To schedule an on-demand Hands-on Lab session:**

1. Go to the Hands-on Lab page on your Training Center Web site.
2. Click the **Hands-on Labs** tab.
3. In the **On-demand Lab** column, click any **Reserve Computers** link.
4. On the page that appears, specify the reservation options.
   - For details, see *About the Reserve Lab Computers for On-demand Use page* (on page 347).
5. Click **Reserve**.

See also *Inviting attendees for on-demand Hands-on Lab* (on page 349).
Inviting attendees for on-demand Hands-on Lab

Once you finish scheduling an on-demand Hands-on Lab session, you can invite attendees to the session by sending them invitation email messages.

**To invite attendees to a scheduled on-demand Hands-on Lab session:**

1. On the Hands-on Lab page, under the My Reservations tab, click On-demand use.
2. In the Session Name column, click the link for the topic of the Hands-on Lab session.

   The On-demand Hands-on Lab Session Information page appears.
3. Click Invite Attendees.
4. Do any of the following as appropriate:
   - Click Select Live Sessions to invite all attendees from an existing training session.
   - Type the email addresses of the individuals you want to invite in the Invited attendees text box.
   - Click Select Attendees to select contacts from an address book stored on your Training Center Web site.
   - Optional. Click Edit Email Options to customize the content of the invitation email message.
5. Click OK.

Changing reservations

You can change your reservations for on-demand Hands-on Lab at any time.

**To change your reservation for an on-demand Hands-on Lab session:**

1. On the Hands-on Lab page, click the My Reservations tab, and then click On-demand use.
2. In the Session Name column, click the link for the Hands-on Lab session reservation you want to change.

   The On-demand Hands-on Lab Session Information page appears.
3 Click **Change Reservation**. The Change Hands-on Lab Reservation page appears.

4 Do one of the following as appropriate:
   - To delete the reservation, click **Cancel Reservation**.
   - To make changes to the reservation, update the information and click **Change Reservation**.

For details about reservation options, see *About the Reserve Lab Computers for On-demand Use page* (on page 347).

### Starting a Hands-on Lab session

*For training hosts only*

If you have scheduled a Hands-on Lab, you can start the Hands-on Lab session within 15 minutes of the reserved time. The presenter is responsible for managing the Hands-on Lab session.

**To start a Hands-on Lab session:**

1. In the Session window, on the **Lab** menu, click **Start Hands-on Lab**.
   The Start Hands-on Lab dialog box appears showing which lab and how many computers are reserved.
Note: You can start the Hands-on Lab session 15 minutes or less before the scheduled reserved time. If you try to start the Hands-on Lab session earlier than 15 minutes before the scheduled reserved time, an error message appears informing you to start the Hands-on Lab session during the reserved time.

2 Under **Computer Allocation**, select one of the following:
   - **Allow attendees to choose computers**. This allows participants to choose any computer reserved for this session.
   - **Assign attendees to computers manually**. When you select this option, participants can only connect to computers assigned to them.

3 Optional. Select the **Record remote computers automatically when participants connect** check box. When you select this option, the **Record** button turns on for all reserved computers. Whenever a participant logs into a reserved computer, the computer records the actions. When the participant logs out, the recording stops.

4 Click **Start**.

   Training Manager contacts the remote computers reserved for your Hands-on Lab session.

   Once the reserved computers are contacted, the Start Hands-on Lab Confirmation dialog box appears.

   The Start Hands-on Lab Confirmation dialog box lists all the computers that are connected to the session and the total attendees in the session.

5 Optional. To limit the number of attendees that can connect to each remote computer, under **Limit Attendees**, select the check box next to **Limit**. Select the number of attendees that you want to limit to each computer.

6 If you selected **Assign attendees to computers manually** in the Start Hands-on Lab dialog box, see **Assigning computers during Hands-on Lab sessions** (on page 354).

7 Click **Done**.
Recording Hands-on Lab sessions

As the presenter, you can record the actions of each remote computer in the Hands-on Lab session. This can be helpful for observing how participants use the remote computer during a training session. You can choose to begin recording automatically when participants connect to a remote computer, or you can start recording at any time from the Hands-on Lab panel.

Once you record a remote computer, Training Manager downloads and installs WebEx Player on your computer. You must use WebEx Player to play a recording.

To record remote computers automatically when connected:

1. In the Session window, on the Lab menu, choose Hands-on Lab Options. The Hands-on Lab Options dialog box appears.

2. Select the Record remote computers automatically when participants connect check box.

3. Under Record to folder on remote computer, type a folder location at which to store the recording.

   The folder is stored on the remote computer. The names of WebEx Recording Format (WRF) files have a .wrf extension.

4. Click OK.

Training Manager records all actions taken on the remote computers while participants are connected.
To start recording from the Hands-on Lab panel:
1. On the Hands-on Lab panel, select the computer that you want to record from the Computers list.
2. Click the Record button.

Training Manager records all actions taken on the remote computers while participants are connected.

To pause recording:
1. Under Computers on the Hands-on Lab panel, select the computer that you want to pause recording from the list of computers.
2. Click the Pause button.
3. To resume recording, click the Pause button again.

To stop recording:
1. Under Computers on the Hands-on Lab panel, select the computer that you want to stop recording from the list of computers.
2. Click the Stop button.
Assigning computers during Hands-on Lab sessions

If you selected **Assign attendees to computers manually** in the Start Hands-on Lab dialog box, you can assign computers to participants from the Start Hands-On Lab Confirmation dialog box, from the Hands-on Lab panel, or from the **Lab** menu.

**Note:** If you chose the scheduling option to support over 500 attendees for this session, the number of participants that can access a Hands-on Lab computer is limited to 50.

To assign computers to participants during a Hands-on Lab session:

1. From the Start Hands-On Lab Confirmation dialog box, from the Hands-on Lab panel, or from the Session window **Lab** menu, click **Assign Computers**.
   The Assign Computers dialog box appears.
2 Under **Unassigned Participants**, select the name or names of participants that you want to assign to a particular computer. Hold down the **Shift** key to select more than one participant.

3 Under **Computers**, select the computer that you want to assign to the selected participant.

4 Click **Assign**.

5 To give control of the computer to a particular participant, click **Give Control**.

6 When you are finished assigning computers, click **OK**.

7 Click **Done** in the Start Hands-on Lab Confirmation dialog box.
Unassigning Participants from Computers

To unassign a participant from a computer, do one of the following:

- On the Lab menu, point to Assign Computers. In the Assign Computers dialog box, select the name of the participant that you want to unassign. Click Unassign.
- On the Hands-on Lab panel, click Assign. In the Assign Computers dialog box, under Computers, expand the user list for the computer. Select the name of the participant that you want to unassign and click Unassign.
- Click OK.

Broadcasting a message to participants

As the presenter, you can choose to broadcast a message to all participants or to select participants in the Hands-on Lab session.

To broadcast a message,

1. Do either of the following:
   - On the Lab menu, point to Broadcast Message To.
   - On the Hands-on Lab panel, click the Broadcast Message button.

2. In the menu that appears, select All or choose a remote computer to which you want to broadcast your message.

The Broadcast Message dialog box appears.
Chapter 24: Managing Hands-on Lab

In the Message box, type your message.

4 Click OK.

Your message appears on the selected participants' desktops.

Responding to a request for help

If a participant requests help, the Ask for Help indicator appears next to participant's name in the Hands-on Lab panel.

To respond to a request for help:

1 Next to the participant's name, click the Ask for Help indicator.

The Broadcast Message dialog box appears.

2 Type a message in the Message box.

3 Click OK.

Your message appears on the participant's desktop.
Tip: You can then connect to the participant’s remote computer and use the chat viewer to continue to help the participant.

Taking control of a Hands-on Lab computer

As the presenter, you can take control of any Hands-on Lab computer.

To take control of a computer:
1. Connect to the remote computer.
2. In the Hands-on Lab Manager panel, click the Pass Control button.

You now have control of the remote computer.

Asking all to return from labs

During a Hands-on Lab session, you can ask all the participants to return from the Hands-on Lab session to the main training session. You can choose to have the participants return immediately, or you can give them a time limit for returning.

To ask participants to return:
1. On the Lab menu, choose Ask All To Return.
   The Ask All To Return dialog box appears.
2 Do either of the following:
   - Select within and choose a time in minutes from the drop-down list. This option gives participants time to finish the tasks that they are working on.
   - Select immediately and end all sessions after 30 seconds.

3 Click OK.

   A confirmation dialog box appears in which you confirm your request to ask all participants to return from Hands-on Lab.

4 Click OK.

   All participants receive a message asking them to return from Hands-on Lab. The Hands-on Lab sessions end either after 30 seconds or after the time you selected in the Ask All To Return dialog box.

Ending the Hands-on Lab session

*For training hosts only*

You, as the training session host, can end the Hands-on Lab sessions at any time.

**To end a Hands-on Lab session:**

1 On the Lab menu, click **End Hands-on Lab**.
   
   A confirmation message appears.

2 Click **OK**.

   The Hands-on Lab session ends for all participants.
Note: If you do not manually end the Hands-on Lab sessions, they end automatically when your reservation for Hands-on Lab computers expires. A message appears on your screen 15 minutes before your reservation expires. If the computers have not been reserved for another training session, you can continue to connect to the Hands-on Lab computers. If the host of the new session attempts to connect to the reserved computers, you will be disconnected from the reserved computers.
Using Hands-on Lab

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of Hands-on Lab</td>
<td>About Hands-on Lab (on page 361)</td>
</tr>
<tr>
<td>connect to a reserved computer</td>
<td>Connecting to a reserved computer (on page 362)</td>
</tr>
<tr>
<td>use the Hands-on Lab Session Manager</td>
<td>Using the Hands-on Lab Manager (on page 365)</td>
</tr>
<tr>
<td>use Hands-on Lab chat</td>
<td>Using Hands-on Lab chat (on page 366)</td>
</tr>
<tr>
<td>ask for help in Hands-on Lab</td>
<td>Asking for help in Hands-on Lab (on page 367)</td>
</tr>
<tr>
<td>transfer files in a Hands-on Lab session</td>
<td>Transferring files in a Hands-on Lab session (on page 368)</td>
</tr>
<tr>
<td>pass control of the Hands-on Lab computer</td>
<td>Passing control of the Hands-on Lab computer (on page 369)</td>
</tr>
<tr>
<td>leave a Hands-on Lab session</td>
<td>Leaving a Hands-on Lab session (on page 370)</td>
</tr>
<tr>
<td>disconnect from computers</td>
<td>Disconnecting from computers (on page 371)</td>
</tr>
</tbody>
</table>

About Hands-on Lab

Hands-on Lab sessions allow instructors to prepare lessons or exercises that students can complete on remote computers on which training software is installed. Students can use these remote computers during a training session for hands-on learning and practice. Because instructors can control Hands-on Lab sessions, they can maintain an optimized lab environment that is effective, familiar, and consistent.
To set up a Hands-on Lab session, the host schedules the lab and reserves the computers for the presenter. Then the host starts the Hands-on Lab within the training session. The presenter assigns computers to participants, connects the computers with a mouse click so that participants can use the virtual computer for their learning and practice activities. Participants can also

- connect to a reserved computer
- chat with other Hands-on Lab participants
- ask for help during a Hands-on Lab session
- transfer files in a Hands-on Lab session
- pass control of a Hands-on Lab computer
- disconnect from a Hands-on Lab computer

## Connecting to a reserved computer

Participants in a Hands-on Lab session can connect to an unassigned computer or a preassigned computer depending on which option the presenter chose when starting the session.

## Connecting to unassigned computers

If the presenter has allowed participants to choose their own remote computer, they can connect to any reserved computer in the session.

**To connect to a computer, do one of the following:**

1. On the Lab menu, point to Connect to Computer. Then select the remote computer to which you want to connect.
2. On the Hands-on Lab panel, select the computer to which you want to connect.
3. Click Connect.

You are connected to the remote computer. The Hands-on Lab Manager window is available from the Session Controls Panel on your desktop. You can also control the remote computer using the Sharing menu.
Connecting to preassigned computers

If the presenter has manually assigned computers to Hands-on Lab participants, the Hands-on Lab Session connect message appears on the participant's desktop.

To connect to the remote computer, click Yes.

You are now connected to the remote computer. The Hands-on Lab Manager window is available from the Session Controls Panel on your desktop. You can also control the remote computer using the Sharing menu.

Using an audio conference in a Hands-on Lab session

You can communicate with participants in a Hands-on Lab session using your computer or telephone. All the audio conferencing options that the host sets up in the main session apply to the Hands-on Lab session.

Notes:

- Participants in a Hands-on Lab session cannot join a Hands-on Lab session audio conference until the Hands-on Lab session presenter joins the audio conference.
- When a participant who has already joined the main audio conference session joins a Hands-on Lab session, he or she is switched from the main session audio conference to the Hands-on Lab session audio.
conference automatically. Participants cannot join an audio conference in the main session while connected to a Hands-on Lab session audio conference.

- If audio conferencing is not available or has not been started for the main session before the Hands-on Lab session is started, audio conferencing for Hands-on Lab sessions is disabled also.
- When a participant who is in the Hands-on Lab session audio conference leaves a Hands-on Lab session, he or she disconnects from the Hands-on Lab session audio conference automatically. The participant returns to the main session and can join the main audio conference by selecting Join Audio Conference on the Audio menu.

Starting an audio conference during a Hands-on Lab session

When you start a Hands-on Lab session, all the audio conference options that the host sets up in the main session are available during the Hands-on Lab session.

The Join Audio Conference message box automatically appears in the Session window for each participant in the Hands-on Lab session.

Note: To use a VoIP audio conference, your computer must meet the system requirements for Integrated VoIP. For details, see the Audio release notes available from the User Guides page on your Training Center Web site.

To start an audio conference in a breakout session:

1. In the Audio Conference dialog box, decide whether to use the computer or phone to join the audio conference. If the Audio Conference dialog is not already appearing when the Hands-on Lab session starts, it is available from the Audio menu.

2. If joining by phone, make your selections in the dialog box, click Call Me, and then follow the instructions on the phone.

   A telephone icon appears next to your name in the Participants panel to indicate that you have joined the audio conference using your phone.

3. If joining by computer, click Join.

4. Optional. Use the Volume dialog box to adjust the volume of your speakers or microphone or to mute or unmute your speakers or microphone.
Optional. To use the Audio Setup Wizard to set up audio options, choose Audio Setup Wizard on the Audio menu.

A headset symbol appears to the left of your name in the participant list on the Hands-on Lab Sessions Manager panel.

Note: The headset or telephone icon flashes to indicate which participant is speaking during the Hands-on Lab session.

To change to an audio conference in a Hands-on Lab session:
1. In the Audio Conference dialog box, decide whether to change to the Hands-on Lab session audio conference.
2. Select Yes to join the Hands-on Lab session audio conference.
3. Select No to remain in the main session's audio conference.

Leaving and ending an audio conference in a Hands-on Lab session

You can leave or end an audio conference at any time during a Hands-on Lab session.

To leave an audio conference:
1. Click the Audio button on the Participants panel.
2. In the Audio Conference dialog box, click Leave WebEx Audio.

To end a Hands-on Lab session and audio conference (hosts only):
From the Lab menu, click End Hands-on Lab, and then click OK in the confirmation message that appears.

Using the Hands-on Lab Manager

Once the presenter starts the Hands-on Lab session and participants have connected to the computers, the Hands-on Lab Session Manager is available on your desktop. On the Session Controls Panel, click Hands-on Lab Panel.
The Hands-on Lab Manager lists the participants in the lab to which they are connected. In the Hands-on Lab Manager, participants can transfer files to and from their computers and ask for help. When you are in a Hands-on Lab session, you can use the Hands-on Lab computer directly from your own computer just as if you are sitting at the Hands-on Lab computer.

A green computer icon next to your name indicates that you are connected to the Hands-on Lab computer.

**Using Hands-on Lab chat**

You can send and receive chat messages to and from other Hands-on Lab participants. All chat messages that you either send or receive appear in your Chat viewer. Hands-on Lab chat works the same way that chat works in the training session, except in Hands-on Lab, your chat message sends to all Hands-on Lab participants.
To use Hands-on Lab chat:

1. On the Session Controls Panel on your desktop, click Chat Panel.

2. Type a message in the Chat box.

3. Click Send.

   All Hands-on Lab participants receive the chat message in their Chat message boxes.

**Asking for help in Hands-on Lab**

You can ask for help at any time during the Hands-on Lab session.

**To ask for help:**

On the Hands-on Lab Manager window, click the Raise Hand button.
The **Raise Hand** indicator appears next to your name on the Hands-on Lab Manager window, alerting the presenter to your request for help.

**Transferring files in a Hands-on Lab session**

During a Hands-on Lab session, you can transfer files to and from the Hands-on Lab computer. You can transfer files that reside at any location on either the Hands-on Lab computer or on your local computer.

Transferring files works the same way as it does within the training session.

*Note: This feature is not supported on the Mac.*

**To transfer files to or from your computer,**

1. Do *one* of the following:
   - On the Hands-on Lab Manager window, click the **Transfer File** button.
   - On the **Sharing** menu, click **Transfer File**.

The Hands-on Lab Transfer File window appears.
In the pane on the left, the file directory for your local computer is labeled Local Computer. The file directory for the Hands-on Lab remote computer is labeled Remote Computer.

2 In the pane on the left, expand a directory to display the folder in which you want to transfer a file.

3 In the pane on the right, expand the other directory until the file that you want to transfer appears.

4 Drag the file to the folder in which you want to transfer it into the pane on the left.

**Passing control of the Hands-on Lab computer**

During a Hands-on Lab session, you can pass control of the computer to anyone connected to the same computer.

**To pass control of the computer:**

1 On the Hands-on Lab Manager window, select the name of the participant to whom you want to transfer control. The participant must be connected to the computer at the time you transfer control.

A green icon next to a participant’s name indicates that the participant is connected to the computer.
A gray icon next to a participant’s name indicates that the participant is disconnected from the computer.

2 In the Hands-on Lab Manager window, click the **Pass Control** icon.

The **Pass Control** icon appears next to the participant who has control of the Hands-on Lab computer.

**Leaving a Hands-on Lab session**

You can leave a Hands-on Lab session and return anytime during the session.

**To leave a Hands-on Lab session:**

On the *Sharing* menu, click **Leave Hands-on Lab**.
To reconnect to the Hands-on Lab computer, see *Connecting to a reserved computer* (on page 362).

### Disconnecting from computers

Once you have finished your Hands-on Lab sessions, you can disconnect from your remote computer.

**To disconnect from the remote computer:**

1. On the Session Controls Panel, click **Return to Main Window**.

   ![Return to Main Window](image)

   The Return to Hands-on Lab Computer dialog box appears.

2. Click **Disconnect from Computer**.
Using Breakout Sessions

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>See…</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of breakout sessions</td>
<td>About Breakout sessions (on page 373)</td>
</tr>
<tr>
<td>use the Breakout Sessions window</td>
<td>Using the Breakout Session window (on page 374)</td>
</tr>
<tr>
<td>use the breakout sessions menus</td>
<td>Breakout Session menus (on page 378)</td>
</tr>
<tr>
<td>control breakout sessions</td>
<td>Controlling breakout sessions (on page 382)</td>
</tr>
<tr>
<td>present a breakout session</td>
<td>Presenting breakout sessions (on page 393)</td>
</tr>
</tbody>
</table>

About Breakout sessions

A breakout session is a private content sharing session that includes two or more participants. Breakout sessions allow participants to brainstorm and collaborate in small, private groups that can include presenters or other students, away from the main training session. In a breakout session, small groups interact within a main Breakout Session window using much of the same features, such as sharing whiteboards and applications, as in the main training session. Multiple breakout sessions can occur at once. For more information about the Breakout Session window, see Using the Breakout Session window (on page 374).

Only those who are participating in a breakout session can view shared content. You can view a list of current breakout sessions in the main Session window on the Breakout Sessions panel.
In a breakout session, the participant who starts and conducts the breakout session is designated as the presenter of the breakout session. If Automatic Assignment is enabled, then a presenter may be randomly assigned to a breakout session. The Presenter’s icon appears next to the presenter’s name on the Breakout Session’s Participant’s panel.

For participants to start and join breakout sessions, the presenter must first allow breakout sessions for the training session. Then the host, the presenter, or an attendee who has breakout session privileges can create a breakout session.

**Tip:** Although breakout session attendees can be assigned manually or automatically during the training session, you can save time by pre-assigning attendees while scheduling the training session. For more information, see *Setting up breakout sessions* (on page 91).

**Note:** If you chose the scheduling option to support over 500 attendees for this session, the number of participants that can join a breakout session will still be limited to 100.

### Using the Breakout Session window

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>See…</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of Breakout Session window</td>
<td><em>Breakout Session window overview</em> (on page 375)</td>
</tr>
<tr>
<td>get an overview of Breakout Session panels</td>
<td><em>Breakout Session panel overview</em> (on page 377)</td>
</tr>
<tr>
<td>get an overview of Breakout Session menus</td>
<td><em>Breakout Session menus</em> (on page 378)</td>
</tr>
</tbody>
</table>
Breakout Session window overview

The Breakout Session window appears in the main session window once you start or join a breakout session. It provides the ability for you to share documents or presentations, applications, whiteboards, or your desktop during a breakout session.

When you are viewing the Breakout Session window, the words **Breakout Session** appears on the Breakout Session Quick Start and Info tabs, and on the title bar of the window. The Breakout Session window has its own menus and toolbar. It also has a Breakout Session panel that allows you to view the presenter and participants of the breakout session. You can also chat with the other breakout session participants using the **Chat** box on the Breakout Session panel.

The Breakout Session Quick Start page appears only for the Breakout Session presenter. As a presenter, you can quickly connect to your Breakout Session audio conference, open a new whiteboard, or choose a sharing option. The Session Info page appears for both presenters and participants, and includes details for your session.
Chapter 26: Using Breakout Sessions
Breakout Session panel overview

The Breakout Session panel appears on the right side of the Breakout Session Manager window during a breakout session. It allows you to view the presenter and participants of the breakout session. You can also chat with the other breakout session participants using the Chat box on the Breakout Session panel.

The attendee's Breakout Session Participants panel also includes feedback icons, as in the main session. For information on using feedback icons, see Providing feedback (on page 338).

When an application, desktop, Web browser, or document is shared in a breakout session, the Breakout Session panel appears on each participant's desktop as a floating panel. You can then access the Sharing Controls dashboard that appears in the breakout session window.
# Breakout Session menus

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>learn about Breakout Session File menu</td>
<td>Breakout Session File menu (on page 379)</td>
</tr>
<tr>
<td>learn about Breakout Session Edit menu</td>
<td>Breakout Session Edit menu (on page 380)</td>
</tr>
<tr>
<td>learn about Breakout Session Share menu</td>
<td>Breakout Session Share menu (on page 380)</td>
</tr>
<tr>
<td>learn about Breakout Session View menu</td>
<td>Breakout Session View menu (on page 381)</td>
</tr>
<tr>
<td>learn about Breakout Session Communicate menu</td>
<td>Breakout Session Communicate menu (on page 381)</td>
</tr>
<tr>
<td>learn about Breakout Session Participant menu</td>
<td>Breakout Session Participant menu (on page 382)</td>
</tr>
</tbody>
</table>
Note: For Mac users, the Breakout Session windows described in this section will differ slightly. All functionality will remain, although selections may be found under another menu. For example, the End Breakout Session command is available from the Training Center menu.

Breakout Session File menu

The File menu in the Breakout Session window is similar to the File menu in the main Session window. You can open and share files, open chat, save documents and chats, print, end the breakout session (if you are the presenter of that session), or leave the breakout session (if you are a participant). You cannot end a training session, and you cannot transfer files or upload files using the File menu in a breakout session.
Breakout Session Edit menu

The Edit menu in the Breakout Session window is similar to the Edit menu in the main Session window. Using the Edit menu, you can edit and annotate shared content in the content viewer. The Find command and the Preferences command are not available on the File menu in a breakout session.

Breakout Session Share menu

The Share menu in the Breakout Session window works the same way as the Share menu in the main Session window.
Chapter 26: Using Breakout Sessions

Breakout Session View menu

The **View** menu in the Breakout Session window works the same way as the **View** menu in the main Session window. The only difference is that the **Panels** command refers to viewing the **Breakout Session panel** only.

Breakout Session Audio menu

The **Audio** menu in the Breakout Session window is similar to the **Audio** menu in the main Session window. The only differences are that you cannot open chat or feedback from the **Audio** menu in a breakout session. Depending on your role and privileges during a breakout session, the **Audio** menu provides commands to

- join, leave, or switch to another audio conference mode (join by phone or computer)—*all participants*
- adjust volume in if joining by computer—*all participants*
Breakout Session Participant menu

The Participant menu in the Breakout Session window is similar to the Participant menu in the main Session window. Using the Participant menu, you can make a participant the current speaker, mute and unmute microphones, pass the presenter role to another participant, limit attendance to the breakout session, and expel a participant from a breakout session (training session presenter only). Breakout session participants are limited to muting themselves.

Controlling breakout sessions

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of control breakout</td>
<td>About controlling breakout sessions (on page</td>
</tr>
<tr>
<td>sessions</td>
<td>383)</td>
</tr>
<tr>
<td>grant breakout session privileges</td>
<td>Granting breakout session privileges (on page</td>
</tr>
<tr>
<td></td>
<td>383)</td>
</tr>
<tr>
<td>allow breakout sessions</td>
<td>Allowing breakout sessions (on page 384)</td>
</tr>
<tr>
<td>create a breakout session for another</td>
<td>Manually creating a breakout session for another</td>
</tr>
<tr>
<td>participant</td>
<td>participant (on page 388)</td>
</tr>
<tr>
<td>ask all participants to return from a</td>
<td>Asking all participants to return from a</td>
</tr>
<tr>
<td>breakout session</td>
<td>breakout session (on page 390)</td>
</tr>
<tr>
<td>end all breakout sessions</td>
<td>Ending all breakout sessions (on page 391)</td>
</tr>
<tr>
<td>request a breakout session presenter</td>
<td>Requesting a breakout session presenter to share content (on page 391)</td>
</tr>
</tbody>
</table>
If you want to… | See…
---|---
remove a participant from a breakout session | Removing a participant from a breakout session (on page 392)

### About controlling breakout sessions

During a training session, depending on your role and privileges, you can control breakout sessions by doing the following:

- Specify breakout session privileges for attendees.
- Allow participants to start their own breakout sessions.
- Create a breakout session for another participant.
- Send a broadcast message to all breakout session participants
- Ask panelists and participants to return from their breakout sessions.
- End all of the breakout sessions at once.
- Request a breakout session presenter to share content.
- Remove a participant from a breakout session.

### Granting breakout session privileges

At any time during a training session, you can specify that attendees can start breakout sessions with

- all attendees or all participants
- only the training session host
- only the presenter
- any other attendee, privately

You can also remove breakout session privileges at any time.

**To specify privileges for attendees during a breakout session:**

1. In the Session window, on the Participant menu, choose **Assign Privileges**. The Assign Privileges dialog box appears.
2. Under **Communications**, select the check box next to **Breakout sessions with**.
Then select the check boxes for the breakout session privileges that you want to grant to all attendees:

- Host
- Presenter
- Panelists
- All attendees

3 Click OK.

**Note:** The training session host and the presenter always have all breakout session privileges, regardless of the breakout session privileges that other attendees have.

### Allowing breakout sessions

As a presenter, you can allow panelists or participants to start their own breakout sessions.

**Note:** This option is only available when manual breakout session assignment is selected.

**To allow breakout sessions:**

1 In the Session window, on the **Breakout** menu, choose **Open Breakout Session Panel**.
On the Breakout Sessions panel, select **Breakout Assignments**. The Breakout Session Assignment window appears.

3. Select the **Allow attendees to create breakout sessions** check box.

4. Click **OK**.

The Breakout menu displays the breakout session options for all participants.

**Note:**
- When a participant who has already joined the main audio conference session joins a breakout session, he or she is switched from the main session audio conference to the breakout session audio conference automatically. Participants cannot join an audio conference in the main session while connected to a breakout session audio conference.
- If audio conferencing is not available or has not been started for the main session before the breakout session is started, audio conferencing for breakout sessions is disabled also.
- When a participant who is in the breakout session audio conference leaves a breakout session, he or she disconnects from the breakout session audio conference automatically. The participant returns to the main session and can join the main audio conference by selecting Join Audio Conference on the Audio menu.

**Creating a breakout session with automatic assignment**

*For host, panelists, or training session presenters only*

As the training session presenter or panelist, you can create a breakout session with attendee assignments made automatically.
To create a breakout session with automatic assignments:

1. In the Breakout Session panel, click **Breakout Assignment**. The Breakout Session Assignment dialog box appears.
2. Select **Automatically**.

3. Choose one of the following settings for your breakout session:
   - Set the number of breakout sessions
   - Set the number of attendees in each breakout session

4. Choose the number value for your setting.
5. Click **OK**.

   Your settings will be reflected in the Breakout Session panel. Once you start a breakout session, an attendee will be assigned randomly as the presenter.

Creating a breakout session with manual assignment

*For host, panelists, or training session presenters only*

As the training session presenter or panelist, you can create a breakout session and assign attendees manually during a session.

**To create a breakout session and manually assign attendees:**

1. In the Breakout Session panel, click **Breakout Assignment**.
   
The Breakout Session Assignment dialog box appears.
2 Select **Manually**.

3 Add a session by clicking the following:

![Add Session button](image)

4 In the breakout session name text box, type a new name or use the default name that is provided.

5 Highlight the name of the breakout session.

6 Highlight the names of any **Not Assigned** participant for whom you want to add to the breakout session and click the >> button.
7 Select the radio button next to the participant that you would like to be the presenter.

8 Click OK.

The breakout session appears in the Breakout Session panel and can be started by the presenter at any time.

Manually creating a breakout session for another participant

For host, panelists, or training session presenters only

As the training session presenter or panelist, you can create a breakout session and select another participant as the breakout session presenter.

To create a breakout session manually for another participant:

1 In the Breakout Session window, select the name of the participants whom you want to invite to the breakout session. To select more than one participant, hold down the Shift key while you select participants.

2 Do either of the following:
   - On the Breakout menu, point to Breakout Session Assignment.
   - On the Breakout Session panel, click Breakout Assignment.

The Breakout Session Assignment dialog box appears.
3 Add a session by clicking the following:

[Add Session]  [Mac version]

4 In the breakout session name text box, type a new name or use the default name that is provided.

5 Highlight the name of the breakout session.

6 Highlight the name of the participant for whom you are creating the breakout session and click the >> button.

7 Add additional **Not Assigned** participants to the session.
8 Ensure that the radio button is selected next to the participant that you would like to be the presenter.

9 Click OK.

The breakout session appears in the Breakout Session panel and can be started by the presenter at any time.

Asking all participants to return from a breakout session

As the presenter, you can ask panelists and participants to return from their breakout sessions.

To ask all to return from breakout sessions:

In the Session window, on the Breakout menu, choose Ask All to Return. All participants in breakout sessions receive a message asking them to return to the main training session. They can choose to leave the session or continue.

Sending a broadcast message to all breakout sessions

As the presenter, you can broadcast a message to all participants or to select participants in breakout sessions.

To broadcast a message:

1 In the Session window, on the Breakout menu, choose Broadcast Message. The Broadcast Message dialog box appears.

2 Select who you would like to receive the message from the To drop-down list.
3 In the **Message** box, type your message.

4 Click **OK**.

Your message appears on the selected participants' desktops during their breakout sessions.

**Ending all breakout sessions**

As the presenter, you can end all of the breakout sessions at once.

**To end all breakout sessions:**

In the Breakout Session panel, click **End All**. You can also end all sessions from the Breakout menu.

All participants receive a message that their breakout session will end in 30 seconds.

**Requesting a breakout session presenter to share content**

As the training session presenter, you can request a breakout session presenter to share his or her shared content in the main training session. Before a breakout session presenter can share content in the main session, you must end all the breakout sessions.

**To request a breakout session presenter to share content:**

1 In the Session window, on the **Breakout** menu, choose **Share Breakout Session Content**.

The Share Breakout Session Content dialog box appears. The names of the breakout sessions and the names of the last presenters of the breakout sessions appears in a list.
2 Select the name of the presenter in the list whom you want to request to share breakout session content.

3 Click OK.

The last presenter receives instructions for sharing content from the breakout session in the main training session.

Removing a participant from a breakout session

As the original presenter of a training session, you can remove a participant from a breakout session. Removing a participant from a breakout session does not remove the participant from the main training session.

To remove a participant from a breakout session:

1 In the Breakout Session window, in the participant list on the Breakout Session panel, select the name of the participant whom you want to remove from the breakout session.

2 On the Participant menu, choose Expel from Breakout Session.

A confirmation message appears, in which you can verify that you want to remove the participant from the breakout session.

3 Click Yes.
The participant is removed from the breakout session.

**Presenting breakout sessions**

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>See…</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of presenting a breakout session</td>
<td>About presenting a breakout session (on page 393)</td>
</tr>
<tr>
<td>create a breakout session</td>
<td>Creating a breakout session (on page 394)</td>
</tr>
<tr>
<td>start a breakout session that was created for you</td>
<td>Starting a breakout session that was created for you (on page 396)</td>
</tr>
<tr>
<td>leave a breakout session</td>
<td>Leaving a breakout session (on page 397)</td>
</tr>
<tr>
<td>use an audio conference in a breakout session</td>
<td>Using an audio conference in breakout sessions (on page 397)</td>
</tr>
<tr>
<td>allow, limit, or prevent more participants from joining the breakout session</td>
<td>Managing who can join the breakout session (on page 399)</td>
</tr>
<tr>
<td>pass the presenter role to another participant</td>
<td>Passing the presenter role to another participant (on page 401)</td>
</tr>
<tr>
<td>present information in a breakout session</td>
<td>Presenting information in a breakout session (on page 402)</td>
</tr>
<tr>
<td>grant remote control to a participant in a breakout session</td>
<td>Granting remote control to a participant in a breakout session (on page 402)</td>
</tr>
<tr>
<td>end your breakout session</td>
<td>Ending your breakout session (on page 403)</td>
</tr>
<tr>
<td>share content from your breakout session in the main session</td>
<td>Sharing content from your breakout session in the main session (on page 404)</td>
</tr>
</tbody>
</table>

**About presenting a breakout session**

Once you start a breakout session, you can begin sharing content. The Breakout Session window replaces the main Session window on your desktop. You conduct your breakout session using the options available in the Breakout Session window menus and the **Sharing Controls** dashboard that appears on your screen.

As the presenter of the breakout session, you can:
Chapter 26: Using Breakout Sessions

- Use an audio conference. For details, see *Using an audio conference in breakout sessions* (on page 397).

- Allow or prevent more participants from joining a breakout session, as well as limit the number of participants. For details, see *Managing who can join the breakout session* (on page 399).

- Pass the presenter role to another participant. For details, see *Passing the presenter role to another participant* (on page 401).

- Present information from your computer. For details, see *Presenting information in a breakout session* (on page 402).

- Let another participant remotely control your application or desktop. For details, see *Granting remote control to a participant in a breakout session* (on page 402).

- End the breakout session. For details, see *Ending your breakout session* (on page 403).

- Share content from your breakout session in the main session (last presenters only). For details, see *Sharing content from your breakout session in the main session* (on page 404).

Creating a breakout session - attendees

Once the presenter allows breakout sessions, attendees can create their own sessions.

**To create a breakout session:**

1. Do *either* of the following:
   - On the Breakout menu, point to Breakout Session Assignment.
   - On the Breakout Session panel in the main Session window, click Breakout Assignment.

The Breakout Session Assignment dialog box appears.
2 Select **Manually** and then add a breakout session.

3 Add a session by clicking the following:

![Add Session button](image)

<table>
<thead>
<tr>
<th>Windows version</th>
<th>Mac version</th>
</tr>
</thead>
</table>

4 Type a new breakout session name or use the default name that is provided.

5 Highlight the name of the breakout session.

6 Highlight the names of the **Not Assigned** participants for whom you want to add to the breakout session and click the **>>** button.

7 Optional. To view additional options, select the options icon.
Chapter 26: Using Breakout Sessions

8 Optional. To allow participants to join the breakout session without an invitation, select the check box next to **Let others join the breakout session without invitation**.

9 Optional. To limit the number of participants for the breakout session, select the check box next to **Limit number of participants who can join this session**. Then, in the box, type or select a number of participants.

10 Click **OK**.

Your breakout session automatically starts, and each invitee receives an invitation to join. The invitee can choose **Yes** or **No**. For breakout session participants, the Breakout Session window appears, listing the names of the presenter and participants of the breakout session in the Breakout Sessions panel. It also displays a chat panel in which participants can chat with other participants. Your name appears in the Breakout Sessions panel in the main Session window.

**Starting a breakout session that was created for you**

The training session host, presenter, or panelist may create a breakout session by inviting participants and designate you as the presenter.

**To start a breakout session that was created for you:**

1 In the message box that you receive when someone else creates a breakout session for you, click **Yes**.

2 Optional. To start the breakout session later, click **No**. You can start the breakout session any time by selecting the name of the session or your name on the Breakout Session panel, and then clicking **Start**.

**Joining a breakout session**

The presenter determines whether a participant can join a breakout session, either by inviting participants, or by allowing participants to join without an invitation.
For details on the audio conference in a breakout session, see *Using an audio conference in breakout sessions* (on page 397).

**To join a breakout session, do one of the following:**
- On the Breakout menu, choose Join Breakout Session and then the name of the breakout session that you wish to join.
- On the Breakout Session panel, highlight the name of the breakout session that you wish to join and then click Join.

**Leaving and re-joining a breakout session**

If you are a participant in a breakout session, rather than the presenter, you can leave a session and return to it later.

**To leave a breakout session, do one of the following:**
- Close the Breakout Session Manager window by clicking the Close button in the upper-right corner of the window.
- On the File menu, choose Leave Breakout Session.
- On the Breakout Session panel, click Leave Breakout Session.

**To re-join a breakout session:**

From the Breakout Session menu, select Join Breakout Session.

**Using an audio conference in breakout sessions**

You can communicate with participants in a breakout session using your computer or telephone. All the audio conferencing options that the host sets up in the main session apply to the breakout session.

---

**Note:**

When a participant who has already joined the main audio conference session joins a breakout session, he or she is switched from the main session audio conference to the breakout session audio conference automatically. Participants cannot join an audio conference in the main session while connected to a breakout session audio conference.

If audio conferencing is not available or has not been started for the main
session before the breakout session is started, audio conferencing for breakout sessions is disabled also.

When a participant who is in the breakout session audio conference leaves a breakout session, he or she disconnects from the breakout session audio conference automatically. The participant returns to the main session and can join the main audio conference by selecting Join Audio Conference on the Audio menu.

Starting an audio conference during a breakout session

When you start a breakout session, all the audio conference options that the host sets up in the main session are available during the breakout sessions.

The Join Audio Conference message box automatically appears in the Session window for each participant in the breakout session.

Note: To use a VoIP audio conference, your computer must meet the system requirements for Integrated VoIP. For details, see the Audio release notes available from the User Guides page on your Training Center Web site.

To start an audio conference in a breakout session:

1 In the Audio Conference dialog box, decide whether to use the computer or phone to join the audio conference. If the Audio Conference dialog is not already appearing when the breakout session starts, it is available from the Audio menu.

2 If joining by phone, make your selections in the dialog box, click Call Me, and then follow the instructions on the phone.

A telephone icon appears next to your name in the Participants panel to indicate that you have joined the audio conference using your phone.

3 If joining by computer, click Join.

4 Optional. Use the Volume dialog box to adjust the volume of your speakers or microphone or to mute or unmute your speakers or microphone.

5 Optional. To use the Audio Setup Wizard to set up audio options, choose Audio Setup Wizard on the Audio menu.

A headset symbol appears to the left of your name in the participant list on the Breakout Sessions panel.
Chapter 26: Using Breakout Sessions

To change to an audio conference in a breakout session:
1. In the Audio Conference dialog box, decide whether to change to the breakout session audio conference.
2. Select Yes to join the breakout session audio conference.
3. Select No to remain in the main session’s audio conference.

Leaving and ending an audio conference in a breakout session
You can leave or end an audio conference at any time during a breakout session.

To leave an audio conference:
1. Click the Audio button on the Participants panel.
2. In the Audio Conference dialog box, click Leave WebEx Audio.

To end a breakout session and audio conference:
In the Breakout Session panel, click End Breakout Session.

Managing who can join the breakout session
You can control who can join a breakout session that is in progress in several ways:
- Let more participants join
- Prevent more participants from joining
- Specify the number of participants that can join

Note: If you chose the scheduling option to support over 500 attendees for this session, the number of participants that can join a breakout session will still be limited to 100.
To manage who can join a breakout session in progress:

1. Do *either* of the following:
   - On the **Breakout** menu, point to **Breakout Session Assignment**.
   - On the Breakout Session panel in the main Session window, click **Breakout Assignment**.

   The Breakout Session Assignment dialog box appears.

2. Select **Manually** and then add a breakout session.

3. Add a session by clicking the following:
4 Type a new breakout session name or use the default name that is provided.
5 Highlight the name of the breakout session.
6 Highlight the names of the **Not Assigned** participants for whom you want to add to the breakout session and click the >> button.
7 Optional. To view additional options, select the options icon.

8 Optional. To allow participants to join the breakout session without an invitation, select the check box next to **Let others join the breakout session without invitation**.

9 Optional. To limit the number of participants for the breakout session, select the check box next to **Limit number of participants who can join this session**. Then, in the box, type or select a number of participants.

10 Click **OK**.

**Note:** If when starting the session, you specified a number of participants who can join the session, only that number of participants can join the session, even if the **Let more participants join this session without invitation** command is selected.

**Passing the presenter role to another participant**

As the breakout session presenter, you can pass the presenter role to another breakout session participant. The presenter of the breakout session is responsible for conducting the breakout session.

**To pass the presenter role:**

1 On the Breakout Session panel, in the participant list, select the name of the participant to whom you want to pass the presenter role.

2 Do *either* of the following:
In the Breakout Session window, on the Participant menu, choose Pass Presenter Role.

On the Breakout Session panel, click Make Presenter.

The selected participant is now the presenter of the breakout session. The presenter indicator appears next to the participant's name.

Note: You cannot pass the presenter role when sharing an application, your desktop, or a Web browser.

Presenting information in a breakout session

Presenting and sharing information in a breakout session works similarly to presenting information in the main session. The only difference is that you select what content or software that you want to share from the Share menu within the Breakout Session window. The Share menu in the Breakout Session window works the same way as the Share menu in the main Session window.

In a breakout session, you can choose to share

- documents or presentations
- a whiteboard in the Breakout Session window
- a Web browser
- your desktop
- an application
- UCF multimedia

Granting remote control to a participant in a breakout session

During a breakout session, you can allow another participant to remotely control your application. A participant who has remote control of shared software can interact with it completely.

Caution: A participant who has remote control of your desktop can run any
programs and access any files on your computer that you have not protected with a password.

To grant remote control of a shared application to a breakout session participant:

1. Once you are sharing, select Assign Control on the Session Controls Panel.

2. On the menu that appears, point to **Pass Keyboard and Mouse Control** for what you are sharing, and then choose the participant to whom you want to grant remote control.

   Once the participant assumes control, your mouse pointer is no longer active.

   **Note:**
   - You can reassume control of a shared application at any time by clicking your mouse.
   - If a participant requests remote control, a request message appears next to your mouse pointer.

### Ending your breakout session

If you are the presenter in a breakout session, you can end your session for all participants.

**To end a breakout session:**

1. Do one of the following:
   - On the Quick Start page, click **End Breakout Session**.
   - Close the Breakout Session Manager window by clicking the **Close** button in the upper-right corner of the window.
   - On the **File** menu in the Breakout session window, choose **End Breakout session**.
On the Breakout Sessions panel in the main Session window, click **End Breakout Session**.

1. In the dialog box that appears, click **Yes**.

### Restarting a breakout session

Once a breakout session has ended, it remains in the Breakout Session panel and can be restarted at any time by the presenter. As a presenter, you can restart with the same participant assignment, or have new assignments created automatically.

**To restart the breakout session:**

1. In the Breakout Session panel, highlight the breakout session that you want to restart.
2. Click the down arrow on the **Start** button.
3. Select whether to restart this breakout session with the same attendee assignments as before, or with new assignments made automatically.

### Sharing content from your breakout session in the main session

If the training session presenter or host sends you a request, you can share content that you shared in a breakout session when you return to the main training session. To be able to share content in the main session, the training session presenter must have ended all the breakout sessions.

**To share breakout session content in the main session:**

1. If the training session presenter or host sends you a request to share breakout session content, the Share Breakout Session Content dialog box appears.
   
   The content that you shared in your breakout session appears in a list.

2. Select the content that you want to share in the main training session. Hold down the **Shift** key to select more than one choice.

3. Click **OK**.

   Training Manager first opens the shared content, then displays it in your content viewer. Attendees can then view the shared content in their content viewers.

   You can share the content in the main session the same way that you did in the breakout session.
<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of testing and grading</td>
<td>About testing and grading (on page 408)</td>
</tr>
<tr>
<td>add tests to a scheduled training session</td>
<td>Adding tests to a scheduled training session (on page 408)</td>
</tr>
<tr>
<td>add tests to a recorded training session that you created using the On-Demand Module</td>
<td>Adding tests to a recorded training session (on page 410)</td>
</tr>
<tr>
<td>get detailed information about the test library</td>
<td>Understanding the Test Library (on page 413)</td>
</tr>
<tr>
<td>create tests</td>
<td>Creating a new test (on page 414)</td>
</tr>
<tr>
<td>convert an existing test or poll questionnaire to tests</td>
<td>Converting test or poll questionnaires to tests (on page 416)</td>
</tr>
<tr>
<td>determine when and how to deliver the scheduled training session test</td>
<td>Specifying test delivery options for a scheduled training session (on page 417)</td>
</tr>
<tr>
<td>determine when and how to deliver the recorded training session test in a Presentation Studio presentation</td>
<td>Specifying test delivery options for a recorded training session (on page 419)</td>
</tr>
<tr>
<td>manage every aspect of a scheduled test</td>
<td>Starting and managing scheduled training session tests (on page 420)</td>
</tr>
<tr>
<td>manage every aspect of a recorded test in a Presentation Studio presentation</td>
<td>Managing recorded tests (on page 423)</td>
</tr>
<tr>
<td>score the answers after a test</td>
<td>Scoring and grading answers for a test (on page 425)</td>
</tr>
</tbody>
</table>
About testing and grading

The Testing feature in Training Center gives you direct control over test creation, test delivery, test management, and scoring and grading, and the ability to track each attendee’s performance. It also gives you access to the Test Library on your organization's Training Center Web site where you can store your tests and share your tests with other hosts in your organization. Tests are Web-based and easy to manage.

You can add tests to a training session and administer them at all stages of the learning process:

- **Pre-session**—Test attendees' knowledge so you can plan more effective and relevant training content
- **In-session**—Ensure that attendees follow the training content; receive feedback from attendees
- **Post-session**—Test attendees’ comprehension of the training content; helps you plan your next training sessions based on the results of a post-session test
- **Recorded session (only for sites that include the On-Demand Module option, which is Training Center with the Presentation Studio Integration)**—Test users’ comprehension of the training content; session and test can be taken at any time

**Tip:** You can also import a poll questionnaire and convert it to a Web-based test.

Adding tests to a scheduled training session

To test attendees, you must add tests to the training session that they will be attending.

Before you can add tests, schedule, but do not start, a session to turn on the Testing feature.

**Note:** During the training session scheduling process, you can also add a test that you have already created and saved to the Test Library.
To add a test to a scheduled training session:

1. Go to the Session Information page for the session by clicking the session topic.
2. Click **Add New Test** on the Session Information page.

**Important:** During scheduling, if you selected the option to automatically delete the training session from your Training Center Web site after it ends, a message box will appear. If you do not turn off this option, you will lose all tests associated with this session.

3. On the Add Test page, select *one* of the following and click **Next**:
   - **Create a new test**
     For details, see *Creating a new test* (on page 414).
   - **Copy an existing test from the Test Library**
     Select the test you want to copy from the Test Library and click **Next**.
     For details, see *Understanding the Test Library* (on page 413).
   - **Import test questions from saved test or poll questionnaire (*.atp or *.wxt file)**
     Select the file and click **Next**.
     For details, see *Converting test or poll questionnaires to tests* (on page 416).

4. Compose or edit the test, and click **Save**.

5. Specify delivery options, such as the test date and time limit, and click **Save**. For details, see *Specifying test delivery options for a scheduled training session* (on page 417).

   The Manage Test page appears. The following figure shows an example of the Manage Test page.
To return to the Session Information page, click **Done**. For details about managing your tests, see *Starting and managing scheduled training session tests* (on page 420).

Follow the same instructions to add multiple tests to a session.

**Adding tests to a recorded training session**

To test users of a recorded training session that you created using the On-Demand Module, you must add tests to the training recording that they will be using.

Before you can add a test to a recording, the test must already exist in the Test Library. Tests cannot be created or edited in the Presentation Studio editor.

**To add a test to a recorded training session:**

1. Log in to your Training Center Web site.
2. Do one of the following:
   - Click **Host a Session > My Training Recordings**.
   - Click **My WebEx > My Files > My Training Recordings**.
The My Training Recordings page appears.

3 In your list of recordings, click the More drop-down icon for the recording for which you want to add a test and select Modify.

The Presentation Studio editor opens to the Edit Properties page.

4 Click Edit Slides.
5 Under Current Presentation, select a slide in the location where you want to insert the test.

6 Under Source, select **Insert a test**.

7 Select the appropriate insert option from the drop-down list.

8 Click **Insert**.

The Add a Test page opens in a new window.
9. Select a test and click **Next**.

10. In the Test Delivery Options page that appears, select the appropriate options and click **Save**.

11. Click **Close** to return to the Edit Slides page.

12. Repeat these steps to add multiple tests to a session.

13. Click **Submit Changes**.

14. Click **OK** on the Recording Updated page.

You will be notified by email when your updated presentation is ready.

### Understanding the Test Library

The Test Library serves as a repository of tests on your organization’s Training Center Web site. In the Test Library, you can do the following:

- Create, edit, duplicate, or delete a test
- Import a poll or test questionnaire, with an .atp or .wxt file extension, and convert it to a test
- Copy your tests to the **Shared Tests** section so other training hosts can access the tests
- Copy shared tests to the **Private Tests** section
The tests you create or import appear in the **Private Tests** section.

**To access Test Library:**

1. Log in to your Training Center Web site.
2. Click **Test Library** under **Host a Session** on the left navigation bar.

The Test Library page appears.

### Test Library

<table>
<thead>
<tr>
<th>Private Tests</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Title</strong></td>
</tr>
<tr>
<td>Chemistry 101</td>
</tr>
<tr>
<td>Chemistry 105</td>
</tr>
<tr>
<td>Copy of Chemistry 101 Midterm</td>
</tr>
<tr>
<td>Western Literature</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Shared Tests</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Title</strong></td>
</tr>
<tr>
<td>Western Literature</td>
</tr>
</tbody>
</table>

Creating a new test

You can create a test in the Test Library or create a test and then add it to a scheduled training session. You can add a test to a recorded session only if your site includes the On-Demand Module option.

**To create a test:**

1. Do one of the following:
   - On the Test Library page, click **Create New Test**.
   - On the Session Information page, click **Add New Test**. Select **Create a new test**, and click **Next**.

The Create Test page appears.
2 Specify the following:

- **Test title and description**
- **Maximum score** — Select the check box and type the score in the text box to specify the maximum score an attendee can receive.
- **Grades** — Select the check box to assign a grade based on the attendee's scores. Click the **Specify Grades** link to specify a grading scale.
- **Display question** — Select one of the following:
  - All questions in one page
  - One question per page

3 Click the **Insert Question** link to add a question or instructions to the test. The Add Question window appears.

4 Click the **Question Type** drop-down list. The following table defines each question type.

<table>
<thead>
<tr>
<th>Question type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Essay</td>
<td>A question that requires attendees to type text answers</td>
</tr>
<tr>
<td>Fill in the blanks</td>
<td>A question that requires attendees to type text answers in the blanks</td>
</tr>
<tr>
<td>Instructions</td>
<td>Instructions that you can provide attendees in the beginning of a test</td>
</tr>
<tr>
<td>Multiple Choice</td>
<td>A question that requires attendees to select one correct answer</td>
</tr>
<tr>
<td>Multiple Response</td>
<td>A question that requires attendees to select more than one correct answer</td>
</tr>
<tr>
<td>True/False</td>
<td>A question that requires attendees to indicate whether the statement in the question is true or false</td>
</tr>
</tbody>
</table>

5 In the drop-down list, do **one** of the following:

- Choose **Instructions** to add instructions in the beginning of the test, and click **Save**.
- Choose one question type, compose the question, specify the correct answers, and click **Save**.
Chapter 27: Testing and Grading

Important: To save you time in scoring, Training Center automatically checks attendees' answers against the correct answers you specify. You must specify answers for all question types except Essay. Once you start a test, you cannot change the questions or answers. Ensure that the answers are correct before you start the test or the scoring will be incorrect. For details, see Scoring and grading answers for a test (on page 425).

6 Follow the same instructions to add additional questions to the test.

7 In the Scoring Panel area for each question, specify a score for the correct answer and optionally type scoring guidelines or comments for the person who will score the test.

8 To rearrange questions, click the Move Up or Move Down links. To edit a question, click Edit.

9 Click Save.

Converting test or poll questionnaires to tests

You can import test or poll questionnaires that were created and saved in previous versions of Training Center and convert them to Web-based tests. Test or poll questionnaire files have a .atp extension.

You can also import files that have been converted with the WebEx Conversion Tool for use in Training Center. These files have a .wxt extension.

To convert a test or poll questionnaire to a test:

1 Do one of the following:
   - On the Test Library page, click Import.
   - On the Session Information page, click Add New Test, select Import test questions from saved test or poll questionnaire (*.atp or *.wxt file), and click Next.

2 Select the file that you want to import and click Next.
   The questionnaire is copied to the Edit Test page.

3 Edit the questions if necessary.

4 Click Save.
Specifying test delivery options for a scheduled training session

The Test Delivery Options page appears during the process of adding a test to a scheduled training session. On this page, you determine when and how to deliver the test. Once you start a test, you cannot change the delivery options.

The following figure shows an example of the Test Delivery Options page.

### Test Delivery Options

**Delivery method:**
- Start this test within a live session
- Deliver this test on the website (pre-session and post-session test)

**Start date and time:**
- March 27, 2007
- 4 pm

**Due date and time:**
- April 3, 2007
- 4 pm

**Time limit:**
- No time limit
- Attendees must finish the test within 30 minutes

**Email attendees:**
- Indicate email to take the test
- Send the email 5 days, 0 hours, 0 minutes before the test starts
- Send this email to all attendees that register after the test starts
- Reminder email after test starts
- Notify host when an attendee submits a test
- Scoring and grading report

**Attempt limit:**
- Allow attendees to take the test 2 times
- No limit

---

Specifying the delivery method

Next to Delivery method, select one of the following:

- **Start this test within a live session**—You can start the test anytime during the training session.
Chapter 27: Testing and Grading

- **Deliver this test on the Web site**—Specify the starting and due dates and times for the test. Attendees can take the test anytime between the starting and due dates and times.

**Specifying a time limit**

Next to **Time limit**, select one of the following:

- **No time limit**
- **Attendees must finish the test within X minutes**
  Type the length of time in the text box.

**Note:** If the test is set to be delivered outside the session, attendees can take the test anytime between the starting and due dates but must finish the test within the specified length of time.

**Sending email messages to attendees**

Next to **Email attendees**, select from the following:

- **Invitation email to take the test**—Specifies when to send the email before the test starts
  Type the number of days, hours, and minutes before the test starts to send the email in the text box.
- **Send this email to all attendees that register after the test starts**
- **Reminder email after a test starts**
- **Notify host when an attendee submits a test**
- **Scoring and grading report**—Sends grade reports to attendees after the host finishes scoring their tests or after the host updates the scores or comments

**Specifying a test attempt limit**

Next to **Attempt limit**, select from the following:

- **Allow attendees to take the test X times**
  Type the number of times that an attendee can take the test.
Specifying test delivery options for a recorded training session

The Test Delivery Options page appears during the process of adding or managing a test for a recorded training session that you created using the On-Demand Module. On this page, you determine the time limit and email options for the test.

The following figure shows the Test Delivery Options page.

![Test Delivery Options](image)

Specifying a time limit

Next to **Time limit**, select one of the following:

- **No time limit**
- **Attendees must finish the test within X minutes**
  Type the length of time in the text box.

**Note:** Attendees can start the test at any point during the recording but must finish the test within a specified length of time.

Sending email messages to attendees

Next to **Email attendees**, select the **Scoring and grading report** check box to send grade reports to attendees after the host finishes scoring their tests or after the host updates the scores or comments.
Starting and managing scheduled training session tests

You can use the Manage Test page to manage every aspect of a test.

To access the Manage Test page for a test:

Click the test topic on the Session Information page. The following figure shows an example of the Test section on a Session Information page.

Click the Manage button to open the Manage Test page.
The options on the Manage Test page vary, dependent on the delivery options and the status of the test. Tests can fall into the following categories:

- Pre-session tests and post-session tests
- In-session tests

**Managing pre-and post-session tests**

**To manage pre- and post-session tests:**

Pre- and post-session tests automatically start at the time you specified on the Test Delivery Options page.

The following table shows the management options for a pre- or post-session test.

<table>
<thead>
<tr>
<th>Status</th>
<th>Management Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Before test starts</td>
<td>Change delivery options</td>
</tr>
<tr>
<td></td>
<td>Copy the test to Test Library</td>
</tr>
<tr>
<td></td>
<td>Edit test questions</td>
</tr>
<tr>
<td>Test in progress</td>
<td>End test immediately</td>
</tr>
<tr>
<td></td>
<td>Extend due date of the test</td>
</tr>
<tr>
<td></td>
<td>View and score attendees’ answers</td>
</tr>
<tr>
<td></td>
<td>Copy the test to Test Library</td>
</tr>
<tr>
<td></td>
<td>View test questions</td>
</tr>
<tr>
<td>After test ends</td>
<td>Re-start the test</td>
</tr>
<tr>
<td></td>
<td>View and score attendees’ answers</td>
</tr>
<tr>
<td></td>
<td>Copy the test to Test Library</td>
</tr>
<tr>
<td></td>
<td>View test questions</td>
</tr>
</tbody>
</table>

**Managing and starting in-session tests**

You administer an in-session test during a training session. Attendees take the test during the session rather than before or after.
To manage in-session tests:

1. Specify **Start this test within a live session** option on the Test Delivery Options page when adding the test to the session.

2. After the session starts, choose **Testing** in the drop-down list on the **Participants & Communications** panel.

3. Select the title of the test, and then click **Launch for All**.

4. On the page that appears, click **Start Test**.

The following table shows the management options for an in-session test.

<table>
<thead>
<tr>
<th>Status</th>
<th>Management Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Before test starts</td>
<td>Change delivery options</td>
</tr>
<tr>
<td></td>
<td>Copy the test to Test Library</td>
</tr>
<tr>
<td></td>
<td>Edit test questions</td>
</tr>
<tr>
<td>After you click <strong>Launch for All</strong></td>
<td>Start the test</td>
</tr>
<tr>
<td></td>
<td>Copy the test to Test Library</td>
</tr>
<tr>
<td></td>
<td>Edit test questions</td>
</tr>
<tr>
<td>Test in progress</td>
<td>End the test immediately</td>
</tr>
<tr>
<td></td>
<td>Increase time limit if you have specified it</td>
</tr>
<tr>
<td></td>
<td>View and score attendees’ answers</td>
</tr>
<tr>
<td></td>
<td>Copy the test to Test Library</td>
</tr>
<tr>
<td></td>
<td>View test questions</td>
</tr>
<tr>
<td>After test ends</td>
<td>Re-start the test</td>
</tr>
<tr>
<td></td>
<td>View and score attendees’ answers</td>
</tr>
<tr>
<td></td>
<td>Copy the test to Test Library</td>
</tr>
<tr>
<td></td>
<td>View test questions</td>
</tr>
<tr>
<td>Test suspended in the event of a session crash</td>
<td>Resume the test</td>
</tr>
<tr>
<td></td>
<td>Re-start the test</td>
</tr>
<tr>
<td></td>
<td>View and score attendees’ answers</td>
</tr>
<tr>
<td></td>
<td>Copy the test to Test Library</td>
</tr>
<tr>
<td></td>
<td>View test questions</td>
</tr>
</tbody>
</table>
Managing recorded tests

You can use the Manage Test page to manage every aspect of a test that you created using the On-Demand Module.

To access the Manage Test page for a test:

Click the test topic on the Recording Information page. The following figure shows an example of the Tests in Presentation section on a Recording Information page.

Click the Manage Test link next to your test to open its Manage Test page.
The host has the following management options for a recorded test:

- Change the time and email options by clicking **Change Delivery Options**.
- Copy the test to the Test Library.
- View the test questions.

**Note:** The questions cannot be edited in a recording. They can only be edited in the Test Library.

- Check the status of the students taking the test.
- View and score students’ answers.
Scoring and grading answers for a test

Training Center automatically checks attendees’ answers against the correct answers you specified when creating the test and then scores the results.

An entire test is scored automatically if it contains no essay or fill-in-the-blanks questions. In this case, attendees can view test results once they submit their answers.

If a test contains essay or fill-in-the-blanks questions, you must manually review and score the test. A complete score is unavailable until you finish scoring the essay or fill-in-the-blanks questions.

To score the answers for a test:

1. Do one of the following:
   - From the Session Information page, click Score & Report.
   - From the Manage Test page, in the Student Answers section, click View and Score Answers.

The Submitted Tests page appears. This page lists attendees who have submitted their tests and attendees who have received their scores and grades, if assigned. You can also view the questions and grading scale, if specified.

### Submitted Tests

<table>
<thead>
<tr>
<th>Student Name</th>
<th>Email</th>
<th>Date &amp; Time submitted</th>
<th>Score</th>
<th>Grade</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gordon Ford</td>
<td><a href="mailto:gordonfl@webex.com">gordonfl@webex.com</a></td>
<td>03/03 11:03 am</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Jenny Parker</td>
<td><a href="mailto:jennyp1@webex.com">jennyp1@webex.com</a></td>
<td>03/03 9:54 am</td>
<td>95</td>
<td>A</td>
</tr>
<tr>
<td>Eric Franco</td>
<td><a href="mailto:ericfl@webex.com">ericfl@webex.com</a></td>
<td>03/03 2:00 pm</td>
<td>80</td>
<td>B</td>
</tr>
<tr>
<td>Cynthia King</td>
<td><a href="mailto:cynthiakl@webex.com">cynthiakl@webex.com</a></td>
<td>03/03 11:58 pm</td>
<td>70</td>
<td>C</td>
</tr>
<tr>
<td>Cathy Lee</td>
<td><a href="mailto:cathyfl@webex.com">cathyfl@webex.com</a></td>
<td>03/03 11:05 am</td>
<td>100</td>
<td>A</td>
</tr>
<tr>
<td>John Smith</td>
<td><a href="mailto:johns1@webex.com">johns1@webex.com</a></td>
<td>03/03 3:23 pm</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Diana Liang</td>
<td><a href="mailto:diannali@webex.com">diannali@webex.com</a></td>
<td>03/03 5:00 pm</td>
<td>85</td>
<td>B</td>
</tr>
</tbody>
</table>

Total submitted tests: 7
2 To score an attendee's test, click the Score Answers link for the attendee or click the attendee's name.

The Score Submitted Answers page appears. All answers, except for essay questions, are automatically scored. A partial score appears in the Results area. Although fill-in-the-blanks answers are scored automatically, you may want to review them and change the scores, if necessary.

3 Review the essays or fill-in-the-blanks answers that need manual scoring, and specify the scores for the essays.

   ▪ To quickly go to a question that needs manual scoring, go to the Unscored questions section, choose a question in the drop-down list, and click Go.
   ▪ To change the score for a fill-in-the-blanks answer, select correct or incorrect for the question. Clicking Save updates the score.

4 Optionally type comments for the attendee.

5 Click Save to update the score or your comments.

The test results are updated on the View Test Results page. If you have specified to send grade reports to attendees, the attendee receives the update via email.
Taking a Test

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of taking a test</td>
<td>About taking a test (on page 427)</td>
</tr>
<tr>
<td>obtain test information before taking a test</td>
<td>Obtaining test information (on page 428)</td>
</tr>
<tr>
<td>take a pre- or post-session test</td>
<td>Taking a pre- or post-session test (on page 431)</td>
</tr>
<tr>
<td>take an in-session test</td>
<td>Taking an in-session test (on page 434)</td>
</tr>
<tr>
<td>take a recorded session test in a Presentation Studio presentation</td>
<td>Taking a recorded session test in a Presentation Studio presentation (on page 436)</td>
</tr>
<tr>
<td>know how to answer questions during a test</td>
<td>Answering questions (on page 438)</td>
</tr>
<tr>
<td>view your test results</td>
<td>Viewing test results (on page 440)</td>
</tr>
</tbody>
</table>

About taking a test

The host or presenter of a training session that you are attending can conduct tests before, during, or after the session, or during a recorded session in a Presentation Studio presentation, to test your knowledge of the training content or seek feedback.

A host may request you to take one of the following types of tests:

- Pre- or post-session tests—A test starts and ends at the specified times and dates outside a training session. Email messages you receive from the host contain information about how to access these tests.
Chapter 28: Taking a Test

- In-session tests—The host starts a test during a training session. Your training service does not send email messages about these tests on behalf of the host. You can obtain test information by contacting the host.

- Recorded session tests (only in Presentation Studio presentations)—A test can be taken once, at any time during the recorded session.

You take tests and submit your answers on the Web. Once scoring is completed, you can view test results from the Session Information page on your Training Center Web site, on the Test Submitted page for a recorded session, or from the host's email message that contains your grade report.

To access the Session Information page for a training session, you can go to the training calendar on your Training Center Web site and then click the link for the session topic.

### Obtaining test information

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of obtaining test information</td>
<td>About obtaining test information (on page 428)</td>
</tr>
<tr>
<td>obtain test information from a registration confirmation email message you receive from the host</td>
<td>Obtaining test information from a registration confirmation email message (on page 429)</td>
</tr>
<tr>
<td>obtain test information from the training calendar on your Training Center Web site</td>
<td>Obtaining test information from the training calendar (on page 429)</td>
</tr>
<tr>
<td>obtain test information from an invitation email message to take a test</td>
<td>Obtaining test information from an invitation email message to take a test (on page 430)</td>
</tr>
</tbody>
</table>

### About obtaining test information

**Note:** Test information is not available in advance for recorded session tests.

You can obtain information about a pre- or post-session test from any of the following:

- A registration confirmation email message
Chapter 28: Taking a Test

- The training calendar on your Training Center Web site
- An invitation email message to take a test, if you received the email from the host

To obtain information about an in-session test prior to joining the training session, contact your training session host.

Obtaining test information from a registration confirmation email message

Once the training session host approves your registration request, you receive a registration confirmation email message that contains a link you can click to obtain test information.

**To obtain test information from a registration confirmation email message:**

1. Open the registration confirmation email, and then click the appropriate link.
2. If the host requires a session password, type the session password in the **Password** text box, and then click **View Info**.
   The Session Information page, with full details, appears. The Tests section displays all pre- or post-session tests associated with this training session.
3. In the Test section, locate the test you want to view, and then do *either* of the following:
   - In the Action column, click **View Info**.
   - In the Title column, click the test title.
   The Take Test page appears.
4. Enter the session password, and click **OK**.
5. Click **OK**.
   The Session Information page appears.

Obtaining test information from the training calendar

You can obtain test information from the training calendar on your Training Center Web site once the training session host approves your registration.
To obtain test information from the training calendar:

1. On your Training Center Web site, expand Attend a Session, and then click Live Sessions.

2. Locate the training session with which the test is associated, and then click the link for the session topic.
   
   The Session Information page appears.

3. Click View Session Details.
   
   The Take Test page appears.

4. If the host requires a session password, type the session password in the text box, and then click OK.
   
   The Session Information page, with full details, appears. The Test section displays all pre- or post-session tests associated with this training session.

5. In the Test section, locate the test you want to view, and then do either of the following:
   
   - In the Action column, click View Info.
   - In the Title column, click the test title.
   
   The Take Test page appears.

6. Click OK.

Obtaining test information from an invitation email message to take a test

You may receive an invitation email message to take a test if the training session host sends such email messages to attendees whose registration has been approved.

To obtain test information from an invitation email message to take a test:

Open the invitation email message, and then click the appropriate link.

The Take Test page appears.

About attendee accounts

An attendee account stores a user's personal information and session information associated with that user, such as a registration number.
A training session host may require that you have an attendee account to join a training session, view test information, or take a test. If you sign in using an attendee account, you do not need to provide personal information or a registration number for those tasks.

For information about obtaining an attendee account, ask your training session host.

## Taking a pre- or post-session test

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of taking a pre- or post-session test</td>
<td>About taking a pre- or post-session test (on page 431)</td>
</tr>
<tr>
<td>take a test from a registration confirmation email message you receive from the host</td>
<td>Taking a test from a registration confirmation email message (on page 432)</td>
</tr>
<tr>
<td>take a test from the training calendar on your Training Center Web site</td>
<td>Taking a test from the training calendar (on page 432)</td>
</tr>
<tr>
<td>take a test from an invitation email message to take a test</td>
<td>Taking a test from an invitation email message (on page 433)</td>
</tr>
<tr>
<td>leave and return to a test</td>
<td>Leaving and returning to a test (on page 433)</td>
</tr>
</tbody>
</table>

### About taking a pre- or post-session test

A pre- or post-session test starts and ends at the times specified by your training session host. If the host also specifies a time limit, you must finish the test within the time limit during the scheduled time frame.

You can take a pre- or post-session test from *any* of the following:

- A registration confirmation email message
- The training calendar on your Training Center Web site
- An invitation email message to take a test, if you received the email from the host
Taking a test from a registration confirmation email message

Once the host approves your registration, you receive a confirmation email message that contains a link you can click to open the Session Information page, from which you can take a test.

**To take a test from a registration confirmation email message:**

1. Open the email, and then click the appropriate link.
2. If the host requires a session password, type the session password in the **Password** text box, and then click **View Info**.

   The Session Information page, with full details, appears. The Test section displays all pre- or post-session tests associated with this training session.
3. In the Test section, do *either* of the following:
   - In the Action column, click **Take Test**.
   - In the Title column, click the test title.

   The Take Test page appears.
4. If the host requires a session password, type it in the text box, and then click **OK**.
5. Click **Take Test**.
6. Answer the questions.
7. When finished, click **Submit Test**.

For more information about answering questions, see *Answering questions* (on page 438).

Taking a test from the training calendar

You can take a test from the training calendar on your Training Center Web site.

**To take a test from the training calendar:**

1. On your Training Center Web site, expand **Attend a Session**, and then click **Live Sessions**.
2. Locate the training session with which the test is associated, and then click the link for the session topic.
3. Click **View Session Details**.
If the host requires a session password, type the session password in the text box, and then click OK.

The Session Information page, with full details, appears. The Test section displays all pre- or post-session tests associated with this training session.

In the Test section, locate the test that you want to take, and then click Take Test in the Action column.

The Take Test page appears.

Provide the required information, and then click OK.

Click Take Test.

Answer the questions. When finished, click Submit Test.

For more information about answering questions, see Answering questions (on page 438).

Taking a test from an invitation email message

If you receive an invitation email message to take a test, you can take the test from the email message.

To take a test from an invitation email message:

1. Open the invitation email, and then click the appropriate link.

   The Take Test page appears.

2. Click Take Test.

3. Answer the questions.

4. When finished, click Submit Test.

For more information about answering questions, see Answering questions (on page 438).

Leaving and returning to a test

You can leave a test and return to it later only if the test is pre- or post-session.

If the host specifies a time limit for the test you are taking, remember the following:

- You must return to the test within the time limit.
- The duration of your absence counts toward the time limit.
To leave a test temporarily:

1. Click **Return to Test Later**.
   - The Leave Test page appears.
2. To confirm your leaving, click **Leave Test**.
   - The Session Information page appears.

To return to the test that you left temporarily:

Follow the same steps as if you were to take the test for the first time. For details, see *Taking a pre- or post-session test* (on page 431).

## Taking an in-session test

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of taking an in-session test</td>
<td><em>About taking an in-session test</em> (on page 434)</td>
</tr>
<tr>
<td>take an in-session test</td>
<td><em>Taking an in-session test</em> (on page 435)</td>
</tr>
</tbody>
</table>

## About taking an in-session test

During the training session that you are attending, the presenter may conduct in-session tests.

Before the presenter starts the test, there may be a waiting period that allows you to view test information, such as the test title and description, time limit, if any, number of questions, and the maximum score, if any.

The following figure shows an example of the page that appears in a new Web browser on your computer while you wait for the presenter to start the test.
Taking an in-session test

To take an in-session test, follow these steps:

1. Once the presenter starts the test, a page appears on which you can answer the questions.

   **Note:** When taking an in-session test, you cannot leave and return to the test later.

2. When finished, click **Submit Test**.

   For more information about answering questions, see *Answering questions* (on page 438).
Taking a recorded session test in a Presentation Studio presentation

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of taking a recorded session test</td>
<td>About taking a recorded session test (on page 436)</td>
</tr>
<tr>
<td>take a recorded session test</td>
<td>Taking a recorded session test (on page 437)</td>
</tr>
</tbody>
</table>

About taking a recorded session test

During the recorded training session that you are viewing, there may be tests within the presentation if it is a Presentation Studio presentation.

When you arrive at a test in the recorded session, the Take Test page appears, which shows test information, such as the test title and description, time limit, if any, number of questions, and the maximum score, if any. You have the option to take the test now or continue with the presentation and return to the test at a later time. You can take each test only once.

There are also fields for you to enter your name and email address. These fields will be populated if you have already registered for the recorded session or have already taken a test during the session.

The following figure shows an example of the Take Test page.
Taking a recorded session test

To take a recorded session test, follow the steps:

1. On the Take Test page, click Take Test.
   
   A page appears on which you can answer the questions.

2. When finished, click Submit Test.

   For more information about answering questions, see Answering questions (on page 438).

Leaving and returning to a recorded session test

You can leave a test and return to it later during a recorded session.

If a time limit is specified for the test you are taking, remember the following:
Chapter 28: Taking a Test

- You must return to the test within the time limit.
- The duration of your absence counts toward the time limit.

To leave a test temporarily:

1. Click the **Save Answers** button to save all of your answered questions.  
   The button changes to **Answer Saved** for those questions that you have already answered.
   
   For more information about answering questions, see *Answering questions* (on page 438).

2. Click the arrows or another slide in the presentation to change slides.

To return to the test that you left temporarily:

Click the slide that contains the test to resume the test. All answers that have been saved will remain answered.

### Answering questions

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>learn how to answer questions in a test</td>
<td><em>Answering questions</em> (on page 438)</td>
</tr>
<tr>
<td>know how to save your answers and navigate in a test</td>
<td><em>Saving answers and navigating in a test</em> (on page 439)</td>
</tr>
</tbody>
</table>

### Answering questions

Answering questions in a test requires that you select or type your answers by using your mouse.

To learn how to answer each type of question, see the following table.

<table>
<thead>
<tr>
<th>If you want to</th>
<th>Do the following</th>
</tr>
</thead>
</table>
| answer a question that requires you to select one correct answer | Click the radio button for your choice.  
*Note* To click, press your mouse once and then release it.  |
### Saving answers and navigating in a test

The ways you navigate in a test and save your answers differ, depending on how the questions are displayed. The host who creates a test can choose *either* of the following displays:

- **All questions in one page**—Displays test information, instructions, if any, and all questions in one page.
  
  To view more questions on the page, use the scroll bar in your browser.
  
  To save all the answers you have not saved, click *any Save Answers* button.
  
  Each question is indicated by one of the following buttons, so you know which questions you have or have not answered.

  - ![Not Yet Answered](Not Yet Answered)
  - ![Answer Saved](Answer Saved)

- **One question per page**—Each page displays only one question. The first page displays the test information; the second page displays the instructions, if any.
To navigate between questions, use the Control Panel, which appears in each page. Moving to any question saves the answers you previously selected or typed.

The following figure shows the Control Panel.

To move to a question, do either of the following:
- Choose the question in the drop-down list.
- Click Next Page or Previous Page to move to the question.

### Viewing test results

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of viewing test results</td>
<td>About viewing test results (on page 440)</td>
</tr>
<tr>
<td>view results of a test that contains essay or fill-in-the-blanks questions</td>
<td>Viewing results of a test that requires manual scoring (on page 441)</td>
</tr>
<tr>
<td>retake the test</td>
<td>Taking the test again (on page 442)</td>
</tr>
</tbody>
</table>

### About viewing test results

You can click View Results on the Session Information page or, for a recorded session, on the Test Submitted page, to view your test results. You can also click a link sent via email to view your test results if you receive grade reports from the host.

If the test contains no essay or fill-in-the-blanks questions that need manual scoring, your test results are available once you submit your answers. In this case, you can click the view the results link to view your test results. See the following figure for an example.
For a recorded session test, you can view results or continue with the presentation by clicking the appropriate button.

**Test Submitted: Test 3**

Your test has been submitted to the instructor. Your test is scored and graded automatically. You can view the results now.

Viewing results of a test that requires manual scoring

If a test contains essay or fill-in-the-blanks questions that require manual scoring, you must wait for the instructor to complete scoring.

For in-session, pre-, or post-session tests, check the Session Information page on your Training Center Web site for your test results, or the host's email message that contains your grade reports. For recorded session tests, your results will be emailed to you when they are ready.

**Note:**

- Before the test ends, and if the scoring is completed, you can view your score and grade, if assigned.
After the test ends, and if the scoring is completed, you can view detailed results, including your score, your grade, if assigned, correct answers, and the instructor’s comments. You may also be able to retake the test.

**Taking the test again**

The training session host who creates the test will determine whether a test can be retaken, as well as the number of attempts.

If you are allowed to retake the test, once the test has been graded, you will see the following box on the View Test Results page.

Click **Take Test Again**.

The Take Test page opens, and you can retake the test.
Sending and Receiving Video

If a video camera is installed on your computer, you can send video. Other participants can see you, or whatever you focus your webcam on. To see video, participants do not need to have a webcam installed on their computers.

WebEx Meeting Center supports high-definition (HD) video with up to 720p resolution. Other WebEx services, such as Training Center, Event Center, and Support Center, support high-quality video with up to 360p resolution. The Cisco technology automatically adjusts video to the highest quality for each participant according to the computer capabilities and network bandwidth.

Your administrator can set video options at the site level. A meeting host can set video options on the scheduler as well as in the meeting. If your site or meeting is not set up to use HD or high-quality video, standard video is used.

To start or stop sending video, select the video icon beside your name.

The icon turns green when you are sending video.

If you have a High Definition camera and you select the video icon, a one-time notification indicating You are ready to send HD video to other participants displays.
After you start sending video, you can perform the following tasks depending on your role.

<table>
<thead>
<tr>
<th>Role</th>
<th>Tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host</td>
<td>What you can do:</td>
</tr>
<tr>
<td></td>
<td>Start or stop sending video at will.</td>
</tr>
<tr>
<td></td>
<td><em>Lock focus on one participant</em> (on page 445).</td>
</tr>
<tr>
<td></td>
<td><em>View everyone who is sending video</em> (on page 448) on one big screen.</td>
</tr>
<tr>
<td></td>
<td><em>List participants or show thumbnails</em> (on page 446)</td>
</tr>
<tr>
<td></td>
<td>Set <em>webcam options</em> (on page 451).</td>
</tr>
<tr>
<td>Participant</td>
<td>What you can do:</td>
</tr>
<tr>
<td></td>
<td>Start or stop sending video at will.</td>
</tr>
<tr>
<td></td>
<td><em>View everyone who is sending video</em> (on page 448) on one big screen.</td>
</tr>
<tr>
<td></td>
<td><em>List participants or show thumbnails</em> (on page 446)</td>
</tr>
<tr>
<td></td>
<td>Set <em>webcam options</em> (on page 451).</td>
</tr>
</tbody>
</table>

**Note:** If you are managing a meeting that includes TelePresence systems (Meeting Center only), the following WebEx features are unavailable:
Chapter 29: Sending and Receiving Video

Minimum system requirements

To send or receive video with a resolution of 360p, ensure that your system meets the following minimum requirements:

<table>
<thead>
<tr>
<th>Action</th>
<th>What you need</th>
</tr>
</thead>
</table>
| Send   | - A webcam capable of producing high-quality video. WebEx supports most webcams of this type  
        - A computer with at least 1 GB of RAM and a dual-core processor  
        - A fast network connection |
| Receive| - A computer with at least 1 GB of RAM and a dual-core processor  
        - A fast network connection |

To send or receive video with a resolution of 720p, ensure that your system meets the following minimum requirements:

<table>
<thead>
<tr>
<th>Action</th>
<th>What you need</th>
</tr>
</thead>
</table>
| Send   | - A webcam capable of producing HD video. WebEx supports most webcams of this type  
        - A computer with at least 2 GB of RAM and a quad-core processor  
        - A fast network connection |
| Receive| - A computer with at least 2 GB of RAM and a dual-core processor  
        - A fast network connection |

Locking focus on one participant

If you are the host, you can select whose video you want everyone to see. Follow these steps:

1. Select the name on the video display.
Chapter 29: Sending and Receiving Video

2 In the dialog box, select one of the following:

- **The active speaker.** This is the default. The display focuses on the person currently speaking and switches as the loudest speaker changes.

- **A specific participant.** The display focuses on only the specific participant that you select. All participants see that person, regardless of who is speaking.

Switching between a list or thumbnail view of participants

You can switch between the Participant List and participants’ video thumbnails.
Chapter 29: Sending and Receiving Video

To view video thumbnails:
Select the list icon.
Select Thumbnails.

To view Participant List:
Select the thumbnail icon.
Select List.

In the thumbnails view, select the down or up arrow to view additional thumbnails.
Viewing everyone who is sending video

With one click, you can view live, high-quality video display across your entire screen. In the video view, you see all participants who are sending video, including:

- the active speaker or a specific participant whom the host chose to lock on
- five thumbnails on the bottom. To see more participants, use the arrow on either side.

To view all participants who are sending video:
Select the icon in the upper-right corner of the display.

To return to the Session window:
Select Exit Full-Screen Mode in the upper-right corner of the screen.

Understanding the large video view

When you are viewing everyone who is sending video, high-quality video displays across your entire screen.
One of the following is displayed here:

1. The active speaker’s video, which switches as the loudest speaker changes
   A specific participant’s video that the host chose to lock on

Your self-view appears in this corner. You can

2. Minimize or restore the display by selecting the icon in the upper-right corner of the self-view.
   Mute or unmute your audio by selecting Mute Me or Unmute Me.
   Stop or show your self-view by selecting Stop My Video or Start My Video.

Video thumbnails of five other participants appear here.

Use these controls to see additional participants.

If you are the host or presenter, you can choose to lock everyone’s focus on the active speaker’s video or a specific participant’s video. Select the name to get started. More… (on page 445)

You can expand the active speaker’s video display to full screen. More… (on page 450)
Expanding the active speaker's video display

When you are viewing all participants who are sending video, you can expand the active speaker's video display to full screen. With the full-screen display, you can continue sending or receiving HD video (applicable for Meeting Center only).

To see the active speaker (or the specific participant the host chose to lock on) in full-screen view, select this icon in the upper-right corner of the active speaker's display.

To return to the view where you see everyone who is sending video, select this icon in the upper-right corner of your screen.

Floating Icon Tray in Video Full Screen Mode

Meeting participants have access to the Floating Icon Tray in full video mode making it easy to use the all the common WebEx functions. The Floating Icon Tray automatically displays at the top of the video screen.
Setting webcam options

If you have a working webcam, you can set options that are available for that webcam directly from your training session.

To set webcam options:

Windows:
At the top right of the Participants panel, select the options icon.

Mac:
At the bottom right of the Participants panel, select the options icon.

Typically, you can set options for general settings, such as contrast, sharpness, and brightness. But options can vary depending on your webcam.

**Note:** Screen save option is disabled in video and other full screen modes.
Managing video display during sharing

When you are sharing information or someone else is sharing information with you, a floating panel containing participant video and your self-view appears on the right-hand side of your screen.

What you can do on the floating panel:

- Stop or start your video. More… (on page 452)
- Minimize or restore your video. More… (on page 452)
- Move the panel by dragging it. More… (on page 453)
- Switch to view everyone who is sending video. More… (on page 453)
- Lock focus on another participant (for host and presenter only). More… (on page 445)

Note: If your are viewing everyone sending video and the presenter starts sharing, you will automatically exit the video view so that you can view what is being shared.

Controlling your self-view

During sharing, your self-view appears in the lower-right portion of the floating panel. You can manage your self-view in several ways.
To minimize self-view:
Select the icon in the upper-right portion of the self-view display.

To restore self-view:
Select the icon in the lower-right portion of the floating panel.

To stop or show self-view:
Select the video icon at the center of the self-view display.

Controlling video display

During sharing, you see the active speaker’s video or a specific participant’s video, if the host chose to lock on the participant, in a floating panel. You can manage this video display in several ways.

To minimize:
Select the downward arrow in the upper-left corner.

To resize:
Select the bottom right-corner and drag the edge.

To move:
Select and drag the display to another location on your screen.

To lock another participant’s video:
Select the name and then select the participant in the dialog box. For details, see Locking focus on one participant (on page 445).

To switch to view everyone:
Select the icon in the upper-right corner of the display.
Obtaining video and audio data during a training session

Having video or audio problems in a meeting? If you contact technical support, the video and audio data you can obtain within the meeting comes in handy.
To obtain audio and video data while in the Session window:

Windows

Select Meeting > Audio & Video Statistics...
To obtain audio and video data while viewing everyone sending video:
Right-click the active speaker's display and then select Audio & Video Statistics...
### Using My WebEx

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of My WebEx</td>
<td><em>About My WebEx</em> (on page 458)</td>
</tr>
<tr>
<td>set up a user account on your WebEx service Web site</td>
<td><em>Obtaining a user account</em> (on page 459)</td>
</tr>
<tr>
<td>log in to or out from My WebEx</td>
<td><em>Logging in to and out of the WebEx service site</em> (on page 460)</td>
</tr>
<tr>
<td>use your list of meetings</td>
<td><em>Using your list of meetings</em> (on page 461)</td>
</tr>
<tr>
<td>install WebEx Productivity Tools, which let you start One-Click meetings, start instant training sessions from applications on your desktop, or schedule training sessions from Microsoft Outlook or IBM Lotus Notes</td>
<td><em>Installing WebEx Productivity Tools</em> (on page 130)</td>
</tr>
<tr>
<td>set up a One-Click Meeting</td>
<td><em>Setting Up a One-Click Meeting</em> (on page 125)</td>
</tr>
<tr>
<td>view or set options for your Personal Meeting Room page</td>
<td><em>Maintaining Your Personal Meeting Room Page</em> (on page 474)</td>
</tr>
<tr>
<td>set up or access remote computers, using Access Anywhere</td>
<td><em>Using Access Anywhere (My Computers)</em> (on page 478)</td>
</tr>
<tr>
<td>add, edit, or delete files in your personal storage space for files</td>
<td><em>Maintaining files in your personal folders</em> (on page 479)</td>
</tr>
</tbody>
</table>
### About My WebEx

My WebEx is an area on your WebEx service Web site in which you can access your user account and personal productivity features. The following features are available, depending on the configuration of your site and user account:

- **Personal list of meetings**: Provides a list of all the online meetings that you are hosting and attending. You can view the meetings by day, week, or month, or you can view all meetings.

- **Productivity Tools Setup**: Optional feature. Lets you set up options for instant or scheduled meetings that you can start from applications on your desktop. If you install WebEx Productivity Tools, you can start or join meetings, sales meetings, training sessions, and support sessions instantly from One-Click or from other applications on your desktop, such as Microsoft Office, Web browsers, Microsoft Outlook, IBM Lotus Notes, and instant messengers. You can also schedule meetings, sales meetings, events, and training sessions using Microsoft Outlook or IBM Lotus Notes without going to your WebEx service site.

- **Personal Meeting Room**: Optional feature. A page on your WebEx service Web site on which visitors can view a list of meetings that you are hosting and join a meeting in progress. Visitors can also access and download files that you share.

---

<table>
<thead>
<tr>
<th>Feature</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>publish recorded training sessions on your WebEx service Web site</td>
<td>Publishing a Recorded Training Session (on page 527)</td>
</tr>
<tr>
<td>add, edit, or delete information about your contacts in your online address book</td>
<td>Maintaining contact information (on page 498)</td>
</tr>
<tr>
<td>change information or settings in your user profile, including personal information and preferences</td>
<td>Maintaining your user profile (on page 513)</td>
</tr>
<tr>
<td>manage the scheduling templates you saved</td>
<td>Managing scheduling templates (on page 520)</td>
</tr>
<tr>
<td>generate reports about online sessions</td>
<td>Generating Reports (on page 522)</td>
</tr>
</tbody>
</table>
Access Anywhere: Optional feature. Lets you access and control a remote computer from anywhere in the world. For more information about Access Anywhere, refer to the guide Getting Started with Access Anywhere, which is available on your WebEx service Web site.

File storage: Lets you store files in personal folders on your WebEx service Web site, where you can access them on any computer that has access to the Internet. Also lets you make specific files available on your Personal Meeting Room page, so visitors to your page can access them.

Recorded training session management: Lets you maintain recorded training sessions and publish them on your WebEx service Web site. For more information, see *Publishing a Recorded Training Session* (on page 527).

Address book: Lets you keep information about your personal contacts on your WebEx service Web site. Using your address book, you can quickly access contacts when inviting them to a meeting.

User profile: Lets you maintain your account information, such as your username, password, and contact information. Also lets you specify another user who can schedule meetings on your behalf, set options for your Personal Meeting Room page, and manage scheduling templates.

Web site preferences: Lets you specify the home page for your WebEx service Web site—that is, the page that appears first whenever you access your site. If your site provides multiple languages, you can also choose a language and locale in which to display text on your site.

Usage reports: Optional feature. Lets you obtain information about meetings that you hosted. If you use the Access Anywhere option, you can also obtain information about computers that you access remotely.

### Obtaining a user account

Once you obtain a user account, you can use My WebEx features and host sessions on the Web.

You can obtain a user account in one of two ways:

- **The site administrator for your WebEx service Web site** can create a user account for you. In this case, you need not sign up for an account on your site, and you can begin hosting sessions immediately.

- **If your site administrator has made the self-registration feature available,** you can sign up for an account on your WebEx service Web site at any time.
To obtain a user account using the self-registration feature:

1. Go to your WebEx service Web site.
2. On the navigation bar, click **Set Up > New Account**.
   The Sign Up page appears.
3. Provide the required information.
4. Click **Sign Up Now**.
   You receive an email message, confirming that you have signed up for a user account.
   Once your site administrator approves your new user account, you receive another email message containing your username and password.

**Note:** Once you obtain a user account, you can edit your user profile to change your password and provide additional personal information. You can also specify site preferences, such as your default home page and time zone. For details, see *Maintaining your user profile* (on page 513).

### Logging in to and out of the WebEx service site

To manage your online meetings and maintain your user account, you must log in to your WebEx service Web site. If you do not yet have a user account, see *Obtaining a user account* (on page 459).

**To log in to your WebEx service site:**

1. Go to your WebEx service Web site.
2. In the upper-right corner of the page, click **Log In**.
   The Log In page appears.
3. Enter your username and password.
   Passwords are case-sensitive, so you must type your password exactly as you specified it in your user profile.
4. Click **Log In**.

**Tip:** If you have forgotten your username or password, click **Forgot your password**. Provide your email address, type verification characters, and then click **Submit**. You will receive an email message containing your username and password.
To log out from your WebEx service site:
In the upper-right corner of the page, click Log Out.

Using your list of meetings

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of your list of meetings</td>
<td>About your list of meetings (on page 461)</td>
</tr>
<tr>
<td>open your list of meetings</td>
<td>Opening your meetings list (on page 461)</td>
</tr>
<tr>
<td>maintain your list of meetings</td>
<td>Maintaining your scheduled meetings list (on page 463)</td>
</tr>
</tbody>
</table>

About your list of meetings

On your WebEx service Web site, your My Meetings page in My WebEx includes:

- A list of all the online meetings that you have scheduled, including both listed and unlisted meetings.
- A list of meetings on your site to which you are invited.
- An option to start a One-Click meeting (not available for Event Center).
- Any Personal Conference meetings that you scheduled (if your site and account have the Personal Conferencing feature turned on).

Tip: You can specify that your My WebEx meetings page is the home page that appears once you log in to your WebEx service Web site. For details, see Maintaining your user profile (on page 513).

Opening your meetings list

You can open your personal list of scheduled meetings on your WebEx service Web site to:

- Start a training session
- Modify a training session
- Cancel a training session
Chapter 30: Using My WebEx

You can open your personal list of meetings to which you are invited:

- Obtain information about a training session
- Join a training session in progress

**To open your meetings list:**

1. Log in to your WebEx service Web site, and then click **My WebEx**.

   The My Meetings page appears, showing your list of scheduled meetings.

   ![My WebEx Meetings](image)

   - **Go to My Personal Meeting Room**
   - **Start a One-Click Meeting**

   **Daily** | **Weekly** | **Monthly** | **All Meetings**
---|---|---|---


   - **The meetings you host**
   - **Show past meetings**

   - **Time** | **Topic** | **Type** | **Type** | **Type**
   - 3:00 pm | ZipSoft Fundamentals | Training | N/A | N/A | N/A | Start
   - 4:00 pm | ZipSoft Fundamentals II | Training | N/A | N/A | N/A | Start
   - 5:00 pm | ZipSoft Advanced Techniques | Training | N/A | N/A | N/A | Start
   - 6:00 pm | Hands-On Training with ZipSoft | Training | 0 | 0 | 0 | Start

3. Click *one* of the tabs to navigate to different views of the My Meetings page:

   - You can choose **Daily**, **Weekly**, **Monthly**, or **All Meetings**.

3. Optional. Do *either* of the following:

   - To view the list of meetings to which you are invited, select **The meetings you are invited to** from the list.
   - To include sessions in the view that have already occurred, turn on **Show past meetings**.

4. (Optional) Select options to control the view:

   - To view the list of meetings to which you are invited, select **The meetings you are invited to** from the list.
Chapter 30: Using My WebEx

- To include meetings in the view that have already occurred, turn on Show past meetings.

Tip: You can specify that your My WebEx Meetings page is the home page that appears once you log in to your WebEx service Web site. For details, see Maintaining your user profile (on page 513).

Maintaining your scheduled meetings list

Once you schedule a training session, it appears in your meetings list on your My Meetings page. For more information, see Opening your meetings list (on page 461).

An online training session remains on your My Meetings page until you delete it. When scheduling a training session, you can choose to automatically delete the training session from your list of meetings once both of these conditions occur:

- You start and end the training session.
- The scheduled time for the training session has passed.

However, if you required registration for a scheduled training session, the training session remains in your list until you remove it. That way, you can still view information about attendees who registered for the training session at any time after you host the training session.

To remove a training session from your list of meetings on your My Meetings page, you must cancel the training session by deleting it on this page.

For details about the options on the My WebEx Meetings page, see About the My WebEx Meetings page (on page 463).

About the My WebEx Meetings page

How to access this tab

On your WebEx service Web site, click the My WebEx tab.

What you can do here

Access these features:
Chapter 30: Using My WebEx

- A link to your personal meeting room
- A list of meetings you are hosting or are invited to for the specified day, week, or month
- A list of all meetings you are hosting or are invited to
- A link to start a One-Click meeting

Options on this page

<table>
<thead>
<tr>
<th>Use this option…</th>
<th>To…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Go To My Personal Meeting Room</td>
<td>Go to your Personal Meeting Room page. Your Personal Meeting Room page lists any training sessions that you scheduled and any in-progress training sessions that you are currently hosting. Users to whom you provide your personal URL can use this page to join any training session that you are hosting. They can also download files in any folders that you share.</td>
</tr>
<tr>
<td>Start a One-Click Meeting</td>
<td>Start a One-Click Meeting based on settings you have specified in One-Click Setup. For details, see Setting Up a One-Click Meeting (on page 125).</td>
</tr>
<tr>
<td>Daily</td>
<td>View a list all of the meetings for the specified day. For details, see About the My WebEx Meetings - Daily tab (on page 465).</td>
</tr>
<tr>
<td>Weekly</td>
<td>View a list all of the meetings for the specified week. For details, see About the My WebEx Meetings - Weekly tab (on page 467).</td>
</tr>
<tr>
<td>Monthly</td>
<td>View a list all of the meetings for the specified month. For details, see About the My WebEx Meetings - Monthly tab (on page 470)</td>
</tr>
<tr>
<td>All Meetings</td>
<td>View a list all meetings, or search for meetings by date, host, topic, or words in the agenda. For details, see About the My WebEx Meetings - All Meetings tab (on page 472)</td>
</tr>
<tr>
<td>Refresh</td>
<td>Refresh the information in the meeting list.</td>
</tr>
</tbody>
</table>
Chapter 30: Using My WebEx

About the My WebEx Meetings page - Daily tab

How to access this tab
On your WebEx service Web site, click My WebEx > My Meetings > Daily tab.

Options on this tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Refresh icon</td>
<td>Click the Refresh icon at any time to display the most current list of training sessions.</td>
</tr>
<tr>
<td>Language link</td>
<td>Click to open the Preferences page, where you can select the language setting for your WebEx service Web site.</td>
</tr>
<tr>
<td>Time zone link</td>
<td>Click to open the Preferences page, where you can select the time zone setting for your WebEx service Web site.</td>
</tr>
<tr>
<td>Date</td>
<td>The date for the daily list of training sessions. The default is the current date.</td>
</tr>
<tr>
<td>Previous Day</td>
<td>Click the Previous Day icon to display a list of training sessions for the previous day.</td>
</tr>
<tr>
<td>Next Day</td>
<td>Click the Next Day icon to display a list of training sessions for the next day.</td>
</tr>
<tr>
<td>The meetings you host</td>
<td>Shows a list all of the online training sessions or Personal Conference meetings that you are hosting.</td>
</tr>
<tr>
<td>The meetings you are invited to</td>
<td>Shows a list all of the training sessions or Personal Conference meetings to which you have been invited.</td>
</tr>
<tr>
<td>Show past meetings</td>
<td>Select to include concluded training sessions in the list of meetings.</td>
</tr>
<tr>
<td>Ascending Sort</td>
<td>The Ascending Sort indicator appears next to a column heading, and the training sessions are sorted by the column, in ascending order.</td>
</tr>
<tr>
<td>Descending Sort</td>
<td>The Descending Sort indicator appears next to a column heading, and the training sessions are sorted by the column, in descending order.</td>
</tr>
</tbody>
</table>
Chapter 30: Using My WebEx

<table>
<thead>
<tr>
<th>Time</th>
<th>The starting time for each scheduled training session. Click the box next to a meeting start time to select that training session. Click the box next to the <strong>Time</strong> column heading to select or clear all training sessions in the list.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Topic</td>
<td>The topic for a training session that you are hosting. Click the topic name to get information about that training session.</td>
</tr>
<tr>
<td>Type</td>
<td>Indicates the type of online training session that you are hosting. Available training session types depend on the configuration of your WebEx service Web site.</td>
</tr>
<tr>
<td>Assist</td>
<td>If an Assist has been requested for this training session, indicates the type of Assist:</td>
</tr>
<tr>
<td></td>
<td><em>None</em></td>
</tr>
<tr>
<td></td>
<td><em>Dry Run</em></td>
</tr>
<tr>
<td></td>
<td><em>Consult</em></td>
</tr>
<tr>
<td></td>
<td><em>Live Event Support</em></td>
</tr>
<tr>
<td></td>
<td><em>Audio Streaming</em></td>
</tr>
<tr>
<td></td>
<td><em>Video</em></td>
</tr>
<tr>
<td>Status</td>
<td>The status of the training session.</td>
</tr>
<tr>
<td></td>
<td><strong>Start:</strong> You can start this training session that you are hosting at any time by clicking the link.</td>
</tr>
<tr>
<td></td>
<td>**Join</td>
</tr>
<tr>
<td></td>
<td><strong>Join:</strong> Lets you join the training session in progress.</td>
</tr>
<tr>
<td></td>
<td><strong>End:</strong> Ends the training session.</td>
</tr>
<tr>
<td></td>
<td><strong>Join:</strong> (for attendees) The training session that you are invited to has started, and you can now join the training session.</td>
</tr>
<tr>
<td></td>
<td><strong>Registration:</strong> (for attendees) The training session that you are invited to requires registration. To display a page on which you can register to attend the training session, click the link. (Does not apply to sales meetings or support sessions.)</td>
</tr>
<tr>
<td></td>
<td><strong>Full:</strong> The maximum number of attendees has registered for the training session. (Applies to training sessions only.)</td>
</tr>
<tr>
<td></td>
<td><strong>Closed:</strong> The host has closed registration for the training session. (Applies to training sessions only.)</td>
</tr>
</tbody>
</table>
### About the My WebEx Meetings page - Weekly tab

**How to access this tab**

On your WebEx service Web site, click *My WebEx > My Meetings > Weekly tab.*

<table>
<thead>
<tr>
<th>Delete</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cancels any training session that are currently selected in the list. If you click this link, a message appears, allowing you to confirm that you want to cancel the training session. Another message appears, allowing you to inform any invited attendees that you canceled the training session. (Does not apply to support sessions.)</td>
</tr>
</tbody>
</table>
### Options on this tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Refresh icon</td>
<td>Click the Refresh icon at any time to display the most current list of training sessions.</td>
</tr>
<tr>
<td>Language link</td>
<td>Click to open the Preferences page, where you can select the language setting for your WebEx service Web site.</td>
</tr>
<tr>
<td>Time zone link</td>
<td>Click to open the Preferences page, where you can select the time zone setting for your WebEx service Web site.</td>
</tr>
<tr>
<td>Week link</td>
<td>The beginning and ending date for the weekly list of training sessions.</td>
</tr>
<tr>
<td>Previous Week icon</td>
<td>Click the Previous Week icon to display a list of meetings for the previous week.</td>
</tr>
<tr>
<td>Next Week icon</td>
<td>Click the Next Week icon to display a list of meetings for the next week.</td>
</tr>
<tr>
<td>Calendar icon</td>
<td>Click the Calendar icon to open the Calendar window for the current month. Click on any date to open its schedule in the Daily view.</td>
</tr>
<tr>
<td>The meetings you host</td>
<td>Shows a list all of the online training sessions or Personal Conference meetings that you are hosting.</td>
</tr>
<tr>
<td>The meetings you are invited to</td>
<td>Shows a list all of the training sessions or Personal Conference meetings to which you have been invited.</td>
</tr>
<tr>
<td>Show past meetings</td>
<td>Select to include concluded training sessions in the list of meetings.</td>
</tr>
<tr>
<td>Day link Friday</td>
<td>Opens the Daily view, which shows the scheduled training sessions for the selected day.</td>
</tr>
<tr>
<td>Ascending Sort indicator</td>
<td>The Ascending Sort indicator appears next to a column heading, and the training sessions are sorted by the column, in ascending order.</td>
</tr>
<tr>
<td>Descending Sort indicator</td>
<td>The Descending Sort indicator appears next to a column heading, and the training sessions are sorted by the column, in descending order.</td>
</tr>
</tbody>
</table>
The **Expand** button appears next to a Day link. Click this button to expand and display the list of training sessions for that day.

The **Collapse** button appears next to a Day link. Click this button to collapse and hide the list of training sessions for that day.

<table>
<thead>
<tr>
<th>Time</th>
<th>The starting time for each scheduled training session. Click the box next to a meeting start time to select that training session. Click the box next to the <strong>Time</strong> column heading to select or clear all training sessions in the list.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Topic</td>
<td>The topic for a training session that you are hosting. Click the topic name to get information about that training session.</td>
</tr>
<tr>
<td>Type</td>
<td>Indicates the type of online training session that you are hosting. Available training session types depend on the configuration of your WebEx service Web site.</td>
</tr>
<tr>
<td>Assist</td>
<td>If an Assist has been requested for this training session, indicates the type of Assist:</td>
</tr>
<tr>
<td></td>
<td>- None</td>
</tr>
<tr>
<td></td>
<td>- Dry Run</td>
</tr>
<tr>
<td></td>
<td>- Consult</td>
</tr>
<tr>
<td></td>
<td>- Live Event Support</td>
</tr>
<tr>
<td></td>
<td>- Audio Streaming</td>
</tr>
<tr>
<td></td>
<td>- Video</td>
</tr>
<tr>
<td></td>
<td>Indicates that the live training session is in process.</td>
</tr>
</tbody>
</table>
### Status

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Start</strong></td>
<td>You can start this training session that you are hosting at any time by clicking the link.</td>
</tr>
<tr>
<td>**Join</td>
<td>End** (for hosts) For a training session in progress that you are hosting, you can join or end the training session. Appears if you left a training session, or you allowed participants to join the training session before its starting time and participants have already joined the training session.</td>
</tr>
<tr>
<td><strong>Join</strong></td>
<td>Lets you join the training session in progress.</td>
</tr>
<tr>
<td><strong>End</strong></td>
<td>Ends the training session.</td>
</tr>
<tr>
<td><strong>Join</strong></td>
<td>(for attendees) The training session that you are invited to has started, and you can now join the training session.</td>
</tr>
<tr>
<td><strong>Registration</strong> (for attendees) The training session that you are invited to requires registration. To display a page on which you can register to attend the training session, click the link. (Does not apply to sales meetings or support sessions.)</td>
<td></td>
</tr>
<tr>
<td><strong>Full</strong></td>
<td>The maximum number of attendees has registered for the training session. (Applies to training sessions only.)</td>
</tr>
<tr>
<td><strong>Closed</strong></td>
<td>The host has closed registration for the training session. (Applies to training sessions only.)</td>
</tr>
</tbody>
</table>

### Delete

Cancels any training sessions that are currently selected in the list. If you click this link, a message appears, allowing you to confirm that you want to cancel the training session. Another message appears, allowing you to inform any invited attendees that you canceled the training session. (Does not apply to support sessions.)

---

**About the My WebEx Meetings page - Monthly tab**

**How to access this tab**

On your WebEx service Web site, click **My WebEx > My Meetings > Monthly tab**.

**Options on this tab**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Refresh icon]</td>
<td>Click the <strong>Refresh</strong> icon at any time to display the most current list of training sessions.</td>
</tr>
<tr>
<td><strong>Language link</strong></td>
<td>Click to open the Preferences page, where you can select the language setting for your WebEx service Web site.</td>
</tr>
<tr>
<td>-------------------</td>
<td>------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Time zone link</strong></td>
<td>Click to open the Preferences page, where you can select the time zone setting for your WebEx service Web site.</td>
</tr>
<tr>
<td><strong>Month</strong></td>
<td>The month for the monthly calendar of training sessions. The default is the current month.</td>
</tr>
<tr>
<td>![Previous Month icon]</td>
<td>Click the <strong>Previous Month</strong> icon to display a list of training sessions for the previous month.</td>
</tr>
<tr>
<td>![Next Month icon]</td>
<td>Click the <strong>Next Month</strong> icon to display a list of training sessions for the next month.</td>
</tr>
<tr>
<td>![Calendar icon]</td>
<td>Click the <strong>Calendar</strong> icon to open the Calendar window for the current month. Click on any date to open its schedule in the Daily view.</td>
</tr>
<tr>
<td><strong>Week Number link</strong></td>
<td>Opens the Weekly view, which shows the scheduled training sessions for each day of the selected week.</td>
</tr>
<tr>
<td>![Week Number 10]</td>
<td></td>
</tr>
<tr>
<td><strong>Day link</strong></td>
<td>Opens the Daily view, which shows the scheduled training sessions for the selected day.</td>
</tr>
<tr>
<td>![Day link icon]</td>
<td></td>
</tr>
<tr>
<td><strong>The meetings you host</strong></td>
<td>Shows a list all of the online training sessions or Personal Conference meetings that you are hosting.</td>
</tr>
<tr>
<td><strong>The meetings you are invited to</strong></td>
<td>Shows a list all of the training sessions or Personal Conference meetings to which you have been invited.</td>
</tr>
<tr>
<td><strong>Show past meetings</strong></td>
<td>Select to include concluded training sessions in the list of meetings.</td>
</tr>
<tr>
<td><strong>Topic</strong></td>
<td>The topic for a training session that you are hosting. Click the topic name to get information about that training session.</td>
</tr>
<tr>
<td>![Topic icon]</td>
<td>Indicates that the live training session is in process.</td>
</tr>
</tbody>
</table>
About the My WebEx Meetings page - All Meetings tab

How to access this tab

On your WebEx service Web site, click My WebEx > My Meetings > All Meetings tab.

Options on this tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click the Refresh icon at any time to display the most current list of training sessions.</td>
<td></td>
</tr>
<tr>
<td>Language link</td>
<td>Click to open the Preferences page, where you can select the language setting for your WebEx service Web site.</td>
</tr>
<tr>
<td>Time zone link</td>
<td>Click to open the Preferences page, where you can select the time zone setting for your WebEx service Web site.</td>
</tr>
<tr>
<td>Date</td>
<td>The date for the daily list of training sessions. The default is the current date.</td>
</tr>
<tr>
<td>Click the Previous Day icon to display a list of training sessions for the previous day.</td>
<td></td>
</tr>
<tr>
<td>Click the Next Day icon to display a list of training sessions for the next day.</td>
<td></td>
</tr>
<tr>
<td>Search for meetings by date, host, topic, or words in the agenda</td>
<td>Allows you type or select a date range to search for training sessions, or allows you to type text to search in host names, topics, or agendas. Click Search to start the search.</td>
</tr>
<tr>
<td>Click the Calendar icon to open the Calendar window. Click on any date to select that date as part of your search criteria.</td>
<td></td>
</tr>
<tr>
<td>The meetings you host</td>
<td>Shows a list all of the online training sessions or Personal Conference meetings that you are hosting.</td>
</tr>
<tr>
<td>The meetings you are invited to</td>
<td>Shows a list all of the training sessions or Personal Conference meetings to which you have been invited.</td>
</tr>
<tr>
<td>Show past meetings</td>
<td>Select to include concluded training sessions in the list of meetings.</td>
</tr>
</tbody>
</table>
Chapter 30: Using My WebEx

<table>
<thead>
<tr>
<th><strong>Ascending Sort</strong> indicator appears next to a column heading, and the training sessions are sorted by the column, in ascending order.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Descending Sort</strong> indicator appears next to a column heading, and the training sessions are sorted by the column, in descending order.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Time</strong></th>
<th>The starting time for each scheduled training session. Click the box next to a meeting start time to select that training session. Click the box next to the <strong>Time</strong> column heading to select or clear all training sessions in the list.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Topic</strong></td>
<td>The topic for a training session that you are hosting. Click the topic name to get information about that training session.</td>
</tr>
<tr>
<td><strong>Type</strong></td>
<td>Indicates the type of online training session that you are hosting. Available training session types depend on the configuration of your WebEx service Web site.</td>
</tr>
<tr>
<td><strong>Assist</strong></td>
<td>If an Assist has been requested for this training session, indicates the type of Assist:</td>
</tr>
<tr>
<td></td>
<td>- None</td>
</tr>
<tr>
<td></td>
<td>- Dry Run</td>
</tr>
<tr>
<td></td>
<td>- Consult</td>
</tr>
<tr>
<td></td>
<td>- Live Event Support</td>
</tr>
<tr>
<td></td>
<td>- Audio Streaming</td>
</tr>
<tr>
<td></td>
<td>- Video</td>
</tr>
<tr>
<td></td>
<td>Indicates that the live training session is in process.</td>
</tr>
</tbody>
</table>
### Status

<table>
<thead>
<tr>
<th>The status of the training session.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Start:</strong> You can start this training session that you are hosting at any time by clicking the link.</td>
</tr>
<tr>
<td>**Join</td>
</tr>
<tr>
<td><strong>Join:</strong> Lets you join the training session in progress.</td>
</tr>
<tr>
<td><strong>End:</strong> Ends the training session.</td>
</tr>
<tr>
<td><strong>Join:</strong> (for attendees) The training session that you are invited to has started, and you can now join the training session.</td>
</tr>
<tr>
<td><strong>Registration:</strong> (for attendees) The training session that you are invited to requires registration. To display a page on which you can register to attend the training session, click the link. (Does not apply to sales meetings or support sessions.)</td>
</tr>
<tr>
<td><strong>Full:</strong> The maximum number of attendees has registered for the training session. (Applies to training sessions only.)</td>
</tr>
<tr>
<td><strong>Closed:</strong> The host has closed registration for the training session. (Applies to training sessions only.)</td>
</tr>
</tbody>
</table>

### Delete

| Cancels any training sessions that are currently selected in the list. If you click this link, a message appears, allowing you to confirm that you want to cancel the training session. Another message appears, allowing you to inform any invited attendees that you canceled the training session. (Does not apply to support sessions.) |

---

### Maintaining Your Personal Meeting Room Page

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of your Personal Meeting Room page</td>
<td>About your Personal Meeting Room (on page 475)</td>
</tr>
<tr>
<td>access your Personal Meeting Room page</td>
<td>Viewing your Personal Meeting Room (on page 475)</td>
</tr>
<tr>
<td>add images and text to your Personal Meeting Room page</td>
<td>Setting options for your Personal Meeting Room (on page 476)</td>
</tr>
<tr>
<td>share files on your Personal Meeting Room</td>
<td>Sharing files on your Personal Meeting Room</td>
</tr>
</tbody>
</table>
About your Personal Meeting Room page

Your user account includes a Personal Training Session Room page on your WebEx service Web site. Users who visit your page can:

- View a list of online training sessions that you are hosting, either scheduled or in progress.
- Join a training session in progress.
- View your personal folders and upload or download files to or from your folders, depending on the settings you specify for your folders.

You can customize your Personal Meeting Room page by adding images and text to it.

To provide users with access to your Personal Meeting Room page, you must provide them with your Personal Meeting Room URL. For more information, see Viewing your Personal Meeting Room page (on page 475).

**Tip:** Add your Personal Meeting Room URL to your business cards, your email signature, and so on.

Viewing your Personal Meeting Room page

You can view your Personal Meeting Room page at any time, by going to the link for the page. The link for your Personal Meeting Room page is available on your:

- My WebEx Meetings page
- My WebEx Profile page

To view your Personal Meeting Room page:

1. Log in to your WebEx service Web site, and then click My WebEx.
   
   The My WebEx Meetings page appears.

2. Click the Go to My Personal Meeting Room link.
Alternatively, in My WebEx, click My Profile, and then click the Personal Meeting Room URL link in the Personal Meeting Room section.

Your Personal Meeting Room page appears. The following is an example of a Personal Meeting Room page.

**Tip:** Add your Personal Meeting Room URL to your business cards, your email signature, and so on.

**Setting options for your Personal Meeting Room page**

You can add the following to your Personal Meeting Room page:

- An image (for example, you can add a picture of yourself or your company’s product).
- A custom banner image to the header area of your Personal Meeting Room page, if your user account has the “branding” option. For example, you can add your company’s logo.
- A welcome message. For example, you can provide a greeting; instructions on joining an online session; information about yourself, your product, or your company.

At any time, you can replace or delete images and text that you add.

**To add an image to your Personal Meeting Room page:**

1. If you have not already done so, log in to your WebEx service Web site. For details, see *Logging in to and out of the WebEx service site* (on page 460).
2. On the navigation bar at the top of the page, click My WebEx.
3. Click My Profile.

The My WebEx Profile page appears.
4 Under **Personal Meeting Room**, specify options for your page.
5 At the bottom of the My WebEx Profile page, click **Update**.
6 For details about the options for your Personal Meeting Room page, see *About your Personal Meeting Room page* (on page 475).

**Sharing files on your Personal Meeting Room page**

You can share folders on your My WebEx Files: Folders page so that they appear on the **Files** tab on your Personal Meeting Room page. For any folder that you share, you can specify whether users can download files from or upload files to the folder.

For more information about your Personal Meeting Room page, see *About your Personal Meeting Room page* (on page 475).

**To share files on your Personal Meeting Room page:**

1 Open the My WebEx Files page. For details, see *Opening your personal folders, documents, and files* (on page 481).
2 Under **Name**, locate the folder in which you want to share files.
3 If the file or folder is in a closed folder, click the folder to open it.
4 Click the **Properties** icon for the folder in which you want to share files.

The Edit Folder Properties window appears.
5 Specify sharing options for the folder.

6 Click **Update**.

For details about sharing options, see *About the Edit Folder Properties page* (on page 488).

### Using Access Anywhere (My Computers)

For information about and instructions for using Access Anywhere to set up and access a remote computer, please refer to the guide *Getting Started with WebEx Access Anywhere*. This guide is available on the Support page on your WebEx service Web site.

### About the My Computers page

**How to access this page**

On your WebEx service Web site, click My WebEx Files > My Computers.
What you can do here
Set up and access remote computers using Access Anywhere.

Options on this page

<table>
<thead>
<tr>
<th>Link or option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Computer</td>
<td>The name you have assigned to your remote computer.</td>
</tr>
<tr>
<td>Status</td>
<td>The status of your remote computer:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Available</strong>—the computer is available for remote access.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Offline</strong>—the computer is offline and is not available for remote access.</td>
</tr>
<tr>
<td>Application</td>
<td>The application on your remote computer that you have allowed to access, based on what you specified during set up. It may be <strong>Desktop</strong>, if you set up your desktop for access, or it may be a specific application name.</td>
</tr>
<tr>
<td>Status</td>
<td>If the computer is available for access, you can click the <strong>Connect</strong> link to connect to your remote computer.</td>
</tr>
<tr>
<td>Remove</td>
<td>Removes the selected computer from the list of remote computers.</td>
</tr>
<tr>
<td>Set Up Computer</td>
<td>Sets up the current computer for Access Anywhere and adds it to the list of remote computers.</td>
</tr>
<tr>
<td>Download manual installer</td>
<td>Downloads the manual installer for the Access Anywhere software.</td>
</tr>
</tbody>
</table>

Maintaining files in your personal folders

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of your personal storage space for files</td>
<td>About maintaining files in your folders (on page 480)</td>
</tr>
<tr>
<td>open your personal storage space for files</td>
<td>Opening your personal folders, documents, and files (on page 481)</td>
</tr>
</tbody>
</table>
### Chapter 30: Using My WebEx

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>create new folders to organize your files</td>
<td>Adding new folders to your personal folders (on page 482)</td>
</tr>
<tr>
<td>upload files to your personal folders</td>
<td>Uploading files to your personal folders (on page 482)</td>
</tr>
<tr>
<td>move or copy files or an entire folder to another folder</td>
<td>Moving or copying files or folders in your personal folders (on page 483)</td>
</tr>
<tr>
<td>change information about files or folders, including their names or descriptions</td>
<td>Editing information about files or folders in your personal folders (on page 484)</td>
</tr>
<tr>
<td>search for files or folders in your personal storage space for files</td>
<td>Searching for files or folders in your personal folders (on page 485)</td>
</tr>
<tr>
<td>download files in your personal storage space to your computer</td>
<td>Downloading files in your personal folders (on page 486)</td>
</tr>
<tr>
<td>share, or publish, files in your personal folders on your Personal Meeting Room, so others can access them</td>
<td>Sharing files on your Personal Meeting Room page (on page 477)</td>
</tr>
<tr>
<td>remove files or folders from your personal folders</td>
<td>Deleting files or folders in your personal folders (on page 486)</td>
</tr>
</tbody>
</table>

### About maintaining files in your folders

Your user account includes personal storage space for files on your WebEx service Web site.

In your personal storage space, you can:

- Create folders to organize your files.
- Edit information about any file or folder in your personal folders.
- Move or copy a file or folder to a different folder.
- Share a folder so it appears on your Personal Meeting Room page.

**Tip:**

You can use this storage space to access important information when you are away from the office. For example, if you are on a business trip and want to share a file during an online session, you can download the file in your personal folders to a computer, and then share the file with attendees.

If you share a folder, visitors to your Personal Meeting Room page can
Opening your personal folders, documents, and files

To store files on your WebEx service Web site, or to access files that you stored, you must open your personal folders.

**To open your personal folders:**

1. Log in to your WebEx service Web site, and then click **My WebEx**.
2. Click **My Files**.

   The My WebEx Files page appears, showing your personal folders and files. Depending on the settings for your WebEx Service Web site, you may see different categories of folders and files, and you can click on the heading links to see each category:

   - **My Documents**
   - **My Recordings**
   - **My Event Recordings** (available only in Event Center)
   - **My Training Recordings** (available only in Training Center)

For details about the My WebEx Files page, see *About the My WebEx Files > My Documents page* (on page 486) and *About the My WebEx Files > My Recordings page* (on page 496).
Chapter 30: Using My WebEx

Adding new folders to your personal folders

To organize your files on your WebEx service Web site, you can create folders in your personal storage space for files.

To create a new folder:

1. Open the My Documents page. For details, see Opening your personal folders, documents, and files (on page 481).
2. Under Action, click the Create Folder button for the folder in which you want a new folder.

The Create Folder window appears.

3. In the Folder Name box, type a name for the folder.
4. Optional. In the Description box, type a description to help you to identify the folder's contents.
5. Click OK.

Uploading files to your personal folders

To store files in your personal folders on your WebEx service Web site, you must upload them from your computer or a local server.

You can upload up to three files at once. The is no limit to the size of the files, as long as you have available storage space. The amount of space available for storing files is determined by your site administrator. If you require more disk space, contact your site administrator.

To upload files to your personal folders:

1. Open the My Documents page. For details, see Opening your personal folders, documents, and files (on page 481).
2. Locate the folder in which you want to store the file.
3. Under Action for the folder, click the Upload button for the folder in which you want to store the file.
The Upload File window appears.

4 Click **Browse**.

The Choose File dialog box appears.

5 Select the file that you want to upload to your folder.

6 Click **Open**.

The file appears in the **File name** box.

7 Optional. In the **Description** box, type a description to help you to identify the file.

8 Optional. Select up to two additional files to upload.

9 Click **Upload**.

The files are uploaded to the folder that you selected.

10 Once you are finished uploading files, click **Finish**.

---

### Moving or copying files or folders in your personal folders

You can move one or more files or folders to another folder on your WebEx service Web site.

**To move or copy a file or folder:**

1 Open the My Documents page. For details, see *Opening your personal folders, documents, and files* (on page 481).

2 Locate the file or folder that you want to move.

3 Select the check box for the file or folder that you want move.

   You can select multiple files or folders.

4 Click **Move** or **Copy**.

   The Move/Copy File or Folder window appears, showing a list of your folders.

5 Select the option button for the folder in which you want to move or copy the file or folder.

6 Click **OK**.
Editing information about files or folders in your personal folders

You can edit the following information about a file or folder in your personal folders on your WebEx service Web site:

- Name
- Description

You can also specify sharing options for folders that appear on your Personal Training Session Room page. For more information, see Sharing files on your Personal Training Session Room page (on page 477).

To edit information about a file or folder:

1. Open the My Documents page. For details, see Opening your personal folders, documents, and files (on page 481).
2. Locate the file or folder for which you want to edit information.
3. Click the Properties icon for the file or folder for which you want to edit information.

The Edit File Properties or Edit Folder Properties window appears.
In the Description box, type a new name for the file or folder.

- In the Name box, type a new name for the file or folder.

4 Click Update.

**Searching for files or folders in your personal folders**

In your personal folders on your WebEx service Web site, you can quickly locate a file or folder by searching for it. You can search for a file or folder by text that appears in either its name or description.

**To search for a file or folder:**

1 Open the My Documents page. For details, see *Opening your personal folders, documents, and files* (on page 481).

2 In the Search For box type all or part of the file’s name or description.

3 Click Search.

A list of any files or folders that contain the search text appears.
Chapter 30: Using My WebEx

Downloading files in your personal folders

In your personal folders on your WebEx service Web site, you can download any files to your computer or a local server.

1. Open the My Documents page. For details, see Opening your personal folders, documents, and files (on page 481).
2. Locate the file that you want to download.
3. Under Action, click the Download button for the file that you want to download.

The File Download dialog box appears.
4. Follow any instructions that your Web browser or operating system provides to download the file.

Deleting files or folders in your personal folders

You can delete files or folders in your personal folders on your WebEx service Web site.

To delete a file or folder:

1. Open the My Documents page. For details, see Opening your personal folders, documents, and files (on page 481).
2. Under Name, locate the file or folder that you want to delete.
3. Select the check box for the file or folder that you want delete.
   You can select multiple files or folders.
4. Click Delete.

About the My WebEx Files > My Documents page

How to access this page

On your WebEx service Web site, click My WebEx Files > My Documents.
What you can do here

- Store files that you use in your online sessions or that you want to access when away from your office.
- Specify in which folders that visitors to your Personal Meeting Room can download or upload files.

Options on this page

<table>
<thead>
<tr>
<th>Link or option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Capacity</td>
<td>The storage space available for your files, in megabytes (MB).</td>
</tr>
<tr>
<td>Used</td>
<td>The amount of storage space that your files occupy, in megabytes (MB). Once this value exceeds your capacity, you can no longer store files until you remove existing files from your folders.</td>
</tr>
<tr>
<td>Search for</td>
<td>Lets you locate a file or folder by searching for it. You can search for a file or folder by text that appears in either its name or description. To search for a file or folder, type all or part of its name or description in the box, and then click Search.</td>
</tr>
<tr>
<td>Name</td>
<td>The name of the folder or file. Click a folder or file name to open the Folder Information page or File Information page. From the Information page, you can access the properties of a folder or file. Indicates that the item is a folder. Click the image to display the contents of the folder. Indicates that the item is a file.</td>
</tr>
<tr>
<td>Path</td>
<td>The folder hierarchy for the folder or file. The Root folder is the top-most folder in which all other folders and files reside.</td>
</tr>
<tr>
<td>Size</td>
<td>The size of the folder or file, in kilobytes (KB).</td>
</tr>
</tbody>
</table>
| Actions        | Click the icons to perform an action on the folder or file that is associated with it.  
  - **Upload file**: Available only for files. Click this icon to open the File Upload page, on which you can select up to three files at a time to upload to a specified folder.  
  - **Download file**: Available only for files. Click this icon to download the file associated with it. |
### Link or option

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Edit File Properties</strong> or <strong>Edit Folder Properties</strong>: Click this icon to open the Edit File Properties page or Edit Folder Properties page, on which you can edit information about the file or folder, respectively.</td>
</tr>
<tr>
<td><strong>Create Folder</strong>: Available for folders only. Click this icon to open the Create Folder page on which you can create a new folder in your personal storage space.</td>
</tr>
</tbody>
</table>

### Shared

- **Read only**: Visitors to your Personal Meeting Room can view the list of files in the folder and download the files.
- **Write only**: Visitors to your Personal Meeting Room can upload files to the folder, but they cannot view the files in it.
- **Read and write**: Users can view files in the folder, download files from the folder, and upload files to the folder.
- **Password Protected**: Indicates that the folder is password protected. Visitors to your Personal Meeting Room must provide the password you specify to access the folder.

### Select All

Selects the check boxes for all the folders and files that are visible in the list. You can then click the **Copy** or **Move** button or click the **Delete** link to perform an action on the selected folders or files.

### Clear All

Clears the check boxes for all the folders and files that are selected in the list.

### Delete

Deletes the selected folders and files from the list.

### Copy

Opens a page on which you can copy the selected folder or file to another folder.

### Move

Opens a page on which you can move the selected folder or file to another folder.

---

**About the Edit Folder Properties page**

**How to access this page**

On your WebEx service Web site, click **My WebEx > My Files > Properties** icon for folder.
What you can do here
Specify a name, a description, and sharing options for a folder that you created in your personal folders.

Options on this page

<table>
<thead>
<tr>
<th>Use this option…</th>
<th>To…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter the name of the folder.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter the description of the folder.</td>
</tr>
<tr>
<td>Share</td>
<td>Specify who can access this folder.</td>
</tr>
<tr>
<td></td>
<td><strong>Do not share this folder</strong>: This folder does not appear on your Personal Meeting Room page. Thus, visitors to your page cannot view the folder or access any files in it.</td>
</tr>
<tr>
<td></td>
<td><strong>Share this folder</strong>: This folder appears on your Personal Meeting Room.</td>
</tr>
<tr>
<td></td>
<td>The drop-down list specifies which users can access the folder, as follows:</td>
</tr>
<tr>
<td></td>
<td><strong>With all</strong>: All visitors to your Personal Meeting Room can access this folder.</td>
</tr>
<tr>
<td></td>
<td><strong>With users with host or attendee accounts</strong>: Only visitors to your Personal Meeting Room who have either a host account or an attendee account on your WebEx service Web site can access this folder.</td>
</tr>
<tr>
<td></td>
<td><strong>With users with host accounts only</strong>: Only visitors to your Personal Meeting Room who have a host account on your WebEx service Web site can access this folder.</td>
</tr>
<tr>
<td>Share as</td>
<td>Enter the name for the folder that will appear on your Personal Meeting Room page.</td>
</tr>
<tr>
<td>Read</td>
<td>Let visitors to your Personal Meeting Room view the list of files in the folder and download the files.</td>
</tr>
<tr>
<td>Write</td>
<td>Let visitors to your Personal Meeting Room upload files to the folder but does not allow them to view the files in it.</td>
</tr>
<tr>
<td>Read &amp; write</td>
<td>Let users view files in the folder, download files from the folder, and upload files to the folder.</td>
</tr>
<tr>
<td>Allow files to be overwritten</td>
<td>Let users upload a file with the same name as an existing file in the folder and replace the existing file. If this option is not selected, users cannot overwrite any files in the folder.</td>
</tr>
</tbody>
</table>
Chapter 30: Using My WebEx

<table>
<thead>
<tr>
<th>Use this option…</th>
<th>To…</th>
</tr>
</thead>
</table>
| **Password protected** | Let only visitors to your Personal Meeting Room who know the password view the list of files in the folder, download files from the folder, or upload files to the folder, depending on the read/write settings for the folder.  
  **Password**: The password that visitors to your Personal Meeting Room must provide to access the folder.  
  **Confirm**: If you specified a password, type it again to verify that you typed it correctly. |
| **Update** | Save any changes that you made to folder's properties, and then closes the Edit Folder Properties window. |
| **Cancel** | Close the Edit Folder Properties window, without saving any of the changes that you made. |

Opening the My Recordings Page

To upload or maintain recordings, you must do so from the My Recordings page on your WebEx service Web site.

**To open the My Recordings page:**

1. Log in to your WebEx service Web site, and then click **My WebEx**.
2. Click **My Files > My Recordings**.
   
   The My Recordings page appears, showing your recording files.

   For details about the My Recordings page, see *About the My WebEx Files > My Recordings page* (on page 496).

Uploading a recording file

If you recorded a training session using the integrated or standalone WebEx Recorder, you can upload the recording file, with a .wrf extension, from your local computer to the My Recordings page.

For instructions on editing a recording, see *Editing information about a recording* (on page 491).
Note: If you recorded a training session using the WebEx Network-Based Recorder (NBR), the WebEx server automatically uploads the recording file, with an .arf extension, to the appropriate tab on the My Recordings page once you stop the Recorder. You do not need to upload it yourself.

To upload a recording file:
1. Go to the My Recordings page. For details, see Opening the My Recordings page (on page 490).
2. Click Add Recording.
3. On the Add Recording page, enter information and specify options.
   For details about what you can do with each option on the Add/Edit Recordings page, see About the My WebEx Files > My Recordings page (on page 496).
4. Click Save.

Editing information about a recording
You can edit information about a recording at any time.

To edit information about a recording:
1. Go to the My Recordings page. For details, see Opening the My Recordings page (on page 490).
2. Click the following icon for the recording that you want to edit.

The Edit Recording page appears.
3. Make your changes.
   For details about what you can do with each option on the Edit Recording page, see About the My WebEx Files > My Recordings page (on page 496).
4. Click Save.
About the Add/Edit Recording page

How to access this page

If you are adding a recording...
1 On your WebEx service Web site, click My WebEx > My Files > My Recordings.
2 Click Add Recording.

If you are editing information about a recording...
1 On your WebEx service Web site, click My WebEx > My Files > My Recordings.
2 Click the More button in the row of the recording that you want to edit.

3 Click Modify.

What you can do here
- Edit general information about a recording, including the topic and description.
- Require a password to play or download the recording.

Options on this page

<table>
<thead>
<tr>
<th>Use this option.....</th>
<th>To....</th>
</tr>
</thead>
<tbody>
<tr>
<td>Topic</td>
<td>Specify the topic of the recording.</td>
</tr>
<tr>
<td>Description</td>
<td>Provide a description of this recording.</td>
</tr>
<tr>
<td>Recording file</td>
<td>Click Browse to select the recording file that resides on your</td>
</tr>
</tbody>
</table>
### Chapter 30: Using My WebEx

<table>
<thead>
<tr>
<th>Use this option....</th>
<th>To....</th>
</tr>
</thead>
<tbody>
<tr>
<td>local computer.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Use this option....</th>
<th>To....</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specify the duration of the recording.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Use this option....</th>
<th>To....</th>
</tr>
</thead>
<tbody>
<tr>
<td>Displays the size of the recording file. (Available only when editing recording information.)</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Use this option....</th>
<th>To....</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set an optional password that users must provide to view the recording.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Use this option....</th>
<th>To....</th>
</tr>
</thead>
<tbody>
<tr>
<td>Confirm the password that users must provide to view the recording.</td>
<td></td>
</tr>
</tbody>
</table>

### Playback control options

<table>
<thead>
<tr>
<th>Use this option....</th>
<th>To....</th>
</tr>
</thead>
<tbody>
<tr>
<td>Panel Display Options</td>
<td>Determines which panels are displayed in the recording when it is played back. You can select any of the following panels to be included the recording playback: Chat Q &amp; A Video Polling Notes File Transfer Participants Table of Contents Panel display options do not modify the panel display in the actual recording that is stored on the WebEx network.</td>
</tr>
</tbody>
</table>

---

493
### About the Recording Information page

#### How to access this page

On your WebEx service Web site, click **My WebEx > My Files > My Recordings > [recording type] > [topic of a recording].**

#### What you can do here

- View information about the recording.
- Play back the recording.
- Send an email to share the recording with others.
- Download the recording.
- Enable or disable the recording.

---

<table>
<thead>
<tr>
<th>Use this option...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Recording Playback Range</strong></td>
<td>Determines how much of the recording is actually played back. You can select <em>either</em> of the following:</td>
</tr>
<tr>
<td><strong>Full playback:</strong> Plays back the full length of the recording. This option is selected by default.</td>
<td></td>
</tr>
<tr>
<td><strong>Partial playback:</strong> Plays back only part of the recording based on your settings for the following options:</td>
<td></td>
</tr>
<tr>
<td><strong>Start: X min X sec of the recording:</strong> Specifies the time to start playback; for example, you can use this option if you would like to omit the &quot;dead time&quot; at the beginning of the recording, or if you would like to show only a portion of the recording.</td>
<td></td>
</tr>
<tr>
<td><strong>End: X min X sec of the recording:</strong> Specifies the time to end playback; for example, you can use this option if you would like to omit the &quot;dead time&quot; at the end of the recording. You can not specify an end time greater than the length of the actual recording.</td>
<td></td>
</tr>
<tr>
<td>The partial playback range you specify does not modify the actual recording that is stored on the server.</td>
<td></td>
</tr>
<tr>
<td><strong>Include NBR player controls</strong></td>
<td>Includes full Network Recording Player controls, such as stop, pause, resume, fast forward, and rewind. This option is selected by default. If you would like to prevent viewers from skipping portions of the recording, you can turn off this option to omit Network Recording Player controls from the playback.</td>
</tr>
</tbody>
</table>
Open the Edit Recording page on which you can edit information about a recording.

Options on this page

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Topic</td>
<td>The name of the recording. You can edit the topic at any time.</td>
</tr>
<tr>
<td>Create time</td>
<td>The time and date the recording was created.</td>
</tr>
<tr>
<td>Duration</td>
<td>The length of the recording.</td>
</tr>
<tr>
<td>Description</td>
<td>A description of the recording.</td>
</tr>
<tr>
<td>File size</td>
<td>The file size of the recording.</td>
</tr>
<tr>
<td>Create time</td>
<td>The date and time at which the recording was created.</td>
</tr>
<tr>
<td>Status</td>
<td>The status of the recording. The possible options are Enable or Disable.</td>
</tr>
<tr>
<td>Password</td>
<td>Indicates whether a user must provide a password to view the recording.</td>
</tr>
<tr>
<td>Stream recording link</td>
<td>Clicking the link lets you play the recording (available only for recording files with the .arf extension that were recorded by NBR).</td>
</tr>
<tr>
<td>Download recording link</td>
<td>Clicking the link lets you download the recording.</td>
</tr>
</tbody>
</table>

- **Play Now**
  - Clicking the button lets you play the recording (available only for recording files with the .arf extension that were recorded by NBR).
  - If you want to download the recording, you can also click the link for downloading under **Play Recorded a training session Now**.

- **Send Email**
  - Clicking the button opens the Share My Recording window, which allows you to send an email message to selected recipients, inviting them to play your recording.
  - If you want to send the email with your local email client instead, click the link for using the email client under **Share My Recording**.

- **Modify**
  - Clicking the button opens the Edit Recording page.
About the My WebEx Files > My Recordings page

How to access this page
Log in to your WebEx service Web site, and then click My WebEx. From the left navigation bar, click My Files > My Recordings.

What you can do here
Manage, upload, and maintain your recording files.

Options on this page
View different categories of recordings:
- Meetings
- Events
- Sales Meetings
- Training Sessions
- Miscellaneous
About the My WebEx Files > My Recordings > Miscellaneous page

How to access this page
Log in to your WebEx service Web site, and then click My WebEx. From the left navigation bar, click My Files > My Recordings > Miscellaneous.

What you can do here
Manage, upload, and maintain recording files of training sessions you host.

Options on this page

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Refreshes the information on the page.</td>
<td>-------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Allows you type text to search for within recording names. Click Search to start the search.</td>
<td></td>
</tr>
<tr>
<td>The percentage of available personal storage space on your WebEx Service Web site that is being used by your recordings. This field appears only if your site administrator has turned on the option to show personal recording storage allocation usage. If this field does appear, and you exceed your personal storage allocation, you will not be able to record meetings until some recordings are deleted or the storage allocation is increased by your system administrator.</td>
<td></td>
</tr>
<tr>
<td>The percentage of total available storage space on your WebEx Service Web site that is being used by all recordings on your site. If your site exceeds its storage allocation, users will not be able to record meetings until recordings are deleted or the storage allocation is increased by your system administrator.</td>
<td></td>
</tr>
<tr>
<td>The name of the recording. If you record a training session on the server, the WebEx server automatically uploads the recording to this page. In this case, the topic of the recording is the topic of the training session. You can edit the topic at any time.</td>
<td></td>
</tr>
<tr>
<td>The size of the recording.</td>
<td></td>
</tr>
<tr>
<td>The date and time the recording was created.</td>
<td></td>
</tr>
</tbody>
</table>
# Chapter 30: Using My WebEx

## Duration
The length of the recording.

## Format
The format of the recording file.

A recording file can be in WebEx Advanced Recording Format (ARF) or WebEx Recording Format (WRF). You can also store recording files that are in Windows Media Audio/Video (WMV) format. For Event Center and Training Center, you can also store Shockwave Flash Object (SWF) format files.

Displays a menu with more options for your recording:

- **Download:** Lets you download the recording to your local computer.
  - If downloading the file requires a password, you must provide the password.

- **Modify:** Lets you edit information of the recording. For details, see About the Add/Edit Recordings page (on page 492).

- **Disable:** Lets you disable the recording in all locations.

- **Delete:** Lets you delete the recording from this page.

Indicates that a recording is password-protected.

---

## Maintaining contact information

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of your personal address book</td>
<td>About maintaining contact information (on page 499)</td>
</tr>
<tr>
<td>open your personal address book</td>
<td>Opening your address book (on page 499)</td>
</tr>
<tr>
<td>add a new contact to your personal address book</td>
<td>Adding a contact to your address book (on page 501)</td>
</tr>
<tr>
<td>add multiple contacts to your address book at once</td>
<td>Importing contact information in a file to your address book (on page 503)</td>
</tr>
</tbody>
</table>
**Chapter 30: Using My WebEx**

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>add contacts in Microsoft Outlook to your personal address book</td>
<td>Importing contact information from Outlook to your address book (on page 506)</td>
</tr>
<tr>
<td>view or change information about contacts in your personal address book</td>
<td>Viewing and editing contact information in your address book (on page 507)</td>
</tr>
<tr>
<td>find a contact in your personal address book</td>
<td>Finding a contact in your personal address book (on page 508)</td>
</tr>
<tr>
<td>combine multiple contacts into a single distribution list</td>
<td>Creating a distribution list in your address book (on page 508)</td>
</tr>
<tr>
<td>edit information about a distribution list</td>
<td>Editing a distribution list in your address book (on page 510)</td>
</tr>
<tr>
<td>delete a contact or distribution list</td>
<td>Deleting contact information in your address book (on page 512)</td>
</tr>
</tbody>
</table>

**About maintaining contact information**

You can maintain a personal online address book, in which you can add information about contacts and create distribution lists. When scheduling a meeting or starting an instant meeting, you can quickly invite any contacts or distribution lists in your personal address book. You can also invite contacts in the Company Address Book for your WebEx service Web site, if one is available.

You can add contacts to your personal address book in any of the following ways:

- Specify information about contacts one at a time.
- Import contact information from your Microsoft Outlook contacts.
- Import contact information from a comma-separated/comma-delimited values (CSV) file.

You can also edit or delete the information about any contact or distribution list in your personal address book.

**Opening your address book**

You can open your personal address book on your WebEx service Web site, to view or maintain information about your contacts.
To open your address book:

1. Log in to your WebEx service Web site. For details, see *Logging in to and out of the WebEx service site* (on page 460).

2. On the navigation bar at the top of the page, click **My WebEx**.

3. Click **My Contacts**.

The My WebEx Contacts page appears.

### My WebEx Contacts

![My WebEx Contacts interface](image)

**View:** Personal Contacts

**Import From:** Microsoft Outlook

**Search for:**

*Note: Search queries contact name and email address fields only.*

<table>
<thead>
<tr>
<th>Index</th>
<th>Name</th>
<th>Email Address</th>
<th>Phone Number</th>
<th>Language</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Planning Committee</td>
<td><a href="mailto:christine@aar.com">christine@aar.com</a></td>
<td>1-513-954-0481</td>
<td>English</td>
</tr>
<tr>
<td>B</td>
<td>Sales Department</td>
<td></td>
<td>1-406-233-5567</td>
<td>English</td>
</tr>
<tr>
<td>C</td>
<td>Christine Holtz</td>
<td><a href="mailto:christine@aar.com">christine@aar.com</a></td>
<td>1-513-954-0481</td>
<td>English</td>
</tr>
<tr>
<td>D</td>
<td>John Mullen</td>
<td><a href="mailto:jmullen@zwire.com">jmullen@zwire.com</a></td>
<td>1-406-233-5567</td>
<td>English</td>
</tr>
<tr>
<td>E</td>
<td>Lisa Grantham</td>
<td><a href="mailto:lgraham@zwire.com">lgraham@zwire.com</a></td>
<td>1-512-908-0000</td>
<td>English</td>
</tr>
<tr>
<td>F</td>
<td>Lisa White</td>
<td><a href="mailto:lisa@zwire.com">lisa@zwire.com</a></td>
<td>1-516-996-0888</td>
<td>English</td>
</tr>
<tr>
<td>G</td>
<td>Marcel Tillman</td>
<td><a href="mailto:mtillman@protech.com">mtillman@protech.com</a></td>
<td>415-888-8844</td>
<td>English</td>
</tr>
<tr>
<td>H</td>
<td>Sally Chen</td>
<td><a href="mailto:schen@micolite.com">schen@micolite.com</a></td>
<td>1-512-504-1222</td>
<td>English</td>
</tr>
</tbody>
</table>

4. In the **View** drop-down list, select one of the following contact lists:

- **Personal Contacts:** Includes any individual contacts or distribution lists that you added to your personal address book. If you have a Microsoft Outlook address book or contacts folder, you can import its contacts to this list of contacts.

- **Company Address Book:** Your organization's address book, which includes any contacts that your site administrator has added to it. If your organization uses a Microsoft Exchange Global Address List, your site administrator can import its contacts to this address book.
Adding a contact to your address book

You can add contacts to your personal address book, one at a time.

**To add a contact to your personal address book:**

1. Open your personal address book. For details, see *Opening your address book* (on page 499).
2. In the *View* drop-down list, select *Personal Contacts*.
   A list of contacts in your Personal Contacts list appears.
3. Click *Add Contact*.
   The Add Contact page appears.

### My WebEx Contacts

<table>
<thead>
<tr>
<th>New Contact</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Full name:</strong> [required]</td>
</tr>
<tr>
<td><strong>Email address:</strong> [required]</td>
</tr>
<tr>
<td><strong>Company:</strong></td>
</tr>
<tr>
<td><strong>Job title:</strong></td>
</tr>
<tr>
<td><strong>URL</strong> (if known)</td>
</tr>
<tr>
<td><strong>Phone number</strong> <strong>Country/Region:</strong> <strong>Area or city code:</strong> <strong>Number:</strong> <strong>Extension:</strong></td>
</tr>
<tr>
<td><strong>Phone number for mobile device</strong> <strong>Country/Region:</strong> <strong>Area or city code:</strong> <strong>Number:</strong> <strong>Extension:</strong></td>
</tr>
<tr>
<td><strong>Fax number</strong> <strong>Country/Region:</strong> <strong>Area or city code:</strong> <strong>Number:</strong> <strong>Extension:</strong></td>
</tr>
<tr>
<td><strong>Address1:</strong></td>
</tr>
<tr>
<td><strong>Address2:</strong></td>
</tr>
<tr>
<td><strong>City:</strong></td>
</tr>
<tr>
<td><strong>State/Province:</strong></td>
</tr>
<tr>
<td><strong>ZIP/Postal code:</strong></td>
</tr>
<tr>
<td><strong>Country/Region:</strong></td>
</tr>
<tr>
<td><strong>User name:</strong> (if known)</td>
</tr>
<tr>
<td><strong>Notes:</strong></td>
</tr>
</tbody>
</table>

[Add | Cancel]
Chapter 30: Using My WebEx

4 Provide information about the contact.

5 Click Add.

For descriptions of the information and options on the New Contact page, see About the New/Edit Contact page (on page 502).

Note:
- You cannot add contacts to your Company Address Book.
- If you want to add multiple contacts, you can them all at once, instead of adding one contact at a time. For details, see Importing contact information in a file to your address book (on page 503).

About the New/Edit Contact page

How to access this page

On your WebEx service Web site, click My WebEx > My Contacts > Add Contact or [check box for contact] > Edit.

What you can do here

Enter information about a new or existing contact for your personal address book.

Options on this page

<table>
<thead>
<tr>
<th>Use this option…</th>
<th>To…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full name</td>
<td>Enter the contact's first and last name.</td>
</tr>
<tr>
<td>Email address</td>
<td>Enter the contact's email address.</td>
</tr>
<tr>
<td>Language</td>
<td>Set the language in which any email messages that you send to the contact using your WebEx service site appear. Available only if your WebEx service Web site can be displayed in two or more languages.</td>
</tr>
<tr>
<td>Company</td>
<td>Enter the company or organization for which the contact works.</td>
</tr>
<tr>
<td>Job title</td>
<td>Enter the contact's position in a company or organization.</td>
</tr>
<tr>
<td>URL</td>
<td>Enter the URL, or Web address, for the contact's company or organization.</td>
</tr>
</tbody>
</table>
### Importing contact information in a file to your address book

You can add information about multiple contacts simultaneously to your personal address book, by importing a comma-separated values (CSV) file. A CSV file has the `.csv` file extension; you can export information from many spreadsheet and email programs in CSV format.

**To create a CSV file:**

1. Open your address book. For details, see *Opening your address book* (on page 499).
2. In the **View** drop-down list, ensure that **Personal Address Book** is selected.
3. Click **Export**.
4. Save the `.csv` file to your computer.
5. Open the .csv file that you saved in a spreadsheet program, such as Microsoft Excel.

6. Optional. If contact information exists in the file, you can delete it.

7. Specify information about the new contacts in the .csv file.

   **Important:** If you add a new contact, ensure that the UID field is blank. For information about the fields in the .csv file, see *About the Contact Information CSV template* (on page 505).

8. Save the .csv file. Ensure that you save it as a .csv file.

**To import a CSV file containing new contact information:**

1. Open your address book. For details, see *Opening your address book* (on page 499).

2. In the View drop-down list, ensure that Personal Contacts is selected.

3. In the Import From drop-down list, select Comma Delimited Files.

4. Click Import.

5. Select the .csv file in which you added new contact information.

6. Click Open.

7. Click Upload File.

   The View Personal Contacts page appears, allowing you to review the contact information you are importing.

8. Click Submit.

   A confirmation message appears.

9. Click Yes.

   **Note:** If an error exists in any new or updated contact information, a message appears, informing you that no contact information was imported.
About the Contact Information CSV template

How to access this template

On your WebEx service Web site, click My WebEx > My Contacts > View > Personal Address Book > Export.

What you can do here

Specify information about multiple contacts, which you can then import to your personal address book.

Fields in this template

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>UUID</td>
<td>A number that your WebEx service site creates to identify the contact. If you add a new contact to the CSV file, you must leave this field blank.</td>
</tr>
<tr>
<td>Name</td>
<td>Required. The contact's first and last name.</td>
</tr>
<tr>
<td>Email</td>
<td>Required. The contact's email address. The email address must be in the following format: <a href="mailto:name@company.com">name@company.com</a></td>
</tr>
<tr>
<td>Company</td>
<td>The company or organization for which the contact works.</td>
</tr>
<tr>
<td>JobTitle</td>
<td>The contact's position in a company or organization.</td>
</tr>
<tr>
<td>URL</td>
<td>The URL, or Web address, for the contact's company or organization.</td>
</tr>
<tr>
<td>OffCntry</td>
<td>The country code for the contact's office phone—that is, the number that you must dial if the contact resides in another country.</td>
</tr>
<tr>
<td>OffArea</td>
<td>The area or city code for the contact's office phone number.</td>
</tr>
<tr>
<td>OffLoc</td>
<td>The contact's office phone number.</td>
</tr>
<tr>
<td>OffExt</td>
<td>The extension for the contact's office phone number, if any.</td>
</tr>
<tr>
<td>CellCntry</td>
<td>The country code for the contact's cellular or mobile phone—that is, the number that you must dial if the contact resides in another country.</td>
</tr>
<tr>
<td>CellArea</td>
<td>The area or city code for the contact's cellular or mobile phone number.</td>
</tr>
<tr>
<td>CellLoc</td>
<td>The contact's cellular or mobile phone number.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>CellExt</td>
<td>The extension for the contact's cellular or mobile phone number, if any.</td>
</tr>
<tr>
<td>FaxCntry</td>
<td>The country code for the contact's fax number—that is, the number that you must dial if the contact resides in another country.</td>
</tr>
<tr>
<td>FaxArea</td>
<td>The area or city code for the contact's fax number.</td>
</tr>
<tr>
<td>FaxLoc</td>
<td>The contact's fax number.</td>
</tr>
<tr>
<td>FaxExt</td>
<td>The extension for the contact's fax machine, if any.</td>
</tr>
<tr>
<td>Address 1</td>
<td>The contact's street address.</td>
</tr>
<tr>
<td>Address 2</td>
<td>The additional address information, if necessary.</td>
</tr>
<tr>
<td>State/Province</td>
<td>The contact's state or province.</td>
</tr>
<tr>
<td>ZIP/Postal</td>
<td>The contact's ZIP or postal code.</td>
</tr>
<tr>
<td>Country</td>
<td>The country in which the contact resides.</td>
</tr>
<tr>
<td>Username</td>
<td>The user name with which the user logs in to your WebEx service Web site, if the contact has a user account.</td>
</tr>
<tr>
<td>Notes</td>
<td>Any additional information about the contact.</td>
</tr>
</tbody>
</table>

**Importing contact information from Outlook to your address book**

If you use Microsoft Outlook, you can import the contacts that you maintain in your Microsoft Outlook address book or folder to your personal address book on your WebEx service Web site.

**To import contacts from Outlook to your personal address book:**

1. Open your address book. For details, see *Opening your address book* (on page 499).
2. In the **View** drop-down list, select **Personal Contacts**.
3. In the **Import from** drop-down list, select **Microsoft Outlook**.
4. Click **Import**. The Choose Profile dialog box appears.
5 In the **Profile Name** drop-down list, select the Outlook user profile that includes the contact information that you want to import.

6 Click **OK**.

**Note:**

When you import contacts in Outlook, your WebEx service Web site retrieves contact information from the Outlook address book or folder in which you have chosen to keep personal addresses. For information about keeping personal addresses in Outlook, refer to Microsoft Outlook Help.

If your personal address book already includes a contact who is also in your Outlook contacts list, the contact is **not** imported. However, if you change the contact's email address in your personal address book, importing the contact from Outlook creates a *new contact* in your personal address book.

### Viewing and editing contact information in your address book

In your personal address book, you can view and edit information about individual contacts in your Personal Contacts list. You can view, but not edit, information about contacts in your Company Address Book.

**To view or edit contact information:**

1 Open your address book. For details, see *Opening your address book* (on page 499).

2 In the **View** drop-down list, select **one** of the following:
   - **Personal Contacts**
   - **Company Address Book**

   A list of contacts appears.

3 Locate the contact whose information you want to view or edit. For details about locating a contact, see *Finding a contact in your personal address book* (on page 508).

4 Under **Name**, select the contact whose information you want to view or edit.

5 Do **one** of the following:
   - If the contact is in your Personal Contacts list, click **Edit**.
   - If the contact is in your Company Address Book, click **View Info**.
Information about the contact appears.

6 Optional. If the contact is in your Personal Contacts list, edit the information that you want to change on the Edit Contact's Information page.

For descriptions of the information and options of the Edit Contact's Information page, see About the New/Edit Contact page (on page 502).

7 Click OK.

Finding a contact in your personal address book

You can quickly locate a contact in your personal address book, using one of several methods.

To search for a contact in your address book:

1 Open your address book. For details, see Opening your address book (on page 499).

2 In the View drop-down list, select a contacts list.

3 Do any of the following:

   ▪ In the Index, click a letter of the alphabet to display a list of contacts whose names begin with that letter. For example, the name Susan Jones appears under S.

   ▪ To search for a contact in the list you are currently viewing, type text that appears in either the contact's name or email address in the Search for box, and then click Search.

   ▪ If the entire list of contacts does not fit on a single page, view another page by clicking the links for the page numbers.

   ▪ Sort your personal contacts or company address book by name, email address, or phone number by clicking the column headings.

Creating a distribution list in your address book

You can create distribution lists for your personal address book. A distribution list includes two or more contacts for which you provide a common name and appears in your Personal Contacts list. For example, you can create a distribution list named Sales Department, which includes contacts who are members of your Sales Department. If you want to invite members of the department to a training session, you can select the group rather than each member individually.
To create a distribution list:

1. Open your address book. For details, see Opening your address book (on page 499).

2. Click Add Distribution List.

   The Add Distribution List page appears.

   ![Add Distribution List](image)

3. In the Name box, type the name of the group.

4. Optional. In the Description box, type descriptive information about the group.

5. Under Members, locate the contacts that you want to add to the distribution list, by doing any of the following:
   - Search for a contact, by typing all or part of the contact's first or last name in the Search box.
   - Click the letter that corresponds to the first letter of the contact's first name.
   - Click All to list all contacts in your Personal Contacts list.

6. Optional. To add a new contact to your Personal Contacts list, under Members, click Add Contact.

7. In the box on the left, select the contacts that you want to add to the distribution list.
Chapter 30: Using My WebEx

8 Click Add to move contacts you selected to the box on the right.

9 After you finish adding contacts to the distribution list, click Add to create the list.

   In your Personal Contacts list, the Distribution List indicator appears to the left of the new distribution list:

   ![Planning Committee]

   For descriptions of the information and options on the Add Distribution List page, see About the Add/Edit Distribution List page (on page 511).

Editing a distribution list in your address book

   You can add or remove contacts from any distribution list that you have created for your personal address book. You can also change a group's name or descriptive information.

   To edit a distribution list:

   1 Open your address book. For details, see Opening your address book (on page 499).

   2 In the View drop-down list, select Personal Contacts.

      A list of the contacts in your Personal Contacts list appears, including any distribution lists that you have created. The Distribution List indicator appears to the left of a distribution list:

      ![Planning Committee]

      Under Name, select the name of the distribution list. The Edit Distribution List page appears.
3 Edit information about the distribution list.
4 Click **Update**.

For descriptions of the information and options on the Edit Distribution List page, see *About the Add/Edit Distribution List* (on page 511).

**About the Add/Edit Distribution List page**

**How to access this page**

On your WebEx service Web site, click **My WebEx > My Contacts > Add Distribution List**. Or, select distribution list in Personal Contacts list.
Chapter 30: Using My WebEx

What you can do here
Add contacts to your distribution list or remove contacts from your distribution list.

Options on this page

<table>
<thead>
<tr>
<th>Use this option...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter the name of the distribution list. For example, if you want to add a distribution list that includes members of your company’s sales department, you might name the list Sales Department.</td>
</tr>
<tr>
<td>Description</td>
<td>Optionally enter descriptive information about the distribution list, to help you identify it later.</td>
</tr>
<tr>
<td>Search</td>
<td>Find a contact, by typing all or part of the contact's first or last name.</td>
</tr>
<tr>
<td>Index</td>
<td>Find a contact, by clicking the letter that corresponds to the first letter of the contact's first name. To list contacts for which you identified with a number, click #. To list all contacts in your Personal Contacts list, click All.</td>
</tr>
<tr>
<td>Add&gt;</td>
<td>Add a one or more selected contacts to your distribution list.</td>
</tr>
<tr>
<td>&lt;Remove</td>
<td>Remove one or more selected contacts from your distribution list.</td>
</tr>
<tr>
<td>Add Contact</td>
<td>Add a new contact to your Personal Contacts list and add the contact to your distribution list.</td>
</tr>
<tr>
<td>Add</td>
<td>Add a new distribution list to your Personal Contacts list.</td>
</tr>
<tr>
<td>Update</td>
<td>Update an existing distribution list that you have edited.</td>
</tr>
</tbody>
</table>

Deleting contact information in your address book

You can delete any contact or distribution lists that you have added to your personal address book.

To delete a contact or contact group:

1. Open your address book. For details, see Opening your address book (on page 499).
2. In the View drop-down list, select Personal Contacts.
3 In the list that appears, select the check box for the contact or distribution list that you want to delete.

4 Click **Delete**.

   A message appears, asking you to confirm the deletion.

5 Click **OK**.

### Maintaining your user profile

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of maintaining your user profile</td>
<td><em>About maintaining your user profile</em> (on page 513)</td>
</tr>
<tr>
<td>edit your user profile</td>
<td><em>Editing your user profile</em> (on page 520)</td>
</tr>
</tbody>
</table>

### About maintaining your user profile

Once you obtain a user account, you can edit your user profile at any time to do the following:

- Maintain personal information, including your
  - Full name
  - Username (if your site administrator provides this option)
  - Password
  - Contact information (including your street address, email address, and phone numbers)
  - Tracking codes that your organization uses to keep records of your training sessions (such as project, department, and division numbers)
- Specify whether to display links to your company's partner sites in the My WebEx navigation bar, if your site administrator set up partner links
- Manage any scheduling templates that you saved
- Set options for your Personal Training Session Room options, including the images and welcome message that appear on the page
- Set default options for your online sessions, including
The default session type that you want to use, if your account includes multiple session types

Whether your scheduled training sessions are automatically removed from your list of training sessions once the training session ends

Whether the Quick Start page appears in the content viewer once you start a training session

The users who can schedule training sessions on your behalf

Set Web site preferences, including:

- The home page that appears when you access your WebEx service Web site
- The time zone in which training session times appear
- The language in which your Web site displays text, if your site includes multiple languages
- The locale (the format in which your Web site displays dates, times, currency values, and numbers)

**About the My WebEx Profile page**

**How to access this template**

On your WebEx service Web site, click **My WebEx > My Profile**.

**What you can do here**

Manage the following:

- Account information
- Personal information
- Partner integration options
- Scheduling templates (does not apply to Support Center)
- Personal Meeting Room information
- Training Session options
- Web page preferences, including your home page and language
- Support Center CSR Dashboard options (Support Center only)
## Personal Information options

<table>
<thead>
<tr>
<th>Use this option...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Username</strong></td>
<td>Specify the username for your account. You can change this name only if the administrator for your WebEx service Web site provides this option. <strong>Tip:</strong> If you need to change your username, but cannot edit it on this page, ask your site administrator to change your username or create a new account for you.</td>
</tr>
<tr>
<td><strong>Change Password</strong></td>
<td><strong>Old password:</strong> Type the old password for your account. <strong>New password:</strong> Specify the new password for your account. A password: Must contain at least four characters Can consist of a maximum of 32 characters Can include any letters, numbers, or special characters, but not spaces Is case sensitive <strong>Retype New password:</strong> Verify that you typed your password correctly in the <strong>New password</strong> box.</td>
</tr>
<tr>
<td><strong>Call-in authentication</strong></td>
<td>If enabled by your site administrator, allows you to be authenticated and placed into the correct teleconference without needing to enter a meeting number whenever you dial into any CLI (caller line identification) or ANI (automatic number identification) enabled teleconference. Selecting this option for a phone number in your user profile maps your email address to that phone number. Caller authentication is available only if you have been invited to a CLI/ANI enabled teleconference by email during the meeting scheduling process. Caller authentication is not available if you are dialing in to a CLI/ANI enabled teleconference.</td>
</tr>
<tr>
<td><strong>Call-back</strong></td>
<td>When selected for a phone number in your user profile, allows you to receive a call from the teleconferencing service if it is using an integrated call-back feature. If your site includes the international call-back option, participants in other countries receive a call back. For more information about this option, ask your site administrator.</td>
</tr>
<tr>
<td><strong>PIN</strong></td>
<td>If enabled by your site administrator, allows you to specify a call-in authentication PIN to prevent “spoofers” from using your number to dial into a teleconference. If your site administrator sets the authentication PIN as mandatory for all accounts using call-in authentication on your site, you must specify a PIN number or caller authentication will be disabled for your account. This option is available only if you have selected the <strong>Call-in authentication option</strong> for at least one of the phone numbers in your user profile.</td>
</tr>
</tbody>
</table>
Chapter 30: Using My WebEx

Use this option... | To...
---|---
Numbers in your profile. The PIN can also be used to provide a secondary level of authentication for calls where the host is using the phone and may need to invite additional attendees.

Other personal information options
Enter any personal information that you want to maintain in your profile.

Partner integration options
Your site administrator can set up custom links to the Web sites of your company's partners, and then display the links on the My WebEx navigation bar. For example, if your company uses another company's Web site to provide a service, your site administrator can provide a link to that company's site in your My WebEx navigation bar. You can then show or hide that link.

Use this option... | To...
---|---
Display partner links in My WebEx | Shows or hides partner site links in the My WebEx navigation bar.

Scheduling template options
Use these options to manage scheduling templates that you set up using the scheduling options on your site.

Use this option... | To...
---|---
Get Info | Shows the settings you set for the selected template.
Edit | Opens the scheduling options on your site for the selected template.
Delete | Removes the selected template from your profile.
Select All | Selects all the scheduling templates, allowing you to delete them all at once.

Calendar Work Hours options
Use these options to specify working hours to use with scheduling calendars.
Chapter 30: Using My WebEx

### Personal Meeting Room options

<table>
<thead>
<tr>
<th>Use this option...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Start time</strong></td>
<td>Select the start time for your daily work calendar.</td>
</tr>
<tr>
<td><strong>End time</strong></td>
<td>Select the end time for your daily work calendar.</td>
</tr>
</tbody>
</table>

#### Personal Meeting Room URL

Go to your Personal Meeting Room page. You can click the URL from the My Profile page to preview your current Personal Meeting Room page.

Your Personal Meeting Room page shows online sessions that you scheduled and any in-progress sessions that you are currently hosting.

Users to whom you provide your personal URL can use this page to join any meeting that you are hosting. They can also download files in any folders that you share.

#### Welcome Message

Enter the message that appears on your Personal Meeting Room page. A message can be a maximum of 128 characters, including spaces and punctuation.

To specify a message, type it in the box, and then click Update.

#### Upload Image

Upload an image file from your computer or another computer on your network to your Personal Meeting Room page. For example, you can upload a picture of yourself, your company's logo, or a picture of your company's product. Visitors to your page can see the image that you upload.

The image can be an maximum of 160 pixels wide. If you upload a larger image, its width is automatically reduced to 160 pixels. However, the image's aspect ratio is maintained.

**Browse:** Lets you locate an image.

**Upload:** Uploads the image that you selected.

**Current Image:** Displays the image that currently appears on your Personal Meeting Room page.

**Delete:** Removes the current image from your Personal Meeting Room page. This button is available only if you have uploaded an image for the page.

#### Customize branding of header area

Upload a banner image to the non-scrolling header area for your Personal Meeting Room page. For example, you can upload your company's logo or an advertisement. Visitors to your page can see the image that you upload. Available only if
## Productivity Tools Options

<table>
<thead>
<tr>
<th>Use this option...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatically download Productivity Tools when logging in to the WebEx service site</td>
<td>Specify that WebEx Productivity Tools should be downloaded automatically when you log in to the WebEx service site. If this option is turned off, you can still download Productivity Tools manually.</td>
</tr>
</tbody>
</table>

## Session Options

<table>
<thead>
<tr>
<th>Use this option...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default session type</td>
<td>Specify the default session type that you host, if your user account lets you host different types of online sessions. For more information about session types, ask the site administrator for your WebEx service. You can change this default setting when scheduling a meeting.</td>
</tr>
</tbody>
</table>
Quick Start

Specify whether the Quick Start page appears in the content viewer once you start a meeting. The Quick Start lets you start sharing activities quickly, as an alternative to starting them from a menu or toolbar.

**Show Quick Start to host and presenter:** The Quick Start appears in the content viewer for the host and presenter.

**Show Quick Start to attendees:** The Quick Start appears in the content viewer for attendees. Select this option only if you intend to let attendees share information during your meetings.

You can change this default setting when scheduling a meeting.

---

Scheduling permission

Type the email addresses for any users whom you want to let schedule meetings for you. Separate email addresses with either a comma or a semicolon.

**Select From Host List:** Open the Select Host page, which contains a list of all users who have accounts on your WebEx service Web site. On this page, you can select users whom you want to let schedule meetings for you.

---

### Web page preferences options

<table>
<thead>
<tr>
<th>Use this option...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Home page</td>
<td>Set the first page that appears when you access your WebEx service Web site.</td>
</tr>
<tr>
<td>Time zone</td>
<td>Set the time zone in which you reside. If you select a time zone for which daylight saving time (DST) is in effect, your WebEx service Web site automatically adjusts its clock for daylight saving time.</td>
</tr>
</tbody>
</table>

**Note:** The selected time zone appears:

- Only on your view of your WebEx service Web site, not other users’ views
- In all meeting invitations that you send using your WebEx service Web site
### Use this option... | To...
---|---
Language | Set the language in which your WebEx service Web site displays text. **Note:** The languages that appear in this list are limited to the languages that have been set up for your Web site.
Locale | Set the format in which your Web site displays dates, times, currency values, and numbers.

---

### Editing your user profile

Once you obtain a user account, you can edit your user profile at any time to change account login information, contact information, and other options available for your account.

**To edit your user profile:**

1. Log in to your WebEx service Web site. For details, see *Logging in to and out of the WebEx service site* (on page 460).
2. On the navigation bar, click **My WebEx**.
3. Click **My Profile**.
4. Edit the information on the page.
5. When you are finished editing your user profile, click **Update**.

For descriptions of the information and options on the My Profile page, see *About the My WebEx Profile page* (on page 514).

---

### Managing scheduling templates

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of managing your scheduling templates</td>
<td><em>About managing scheduling templates</em> (on page 521)</td>
</tr>
<tr>
<td>view, edit, or delete a scheduling template</td>
<td><em>Managing scheduling templates</em> (on page 521)</td>
</tr>
</tbody>
</table>
Chapter 30: Using My WebEx

About managing scheduling templates

Scheduling templates let you save the options you set for a training session for later use. Once you save a scheduling template, you can use it to quickly schedule another training session, instead of setting the same options again. If you saved a scheduling template using the Save As Template option when scheduling a training session, you can manage the template, as follows:

- View the options you set in the template.
- Edit the options you set in the template.
- Delete the template.

Managing scheduling templates

You can view, edit, or delete any scheduling templates that you saved.

To manage scheduling templates:

1. Log in to your WebEx service Web site. For details, see Logging in to and out of the WebEx service site (on page 460).
2. On the navigation bar, click My WebEx.
3. Click My Profile.
   The My Profile page appears.
4. Under Scheduling Templates, select a template in the list.
   
   Click one of the following buttons to perform an action on the template:

   - Get Info: Shows the options you set in the template.
   - Edit: Opens the scheduling options on your site.
   - Delete: Removes the template from your profile.
Generating Reports

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of what reports you can generate from your WebEx service Web site</td>
<td>About generating reports (on page 522)</td>
</tr>
<tr>
<td>generate usage reports that provide information about each session that you have hosted on your site</td>
<td>Generating reports (on page 524)</td>
</tr>
</tbody>
</table>

About generating reports

If your user account includes the reports option, you can view the following reports:

**Note:**

For some reports, if you click on the report link within 15 minutes after the training session ends, you will see a preliminary version of that report. The preliminary report provides quick access to data before the final, more accurate data is available. The preliminary report contains only a subset of the information that is available in the final report.

When the final, more accurate data is available, which is usually 24 hours after the training session ends, the preliminary report is replaced by the final report. You can download both preliminary reports and final reports as comma-separated values (CSV) files.

**General Training Session Usage reports**

These reports contain information about each online session that you host. You can view the following reports:

- **Summary Usage report**: Contains summary information about each training session including topic, date, start and end time, duration, number of attendees you invited, number of invited attendees who attended, and type of voice conference you used.

**Note:** Initially, this report appears as a Preliminary Usage Summary
Report, but after the final, more accurate usage data is available, it is replaced by the Final Usage Summary Report.

- **Summary Usage report CSV (comma-separated values) file:** Contains additional details about each training session, including the minutes that all participants were connected to the training session and tracking codes.

- **Session Detail report:** Contains detailed information about each participant in a training session, including the time the participant joined and left the training session, the attentiveness during the training session, and any information that the attendee provided.

  **Note:** Initially, this report appears as a Preliminary Session Detail Report, but after the final, more accurate session detail data is available, it is replaced by the Final Session Detail Report.

**Access Anywhere usage report**

This report shows information about the computers that you access remotely, including the date and start and end times for each session.

**Training Center reports**

- These reports contain detailed information about the training sessions you host. You can view the following types of Training Center reports:

- **Live Training Usage report:** The Live Training Usage report is available in two formats:
  - **Live Training Usage Summary report:** Contains a summary of the information about each training session, including the topic, date, start and end time, duration, number of attendees you invited, number of attendees who registered, and number of invited attendees who attended.

    **Note:** Initially, this report appears as a Preliminary Live Training Usage Summary Report, but after the final, more accurate usage and attendance data is available, it is replaced by the Final Live Training Usage Summary Report.

- **Live Training Usage Detail report:** Contains detailed information about each attendee in a training session, including the time the participant joined and left the meeting and any information that the attendee provided, such as registration information. You can also view information about any registrants who did not attend a session.
• **Recorded Training Access report**: Contains access and registration information about each recorded training session that you published on your Training Center Web site.

• **Registration Report**: Contains attendance, invitation, and registration information all of your live training sessions.

### Generating reports

You can generate usage reports that provide information about each online training session that you have hosted on your site.

You can export or download the data to a comma-separated values (CSV) file which you can then open in a spreadsheet program such as Microsoft Excel. You can also print reports in a printer-friendly format.

**To generate a report:**

1. Log in to your WebEx service Web site, and then click **My WebEx**.
2. Click **My Reports**.
   
   The My Reports page appears.
3. Choose the type of report you want to generate.
4. Specify your search criteria, such as a date range for which you want to view report data.
5. Click **Display Report**.
6. To change the order in which report data is sorted, click the column headings.
   
   The report data is sorted by the column that has an arrow next to the column heading. To reverse the sort order, click the column heading. To sort using another column, click that column's heading.
7. Do one of the following, as appropriate:
   
   • If you are viewing a general training session usage report and want to display the report in a format that is suitable for printing, click **Printer-Friendly Format**.
8. If you are viewing the usage report for a training session and want to view the content in the report, click the link for the training session name.
9. To export the report data in comma-separated values (CSV) format, click **Export Report** or **Export**.
10. If available, click links on the report to display more details.
# Publishing a Recorded Training Session

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of publishing recorded training sessions on your Training Center Web site</td>
<td><em>About publishing recorded training sessions</em> (on page 528)</td>
</tr>
<tr>
<td>open your list of published training session recordings</td>
<td><em>Opening your list of recorded training sessions</em> (on page 528)</td>
</tr>
<tr>
<td>publish a new recorded training session or training presentation on your Training Center Web site</td>
<td><em>Publishing a recorded training session</em> (on page 529)</td>
</tr>
<tr>
<td>send a URL of your recording to a user</td>
<td><em>Making a recording available to users</em> (on page 533)</td>
</tr>
<tr>
<td>edit information about or change options for a published recording</td>
<td><em>Editing information about a recorded training session</em> (on page 535)</td>
</tr>
<tr>
<td>edit a published training recording that you created with the On-Demand Module</td>
<td><em>Editing a recorded training presentation</em> (on page 537)</td>
</tr>
<tr>
<td>stop publishing a recorded training session</td>
<td><em>Removing a recorded training session from your site</em> (on page 543)</td>
</tr>
</tbody>
</table>
Chapter 31: Publishing a Recorded Training Session

About publishing recorded training sessions

If you or another user records a training session using WebEx Recorder, you can publish the recording on your Training Center Web site. Users on your site can either view or download the recording from the Recorded Sessions page, or from the Recording Information page if you have sent them a recording URL. For information on sending a recording URL to a user, see Making a recording available to users (on page 533).

You can publish a recording by:

- Uploading it to your Training Center Web site.
- Specify the Web address, or URL, at which the recording resides on another server.
- Creating a presentation using the On-Demand Module, if your site includes that option

When publishing a recording, you can:

- Specify whether all users on your site can view or download the recording, or only users who have an account on your site
- Password-protect the recording
- Require that users register to view or download the recording

Once you publish a recording, you can:

- Edit information about it
- Edit the recording, if your site has the On-Demand Module option
- Stop publishing it

Opening your list of recorded training sessions

To publish, delete, or edit information about a recording, you must open your list of recorded training sessions.

To open your list of recorded training sessions:

1. Log in to your Training Center Web site.
2. Do one of the following:
   - Click Host a Session > My Training Recordings.
Click **My WebEx > My Files > My Training Recordings**.
The My Training Recordings page appears.

### Publishing a recorded training session

You can publish a recorded training session that was created with WebEx Recorder. A recording that you publish must be in the WebEx Recording format (WRF), which has a `.wrf` extension.

To publish a recording, you can do one of the following:

- (Optional feature) Create a presentation using the On-Demand Module, with which you can re-create the live training experience, insert a test, or add narration. You can upload an existing recording file or PowerPoint file from your computer or another computer on your local network.

  **Note:** The number of On-Demand presentations that can be stored on your Training Center Web site is determined by your licensing agreement. If the upload limit has been reached, you will be unable to create a recording until one is removed.

- Upload the recording to the server for your Training Center Web site. The file that you upload must reside on your computer or a local server.

- Specify the Web address, or URL, for the recording on a publicly accessible Web server. Because your storage space for recordings on your site is limited, you can use this option to publish an unlimited number of recordings, or recordings with
large file sizes. To use this option, you may need to ask your organization's Webmaster to store the recording on the server and provide you with its URL.

To publish a recorded training session:

1. Open the My Training Recordings page. For details, see Opening your list of recorded training sessions (on page 528).

2. Click Add a Recording.
   The Add a Recording page appears.

3. In the Recording topic box, specify the topic of the recorded training.

4. Under Type, select an option to specify whether the recording is listed on the Recorded Sessions page on your site and, if it is listed, which types of users can view the recording.

5. Optional. If eCommerce is enabled for your Training Center Web site, enter the session fee and payment information. You must enable Registration in order to use this feature.
   - Session fee: Enter the amount you want to charge for the session. The default value is 0 (free).
   - Allow attendees to use coupons: Select this check box to allow attendees to use coupons when registering.
   - Access period: Specify how often an attendee can view the recording after registration is approved.

6. In the Presenter box, specify the presenter’s name.

7. In the Email Address box, specify the presenter’s email address.

8. In the Description box, enter a description of the recorded training session.

9. Optional: Specify the agenda for the training session.

10. Under Recording File, publish the recording in one of the following ways:
    Specify the URL for the file on another server:
    - Select I will provide a URL.
    - Type the URL in the box.

    Upload the recording from your local machine to your Training Center Web site:
    - Select Use the file on my local machine.
    - Click Browse, and then select the file that you want to publish.
c. Click **Upload file**.

Upload the recording from the network server:

a. Select **Find the recording from WebEx network**.

b. Click **Look Up**, and then select the file that you want to publish.

11 **(Optional feature) Create a presentation using the On-Demand Module.** After selecting **Create a Presentation Using Presentation Studio**, you can create one of the following presentations:

**Note:** Choosing this option will disable the duration, file size, date, and destination address fields.

Specify a WebEx Recording file:

a. Select **WebEx Recording File (*.wrf)**.

b. Click **Browse**, and then select the file that you want to publish.

**Note:** The maximum file size is 200 MB. Files that exceed the maximum will not be created, causing the Recording Creation Failed page to appear.

c. Click **Open**.

d. Select either **Graphics** or **Text** for playback quality optimization.

Specify a PowerPoint presentation for which you will add narration via telephone:

a. Select **PowerPoint with audio narration using telephone**.

b. Click **Browse** to select the presentation's PowerPoint file.

c. If you want to attach the PowerPoint file for presentation viewers to download it, select the **Make this file available as an attachment** check box.

Specify a PowerPoint presentation for which you will add narration using a video or audio file:

a. Select **PowerPoint with narration using video or audio File**.
b. Click **Browse** to select the presentation's PowerPoint file.

c. If you want to attach the PowerPoint file for presentation viewers to download it, select the **Make this file available as an attachment** check box.

d. Select whether you want to upload a video or audio file from the **File type** drop-down list. This file should be prepared in advance.

e. Click **Browse** to select the video or audio file.

f. In the **Width** and **Height** boxes, specify the size, in pixels, of the video screen in the audio/video window of the Presentation Player.

**Note:** The width must be between 192 to 360 pixels, and the height must be between 144 and 240 pixels.

Specify a video-only or audio-only presentation:

a. Select **Video or audio only**.

b. Select whether you want to upload a video or audio file from the **File type** drop-down list. This file should be prepared in advance.

c. Click **Browse** to select the video or audio file.

12 If you did *not* use the On-Demand Module:

   a. Specify the duration, file size, and date for the recording.

   b. Optional: Specify a destination URL—that is, a Web page that appears automatically once a visitor finishes viewing a recording.

13 Optional: Specify file access options.

   These settings protect your recording by requiring user authentication to view or download, and are necessary if eCommerce is enabled.

14 Click **Add**.

   If you used the On-Demand Module, the Recording Created page opens.
Click **OK**.

You will receive an email confirmation that the presentation has been successfully uploaded and converted into a Presentation Studio presentation. The email will include a link that will take you to the My Training Recordings page.

**Note:** For details about the options on the Add a Recording page, see *About the Add a Recording/Edit Recording Information page* (on page 548).

### Making a recording available to users

Training Center automatically generates a URL for each recorded training session or On-Demand Module recorded session that you create. This URL appears on the Recording Information page.
You can make the recording available to users in the following ways:

- Send the URL via email
- Copy the URL to another location, such as an instant message or to a Web site

**Note:** If you have set a password, registration, or eCommerce for your recording, these features will be enabled when the user accesses the recording from the URL.

**To make the recording available via email:**

1. On the Recording Information page, in the **URL** section, click the **email** link. Your email tool opens, with the recording URL in the body of the email.
2 Enter the recipient's email address and send the email.

To copy the recording URL to another location:

1 On the Recording Information page, in the URL section, highlight the URL with your cursor.
2 Right-click the URL and select Copy.
3 Do one of the following:
   - Paste the URL into an instant message and send it to users.
   - Add the URL to another Web site where users can access the recording.

Editing information about a recorded training session

Once you publish a recorded training session, you can edit information about the recording at any time. This information appears on the Recording Information page that users can view if they select a recording to view or download on the Recorded Sessions page.

Note: If your site has the On-Demand Module option, and the recording contains a Presentation Studio presentation, you can edit information about the recording only in the On-Demand Module (Presentation Studio) editor.
To edit information about a recorded training session:

1. Open the My Training Recordings page. For details, see *Opening your list of recorded training sessions* (on page 528).

2. In your list of recordings, click **Modify** for the recording for which you want to edit information.

   If your site does not include the Presentation Studio option, the Edit Recording Information page appears.

3. Specify new information about the recording.

4. Click **Save**.

   If your site includes the On-Demand Module option, the On-Demand Module (Presentation Studio) editor opens to the Edit Properties page.

5. Specify new information about the recording.

6. Click **Submit Changes**.

   The Recording Updated page opens.

7. Click **OK**.

   You will receive an email confirmation that the presentation has been successfully republished.

---

**Note:** For details about the options on the Add a Recording page, see *About the Add a Recording/Edit Recording Information page* (on page 548).
Chapter 31: Publishing a Recorded Training Session

Editing a recorded training presentation

If you publish a recorded training presentation that you created using the On-Demand Module, you can edit the recording at any time.

To edit a recorded training session:

1. Open the My Training Recordings page. For details, see Opening your list of recorded training sessions (on page 528).

2. In your list of recordings, click Modify for the recording for which you want to edit information.

The On-Demand Module (Presentation Studio) editor opens.

You can edit the presentation by clicking one of the four links at the top of the page:

- Edit Properties: Edit the training recording information. For details, see Editing information about a recorded training session (on page 535).

- Customize Presentation: (Optional) Customize the Presentation Player by adding your own logo or presenter image.
Chapter 31: Publishing a Recorded Training Session

- Slide Detail: Display slide title and start time, as well as display a larger image of the file.
- Edit Slides: Modify your presentation by:
  - Changing the title of a slide
  - Rearranging the slide order
  - Deleting a slide
  - Inserting a file. For details, see *Adding a file to your presentation* (on page 539).
  - Inserting a URL. For details, see *Adding a URL to your presentation* (on page 540).
  - Inserting a test. For details, see *Adding a test to your recording* (on page 540).
  - Inserting a Presentation Studio presentation. For details, see *Adding slides from a Presentation Studio presentation* (on page 542).

3 Click **Submit Changes** when you have completed your edits.

The Recording Updated page opens.

4 Click **OK**.

You will receive an email confirmation that the presentation has been successfully republished.

**Note:** For details about the options on the On-Demand Module (Presentation Studio) editor, see *About the Add a Recording/Edit Recording Information page* (on page 548).
Adding a file to your presentation

You can insert a slide from a file located on your computer.

To insert a file into your presentation:

1. In the On-Demand Module (Presentation Studio) editor, click Edit Slides.

2. Under Current Presentation, highlight the slide next to which you want to insert the file.

3. Under Source, ensure that Insert a file is selected.

4. From the drop-down list, select the appropriate insert option for the file, relative to your highlighted slide.

5. Click Insert.

6. In the Insert a File page, enter a title for the new slide that will contain the file.

7. Click Browse to insert the file from your computer.

8. Select the file and click Open.

9. Select the check box if you want to pause the Media Player at this slide during playback.
Chapter 31: Publishing a Recorded Training Session

Adding a URL to your presentation

You can insert a slide that contains a URL. When this page is reached in the presentation, a separate window opens up at this Web address.

To insert a URL into your presentation:

1. Click Insert.
2. Click Close to return to the Edit Slides page.

Adding a test to your recording

To test users of a recorded training session, you must add tests to the training recording that they will be using.

Before you can add a test to a recording, the test must already exist in the Test Library. Tests cannot be created or edited in the On-Demand Module (Presentation Studio) editor.

For detailed information about testing users of the recorded session, see Testing and Grading on page 351.

To insert a test into your presentation:

1. In the On-Demand Module (Presentation Studio) editor, click Edit Slides.
Chapter 31: Publishing a Recorded Training Session

2 Under Current Presentation, highlight the slide next to which you want to insert the test.

3 Under Source, select **Insert a test**.

4 From the drop-down list, select the appropriate insert option for the URL, relative to your highlighted slide.

5 Click **Insert**.
   The Add a Test page opens in a new window.

6 Select a test and click **Next**.

7 In the Test Delivery Options page that appears, select the appropriate options and click **Save**.

8 Click **Close** to return to the Edit Slides page.

Adding PowerPoint slides from your desktop

If your Training Center site includes the On-Demand Module option, you can insert slides from an existing PowerPoint presentation on your desktop.

To add PowerPoint slides from your desktop:

9 In the On-Demand Module (Presentation Studio) editor, click **Edit Slides**.

10 Under Current Presentation, highlight the slide next to which you want to insert the PowerPoint slides.

11 Under Source, select **Insert PowerPoint slides from desktop**.

12 From the drop-down list, select the appropriate insert option for the PowerPoint slides, relative to your highlighted slide.
Chapter 31: Publishing a Recorded Training Session

13 Click **Insert**.

14 In the Insert slides page, click Browse to select the PowerPoint file to insert.

15 Click **Insert**.

16 Click **Close** to return to the Edit Slides page.

**Adding slides from a Presentation Studio presentation**

If your Training Center site includes the On-Demand Module option, you can insert a slide from one of your existing Presentation Studio presentations.

**To add slides from another presentation:**

1 In the On-Demand Module (Presentation Studio) editor, click **Edit Slides**.

2 Under Current Presentation, highlight a slide near the point in which you want to insert a new slide from an existing presentation.

3 Under Source, click **Select an online presentation**.

   The My Presentations page opens in a new window.

4 Click **Select** to select the presentation from which you want to insert a slide into your current presentation.

5 Highlight the slide that you want to insert.

6 Click **Replace slide only** to replace the highlighted slide in the current presentation with the highlighted slide in the source presentation.

7 Click **Insert before** or **Insert after** to insert the Source highlighted slide into the Current Presentation relative to its highlighted slide.
Adding narration to your presentation

You can use your phone to record audio narration for your presentation slides. Your viewers will hear your narration when they view your presentation.

**Note:** You can add narration only to a PowerPoint presentation that has been successfully converted to a Presentation Studio presentation. Upon successful conversion, you will receive narration instructions by email.

**To add narration to your presentation from the Recording Information page:**

1. Open the My Training Recordings page. For details, see *Opening your list of recorded training sessions* (on page 528).
2. In your list of recordings, click the **Topic** for the recording for which you want to add narration.
3. From the Recording Information page, click **Narrate**.
4. Follow the instructions listed on the Record an Audio Narration page.

Removing a recorded training session from your site

You can either:

- Temporarily remove the recording from the Recorded Sessions page on your site but keep it in your list of recordings on your My Training Recordings page
- Permanently remove the recording from both the Recorded Sessions page on your site and your My Training Recordings page

*(For sites without the On-Demand Module)* To temporarily remove a published recorded training session from the Recorded Sessions page:

1. Open the My Training Recordings page. For details, see *Opening your list of recorded training sessions* (on page 528).
2. In your list of recordings, select **Modify** from the drop-down list for the recording for which you want to edit information.
3. Under **Type**, select **Private**.
4 Click **Save**.

*(For sites with the On-Demand Module) To temporarily remove a published recorded training session from the Recorded Sessions page:*

1 Open the My Training Recordings page. For details, see *Opening your list of recorded training sessions* (on page 528).

2 In your list of recordings, select **Modify** from the drop-down list for the recording for which you want to edit information.

   The On-Demand Module (Presentation Studio) editor opens to the Edit Properties page.

3 Select **Private**.

4 Click **Submit Changes**.

   The Recording Updated page opens.

5 Click **OK**.

**To permanently remove a published recorded training session:**

1 Open the My Training Recordings page. For details, see *Opening your list of recorded training sessions* (on page 528).

2 In your list of recordings, select **Delete** from the drop-down list for the recording that you want to delete.

   A confirmation message appears.

3 Click **OK**.

**Viewing the Recorded Training Access Detail Report**

The Recorded Training Access Detail Report contains access information about recorded training sessions on your Training Center Web site. This report includes the following information for each time that your recorded training session is viewed:

- viewer's name and email address
- registration information
- download information
- access time and date
for WebEx presentations created with the On-Demand Module, the duration that the recording was viewed.

**To view the Recorded Training Access Detail Report:**

1. Log in to your Training Center Web site, and then click **My WebEx**.
2. Click **My Reports**.
   The My WebEx Reports page appears.
3. Click **Recorded Training Access Report**.
   The Recorded Training Access Report page appears.

### Recorded Training Access Report

View Access and Registration information for your Recorded Training sessions.

**To view the Recorded Training Access Detail Report:**

1. Log in to your Training Center Web site, and then click **My WebEx**.
2. Click **My Reports**.
   The My WebEx Reports page appears.
3. Click **Recorded Training Access Report**.
   The Recorded Training Access Report page appears.

4. Specify your search criteria, such as a date range, topic, and sorting preferences, and click **Display Report**.
   The Recorded Training Access Summary Report page appears, which includes information on all the recorded training sessions that have been viewed.

### Recorded Training Access Summary Report

You can sort results by clicking on the column headers. **Search again**

Search Results from 7/10/06 to 7/24/06:

<table>
<thead>
<tr>
<th>Topic</th>
<th>Upload Date</th>
<th>Upload Time</th>
<th>Duration</th>
<th>Registered</th>
<th>Download</th>
<th>Viewed</th>
<th>Fee</th>
</tr>
</thead>
<tbody>
<tr>
<td>web2</td>
<td>1/28/06</td>
<td>8:30 am</td>
<td>45 mins</td>
<td>2</td>
<td>0</td>
<td>1</td>
<td>Free</td>
</tr>
<tr>
<td>web3</td>
<td>1/28/06</td>
<td>8:30 pm</td>
<td>45 mins</td>
<td>2</td>
<td>0</td>
<td>1</td>
<td>Free</td>
</tr>
<tr>
<td>web4</td>
<td>1/28/06</td>
<td>8:30 pm</td>
<td>45 mins</td>
<td>2</td>
<td>0</td>
<td>1</td>
<td>Free</td>
</tr>
<tr>
<td>web5</td>
<td>1/28/06</td>
<td>8:30 pm</td>
<td>45 mins</td>
<td>2</td>
<td>0</td>
<td>1</td>
<td>Free</td>
</tr>
<tr>
<td>web6</td>
<td>1/28/06</td>
<td>8:30 pm</td>
<td>45 mins</td>
<td>2</td>
<td>0</td>
<td>1</td>
<td>Free</td>
</tr>
<tr>
<td>web7</td>
<td>1/28/06</td>
<td>8:30 pm</td>
<td>45 mins</td>
<td>2</td>
<td>0</td>
<td>1</td>
<td>Free</td>
</tr>
<tr>
<td>web8</td>
<td>1/28/06</td>
<td>8:30 pm</td>
<td>45 mins</td>
<td>2</td>
<td>0</td>
<td>1</td>
<td>Free</td>
</tr>
<tr>
<td>web9</td>
<td>1/28/06</td>
<td>8:30 pm</td>
<td>45 mins</td>
<td>2</td>
<td>0</td>
<td>1</td>
<td>Free</td>
</tr>
<tr>
<td>web10</td>
<td>1/28/06</td>
<td>8:30 pm</td>
<td>45 mins</td>
<td>2</td>
<td>0</td>
<td>1</td>
<td>Free</td>
</tr>
<tr>
<td>web11</td>
<td>1/28/06</td>
<td>8:30 pm</td>
<td>45 mins</td>
<td>2</td>
<td>0</td>
<td>1</td>
<td>Free</td>
</tr>
<tr>
<td>web12</td>
<td>1/28/06</td>
<td>8:30 pm</td>
<td>45 mins</td>
<td>2</td>
<td>0</td>
<td>1</td>
<td>Free</td>
</tr>
<tr>
<td>web13</td>
<td>1/28/06</td>
<td>8:30 pm</td>
<td>45 mins</td>
<td>2</td>
<td>0</td>
<td>1</td>
<td>Free</td>
</tr>
<tr>
<td>web14</td>
<td>1/28/06</td>
<td>8:30 pm</td>
<td>45 mins</td>
<td>2</td>
<td>0</td>
<td>1</td>
<td>Free</td>
</tr>
<tr>
<td>web15</td>
<td>1/28/06</td>
<td>8:30 pm</td>
<td>45 mins</td>
<td>2</td>
<td>0</td>
<td>1</td>
<td>Free</td>
</tr>
<tr>
<td>web16</td>
<td>1/28/06</td>
<td>8:30 pm</td>
<td>45 mins</td>
<td>2</td>
<td>0</td>
<td>1</td>
<td>Free</td>
</tr>
<tr>
<td>web17</td>
<td>1/28/06</td>
<td>8:30 pm</td>
<td>45 mins</td>
<td>2</td>
<td>0</td>
<td>1</td>
<td>Free</td>
</tr>
<tr>
<td>web18</td>
<td>1/28/06</td>
<td>8:30 pm</td>
<td>45 mins</td>
<td>2</td>
<td>0</td>
<td>1</td>
<td>Free</td>
</tr>
<tr>
<td>web19</td>
<td>1/28/06</td>
<td>8:30 pm</td>
<td>45 mins</td>
<td>2</td>
<td>0</td>
<td>1</td>
<td>Free</td>
</tr>
<tr>
<td>web20</td>
<td>1/28/06</td>
<td>8:30 pm</td>
<td>45 mins</td>
<td>2</td>
<td>0</td>
<td>1</td>
<td>Free</td>
</tr>
<tr>
<td>web21</td>
<td>1/28/06</td>
<td>8:30 pm</td>
<td>45 mins</td>
<td>2</td>
<td>0</td>
<td>1</td>
<td>Free</td>
</tr>
<tr>
<td>web22</td>
<td>1/28/06</td>
<td>8:30 pm</td>
<td>45 mins</td>
<td>2</td>
<td>0</td>
<td>1</td>
<td>Free</td>
</tr>
<tr>
<td>web23</td>
<td>1/28/06</td>
<td>8:30 pm</td>
<td>45 mins</td>
<td>2</td>
<td>0</td>
<td>1</td>
<td>Free</td>
</tr>
<tr>
<td>web24</td>
<td>1/28/06</td>
<td>8:30 pm</td>
<td>45 mins</td>
<td>2</td>
<td>0</td>
<td>1</td>
<td>Free</td>
</tr>
<tr>
<td>web25</td>
<td>1/28/06</td>
<td>8:30 pm</td>
<td>45 mins</td>
<td>2</td>
<td>0</td>
<td>1</td>
<td>Free</td>
</tr>
<tr>
<td>web26</td>
<td>1/28/06</td>
<td>8:30 pm</td>
<td>45 mins</td>
<td>2</td>
<td>0</td>
<td>1</td>
<td>Free</td>
</tr>
<tr>
<td>web27</td>
<td>1/28/06</td>
<td>8:30 pm</td>
<td>45 mins</td>
<td>2</td>
<td>0</td>
<td>1</td>
<td>Free</td>
</tr>
<tr>
<td>web28</td>
<td>1/28/06</td>
<td>8:30 pm</td>
<td>45 mins</td>
<td>2</td>
<td>0</td>
<td>1</td>
<td>Free</td>
</tr>
<tr>
<td>web29</td>
<td>1/28/06</td>
<td>8:30 pm</td>
<td>45 mins</td>
<td>2</td>
<td>0</td>
<td>1</td>
<td>Free</td>
</tr>
<tr>
<td>web30</td>
<td>1/28/06</td>
<td>8:30 pm</td>
<td>45 mins</td>
<td>2</td>
<td>0</td>
<td>1</td>
<td>Free</td>
</tr>
<tr>
<td>web31</td>
<td>1/28/06</td>
<td>8:30 pm</td>
<td>45 mins</td>
<td>2</td>
<td>0</td>
<td>1</td>
<td>Free</td>
</tr>
<tr>
<td>web32</td>
<td>1/28/06</td>
<td>8:30 pm</td>
<td>45 mins</td>
<td>2</td>
<td>0</td>
<td>1</td>
<td>Free</td>
</tr>
<tr>
<td>web33</td>
<td>1/28/06</td>
<td>8:30 pm</td>
<td>45 mins</td>
<td>2</td>
<td>0</td>
<td>1</td>
<td>Free</td>
</tr>
<tr>
<td>web34</td>
<td>1/28/06</td>
<td>8:30 pm</td>
<td>45 mins</td>
<td>2</td>
<td>0</td>
<td>1</td>
<td>Free</td>
</tr>
<tr>
<td>web35</td>
<td>1/28/06</td>
<td>8:30 pm</td>
<td>45 mins</td>
<td>2</td>
<td>0</td>
<td>1</td>
<td>Free</td>
</tr>
<tr>
<td>web36</td>
<td>1/28/06</td>
<td>8:30 pm</td>
<td>45 mins</td>
<td>2</td>
<td>0</td>
<td>1</td>
<td>Free</td>
</tr>
<tr>
<td>web37</td>
<td>1/28/06</td>
<td>8:30 pm</td>
<td>45 mins</td>
<td>2</td>
<td>0</td>
<td>1</td>
<td>Free</td>
</tr>
<tr>
<td>web38</td>
<td>1/28/06</td>
<td>8:30 pm</td>
<td>45 mins</td>
<td>2</td>
<td>0</td>
<td>1</td>
<td>Free</td>
</tr>
<tr>
<td>web39</td>
<td>1/28/06</td>
<td>8:30 pm</td>
<td>45 mins</td>
<td>2</td>
<td>0</td>
<td>1</td>
<td>Free</td>
</tr>
<tr>
<td>web40</td>
<td>1/28/06</td>
<td>8:30 pm</td>
<td>45 mins</td>
<td>2</td>
<td>0</td>
<td>1</td>
<td>Free</td>
</tr>
</tbody>
</table>

5. Click the **Topic** for the recorded training session report that you wish to view.
Chapter 31: Publishing a Recorded Training Session

The Recorded Training Access Detail Report page appears.

6 If you wish to print the results, click Printer-friendly format.

7 If you wish to save the report as a comma-separated values (CSV) file, which you can export into a spreadsheet program, click Export Report.

About the My Training Recordings page

How to access this page

On your Training Center Web site, do one of the following:

- Click Host a Session > My Training Recordings.
- Click My WebEx > My Files > My Training Recordings.

What you can do here

You can use the My Training Recordings page to archive and publish recordings of training sessions that you host. You can record training sessions using WebEx Recorder, which is available in the Session window during a training session.

Options on this tab
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Topic</td>
<td>Indicates the topic for the recording. Once you publish a recording, you can click this link to view information about the recording and access a page on which you can change information about the recording.</td>
</tr>
<tr>
<td>Presenter</td>
<td>Indicates the name of the person who presented information that was recorded. By default, your name appears as the presenter.</td>
</tr>
<tr>
<td>Type</td>
<td>Indicates the publication status of the recorded training session, which can be one of the following:</td>
</tr>
<tr>
<td></td>
<td><strong>Private</strong>: The recorded session is not published; that is, the recorded session does not appear on the Recorded Sessions page on your Training Center Web site.</td>
</tr>
<tr>
<td></td>
<td><strong>Public</strong>: The recorded session is published; that is, the recorded session appears on the Recorded Sessions page on your Training Center Web site.</td>
</tr>
<tr>
<td></td>
<td><strong>Internal</strong>: The recorded session is published, but only users who have an account on your Training Center Web site can view the recording on the Recorded Sessions page on your Training Center Web site.</td>
</tr>
<tr>
<td>Date</td>
<td>Indicates the date that the recording was created.</td>
</tr>
<tr>
<td>Size</td>
<td>Indicates the size of the recorded file, in kilobytes.</td>
</tr>
<tr>
<td>Duration</td>
<td>Indicates the duration of the recording.</td>
</tr>
<tr>
<td>Format</td>
<td>Indicates the format of the recorded file. The recording may include a PowerPoint file (PPT), a network-based recording file (ARF), or an On-Demand Module file (Presentation Studio).</td>
</tr>
<tr>
<td></td>
<td>Click this icon to play the recording.</td>
</tr>
<tr>
<td></td>
<td>Click this icon to send the recording via email.</td>
</tr>
<tr>
<td></td>
<td>Click this icon to reveal the Download, Modify, and Delete options.</td>
</tr>
<tr>
<td></td>
<td>Click this icon to download the recording to a local drive.</td>
</tr>
<tr>
<td></td>
<td>Click this icon to change any information about the recording that appears in this list. For details about the editing options, see <em>About the Add a Recording/Edit Recording Information page</em> (on page 548).</td>
</tr>
<tr>
<td></td>
<td>Click this icon to delete the selected recording file from the list.</td>
</tr>
<tr>
<td></td>
<td>If this icon appears, indicates that registration is required; that is, users must provide information on a registration form to view the recording. You can specify the information that you want users to provide by editing the</td>
</tr>
</tbody>
</table>
Add a Recording

Opens the Add a Recording page, on which you can publish a recording by doing one of the following:

- Specify the URL for the file on another server
- Upload the recording from your local machine to your Training Center Web site
- Upload the recording from the network server
- Create a Presentation Studio presentation, if your site has the On-Demand Module option.

Once you add a recording, it appears in the list.

For details about the options for publishing a recording, see About the Add a Recording/Edit Recording Information page (on page 548).

About the Add a Recording/Edit Recording Information page

How to access this page

On your Training Center Web site, do one of the following:

- Click Host a Session > My Training Recordings > Add a Recording or Edit icon.
- Click My WebEx > My Files > My Training Recordings > Add a Recording or Edit icon.

Options on this page

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recording topic</td>
<td>Specifies the topic for the recording. (Required with the On-Demand Module)</td>
</tr>
<tr>
<td>Type</td>
<td>Specifies to whom the recording is available.</td>
</tr>
</tbody>
</table>
## Chapter 31: Publishing a Recorded Training Session

### Option Description

- **Private**: The recording is not published on the Recorded Sessions page on your Training Center Web site. It appears only on your My Training Recordings page.
- **Listed for all (public)**: Publishes the recording on the Recorded Sessions page on your Training Center Web site. Visitors to your site need not log in to your site to see the recording in the list.
- **Listed for authorized users only (internal)**: Publishes the recording on the Recorded Sessions page on your Training Center Web site. Users must log in to your site to see the recording in the list.

### Session Fee and Payment

(Optional feature) Set up eCommerce if you want to charge attendees for viewing the recording:

- Enter the session fee
- Select whether you want to allow viewers to use coupons.
- Set the access period.

**Note**: Registration must be enabled in order to use eCommerce.

### Presenter

Specifies the name of the presenter for the training session or the person who made the recording. (Required with the On-Demand Module)

### Email Address

 Specifies the presenter’s email address. (Required with the On-Demand Module)

### Description

Specifies a description of the recorded training session. (Required with the On-Demand Module)

### Agenda

Specifies the agenda for the recorded session.

### Recording file

Lets you select a recording file to publish.

- **I will provide a URL**: Specifies that the recording file resides on a server on the Internet. Specify the URL for a recording file in the box. The server on which the file resides must be publicly accessible—that is, the server cannot be behind a firewall on your private network. If you use this option, your Training Center Web site creates a link to the file on the Recorded Sessions page.
- **Use the file on my local machine**: Specifies that the recording file resides on your computer or another computer on your local network.
  - **Browse**: Lets you select a recording file that resides on your computer or another local computer on your network.
  - **Upload file**: Uploads the file specified in the Browse box to your Training Center Web site.
- **Find the recording from WebEx network**: Specifies that the recording file resides on your WebEx network server.
  - **Look Up**: Lets you select a file from a list of recordings that
Chapter 31: Publishing a Recorded Training Session

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>resides on your WebEx network server.</td>
</tr>
<tr>
<td></td>
<td>□ See the &quot;Playback Control Options&quot; section later in this section for information on recording playback options.</td>
</tr>
<tr>
<td></td>
<td>▪ (Optional feature) Create a Presentation Using Presentation Studio: Specifies that you want to create a presentation using the On-Demand Module. There are four options:</td>
</tr>
<tr>
<td></td>
<td>□ WebEx Recording File (.wrf) - create a presentation based on a recorded training session</td>
</tr>
<tr>
<td></td>
<td>□ PowerPoint with audio narration using telephone - create a voice narrated presentation based on a PowerPoint presentation</td>
</tr>
<tr>
<td></td>
<td>□ PowerPoint with narration using video or audio File - create a Web-based presentation with streaming video or audio based on a PowerPoint presentation</td>
</tr>
<tr>
<td></td>
<td>□ Video or audio only - create a standalone Web-based presentation with streaming video or audio. No PowerPoint presentation is necessary.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> If you choose the Create a Presentation Using Presentation Studio option, the <strong>Duration</strong>, <strong>File size</strong>, and <strong>Date</strong> fields will be disabled.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Duration</th>
<th>(Sites without the On-Demand Module)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Specifies the length of time for the recording.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>File size</th>
<th>(Sites without the On-Demand Module)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Specifies the size of the recording file, in kilobytes (KB).</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Date</th>
<th>(Sites without the On-Demand Module)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Specifies the date on which the recording was made.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Set password</th>
<th>Specifies the password to view or download the recording.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Confirm password</td>
<td>Specifies the password again, to prevent typing errors.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Registration</th>
<th>▪ <strong>Requires registration</strong>: Specifies that a user must provide information on a registration form before viewing or downloading the recording.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>▪ <strong>Customize form</strong>: Opens a page on which you can specify the information that a user must specify on the registration form.</td>
</tr>
</tbody>
</table>

| Add View/Download | ▪ **Attendees can view recordings**: Users can view the recording on your Training Center Web site, but they cannot download the recording file to their computers. |
|                   | ▪ **Attendees can view and download recordings**: Users can view
### Option Description

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>the recording on your Training Center Web site, and they can download the recording file to their computers.</td>
<td><strong>Note</strong> The <strong>Attendees can view and download recordings</strong> option is disabled for Presentation Studio recordings.</td>
</tr>
<tr>
<td>Display this URL at end of playback (Sites without the On-Demand Module)</td>
<td>Specifies a Web page that automatically appears once the recording ends.</td>
</tr>
<tr>
<td>Add (Sites without the On-Demand Module)</td>
<td>Adds the new recording to your list of recordings. If you published the recording, it appears on the Recorded Sessions page on your Training Center Web site.</td>
</tr>
<tr>
<td>Add (Sites with the On-Demand Module)</td>
<td>Opens the Recording Created page, which shows that your recording has been created successfully. Clicking <strong>OK</strong> adds the new recording to your list of recordings. If you published the recording, it appears on the Recorded Sessions page on your Training Center Web site.</td>
</tr>
<tr>
<td>Save (Sites without the On-Demand Module)</td>
<td>Saves your changes to the information about the recording.</td>
</tr>
<tr>
<td>Save (Sites with the On-Demand Module)</td>
<td>Opens the Recording Updated page, which shows that your recording has been updated successfully. Clicking <strong>OK</strong> saves your changes to the information about the recording.</td>
</tr>
<tr>
<td>Submit Changes (Sites without the On-Demand Module)</td>
<td>Opens the Recording Updated page, which shows that your recording has been updated successfully. Clicking <strong>OK</strong> saves your changes and opens the Recording Information page.</td>
</tr>
<tr>
<td>Cancel (Sites without the On-Demand Module)</td>
<td>Cancels all changes made on the page and returns you to the My Training Recordings page.</td>
</tr>
</tbody>
</table>

**Customize Presentation page (On-Demand Module only)**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select a logo image for the presentation (optional)</td>
<td>Click <strong>Browse</strong> to select a JPEG or GIF file that resides on your computer. The file size should be less than 60 KB (210W x 40H pixels is recommended).</td>
</tr>
<tr>
<td>Select a presenter image (optional)</td>
<td>Click <strong>Browse</strong> to select a JPEG file that resides on your computer. The file size should be less than 60 KB (192W x 144H pixels is recommended). If there is no presenter image, the first PowerPoint slide will appear.</td>
</tr>
<tr>
<td>Submit Changes</td>
<td>Opens the Recording Updated page, which shows that your recording has been updated successfully. Clicking <strong>OK</strong> saves your changes and opens the Recording Information page.</td>
</tr>
</tbody>
</table>
# Chapter 31: Publishing a Recorded Training Session

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Option</strong></td>
<td>Description</td>
</tr>
<tr>
<td><strong>Option</strong></td>
<td>opens the Recording Information page.</td>
</tr>
<tr>
<td><strong>Cancel</strong></td>
<td>Cancels all changes made on the page and returns you to the My Training Recordings page.</td>
</tr>
</tbody>
</table>

## Slide Detail page (On-Demand Module only)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Thumbnail/Zoom</strong></td>
<td>Click the slide thumbnail or <strong>Zoom</strong> to view a larger image of the slide. If the slide contains a file, URL, or test, it will open in a separate window for viewing.</td>
</tr>
<tr>
<td><strong>Listen to Audio</strong></td>
<td>Click <strong>Listen to Audio</strong> to open the associated audio file in a new window.</td>
</tr>
<tr>
<td><strong>Submit Changes</strong></td>
<td>Opens the Recording Updated page, which shows that your recording has been updated successfully. Clicking <strong>OK</strong> saves your changes and opens the Recording Information page.</td>
</tr>
<tr>
<td><strong>Cancel</strong></td>
<td>Cancels all changes made on the page and returns you to the My Training Recordings page.</td>
</tr>
</tbody>
</table>

## Edit Slides page (On-Demand Module only)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Source</strong></td>
<td>Insert before/insert after: Inserts the file, URL, or test before or after the highlighted slide in the current presentation.</td>
</tr>
<tr>
<td><strong>Source</strong></td>
<td>Insert a file: Opens a window where you can name and insert a new slide into the presentation from a file stored on your computer.</td>
</tr>
<tr>
<td><strong>Source</strong></td>
<td>Insert a URL: Opens a window where you can name and insert a new slide into the presentation that contains a URL.</td>
</tr>
<tr>
<td><strong>Source</strong></td>
<td>Insert a test: Opens the Add a Test page, where you can select a test from the Test Library and add it to the presentation.</td>
</tr>
<tr>
<td><strong>Source</strong></td>
<td>Insert PowerPoint slides from desktop: Select Insert to add PowerPoint slides from your desktop into your presentation.</td>
</tr>
<tr>
<td><strong>Source</strong></td>
<td>Insert slides from an online presentation: Click Select an online presentation to open a window where you select one of your Presentation Studio presentations, the slides of which will appear in the Select slide section.</td>
</tr>
<tr>
<td><strong>Source</strong></td>
<td>Replace slide only: Replaces the highlighted slide in the current presentation with the highlighted slide in the source presentation.</td>
</tr>
<tr>
<td><strong>Source</strong></td>
<td>Insert before/after: Inserts the highlighted slide into the current presentation according to insert settings and the selected location.</td>
</tr>
<tr>
<td><strong>Source</strong></td>
<td>Zoom: Opens a larger image of the slide.</td>
</tr>
<tr>
<td><strong>Current Presentation</strong></td>
<td>Modify slide title: Opens a window where you can change the title of the highlighted slide.</td>
</tr>
<tr>
<td><strong>Current Presentation</strong></td>
<td>Delete: Removes the highlighted slide from the presentation</td>
</tr>
</tbody>
</table>
Chapter 31: Publishing a Recorded Training Session

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• <strong>Zoom</strong>: Opens a larger image of the slide.</td>
</tr>
<tr>
<td><strong>Submit Changes</strong></td>
<td>Opens the Recording Updated page, which shows that your recording has been updated successfully. Clicking <strong>OK</strong> saves your changes and opens the Recording Information page.</td>
</tr>
<tr>
<td><strong>Cancel</strong></td>
<td>Cancels all changes made on the page and returns you to the My Training Recordings page.</td>
</tr>
</tbody>
</table>

**Playback control options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Panel Display Options** | Determines which panels are displayed in the recording when it is played back. You can select any of the following panels to be included in the recording playback:  
• Chat  
• Q & A  
• Video  
• Polling  
• Notes  
• File Transfer  
• Participants  
• Table of Contents  
Panel display options do not modify the panel display in the actual recording that is stored on the WebEx network. |
### Chapter 31: Publishing a Recorded Training Session

#### Option | Description
--- | ---
**Recording Playback Range** | Determines how much of the recording is actually played back. You can select *either* of the following:
- **Full playback**: Plays back the full length of the recording. This option is selected by default.
- **Partial playback**: Plays back only part of the recording based on your settings for the following options:
  - **Start: X min X sec of the recording**: Specifies the time to start playback; for example, you can use this option if you would like to omit the "dead time" at the beginning of the recording, or if you would like to show only a portion of the recording.
  - **End: X min X sec of the recording**: Specifies the time to end playback; for example, you can use this option if you would like to omit the "dead time" at the end of the recording. You cannot specify an end time greater than the length of the actual recording.

The partial playback range you specify does not modify the actual recording that is stored on the server.

---

**Include NBR player controls** | Includes full Network Recording Player controls, such as stop, pause, resume, fast forward, and rewind. This option is selected by default. If you would like to prevent viewers from skipping portions of the recording, you can turn off this option to omit Network Recording Player controls from the playback.

---

### About the On-Demand Module

The On-Demand Module gives you the maximum flexibility to create high-impact, multimedia on-demand training content and publish it online for your attendees. You can use the On-Demand Module to:

- Re-create the live training experience for on-demand access by inserting a recording of a live session.
- Insert a test, and request your audience to take the test when they view the recording or presentation.
Chapter 31: Publishing a Recorded Training Session

- Create and deliver high-impact multimedia presentations complete with narration.

To create a presentation, select **Create a Presentation Using Presentation Studio** and specify one of the following files to upload (50 MB maximum):

- an existing WebEx recording file (WRF)
- a Powerpoint file (PPT)

Once you complete the Add a Recording page, your presentation will be submitted for processing. Once it is ready, you will receive an email explaining how to edit the presentation or add narration (Powerpoint only). By editing the presentation, you can also insert a test for your attendees to take when they view the presentation.

**About Optimizing Recording Playback Quality**

Once you specify a .wrf file to upload when creating a presentation using the On-Demand Module, you will be prompted to select which content to optimize.

**Options on this page**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Graphics</td>
<td>Select if the content of your presentation is graphic intensive. This option will provide better graphics quality during the playback of your recording.</td>
</tr>
<tr>
<td>Text</td>
<td>Select if the content of your presentation is text intensive. This option will provide better text quality during the playback of your recording.</td>
</tr>
</tbody>
</table>

**Note:** This playback quality option cannot be edited.
Viewing a Recorded Training Session

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>See…</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of viewing a recorded training session</td>
<td>About viewing a recorded training session (on page 557)</td>
</tr>
<tr>
<td>view a recorded training session</td>
<td>Viewing a recorded training session (on page 558)</td>
</tr>
<tr>
<td>take a recorded session test in a Presentation Studio presentation</td>
<td>Taking a recorded session test in a Presentation Studio presentation (on page 436)</td>
</tr>
</tbody>
</table>

**About viewing a recorded training session**

If a training session host publishes a recorded training session on your Training Center Web site, you can view the recording. A host may require that you do *one or both* of the following to view a recorded training session:

- Enroll to view a recorded training session. In this case, you must provide your name, email address, and any other information that the host requires.
- Provide a password. In this case, you must obtain the password from the host.

To view a recorded training session, you must use either the WebEx Player or the Windows Media Player 9 (or higher) to view it, depending on how the training session was recorded.
Your Training Center Web site automatically downloads WebEx Player to your computer the first time you view a recorded training session. A WebEx Player is available for the Windows operating system. If you have a user account, you can also download WebEx Player for Windows from the Support page on your Training Center Web site.

If the recording contains a Presentation Studio presentation, you will need the Windows Media Player 9 (or higher) on your computer to view it, as well as the following:

- Flash Player 7 (recommended but not required if recording includes Flash content)
- Sound card with proper driver installed

Use the latest operating systems and browsers to best view your recording:

- Windows 7 with Internet Explorer 7 (32-bit)
- Windows 7 SP1 with Internet Explorer 7 (64-bit) or Internet Explorer 8
- Windows XP SP3 with Internet Explorer 8
- Mac 10.5 with Safari 4
- Mac 10.6 with Safari 5

These other operating systems and browsers will work as well:

- Windows 2000, XP, or Vista
- Internet Explorer 6 or later, Firefox 3.0 or later, or Chrome 11 or later

**Viewing a recorded training session**

You can view a recorded training session by streaming it from your Training Center Web site, or by clicking the recording URL link that the host has sent to you. Once you select a recording to view, your Training Center Web site automatically downloads WebEx Player to your computer, and then plays the recording. If the recording contains a Presentation Studio presentation, you will need the Windows Media Player 9 (or higher) to view it.

**To view a recorded training session:**

1. If the host requires that you have a user account to view a recording, log in to your Training Center Web site.
2. On the navigation bar, expand *Attend a Session.*
Chapter 32: Viewing a Recorded Training Session

3. Click **Recorded Sessions**.

   The Recorded Sessions page appears.

4. For the recording that you would like to view, click the **Playback icon**.

   - If viewing the recording requires a password or access code, enter the password or access code that the host gave to you, and then click **OK**.
   - If viewing the recording requires registration, provide the required information on the registration form that appears, and then click **Register**.
   - If viewing the recording requires payment information, provide the required information and any coupon codes on the registration form that appears, and then click **Register**.

   The WebEx Player or Presentation Studio Viewer opens and begins playing the recording.

To access a recording URL from an email, instant message, or another Web site:

1. Click the recording URL link that was provided by the host.

   The Recording Information page appears.

   **Recording Information: Recording0221**

   - **Author:** test
   - **Email address:** test@webex.com
   - **Last modified:** Tuesday, February 21, 2006 3:08 pm
   - **Duration:** 1 hour
   - **Fee (USD):** $5
   - **Description:** N/A
   - **Agenda:**
   - **File size:** 469.14 KB
   - **Password:** Required to view or download
   - **View/Download:** Attendees can view and download this recording

   ![Buttons](View | Download | Close)

2. Click **View**.

   - If viewing the recording requires a password or access code, enter the password or access code that the host gave to you, and then click **OK**.
Chapter 32: Viewing a Recorded Training Session

- If viewing the recording requires registration, provide the required information on the registration form that appears, and then click **Register**.

- If viewing the recording requires payment information, provide the required information and any coupon codes on the registration form that appears, and then click **Register**.

The WebEx Player or Presentation Studio Viewer opens and begins playing the recording.

3 Optional. To download the recording, click the **Download icon** and save the file to your computer.
Index

.atp files • 283, 285
Cisco Unified MeetingPlace
  MeetingPlace Personal Conference • 100, 101, 103, 104
contact group • 481
during training session • 270
files, overview • 452
for downloading during training session • 270
in address book • 481
in personal folders, overview • 452
information about • 463
information about files • 456
information about in personal folders • 456
.txt files • 284, 286
for chat messages • 312
.ucf files
  opening • 224
  saving documents • 223
  saving presentations • 223
  saving whiteboards • 223
new personal folders for file storage • 454
pages to shared documents • 217
session to calendar • 8, 97
slides to shared presentations • 217
adding tests while scheduling • 94
address book
  adding contacts • 472
  creating contact group • 479
  importing contacts from file • 475
  importing contacts from Outlook • 477
  opening • 471
  searching for contacts • 479
  using, overview • 470
  viewing or editing contact information • 478
admitting participants • 375
to breakout sessions • 375
agenda • 90
  setting for scheduled session • 90
alerts • 148
  on panels • 148
allowing, breakout sessions • 360
annotating, shared software
  using annotation tools • 253
Annotation Color tool
  overview • 210
annotation tools
  for shared software, descriptions • 253
annotation tools, for shared documents
  Annotation Color tool • 210
  Eraser tool, overview • 210
  Highlighter tool, overview • 210
  Line tool, overview • 210
  Pointer tool, overview • 210
  Rectangle tool, overview • 210
  Text tool, overview • 210
annotations, on shared documents
  clearing • 221
  annotations, on shared documents
  selecting font • 221
answering polls • 280
  stopping • 256
taking screen capture • 257
  using tools • 253
application, shared

A
access • 181
  restricting • 181
Access Anywhere
  using • 451
Access Anywhere Usage report
  description • 492
account, user
  obtaining • 433
adding • 8, 97
  contacts to address book • 472

561
ensuring good imaging of color • 261
asking • 345
for help in Hands-on Lab • 345
assigning computers • 333, 334
in Hands-on Lab • 333
attempt limit, tests • 392
attendees • 69, 178, 180, 181, 184
creating a message or greeting for • 180
estimating number • 69
expelling from a session • 184
preventing from joining session • 181
transferring the host role to • 178
audio files
sharing a Web content • 266

starting Integrated VoIP conference • 374
starting one created on your behalf • 372
using Integrated VoIP conferencing • 373
using teleconferencing • 373
View menu in • 357
bringing application to front
on shared remote computer • 243
browsers, Web
sharing • 266

breakout session • 367
request presenters share content • 367
Breakout Session panel • 354
overview • 354
Breakout Session window • 352
overview • 352
admitting more participants • 375
allowing • 360
asking participants to return from • 366
Communicate menu • 358
creating for another participant • 364
Edit menu • 356
ending • 367, 379
ending Integrated VoIP conference • 375
File menu • 356
granting privileges • 360
leaving • 373
letting participant control software • 378
methods for starting • 370
overview • 351, 369
Participant menu • 358
passing the presenter role to another participant • 377
removing a participant from • 368
Share menu • 357
sharing content in main session • 380

C

calendar, adding session to • 8, 97
calendar. See training session calendar. • 22
canceling
   Personal Conference meetings • 104
chat messages
   printing • 311
   saving • 312
   sending • 309
checking system for UCF compatibility • 3
clearing • 320
   all annotations on shared documents • 221
   all pointers on shared documents • 222
   feedback • 320
   selected annotations on shared documents • 221
   your annotations on shared documents • 221
   your pointers on shared documents • 222
closing
   panels • 141
codes, tracking • 48
collapsing • 140
color in shared application, ensuring good imaging • 261
   Communicate menu • 358
   in breakout session • 358
computer, setting up
Meeting Manager • 2
computers • 60
reserving for Hands-on Lab • 60
computers in Hands-on Lab • 333, 334, 340, 349
assigning • 333
connecting to • 340
disconnecting from • 349
unassigning • 334
connecting • 340
to computer in Hands-on Lab • 340
contact group
creating in address book • 479
contact information
adding to address book • 472
creating contact group • 479
importing to address book from file • 475
importing to address book from Outlook • 477
maintaining, overview • 470
searching for in address book • 479
viewing or editing in address book • 478
content viewer • 134
description • 134
on Session window • 134
resizing • 142
controlling breakout sessions • 359
overview • 359
coupons, using for discounts to attendess • 50
course material • 9, 92
downloading • 9
publishing for scheduled session • 92
creating • 364
breakout session for another participant • 364
customizing • 64, 66, 86, 87
default email messages • 86, 87
about • 54
specifying for scheduled session • 54, 58
daylight saving time, adjusting training session times • 26
deleting
annotations on shared software • 253
contacts • 483
contacts from address book • 483
files • 458
files or folders • 458
from address book • 483
from personal folders • 458
meetings from My Meetings • 436
shortcuts for One-Click Meeting • 123
designating • 177
panelist for training session • 177
distribution list
creating in address book • 479
documents, shared
adding blank pages • 217
advancing pages automatically • 215
annotating • 221
clearing pointers • 222
printing pages • 225
saving to file • 223
downloading • 9
course material • 9
files • 457
from personal folders • 457
published files during a meeting • 270
published files during a training session • 270
published files during an event • 270
shortcuts, for One-Click Meeting • 118
shortcuts, WebEx One-Click panel • 118
drawing annotations
on shared documents • 221
on shared presentations • 221

date • 23
selecting on training session calendar • 23
dates and times • 54, 58

e-commerce • 49
about • 49
Edit menu • 356
in breakout session • 356
editing • 110
contact group in address book • 481
contact information in address book • 478
information about files in personal folders • 456
information about recordings • 463
Personal Conference meetings • 101
SCORM page • 110
e-mail messages • 83, 84, 85, 86, 87
customizing default • 86, 87
selecting to be sent to participants • 83
sending invitation to attendees • 84
sending registration notification to attendees • 85
sending reminders to attendees • 85
sending updates to attendees • 84
variables in default • 87
emoticons • 318
using in feedback • 318
ending • 185, 337, 367, 379
all breakout sessions • 367
breakout session • 379
Hands-on Lab sessions • 337
training sessions • 185
eraser
using to delete annotations on shared software • 253
Eraser tool
overview • 210
erasing
all annotations on shared documents • 221
all pointers on shared documents • 222
selected annotations on shared documents • 221
your annotations on shared documents • 221
your pointers on shared documents • 222
estimating • 69
number of attendees • 69
exchanging files
during a meeting • 270
during a training session • 270
during an event • 270
during event • 270
during training session • 270
expanding • 140
panels • 140
expelling • 184, 368
attendee from session • 184
participant from breakout session • 368

fee-based training • 49
setting up • 49
fee-based training, about • 49
feedback
allowing participants to use • 316
clearing • 320
overview of • 315
using emoticons in • 318
viewing • 317
File menu • 356
in breakout session • 356
files • 9, 283, 284, 285, 286
.atp • 283, 285
txt • 284, 286
.ucf (Universal Communications Format)
for multimedia • 223
during a meeting • 270
during a training session • 270
during an event • 270
exchanging during a meeting • 270
exchanging during a training session • 270
exchanging during an event • 270
exchanging during event • 270
exchanging during training session • 270
for chat • 312
for course material, downloading before a session starts • 9
for poll questionnaire • 283
for poll questionnaires • 285
for poll results • 284, 286
from personal folders • 457
in personal folders • 455, 458
in your personal folders, overview • 452
moving or copying in personal folders • 455
searching in personal folders • 457
sharing on Personal Meeting Room page • 450
stop publishing during event • 270
stop publishing during training session • 270
to personal folders • 454
Flash files
  sharing as Web content • 266
folders, personal
  adding new for file storage • 454
  moving files • 455
  opening • 453
  overview • 452
  searching for files • 457
font
  selecting for annotations • 221
full-screen view • 145, 146
  and panels • 145
  sharing • 146

G

generating reports • 492, 494
grading tests • 397
granting privileges • 188
  to attendees • 188
greeting • 77, 180
  creating for a scheduled session • 77
  creating for attendees • 180
  training session information • 26
group results, for poll • 284
  saving • 284

H

Hands-on Lab • 59, 60, 61, 322, 329, 331,
  333, 334, 335, 336, 337, 340, 341, 342,
  343, 344, 345, 346, 347, 348, 349
  about • 60
  asking all to return • 336
  asking for help • 345
  assigning computers • 333
  broadcasting message • 334
  chatting in • 344
  connecting to computers • 340
  disconnecting from computers • 349
  ending • 337
  ending Integrated VoIP conference • 343
  leaving • 348
Manager window • 343
  overview • 322
  passing control of computer • 347
  recording • 331
  reserving computers for • 60
  responding to request for help • 335
  setting up • 59
  starting • 329
  starting Integrated VoIP conference • 342
  taking control of computer, as presenter • 336
  transferring files in • 346
  unassigning computers • 334
  using Integrated VoIP conferencing • 341
  using teleconferencing • 341
  viewing the schedule • 61
Hands-on Lab page, about • 60
  header, custom
    adding to Personal Meeting Room page • 449
help • 335, 345
  asking for in Hands-on Lab • 345
  responding to in Hands-on Lab • 335
hiding
  contents of screen on shared remote
  computer • 242
Highlighter tool
  overview • 210
high-resolution color in shared application
  ensuring good imagi • 261
home page for site
  setting • 490
host key • 179
  using to reclaim host role • 179
host role • 178, 179
  reclaiming • 179
  transferring to attendee • 178
I

iCalendar • 8, 97
images
adding to Personal Meeting Room page • 449
importing
contacts to address book from file • 475
contacts to address book from Outlook • 477
individual results, for poll • 284
saving • 284
information about training sessions, obtaining • 16
information on session • 179
obtaining • 179
installing
Meeting Manager • 2
WebEx One-Click • 118
Integrated VoIP • 53
system requirements for • 53
integrated VoIP conference • 342, 343, 374, 375
ending in breakout sessions • 375
ending in Hands-on Lab • 343
starting during breakout session • 374
starting during Hands-on Lab • 342
Integrated VoIP phone conference • 53
setting up for a scheduled session • 53
invitations • 84
sending to attendees in email messages • 84
inviting • 68, 69, 71
attendees and presenters to a scheduled session • 68, 69
presenters to a scheduled session • 71
joining training session • 5, 11, 13
from email message • 11
listed • 11
overview • 5
unlisted • 13

K

keyboard
disabling on shared remote computer • 240

L

language and locale for site
setting • 490
leaving • 184, 348, 373
breakout session • 373
Hands-on Lab • 348
training session • 184
Line tool
overview • 210
list of meetings, personal
maintaining • 436
overview • 435
listed sessions • 46
specifying when scheduling • 46
listed sessions, about • 45
listed training session • 11
joining • 11
live sessions calendar • 17, 18, 19
overview • 17
refreshing • 19
searching for a training session in • 18
selecting time zone on • 19
sorting • 18
locking • 181
access to training session • 181
shared remote computer • 243
log in • 75
requiring attendees to • 75
logging in to and out from site • 434
maintaining contact information, overview • 470
personal list of meetings • 436
Personal Meeting Room page, overview • 448
making • 177, 178
another participant the host • 178
attendee a panelist • 177
managing • 393, 396
recorded tests • 396
tests • 393
managing training sessions • 167
overview of • 167
manual installer
Meeting Manager • 2
media players for UCF media files
checking if installed on com • 3
meeting calendar
Daily view • 22
Monthly view • 22
overview • 21
refreshing • 26
removal of training sessions • 21
searching for training session • 24
selecting date • 23
selecting time zone • 26
sorting • 25
Today view • 22
Weekly view • 22
Meeting Manager
setting up • 2
system requirements • 2
meeting service
system requirements • 2
meetings
searching for on training session calendar • 24
menu bar • 134
overview • 134
message • 77, 180
adding to Personal Meeting Room page • 449
creating for a scheduled session • 77
creating for attendees • 180
messages • 83
sending to participants • 83
minimizing • 139
panels • 139
mouse
disabling on shared remote computer • 240
multimedia
sharing as Web content • 266
My Computers
using • 451
My Contacts
adding contacts • 472
creating contact group • 479
importing contacts from file • 475
importing contacts from Outlook • 477
opening • 471
searching for contacts • 479
using, overview • 470
viewing or editing contact information • 478
My Files
adding folders • 454
maintaining, overview • 452
moving or copying files or folders • 455
opening • 453
searching for files • 457
My Meetings
maintaining • 436
overview • 435
My Profile
editing • 490

One-Click Meeting
overview • 113
removing shortcuts • 123
setting up • 114
setting up on service Web site • 114
starting from service Web site • 120
One-Click panel
removing from computer • 123
One-Click Settings page
descriptions • 114
One-Click shortcuts
removing from computer • 123
opening • 22, 285, 286
address book • 471
chat file • 313
file for • 313
list of your recordings • 462
personal folders • 453
poll questionnaire file • 285
poll results file • 286
saved chat files • 313
saved document • 224
saved presentation • 224
saved whiteboard • 224
shared whiteboard • 213
user profile • 490
your list • 462
opening enrollment • 375
to breakout session • 375
options • 143
for panels • 143

password • 45, 75
excluding from email invitations • 75
setting up for scheduled session • 45
pay-per-use • 50
setting up for a session • 50
pay-per-use training, about • 49
PCNow
see Access Anywhere • 451
Personal Conference meetings
adding to calendar • 101
canceling • 104
editing • 101
setting up • 100
personal folders
adding new for file storage • 454
moving or copying files • 455
opening • 453
searching for files or folders • 457
Personal Meeting Room page
add images and text • 449
overview • 448
setting options • 449
sharing files • 450
viewing • 448
picture • 90
adding to Session Information page • 90
pointer
using on shared software • 253
Pointer tool
overview • 210
pointers, clearing from
shared document • 222
shared presentation • 222
shared whiteboard • 222
poll • 279
opening • 279
poll questionnaire • 274
preparing • 274
poll questionnaire and results • 283
save, open • 283
poll questionnaires • 274, 279, 280, 283, 285
filling out • 280
opening file for • 285
preparing • 274
presenting to attendees • 279
saving • 283
poll results • 281, 282, 284, 286
opening file for • 286
saving • 284
share with attendees • 282
sharing results with attendees • 282
view • 282
viewing as attendee • 281
polling • 278, 280
answering • 280
tabs • 278
polls • 273, 279, 280
introduction to • 273
participating in • 280
taking • 279
pre- or post-session test • 405
preferences
setting for site • 490
Presentation Studio • 525
presentations, shared
adding blank slides • 217
annotating • 221
clearing pointers • 222
printing slides • 225
saving to file • 223
printing
chat messages • 311
pages in shared documents • 225
shared whiteboards • 225
slides in shared presentations • 225
privileges • 174, 188, 360
annotating shared documents • 188
chatting privately • 188
chatting with all attendees • 188
displaying thumbnails of pages • 188
granting for breakout sessions • 360
granting for training session • 174, 188
joining breakout sessions • 188
printing shared documents • 188
recording the session • 188
saving shared documents • 188
sharing documents • 188
viewing any document • 188
viewing any page • 188
viewing attendee list • 188
privileges and options • 74
specifying for participants • 74
profile, user
editing • 490
publishing
files during event • 270
files during training session • 270
publishing course material • 92

Q

questionnaire • 274, 277
changing type, editing, rearranging,
deleting • 277
compose, prepare • 274
delete • 277
questionnaires • 390
converting to tests • 390

R

recorded tests • 392, 393, 396
managing • 396
sending grade reports to attendees for • 393
sending invitation to attendee for • 393
setting a time limit for • 393
test delivery options • 392
Recorded Training Access Detail report • 513
description • 513
Recorded Training Access report • 513
description • 513
Recorded Training Access Summary report • 513
description • 513
recorded training sessions • 526
viewing • 526
recordings
uploading • 462
Rectangle tool
overview • 210
refreshing • 19
list of sessions • 19
refreshing training session calendar • 26
registering for a training session • 6
registration • 62
requiring for attendees • 62
registration form • 64, 66
customizing • 64, 66
registration notification • 85
sending to attendees in email messages • 85
registration options for training session • 62
specifying • 62
reminders • 85
sending to attendees in email messages • 85
remote computer sharing
overview • 4
starting • 235
stopping • 238
remote computer, shared
bringing application to the front • 243
disabling and enabling keyboard and mo • 240
hiding contents of screen • 242
locking and unlocking • 243
logging in to and out from • 243
managing, overview • 239
reducing screen resolution • 240
selecting additional applications • 237
showing to attendees • 235
remote control, of software • 378
granting to participant in breakout session • 378
removing • 184
attendee from session • 184
shortcuts for One-Click Meeting • 123
WebEx One-Click from computer • 123
renaming polling tabs • 278
reordering polling tabs • 278
reports • 513
generating • 494
generating, overview • 492
types of • 492, 513
viewing • 513
requirements, system • 525
requiring • 75
attendees to log in to your Web site • 75
requiring registration • 62
resetting
panels • 142
resizing
content viewer • 142
panels • 142
restoring • 139
panels • 139
restricting • 181
access to training session • 181
results, for poll • 284, 286
opening • 286
saving • 284
right-click menu of taskbar icon shortcut • 120
saving • 283, 284
annotations on shared software • 257
chat messages • 312
copy of chat messages • 312
documents, shared • 223
poll questionnaires • 283
poll results • 284
presentations, shared • 223
shared documents • 223
shared presentations • 223
shared whiteboards • 223
whiteboards, shared • 223
schedule • 61
viewing for Hands-on Lab • 61
scheduling a training session • 39, 45, 46, 48, 51, 53, 54, 58, 62, 74, 90, 92, 95, 96, 97
about • 39
allowing another host to schedule yours • 96
training session • 96
allowing another host to schedule yours • 96
for another host • 97
publishing course material for • 92
requiring registration • 62
setting a password • 45
setting a topic name • 45
setting agenda for • 90
setting up a teleconference • 51
setting up Integrated VoIP • 53
specifying dates and times • 54, 58
specifying listed or unlisted • 46
specifying options and privileges available to participants • 74
specifying registration options • 62
specifying tracking codes • 48
using templates • 95
scheduling session • 39
  See also session, scheduling • 39

zzz • 39
scheduling templates
  about managing • 491
scoring tests • 397
SCORM • 109, 110
inging • 110
overview of • 109
viewing • 110
screen capture
  taking of annotations on shared software • 257
screen resolution
  reducing for shared remote computer • 240
searching • 18, 24
  for a training session in list of sessions • 18
  for contacts in address book • 479
  for files in personal folders • 457
  for training session on training session calendar • 24
security • 40
  choosing for a training session • 40
security options • 75
  specifying for a training session • 75
sending
  chat messages • 309
session • 39
  scheduling a • 39
Session Detail report
description • 492
session information • 89
  specifying • 89
Session Information page • 90, 91
  adding picture to • 90
  displaying Quick Start • 91
      adding to Session Information page • 91
Session Options page, about • 78
Session window • 134
  content viewer • 134
sessions. See training sessions. • 177
setting • 143
  options for panels • 143
setting up • 39, 41, 94
  a scheduled training session • 39, 41
    for Access Anywhere • 451
    for remote access • 451
    for Windows • 2
  Meeting Manager • 2
  One-Click Meeting • 114
  Personal Conference meetings • 100
tests for training sessions • 94
setting up One-Click Meeting
  on service Web site • 114
Share menu • 357
  in breakout session • 357
shared remote computer. See remote computer, shared. • 239
sharing • 134, 146, 282, 380
  breakout session content in main session • 380
Flash files, as Web content • 266
  in full-screen view • 146
poll results with attendees • 282
streaming audio, as Web content • 266
streaming video, as Web content • 266
tools in content viewer • 134
Web browsers • 266
Web content, overview • 265
sharing window
  overview • 227
shortcuts
  for One-Click Meeting, downloading • 118
  shortcuts, for One-Click Meeting
    removing • 123
  shortcuts, WebEx One-Click panel
    downloading • 118
slides, in shared presentations
  adding • 217
  clearing annotations • 221
  clearing pointers • 222
  printing • 225
software sharing
  See also software, shared • 227
software, shared
  ensuring good imaging of color • 261
  using annotation tools • 253
viewing • 227
sorting • 18
  list of sessions • 18
training session calendar • 22, 24, 25, 26,
  27, 29, 31, 33, 35
starting • 329, 370, 393
   a test within a session • 393
breakout sessions • 370
Hands-on Lab • 329
remote computer sharing • 235
Web browser sharing • 234
whiteboard sharing • 213
starting a One-Click Meeting
   from Meeting Center • 120
   from service Web site • 120
stopping • 379
   annotations on shared software • 256
   breakout session • 379
   remote computer sharing • 238
streaming audio
   sharing as Web content • 266
streaming video
   sharing as Web content • 266
Summary Usage report
description • 492
Summary Usage report CSV file
description • 492
system requirements • 525
   Meeting Manager • 2

T

Taking • 405
taskbar icon shortcut • 120
teleconference • 51
   setting up when scheduling a session • 51

W

WebEx One-Clickinstalling • 118